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1 What's New?

1.1 What's New in V15?

The main new feature in Version 15 is high DPI support.

When running on high resolution monitors, Windows will automatically use a scaling factor (125% or
150% is typical) to increase the size of text and other user interface elements (eg, icons and buttons).
Unfortunately, this has the effect of making V look a bit blurry.

With the high DPI support in V15, V recognizes that it is running on a high resolution monitor and adjusts
the user interface accordingly. Windows no longer scales the text and V once again looks crisp and
sharp!

Version 15 has a new, slightly larger toolbar. If you prefer smaller icons, you can right-click on the
toolbar and select S m a lle r Ic o ns.

V15 also introduces Tab Sets and a new Highlight All functionality.

T a b  Se ts

FolderTabs are a great way of bookmarking often visited folders. You can quickly go to a folder by
clicking on its tab. However, FolderTabs can get a bit messy once you start having many folders. This is
where Tab Sets are useful.

Tab Sets allow you to create several different sets of tabs and decide which set to use based on what
you are doing. For example, you can use one set of tabs when you are organizing your photo collection,
another set of tabs for your music, another for your Word documents and spreadsheets and another set
for general use.

To save the current tabs in a Tab Set, right-click on any tab and select S a v e  a s  T a b  S e t. To load in a
new Tab Set, right-click on any tab and select Lo a d  T a b  S e t..

Click here for further details.

Hig hlig ht All

The Highlight All functionality has changed in V15. Previously, only all occurrences of the se a rch
string  were highlighted. As of V15, all occurrences of the se le c te d  te xt are highlighted. For example,
if you double-click on a word, all occurrences of that word will be highlighted.

No te s

The Highlight All selections are not sticky. That is, they will disappear as soon as you click the mouse
to clear the text selection.

Highlight All does not work on multiline selections and does not work in Hex mode.
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1.2 What's New in V14?

The main new feature in Version 14 is the introduction of CSV mode.

V will now automatically recognize most CSV files (Comma Separated Values)  and will display them
as a table - where all the columns have the same width.

V14 also introduces the following options:

RE to match path (instead of name) option added to Find Files/GREP. This option matches the
regular expression mask against the fully qualified file path instead of just the file name.

Display generic EXE icon option added to the Directory Options section of Preferences. This
option causes the same icon to be displayed for all EXE files in the directory listing. This can
greatly speed up the directory listing - especially if you are listing EXE files on a slow network
drive.

Use Shell Notifications for directory refresh option added to the More Options section of 
Preferences.

/o command line option to specify the directory sort order.

Subsequent V14 Service Releases added the following options:

Multi-row FolderTabs

Added Octal Word to the Hex Formats.

Added URL Path to the file name formats that can be copied to the clipboard

Expand all Folders command

Expand/Collapse on single click option

Save as ASCII option when extracting from XMIT/AWS files

1.3 What's New in V13?

The two main changes in Version 13 are:

Support for XMIT and AWS files (used in IBM mainframe environments).

An experimental Bioinformatics/DNA search which lets you search for amino acid strings and
IUPAC codes in files containing DNA sequences.

Other minor changes include:

Better support for Unicode files containing Asian characters.

The ability to change the font used by the Directory/Mask/Device boxes and by the FolderTabs.

Environment variables can now be entered in the Directory box.

Spanish, French and Russian language interfaces can now be selected from the new Language
tab of Preferences. More languages will follow.
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1.4 What's New in V12?

The main changes in Version 12 are:

Search can now be initiated from the command line

Support for Everything Search

7Zip support (.7z archives)

Data displayed with GridLines can now be exported to a CSV file (Comma Separated Values). 

Other new features include:

Synchronized scrolling when multiple file windows are open

Allow Partial Name Match and Regular Expression options in Find Files/GREP 

You can limit what archives will be searched in Find Files/GREP

You can now also sort on the Text column in the Search results

Compatibility Files displayed in the directory listing (Vista/Windows 7)

User Commands can now be run as admin (Vista/Windows 7)

Error reports can now be sent to fileviewer.com for analysis

New EOL (End Of Line) options

Disable Automatic Refresh for Network Drives option may help if you find V slow on network/
remote drives

You can now set the File Mask History to 1 (effectively disabling it)

Ctrl+Shift+E is now used to launch the hex editor
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1.5 What's New in V11?

The three main changes in Version 11 are:

A change to the way that V scrolls a document with the introduction of a current line marker

The introduction of more traditional bookmarking (Ctrl+F2/F2)

Improved support for Windows 7/Vista (including better support for themes)

Other new features include:

The File Mask can now be applied to directories as well as files

The Touch command can now reset the Last Modified time to the Creation time

The seconds can now be displayed in the File Time column of the directory listing (right-click on
the header and enable S ho w S e c o nd s)

The Create Directory command will now work with a nested directory path (eg, Dir1\Dir2\Dir3)

A UNC Path option has been added to the Copy to Clipboard command

In Dual Pane mode, you can resize the panes by right-clicking on the splitter bar and selecting
one of the default ratios (like 50% - 50%)

A Check for Updates command on the Help menu

New options in Version 11 include:

Save Bookmarks on Exit (File Options tab)

Do not scroll current line marker and Always scroll window when using arrow keys (File Options
Tab)

Add all viewed files to Windows Recent Documents/Items and Add all executed files to Windows
Recent Documents/Items (Double-Click tab)

New (or modified) keyboard shortcuts in Version 11 are:

Ctrl+Alt+Up/Down are now used for Next/Previous chunk (instead of Ctrl+Up/Down)

Ctrl+Alt+Home/End are now used for First/Last chunk (instead of Ctrl+Alt+Up/Down)

Ctrl+Shift+Up/Down are now used for Continuous Up/Down (instead of Shift+Up/Down)
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1.6 New Scrolling Behavior

Until now, V did not display a c a re t to indicate the c urre nt p o s itio n when viewing a file.

V11 still does not display a caret, but it does now highlight the current line to indicate the c urre nt
p o s itio n.

Pressing the Up/Down arrow keys will now move the current line marker (instead of scrolling the
window). The window is now only scrolled when the line marker reaches the bottom (or top) of the
window.

If you prefer the old behavior (where the window would always scroll), enable Always scroll window
when using arrow keys in the File Options tab of Preferences.

If the window is scrolled using the scroll bars (with the mouse), V will automatically move the current line
marker accordingly. If you prefer the current line marker to stay where it is, enable Do not move current
line marker when using scroll bars.

You can now use the shift keys (eg, Shift+DownArrow, Shift+PageDown) to select text, just as in a text
editor. New keys have been defined and some old keys now have new meanings. For example Ctrl
+S hift+H o m e /Ctrl+S hift+E nd will now move the current line marker to the top/end of the window. If you do
not like some of the new key re-assignments, you can change them to your liking by selecting 
Customize Keyboard from the Tools menu.

Curre nt Line  Co lo r
The background of the current line is drawn in a different color. If you do not like the default color that V
uses, you can change it by selecting Customize Colors from the View menu. Note that setting the c urre nt
line  b a c k g ro und to the same color as the no rm a l b a c k g ro und effectively disables the current line
marker.

Se le c te d  T e xt a nd  Scro ll ing

V does not clear any selected text when the keyboard is used for scrolling. That is, as you scroll the file
with the arrow keys, any selected text remains selected. The selected text will remain selected until you
either start a new text selection or you left-click on the file with the mouse.

The selected text can also be cleared by pressing the key associated with the Cle a r S e le c te d  T e xt
command. There is no default keyboard shortcut to do this, but you can customize the keyboard to
assign a key to Cle a r S e le c te d  T e xt  (which is in the Othe r submenu of FILE).
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1.7 Bookmarking

V11 now allows you to bookmark a line in a file by pressing Ctrl+F2. Pressing Ctrl+F2 again will clear it.

Bookmarked lines will be displayed in a different color. When multiple lines have been bookmarked,
pressing F2 will take you to the ne xt bookmark and pressing Shift+F2 will take you to the p re v io us
bookmark. All bookmarks can be cleared by pressing Ctrl+Shift+F2 or by selecting B o o k m a rk s ->Cle a r
A ll B o o k m a rk s from the Edit menu.

The Search dialog box now contains a B o o k m a rk button. Pressing this button will bookmark all lines
that contain the search string. If you are using the Search Bar, you can right-click on the Find  N e xt button
(down arrow) to bookmark lines containing the search string.

The number of bookmarked lines will be displayed in the status bar.

All bookmarked lines can be c o p ie d  to  the  c lip b o a rd   by selecting Co p y  B o o k m a rk e d  Line s from the
B o o k m a rk s submenu of the E d it menu. All bookmarked lines can be saved to a file by selecting S a v e
B o o k m a rk e d  Line s from the same submenu.

By default, V will clear all bookmarks when it exits. If you want the bookmarks saved so they will be
available every time you view the file, enable Save Bookmarks on Exit in the File Options tab of
Preferences.

No te

The color of the bookmarked line can be changed by selecting Customize Colors from the Tools menu.
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1.8 File Masks

Until now, file masks only applied to files, not to directories. That is, although the directory listing would
only display files that matched the file mask, it would always display a ll the directories.

You can now enter a s e c o nd mask that will be used to only filter the directory names. The second mask
is entered immediately after the first mask separated by a "|". This character is sometimes called a
v e rtic a l b a r, a p ip e or the o r character and is usually found on top of the backslash key (ie, Shift
+Backslash).

For example, using a mask of "*.jpg|D*" will display all .jp g files and only the directories that begin

with "D".

If you leave the directory mask blank (ie, enter nothing after the "|"), no directories will be displayed.
Similarly, leaving the mask empty b e fo re the | will now display no files.

Exa mp le s

*.*|A*  Display all files and only directories that begin with A

*.exe| Display all the .exe files and no  directories

|A* Only display directories that begin with A (and no  files)

No te s

This type of file mask can only be used when displaying the directory listing. It cannot be used when 
searching for files (using Find Files/GREP).

If it exists, the ".." entry will a lwa y s be displayed (to indicate the parent directory), regardless of the file
mask used.
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1.9 What's New in V10?

The main new features in Version 10 are:

Tabbed Browsing (FolderTabs)

Split File View

Keyboard Customization

GREP Favorites

Other new features include:

If Use Windows Explorer right-click menu as default is enabled, the Windows background menu
is now displayed when you right-click on an empty part of the Directory Listing (or the Explorer).
This menu usually contains the options to create New files. Note that this menu will not contain the
options for Paste and Paste Shortcut.

Classic Mode has been removed in V10. Click here for further details.

Single Letter Commands no longer work when viewing a file. However, you can use the new
keyboard customization to assign any command to any alpha key.

Many of the dialogs (like the Favorites, MD5 and Count Words) are now resizable (look out for
the grip in the bottom right of the dialog). Note that only the he ig ht of the dialog is resizable, not
the wid th.

You can now specify a range of line  num b e rs to be printed in the Print Dialog box.

In Dual Pane mode, if you select a Favorite while the SHIFT key is pressed, the Favorite will
always be displayed in the FIRST pane. If the CTRL key is pressed, the Favorite will always be
displayed in the SECOND pane.

New options in Version 10 include:

Hide Directory when viewing files (in the Directory Options tab)

Do not select file extension (in the More Options tab). When enabled, only the name portion of the
file is selected when you go to rename the file. This makes it easier to enter a new name for the
file without having to re-enter the extension.

Collapse Folders on the View menu and on the toolbar.

New command line options are:

/L1: and /L2: to specify the range of lines to print

1.10 Version History

A full version history can be found in the Ve rs io n H is to ry  section towards the end of the Help file.
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2 Getting Started / Command Line Options

2.1 Summary of Features

V is an all-purpose File Manager for Windows (XP/2000/2003/2008/Vista). It is a combination File
Viewer,  Directory Browser, File Finder and File Unzipper. Some of V's main features include:

It is fa s t

An (optional) Dual Pane interface lets you view directories side-by-side.

A tabbed file manager.

It can view files of unlimited size - and quickly! Try it on a 60 Gig a b yte  file (if you've got one
lying around).

File and Text searching

Displays CSV files as tables

It can be installed in the system tray.

ZIP file support.

Thumbnails Mode

A customizable keyboard

A Greenbar mode when viewing files plus the ability to split the file view.

Favorite files and directories may be bookmarked for easier retrieval.

It has an easy to use interface which takes full advantage of keyboard shortcuts and right-click
menus. There is no "File Open Dialog Box" in sight!

Supports various end of line combinations (in particular, Unix format).

It excels at viewing files in hex format. You can also search for a sequence of hex bytes rather
than just a text string. 

It can be used to view the redirected output of another program/command. 

File Tailing - will automatically refresh a file if it is modified while you are viewing it.

Line numbers and rulers can be displayed/printed. 

GridLines can be defined. Vertical lines can be displayed - making it easier to view tabular data.

Ability to highlight and copy columns of data. Numerical columns can be summed.

Files may be fixed at a column position so that anything to the left of the column will not scroll.

It has extensive printing support. Headers/Footers can be customized and the listing can be
printed with or without line numbers. Files can also be printed in 2UP Mode - ie, the file is printed
in landscape mode with 2 pages printed on a sheet of paper. This is ideal for hex dumps and
program listings.

Easy access to basic file management functions - copy, delete, rename, ...

File Renaming - allows you to easily rename a group of files.

Support for Alternate Data Streams (ADS).
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Supports 4DOS Descriptions.

V can be extended by defining User Commands.

It can view EBCDIC files. These files are usually created on IBM mainframes.

Selected text may be appended as well as copied to the clipboard.
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2.2 Single or Dual Pane Interface

When you run V for the first time, you will be asked which type of interface you want to use. You may
choose one of the following:

Explorer-style Interfac e

V will look like Windows Explorer.

The Left Hand Side will contain an expandable Explorer Tree,
listing the available disks and directories.
The Right Hand Side will usually display the contents of the
directory that is selected in the Explorer Tree.

The Explorer Tree can be removed by pressing the small x button
at the top right of the tree. This will leave you with a single pane
displaying the contents of the "current" directory".

Dual Pane (Commander
style) Interfac e

This is generally referred to as a Commander Interface - which was
popularized by such programs as Norton Commander.

V will consist of 2 panes - side by side. Users can copy/move files
by dragging from one pane and dropping onto the other.

Dual Pane with Explorer
Tree

This is similar to the Commander Interface - except an Explorer
Tree is also displayed above each pane.

The panes may be placed on top of each other (instead of side by
side) by clicking on the "Dual Pane" button on the toolbar and
selecting "Horizontal Split Mode".

Note that the type of interface may be changed at any time.

Dual Pane (Split) Mode can be set/removed by clicking on the "Dual Pane (Split Screen)" button on the
toolbar (or by pressing Alt+S).

The Explorer Tree can be removed by pressing the small x button at the top right of the tree. The tree
may be re-displayed by pressing the "Explorer Tree" button in the top left corner - just below the
toolbar.
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2.3 Running V

There are many ways that you can start V.

Fro m the  Wind o ws Sta rt Me nu

When the V setup program is run, it creates a "V - T he  File  Vie we r" program group. To run V, simply
click on the Windows Start button and then select Pro g ra ms->V - T he  File  Vie we r->V. You may
also create a V shortcut on the Windows Desktop and in the Quick Launch Bar by going to the Setup
tab in Preferences.

Fro m the  Co mma nd  Line  (DOS Bo x)

One of the most useful ways of starting V is directly from the command line. You can use V to view a
particular file, view a group of files or to browse the current directory.

To view a particular file, just type:

V FileName (eg, v  re a d me .txt)

To view a group of files, type

V FileMask (eg, v  *.txt)
or

V File1 File2.. (eg, v  re a d me .1st *.d o c)

To browse the files in the current directory, just type

V

If you have enabled Always restore most recent directory on startup, you will have to use:

V .

If you want to browse the files in a particular directory, type

V Directory (eg, v  \ te mp  or v  e :)

To be able to run V from the command line, you will need to add the V directory to the Command Path.
On Windows XP/2000, this is done as follows:

Double-click on System in the Windows Control Panel

Select the Advanced tab and click on the Environment Variables button

Click on the Path entry in the System variables list

Press the Edit button

Add the V directory to the end of the Variable value (eg, C:\Program Files\V) making sure that
there is a semi-colon (;) separating the V directory from the previous directory.

Press the OK button

Alternatively, you can enable Add V Directory to System PATH in the Setup tab of Preferences.
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See the Command Line Options for a list of valid command line options.
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Dra g  a nd  Dro p  Sup p o rt

You may select file(s) from the Exp lo re r (or any other program that allows file dragging) and drop them
onto V. You can either drag files onto an active instance of V, or onto the V Desktop Shortcut.

Us ing  File  Asso c ia tio ns

By associating certain file extensions with V, you can launch V by simply double clicking on a file
name with that extension in Exp lo re r. You can create such associations from the Setup tab in the
Preferences Dialog box.

2.4 Installing V on the Desktop and System Menus

You may use V to install itself onto the Desktop and onto several System Menus.

Further details on how to do this is provided in the Setup tab of the Preferences Dialog box.

2.5 Installing in the System Tray

V can be installed in the system tray and can be configured so that the copy running in the tray is
always activated whenever V is launched (whether it be from the command line, from Explorer or from a
shortcut). If you use V regularly, this will solve the problem of having multiple copies of V running at the
same time. Of course, if you want to launch a second copy of V, you can by specifying the /I command
line option.

Further details on installing V in the system tray can be found in the More Options section of the
Preferences dialog box.

No te

V can only be installed in the system tray once it has been registered.
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2.6 Command Line Options

Command line options may be entered on the V command line.

For example,

V FileName [options]

The following options are valid:
/A View the file in ASCII mode. This is the default mode and will only need to be specified in

order to override an existing EBCDIC mode.

/B View the file in EBCDIC mode.
/CSV[:del] View the file in CSV mode. Non-standard delimiters can be specified after CSV (eg, /

CSV:!)
/E V will start viewing the file from the e nd  instead of the beginning.
/F V will check to see if there is any redirected output that it needs to display (such as the

output of a D IR command). If there is, it will display the redirected output, otherwise it will
display the contents of the current directory.

For example: d ir | v  /F

/FLAT Enables Flat Text Mode
/GB Enables Greenbar Mode
/H This will force the file to be viewed in Hex mode.
/I A new instance of V will be started, regardless of whether V is installed in the system

tray.
/ICRCR Enables the Ignore Consecutive CRs option
/IFF Enables the Ignore Form Feed option
/L V will display the la s t file that it viewed. This will be the first file in the Recent Files list.
/L:nn V will start displaying the file from line  numb e r nn
/LEN:nn Sets the wrap length to nn
/O:xxxx V will start displaying the file from o ffse t xxxx
/O:[NDERST-]Specify the sort order of the directory listing. Click here for further details.
/P Indicates that the specified file(s) are to be p rinte d . Click here for further printing options.
/R When started with no parameters, V will browse the current directory. By specifying the /

R  option, V will display the directory that it last browsed. Note that this option is
automatically added to all shortcuts that V creates for itself.

/T Enable File Tailing
/TEXT This forces a file to be opened in text mode (opposite of /H)
/
TS:TabSetNam
e

Loads the FolderTabs in TabSetName

/VFONT See Font Options
/VH The file will be viewed in Vertical Hex Mode
/VO View Only mode. Click here for further details
/Z Forces V to view the file as a ZIP file - even if it doesn't have a .ZIP extension
/OEM V will display the file using the DOS/OEM character set (if available).
/OEMP V will use the DOS/OEM character set when printing.
/ANSI V will use the default character set.
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Further command line options are explained in the following sections:

/Delete Option
/M Option
/S Option
/Fix Option
Font Options
Printing Options
Text Only Printing Options
EBCDIC Options

No te s

The options may also appear b e fo re  the file name(s)

The options are no t case sensitive.

You can use an equals (=) instead of a colon (:). For example, /L=20 instead of /L:20

Some command line options will only work once V has been registered.

2.7 /Delete Option

The /d e le te  option is used to tell V to delete the file once it has finished viewing it.

This option may be necessary if you are using V as an external file viewer. When using external file
viewers, programs usually create temporary files and then launch the file viewer to display the
temporary file. It is up to the program that launches the file viewer to delete any temporary files it has
created.

However, not all programs are well behaved and it is sometimes not possible to delete the file
because V may still have the file open. If you know that the program in question always creates
temporary files before it passes them to V, you should use the /d e le te  flag. 

*** Ple a se  use  this  o p tio n with ca utio n *** 

2.8 Mask Option: /M

The /M option is used to specify a file mask on the command line.

For example, V /M:*.zip  will display a directory listing of all the ZIP files in the current directory.

Note that this is very different from V *.zip  which will start displaying the contents of all the ZIP files.
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2.9 Directory Sort Option: /O

The sort order of the directory listing can be set by clicking on the column headings or by right-clicking
on the column header and selecting one of the Sort options. Once set, V will continue to use the same
sort order until the user changes it.

The sort order can also be specified on the command line using the /O option. The following options
are available:

/O:[NDSET R-]

where

N Sort by File Name
D Sort by File Date
S Sort by File Size
E Sort by File Type (extension)
T Same as E (ie, type/extension)
R Sort order is random
- Sort order is descending (by default, the sort order is assumed to be ascending)

If using Dual Pane mode, you can specify the /O option twice.

Exa mp le s:

V DirectoryName /O:N Sort in ascending order of the file name

V DirectoryName /O:D- Sort in descending date order

V Dir1 /O:s Dir2 /O:S- Sort the left pane in ascending size order
and the right pane in descending size order
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2.10 Find String Option: /S

The /S option is used to tell V to start displaying the file at the position of a string match.

The format of the /S command line option is as follows:

V Filename /S:SearchString /SO:[CWRHUB] /SN:n /SC:Columns /amino /iupac

where

SO can contain a series of letters which correspond to the options in the search dialog box. These can
be one of:

C Match case
W Word Only
R Regular Expression
H Hex/Binary
U Unicode
B Search backwards (from end of file)

SN indicates which occurrence of the string to find. By default, the first match is found (n=1).

SC can be used to restrict the search to certain columns.

amino indicates that the search string is to be treated as a string of amino acid codes.

iupac indicates that the string is to be treated as a string of IUPAC nucleotide codes.

If the search string contains spaces, you must enclose it in double quotes.
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Exa mp le s

Start viewing at the second occurrence of "Error"

V Filename /S:Error /SN:2

Start viewing at the last line that contains the *word* "Error"

V Filename /S:Error /SO:WB

Note that the first example will match "errors", whereas the second will not.

Start viewing at the first line that *begins* with "Error Log"

V Filename /S:"^Error Log" /SO:R

No te

The /S parameter will not work on wild cards - you must specify a valid file name.

For example, you cannot specify "V *.txt /S:Erro r" hoping that V will display the first txt file that
contains "Error"
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2.11 /Fix Option

The /FIX option tells V to fix the columns when viewing the specified file(s).

The column position may also be specified on the command line.

For example,

V TABLE.TXT /FIX:6

If no column position is specified, the most recent fixed column position is used.

To disable fixed columns, specify a column position of zero. That is,

V TABLE.TXT /FIX:0

2.12 Split Options (Dual Pane Mode)

The following command line options can be used to force V into a particular mode:

/SPLIT V will start in Dual Pane Mode
/NOSPLIT V will start in Single Pane Mode.
/VSPLIT V will start in Vertical Split Mode
/HSPLIT V will start in Horizontal Split Mode

2.13 Font Options

You may specify the display font on the command line by using the VFONT  option as follows:

/VFont:"Font Name",size

For example:

V Filename /VFont:"Courier New",10

No te s

The s ize  option is optional. If not specified, it will default to 10 point.

The /FONT  option is used to specify what font will be used when printing.
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2.14 Viewing Redirected Output

When using a Command Prompt, it is awkward to view the output of a command (like DIR or GREP)
when that command outputs more lines than can fit on the screen.

Sometimes, the Command Prompt allows you to scroll back through the output. However, you still can't
search, or select and copy the output.

Typically, the mo re  command is used as a filter to pause the output a screen at a time. However, it is
still very limited - you can't scroll back or search.

You can solve all the above problems by using V to view the redirected output. You will be able to
scroll and search the output, and even save it to a file.

To use V to view redirected output, you must use the / f option.

For example, dir | v /f

The /f option instructs V to look for redirected output. If you forget to include it, V will ignore the output
and simply display the contents of the current directory.

Alternatively, if you enable the "Check STDIN on startup" option in the File Options section of
Preferences, V will automatically look for redirected output when it starts.

This has been made an option because there may be some overhead in looking for redirected output.
I did not want to adversely affect the load time.

2.15 View Only Mode

When started with the /VO command line option, V is placed in "view only" mode.

In this mode, V simply views the specified file and will exit once the file is closed. Much of V's
functionality (like Favorites, User Commands, File Browsing and GREP) are not available in this mode.

This option is designed to be used by developers who use V to implement the file viewing portion of
their application. They may want to restrict the user to viewing (and possibly printing) the file, 
eliminating the possibility of the user getting into any trouble.
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2.16 Printing Options

The /P option is used on the command line to print the specified file(s). V will immediately start printing
the file (in a minimized state), and will exit when it has finished. If you have V installed in the tray, a
separate instance of V will be launched to do the printing.

The Print Dialog box will not appear when printing from the command line (unless the /PD option is
specified). All the current print settings will be used for printing. Most of these settings can be overridden
by specifying them on the command line. The following command line options are available: 

/Portrait
/Landscape
/2up

If one of the above 3 options is used, the /P option is implied and does not need to be specified.

/Font:"Font Name",size eg, /Font:"Courier New",10

/Printer:"Printer Name" eg, Printer:"HP LaserJet III"

/AM:0.5 Set ALL margins to 0.5 inches

/LM:0.5 Left margin

/RM:0.5 Right

/TM:0.5 Top

/BM:0.5 Bottom

/Header:"Header Text"        /Header:"%f;;Page %p"

/Footer:"Footer Text"

/Copies:2
/From:2 /To:3 Print From Page 2 to Page 3

/L1:1 /L2:200 Print From Line 1 to Line 200

/Pagelen:60 Override Page Length

/Wrap Wrap Long Lines

/Wrappage Wraps long lines onto a new page instead of onto a

new line
/EOL Print End of Line

/PLN Print Line Numbers

/IFFP Ignore Form Feeds

/ODD Only print odd numbered pages

/EVEN Only print even numbered pages

/PX Use Text Only printing

/PB Use Raw/Binary printing

/PGB Enables Greenbar printing

/Profile:"Profile Name" Use the settings stored in the specified printer profile

You may also specify the /PD option which will cause the Print Dialog box to be displayed, allowing
the user to override any print options.
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If your printer supports duplexing (double sided printing), you may also specify one of the following
options:

/dups Enable duplexing with short edge binding

/dupl Enable duplexing with long edge binding

                   
If you do not specify a print setting, the current (most recent) setting will be used. To disable a setting,
prefix the corresponding option with NO.

For example, if the default setting was to print a Header, you would have to specify the /NOHEADER
option to disable the header. You can also use, NOFOOT ER, NO2UP, NOWRAP, NOEOL,
NOPLN and NOPAGELEN. 

/NOP option

When the /P option is used (or implied), V will immediately start to print the file. However, if you would
like the user to be able to view the file before it is printed, you need to specify the /NOP option. V will
retain the command line parameters and use them when the user decides to print the file.

/PAGELIMIT:xxx option

The /PAGELIMIT option is used to specify the maximum number of pages that can be printed. This can
be used to prevent users from accidentally printing the entire contents of very large files.

No te s  

Case is not important (ie, /Font or /font can be used). 

Make sure that there is no space before or after the ":" in each option, and no space before or after the
comma separating the font name and font size. 

The header text, printer name and font name should be enclosed in "quotes". 

If not specified, the default margins will be used. However, if one margin is specified on the command
line, they must ALL be specified. Any margin not specified will default to ZERO. 
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2.17 Text Only Printing Options

The Text Only Printing options can be entered on the command line.

They correspond to the options in the Text Only dialog box, and are as follows:

/TOAM:nn Set *all* margins to nn

/TOLM:nn
/TORM:nn
/TOTM:nn
/TOBM:nn Set left, right, top and bottom margins

/TOW:nn Set page width to nn
/TOH:nn Set page height to nn (ie, page length)

/TOLD:n Set the Line Delay to n
/TOPD:n Set the Page Delay to n
/TODISABLE To disable Text Only printing

/TOSOF:xxx String to send before the start of file is printed
/TOEOF:xxx String to send at end of file
/TOEOL:xxx String to send after each line
/TOEOP:xxx String to send after each page

To include control characters in a string, you must specify their 2 character hex code prefixed by a "%".
For example to send a CR/LF at the end of each line and a FF (form feed) at the end of each page, you
would specify the following options:

/TOEOL:%0d%0a /TOEOP:%0c
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2.18 EBCDIC Options

You can specify the EBCDIC record format and record length by using the RECFM and LRECL
options.

/RECFM=xxx
Use this to specify the record format. The record format can be one of V, VB, F or U . If the file uses
carriage control, you can also specify the type of carriage control by appending one of A, M or Z. An S
may be appended to signify that the file contains ASCII characters (instead of EBCDIC).

/LRECL=nn
Use this to specify the record length for fixed length files (RECFM=F). This is not required for RECFM=V/
VB/U.

Exa mp le s

V Filename /RECFM=F /LRECL=132

V Filename /RECFM=FM /LRECL=80

V Filename /RECFM=VBA

V Filename /RECFM=VS

Click here for further details on EBCDIC record formats

No te

V can usually auto-detect RECFM=V/VB files, so it is not necessary to specify these formats on the
command line. However, V cannot detect if the file contains carriage control. If it does, you will need to
use the RECFM option to specify the type of carriage control (eg, /RECFM=VA).

2.19 Command Line Search (GREP)

File search and text search (GREP) can also be initiated from the command line.

Note that the search results are displayed in V - not on the command line. If you want the results
displayed on the command line, I suggest you either use Windows' FINDST R command and/or GNU
grep: http://www.gnu.org/software/grep/

All command line options are c a s e  ins e ns itiv e. That is, they can be in either upper or lower case.

File Search options

Text Search options

http://www.gnu.org/software/grep/
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2.20 Program Updates

You can select Che c k  fo r U p d a te s from the Help menu to see if you are running the latest version of the
program. If you are not, you will be given the option of downloading and installing the latest version.

Since users are only entitled to six years of free updates, not all updates will be free. If you are not
entitled to a free update, P a id  U p g ra d e  R e q uire d will be displayed next to U p g ra d e  E lig ib ility. In this
case, the user can still install the latest version and use it on a trial basis (for up to 30 days) before
upgrading.

If they decide not to upgrade, they can go back to using the previous version. Click here for further
details.

No te

There is no option to automatically check for updates - you must do it manually.

2.21 Sending Error Reports

If V c ra s he s, it will display a message saying that it encountered an une xp e c te d  p ro b le m and that it
cannot continue.

Press the S e nd button to send a detailed report to fileviewer.com for analysis.

Error reports can also be sent to fileviewer.com by selecting S e nd  E rro r R e p o rt from the Help menu

You will be presented with a list of crash files (Cra sh-xxxx.d a t) and a log file (V.lo g ). Simply select the
files that you want to send and press the Send button.

Please include a description of what you were doing just before the crash.

http://www.fileviewer.com/
http://www.fileviewer.com/
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2.22 Uninstalling V

V is uninstalled from the Windows Control Panel.

If you are running Windows XP, select A d d /R e m o v e  P ro g ra m s from the Control Panel. If you are running
Windows Vista, select P ro g ra m s  a nd  Fe a ture s from the Control Panel. If you are running Windows 7,
select U nins ta ll a  P ro g ra m from the Control Panel.

A list of programs will be displayed. Double-click on V  - T he  F ile  V ie we r to uninstall V.

No te s

The above procedure will only remove shortcuts that V has installed itself. If you have created V
shortcuts of your own, you will have to delete them manually.

If you have associated certain file extensions with V, you will have to remove them manually or remove
them using the Setup tab before uninstalling V.

It may also possible to restore a previous version of V. Click here for details.

2.23 Restoring Previous Versions

As from V11, when a new version of V is installed, a backup copy is made of the previous version. This
makes it possible to restore a previous version should a problem be encountered with the latest
version.

To restore a previous version, follow the same procedure as unins ta ll ing  V. However, instead of
double-clicking on V  - T he  F ile  V ie we r in the program list, you should right-click on it and select Cha ng e
(instead of Uninstall). If you are using Windows XP, you should press the Cha ng e button (instead of
Remove).

You will then be presented with a list of the available versions to restore.

No te

This feature is only available if you have installed V Version 11 (or later).
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3 Command Line Search (GREP)

File search and text search (GREP) can also be initiated from the command line from the command
line.

Note that the search results are displayed in V - not on the command line. If you want the results
displayed on the command line, I suggest you either use Windows' FINDST R command and/or GNU
grep: http://www.gnu.org/software/grep/

All command line options are c a s e  ins e ns itiv e. That is, they can be in either upper or lower case.

File Search Options

Text Search Options

Advanced Search Options

http://www.gnu.org/software/grep/
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3.1 File Search (/sf option)

To search for files, use the following command line syntax:

V /sf [/s][/zip][/ads][/mp][/mr][/es] [/d:]Directory [/m:]FileMask

/s Search Subdirectories
/zip Search Inside Archives
/ads Include Alternate Data Streams
/mp Allow a partial name match
/mr The mask is a regular expression
/mrp The mask is a regular expression but is to match the fully qualified path

(instead of the file name)
/es Use Everything Search

Note that /d : and /m: are optional, as V can usually determine which parameter is the directory and
which is the file mask. If you do not enter a directory, V will search the directory from which the command
was executed.

If Everything Search (ES) is installed (and running), you can use /e s  to let ES perform the search. In this
case, it is not necessary to use the /s f option as it is implied. Note that if you do not specify a directory
when using /e s , V will search a ll d riv e s that ES is monitoring and not just the current directory.

Exa mp le s

V /sf /s *.cpp Recursively search for *.cpp in the current directory
V /sf C:\src *.cpp Search for .cpp files in C:\src
V /es *.tmp Search for all .tmp files (across all drives ES is

monitoring)
V /es /S *.tmp Recursively search for all .tmp files in the current

directory

Ad va nce d  Se a rch Op tio ns

Click here for details on how to specify the Advanced Search Options on the command line (size, date/
time, attributes).
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3.2 Text Search (/st option)

To search for text in files (GREP), you would use the /s t option as follows:

V /st [/s][/zip][/ads][/mp][/mr][/es][/ib][/bin][/re][/mc][/sc:col][/
so:opt] [/amino] [/iupac] [/s:]string [/d:]Directory [/m:]FileMask

/s Search subdirectories (this is different from /s:)
/zip Search Inside Archives
/ads Search Alternate Data Streams
/mp Allow a partial name match
/mr The mask is a regular expression
/mrp The mask is a regular expression but is to match the fully qualified path

(instead of the file name)
/es Use Everything Search to locate the files
/bin The search string is in binary (hex)
/ib Ignore Binary Files
/re The search string is a regular expression
/mc Match case option
/amino indicates that the search string is to be treated as a string of amino acid

codes
/iupac indicates that the string is to be treated as a string of IUPAC nucleotide

codes

Note that /s :, /d : and /m: are optional as V can usually determine which parameter is the string and
which is the directory or file mask. If you do not enter a directory, V will search the directory from which
the command was executed.

Exa mp le s

V /st /s function() *.cpp Recursively search the .cpp files in the current
directory for function()

V /st /s function() C:\src *.cpp Recursively search all the .cpp files in C:\src
for function()

V /st /es function() *.cpp Use ES to locate *all* .cpp files and search
them for function()

The /so : option is used to specify one or more search string options when searching for text:

/so:[CWRHU]

C Match case (can also use /mc)
W Word Only
R Regular Expression (can also use /re)
H Hex/Binary (can also use /bin)
U Unicode

The /sc : option is used to specify a column range when searching for text

/sc:n  Match the string if it begins in column n
/sc:n-m  Match strings that start anywhere between columns n and m (eg /sc:25-30)
/sc:n-  Match strings that start anywhere after (and including) column n
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You can also specify multiple column ranges by separating them with commas.
For example, /sc:8-12,40,80

Ad va nce d  Se a rch Op tio ns

Click here for details on how to specify the Advanced Search Options on the command line (size, date/
time, attributes).
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3.3 Advanced Search Options

The Advanced Search command line options allow you to limit the files being searched by size, date/
time and attributes. They correspond to the options that are available when the Advanced button is
pressed in Find Files/GREP.

File  Size  Op tio ns

[/sg:size] [/sl:size] [/se:size]

/sg:size only search files whose size is at least size

/sl:size only search files whose size is at most size

/se:size only search files whose size is exactly size

s ize is a number (a string of digits) that can be terminated by one of k , m or g  indicating that the size is
in k ilo b yte s , me g a b yte s  or g ig a b yte s  instead of bytes.

Da te /T ime  o p tio ns

[/dm][/da][/dc][/dt][/dp:time][/d1:date][/d2:date]

/dm use the last modified date/time
/da use the last accessed date/time
/dc use the date created date/time
/dt only search files with today's date

/dp:time only search files whose time falls in the previous time period

/d1:date
/d2:date

only search files whose date is between these two dates

/di inverts the date/time search

tim e is a number that ends in m, h, d , n or y  indicating that the time period is in minutes, hours, d ays,
months or years.

d a te is in the same format as entered in the File Date section of the File Finder (and must include the
slashes that separate the date, month and year).

Attrib ute s  o p tio ns

/a:{attributes}

a ttrib ute s is a string of one or more of the following characters. Only files that match these attributes will
be searched.

R Read-Only
A Archive
S System
H Hidden
T Temporary
E Encrypted
C Compressed
C ADS (Alternate Data Stream)

Include a 0 (zero) after an attribute to indicate that you only want to match files with the corresponding
attribute c le a re d (ie, not set).
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Exa mp le s

/sg:100m search files that are greater than (or equal to) 100
megabytes.

/dc /dt search files that have been created today

/dm /dp:1h search files that have been modified in the last hour

/a:rd search read-only directories

/a:r0d0 search files that are not read-only (ie, read-only and
directory attributes are not set)

/dm /d1:01/01/2009

    /d2:01/01/2010

search files that were modified in 2009

/dm /d1:01/01/2010 search files that were modified after Jan 1 2010 (note that /
d2: is not required)
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4 The Basics

4.1 The Basics

V basically consists of three different windows (or v ie ws) - the Directory View (or browser mode), the
File View and the ZIP View. 

In Classic Mode, only one of these views may be active at any one time.

T he  D ire c to ry  Vie w

The Directory View displays the contents of the current directory. Any subdirectories are always
displayed at the top (in alphabetical order) and are then followed by the files in the directory (which can
be sorted in various ways).

The Directory View lets you easily navigate the file system and select files to view.

A Windows Explorer style tree can optionally be displayed to the left of the directory listing.

In Dual Pane (Split) Mode, 2 directory views may be displayed side by side.

T he  File  Vie w

The File View displays the contents of the file. The view may be in Text or Hex mode, and can be
customized further by displaying line numbers, wrapping text lines and displaying a ruler. Files may
also be viewed as EBCDIC instead of ASCII.

Rapid viewing of selected files is made possible by using the Previous and Next file commands, and
positions in files can be bookmarked for later retrieval. The File List allows you to view other files in the
current directory without having to go back to the Directory View.

T he  ZIP Vie w

The ZIP View is a modified Directory View and is used to display the contents of a ZIP file. Most of the
operations available in the Directory View are also available in the ZIP View.

Click here for further details on the ZIP View.

Whe n in d o ub t - rig ht c lick  o r p re ss  F1

If you are not sure how to go about doing something in V - right click. This will usually display a menu of
all the available commands.

Pressing F1 will display the Help file. Use the Ind e x or Find  tab to search for help on the topic you are
interested in.
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4.2 Classic Mode

Prior to Version 8, V was always a o ne  wind o w program. When you viewed a file, the directory
listing would be re p la c e d by the file window. If you wanted to view the file in a separate window,
you would have to launch another instance of V. One instance of V would display the directory
listing and the other would display the file.

Starting with Version 8, you can have more than one file open at once - and the directory listing
will still be visible while you are viewing the file. 

V can still operate as a "one window" program - this is now called CLASSIC mode.

CLASSIC Mo d e  ha s b e e n re mo ve d  in Ve rs io n 10

The Cla s s ic  M o d e option is no longer available in V10. However, similar behavior can be achieved by
enabling Hide Directory when viewing files in the Directory Options tab of Preferences This causes the
directory listing to be hid d e n whenever a file is viewed. This differs from CLASSIC mode where the file
window re p la c e d the directory listing, however, the effect is the same.

4.3 More Basics

Co lo rs
The colors that V uses to display various items can be customized by selecting Cha ng e  Co lo rs  from
the View menu.

Click here for further details.

Alwa ys o n T o p
The main V window may always be kept in the foreground by selecting Alwa ys On T o p  from the View
menu or View->Options menu (or by pressing Ctrl+Shift+T).

Se a rching
V can search for files based on file name, size, date/time and attributes as well as search for files
containing specified text.

Searching is explained in greater detail in this section.

Numb e r Entry
In most places where V asks for a number to be entered, the number may either be entered in decimal
or it can be entered in hex by prefixing the number with 0x

For example, 0x100 is the same as 256.
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4.4 Menu and Toolbar

Like most Windows programs, V has a main menu and a toolbar which allow you to  select the
appropriate commands.

The toolbar may be removed by selecting Op tio ns from the View menu (and then unchecking T o o lb a r).
The menu can not be removed.

Note that the menu and toolbar are different for the three different views (Directory, File and Zip).

Custo mizing  the  T o o lb a r

Right-clicking on the toolbar will display a menu with three options - Custo mize , Sma lle r Ico ns (o r
La rg e r Ico ns) and De fa ult.

V15 introduced a new, slightly larger toolbar. If you prefer a smaller toolbar, select Smaller Icons. If you
want to revert to the larger/default size, select Larger Icons.

Select De fa ult to return the toolbar to its default (uncustomized) state. By selecting Custo mize , a
dialog box will appear with the currently used toolbar buttons on the right hand side and the available
buttons on the left.

To re mo ve  a button from the toolbar, select it and press the "Remove" button. The button will be
placed in the "Available buttons" list where it may be reinserted into the toolbar.

To mo ve  a button to a different position, select it and press the "Move Up" or "Move Down" button. To
a d d  a button to the toolbar, select it from the available buttons and press the "Add" button. It will be
inserted before the currently highlighted toolbar button.

Press the "Reset" button to cancel any changes that you may have made.

No te s

You may only rearrange and/or remove icons from the toolbar. You cannot add your own custom icons.

It is not possible to customize the dropdown toolbar on some of the main toolbar buttons (like Tools).

The default toolbar size can only be made smaller (not larger). If you want a larger toolbar, you will need
to change the Windows scaling factor (in the Windows Display settings).
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4.5 File Management Commands

V gives you access to some basic file management commands which may be invoked from both the
Directory View and the File View.
All these commands may be accessed in a number of different ways -  from the toolbar, main menu,
right click menus and keyboard shortcuts. Further commands, which do not necessarily act on a
particular file, are grouped together under Tools.

In the Directory View, some of the commands apply to multiply selected files (where indicated below) -
others only work on a single file/directory. In the File View, the command applies to the file currently
being viewed.

These commands are:

Co p y
Copies a file(s) to another directory. You will be asked to select a directory where the selected file(s)
will be copied to.

Mo ve
Similar to Copy, except the files are removed from the original directory. The Copy and Move
commands will also work with directories instead of files. Click here for further details on selecting the
destination path.

Re na me
Note that this command does not work on multiple files and can only be accessed from the Directory
View. When this command is invoked, a small box will be drawn around the file (or directory) name.
Simply type in a new name and press ENT ER. If you decide that you don't want to change the name,
press ESC.

De le te
Deletes the selected file(s) or directory. If a directory is selected, you will always be asked to confirm
the deletion, regardless of whether you have disabled the Confirm File Delete option. If the file is
deleted from the File View, the next file in the file list will be displayed, or if no further files exist, the
Directory View will be displayed. If the Delete to Recycle Bin option is set, the file will be moved to the
Recycle Bin. The Recycle Bin may be bypassed by pressing the shift key when selecting the delete
command.

Attrib ute s
This command displays several file properties (size, date, long name, short name) and allows you to
modify the file (or directory) attributes. For example, this command could be used to make all files in the
directory read-only (by setting the read-only attribute). If this command is selected while a file is open
(and in text mode), details of the line lengths in the file will also be displayed.

Pro p e rtie s
This is the same as the Properties option in Explorer. Depending on the file type, several tabs of
information may be displayed. If you select this option for a directory, the total number of files that the
directory contains (and their total size) will be displayed.

Se nd
This will construct an email message using your email client and will attach the selected file(s). Note
that this will only work if MAPI (or Windows Messaging) is installed on your system.
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T o uch
Touching a file means changing its la s t mo d ifie d  time . Click here for further details.

File Na me
This command allows you to modify the file name in several ways. Click here for further details.

Clip b o a rd
This command copies the selected file names to the clipboard. Click here for further details.

Re ce nt File s
This displays a list of the most recently viewed files.  Click here for further details.

Print
Prints the file(s). 

Ed ito r
V is not an editor. That is, you cannot modify the contents of a file with V. In order to edit a file, you need
to specify an editor. The Ed ito r command will launch the specified editor and load the selected file(s).

Exe cute
This command is also known as Run. The selected file is launched together with it's associated
application (if one exists) - just like double-clicking on a file name in Explorer. For example, if a JPG file
was executed, your image viewer would be launched and the JPG file loaded. This command does not
work on multiply selected files.

Use r Co mma nd
This will execute the d e fa ult User Command. Click here for further details. Further commands may be
selected from the UserCommands menu.
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4.6 Recent Files

When V views a file, it adds it to the Recent Files List.

You can then re-view the file by selecting it from the Recent Files menu which is displayed by selecting
Recent Files from the File menu (or various right-click menus).

By default, the last 9 files are displayed in the Recent Files List. This may be modified by setting a new
MRU Size  in the History  section of Preferences (the maximum size is 50). The Recent Files List can
also be disabled by disabling Enable MRU File List.

Exe cuting  File s

By default executed files (ie, files that are not viewed by V when you double-click on them) are also be
added to the Recent Files List. Selecting such files from the Recent Files List will re-execute them.

When the Recent Files List is displayed, an asterisk (*) will be displayed next to a file name to indicate
that the file was executed (instead of viewed).

If you do not want executed files added to the Recent Files List, enable Do not add executed files to the
MRU in the History tab of Preferences.
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4.7 Selecting the Destination Path

When copying and moving files the user will be asked to enter a destination path.

A history of the most recently used paths is displayed in the Copy/Move dialog box. A path may be
selected from this list, a new path may be selected by pressing the Bro wse  button, or you may simply
type the new path in the De stina tio n field.

Press the Fa vo rite s  button (next to Browse) to select a destination from your Favorites.

Pressing the De le te  button will remove the path from the history.

Enable the Use  Curre nt D ire c to ry  option to use the current directory as the destination path.

If a directory is entered which does not exist, you will be asked if you want the directory created.

D ire c to ry  d ro p -d o wn lis t b o x

The selected directory will also be placed at the top of the Directory list box in the Directory View.

This allows you to quickly browse the destination directory by selecting it from the list box.

Sha ring  the  Pa th H is to ry

V maintains distinct path histories for most operations. For example, if you copy a file to a directory, that
directory will appear in the path history next time you do a Co p y - but it will not appear in the history next
time you do a Mo ve .

If you want the same history to be used for all operations, enable the "Use the same history for Copy/
Move/Zip paths" option in the History tab of Preferences.
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4.8 Touching Files

Touching a file means changing its la s t mo d ifie d  time  to the curre nt time. It is mainly used by
programmers to alter the modification time of source code files so that the ma ke  procedure
recompiles them . (If you don't understand this, don't worry). If multiple files are selected prior to
executing the Touch command, all of the selected files will end up having exactly the same time.

You can set the last modified time of the file to one of the following:

1. T he  Curre nt Da te  a nd  T ime

To set the time to the current time, simply enable Use  Curre nt Da te  a nd  T ime  and press the OK
button.

2. T he  File  Cre a tio n T ime

Enable Re se t La st Mo d ifie d  T ime  to  Cre a tio n T ime  to set the time to be the same as the time
that the file was created.

3. A sp e c ific  Da te  a nd  T ime

Disable both of the above options to specify your own date/time. Simply enter the desired date and
time in the fields provided.

Usually the MM, DD, YYYY fields will display the current file date which may be modified by the user.
However, if you enable the "Previous Touch Time" option, the date and time used in the previous touch
command will be displayed (and may be subsequently modified). This makes it easy to touch files in
different directories with the same time.

Us ing  the  File  T ime

Selecting the "File Time" option allows you to set the date/time of a file (or group of files) to the date/
time of another file.

To do this, select all the files that you want touched, and finally select the file that you want the other files
to match. That is, the "master" file should be the last one selected (or have focus).

Select the Touch command (Ctrl-T), disable "Use Current Date and Time" and "Reset Last Modified .."
and select "File Time". The date/time of the selected files will now be the same as that of the "master"
file.

No te

Unregistered versions can only touch a file with the current time.
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4.9 Copying File Names to the Clipboard

The Co p y to  Clip b o a rd  command copies the na me s of the selected file(s) to the clipboard.  If this
command is selected from the File  Vie w, the name of the currently viewed file is copied to the
clipboard.

The name(s) can be copied in one of six formats:

FORMAT
========

EXAMPLE
=========

File  Na me index.html

File  Pa th c:\path\index.html

MSDOS Na me INDEX~1.HTM

MSDOS Pa th C:\PATH\INDEX~1.HTM

Unix Pa th (X:/ .../ ) x:/path/index.html

Unix Pa th (Cyg win) /cygdrive/c/path/index.html

UNC Pa th (\ \Ma chine \ ...) \\Machine\Share\index.html

URL Pa th (fi le :/ / /X:/ ...) file:///X:/Path/index.html
(unsafe characters are replaced with their %hex
equivalent. Eg, a space will be replaced with %20)

If multiple files are selected, the file names will be separated by a CR/LF. 

This command is useful if you want to include the file names in some kind of document (like a README
file) or if you want to create a batch file which performs commands on the selected files.

No te s

If you press the SHIFT key while selecting the format from the menu, the file name(s) will be a p p e nd e d
to the clipboard. This lets you easily copy file names from different directories.

The UNC Path command will only work on network paths that are being accessed via the Network
branch of the Explorer tree. It will not work on a network path that is being accessed  using a network
drive letter.

The Unix path is in a format used by Cygwin - a Unix environment for Windows.

You can also copy a formatted directory listing to the clipboard by using one of the Directory Listing
options.
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4.10 Keyboard Shortcuts

Keyboard shortcuts usually consist of some Alt or Ctrl key combination, and are used in preference to
the menu or toolbar. For example, Ctrl-D  deletes a file. V displays the keyboard shortcut for a
command next to that command in the File Menu (at the top of the program).

If you have enabled Single Letter Commands, V will also accept a single letter (without the Ctrl key
being pressed). For example, C to copy a file and D  to delete a file.

Note that in many cases V has more than one keyboard shortcut assigned to a particular command.

Many of the default keyboard shortcuts can be modified and new keyboard shortcuts can be created.
See the Keyboard Customization section for further details.
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4.11 Tools

The Tools menu contains some general purpose commands which do not necessarily apply to a file
(or group of files).

Wo rd /Line  Co unt
This counts the number of words and lines in the current file. Click here for further explanation.

He x Co nve rte r
This launches a simple Hex Converter which lets you quickly convert between hex and decimal. Note
that the Hex Converter is restricted to numbers less than 256 if V is not registered.

Cre a te  D ire c to ry
This will create a sub-directory in the current directory. Nested paths are supported (eg, Dir1\Dir2\Dir3)

Cre a te  File
This will create an e mp ty  file in the current directory. Nested paths are not supported for creating files.

Exp lo re r
This command launches Windows Explorer. The right hand side of Explorer will display the contents of
the current directory. This is useful in the case where V cannot perform an operation that Explorer can.

If the Ctrl key is pressed when selecting this command (or if you press Ctrl+Alt+O), a ro o te d  Explorer is
displayed. That is, the root of the Explorer tree is the current directory.

Co mma nd  Pro mp t
This launches a Command Prompt (or DOS Box) in the current directory. Click here for further details.

Ma p  Ne two rk  Drive
This lets you assign a drive letter to a shared network resource. Note that you cannot assign a drive
letter to a local directory - unless the local directory has also been shared.

D isco nne ct Ne two rk  Drive
This removes a network drive letter assignment.

ASCII Cha rt
Click here for explanation

De le te  T e mp o ra ry  File s
Click here for explanation



V Help File58

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

4.12 Command Prompt

A Command Prompt may be launched in the current directory by pressing Alt+C, or by selecting
"Command Prompt" from the toolbar or Tools menu.

V looks at the environment variable COMSPEC to decide what program to use as the Command
Prompt. If this does not exist, it will try to launch CMD.EXE.

It is possible to pass command line options to the Command Prompt when it is launched by defining
the COMSPECOPT IONS environment variable. If COMSPECOPT IONS is defined, its contents are
passed to the command line interpreter.

For example, you can set the title of the Command Prompt window to "Command Prompt" by setting 
COMSPECOPT IONS to /K "Title Command Prompt"

You can also pass the path of the current directory by using %1.

For example, setting COMSPECOPT IONS to /K "Title %1" will set the title of the Command

Prompt window to the path of the current directory.

You can also use a different Command Processor (to CMD.EXE) by specifying it in the Editor/CMD tab
of Preferences.

No te s

You cannot use V to set COMSPECOPT IONS - you must do it using the Windows Control Panel
(usually in the System section).

COMSPECOPT IONS is only used by V when launching a Command Prompt - it is not used by
Windows or any other programs.

The syntax of COMSPECOPT IONS may seem a bit cryptic. Unfortunately, this is required by
Windows.
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4.13 ASCII Chart

A good old-fashioned ASCII chart is displayed by selecting the ASCII Chart command from the Tools
menu.

The chart is displayed in two halves - "0 to  127" and "128 to  255". You may toggle between the two
by pressing the button above OK, or by pressing the PageUp/PageDown keys. 

When a character  is selected with the mouse (or by pressing the corresponding key on the keyboard),
the Hex, Decimal, Octal and Binary representation of that character is displayed at the bottom of the
chart.

The Bo ld  checkbox determines how the characters are displayed.

Enabling the EBCDIC option turns the ASCII chart into an EBCDIC chart. The EBCDIC mapping may be
modified in the EBCDIC tab of Preferences.

No te s

You may press Ctrl-C to copy the selected character to the clipboard. Pressing Ctrl-Shift-C will append
the character to the clipboard.

The chart is displayed in the selected display font
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4.14 MD5/CRC32

To calculate the MD5 and CRC32 of a file (or files), select the files(s) and then select "MD5/CRC32"
from the Tools menu (or from the dropdown Tools button on the toolbar).

A dialog box will display the MD5 and CRC32 as they are calculated.

If in Dual Pane Mode, the MD5/CRC32 of the selected file(s) in *both* panes can be calculated by
selecting "MD5/CRC32 (Both Panes)" from the Tools menu. This can be used as an easy way of
determining if 2 files are the same.

Note that it is possible for 2 different files to have the same MD5 - however, this is very unlikely.

MD5/CRC32 o f a  D ire c to ry
It is also possible to calculate the MD5/CRC32 of a *directory*. In this case, V will treat the directory as
one large file - consisting of all the files in the directory (and all subdirectories).

WARNING

V does not guarantee that it will always calculate the same MD5/CRC32 for a given directory -
especially if you copy the directory to another file system. However, if the MD5 of 2 directories is the
same, you can be reasonably confident that the directories are the same (with the following proviso).

The directory MD5/CRC32 calculation does not take into account the *name* of the file. This means that
two directories that contain the same data files (but with different file names) will probably have the
same MD5/CRC32.
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Disp la y ing  the  MD5/CRC32 in a  co lumn o f the  D ire c to ry  Lis ting

If 4DOS Support is enabled, the MD5 or CRC32 can be saved to the 4DOS Description of the file by
pressing the corresponding button in the MD5/CRC32 dialog. The MD5 or CRC32 will then be
displayed in the Description column of the Directory View.

Note that any current 4DOS description will be overwritten by the MD5/CRC32. Also note that if a file is
modified, the MD5/CRC32 will not be automatically updated. You will need to re-calculate the MD5/
CRC32 and re-save it to the 4DOS description.

MD5
MD5 (Message Digest algorithm 5) is a popular hash function with a 128-bit hash value. It is commonly
used to check the integrity of files.

CRC32
This is a 32 bit Cyclic Redundancy Check - mainly used by older applications.

4.15 Word/Line Count

This command will display the number of words and lines in the current file.

The number of lines in a file is also displayed on the status bar when a file is being viewed. However, if
the file is being viewed in chunks, the count will only display the number of lines in the current chunk,
whereas this command will display the number of lines (and words) in the entire file.

When in the Directory Listing, you can select multip le  fi le s  and then select Word/Line Count from the
Tools menu. This will display the word and line count for each file as well as the total.

When viewing a file, Wo rd /Line  Co unt (se le c tio n)  may be selected to count the number of words/
lines in the selected text.

Wha t is  a  wo rd ?

A word is any sequence of alphanumeric characters, or underscores. Note that this is slightly different
from the definition of a word used by some word counting utilities (like wc). In particular, a hyphen is not
treated as a word character. That is, "on-line" will be counted as two words instead of one.

You may change these word characters by defining your own word sets.

Note that V lets you define an alternate (Shift-Double-Click) word set. If you would like to use the
alternate word set to count the number of words, press the Shift key while selecting the Word/Line
Count command.
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4.16 Delete Temporary Files

You have 2 options when deleting temporary files:

De le te  a ll fi le s  c re a te d  b y  V
Under normal circumstances, V automatically deletes any temporary files that it creates. However,
because of a program or system crash, V may not always get a chance to delete such files. Selecting
this option will delete any temporary files that have been created by V.

De le te  ALL fi le s  in the  te mp o ra ry  d ire c to ry
Many programs create temporary files while active - and they almost always create them in the
temporary directory (see below). As above, the temporary files may not always be deleted. This option
will try to delete e ve ry thing  in the temporary directory.

It is recommended that you close all applications before selecting this option, since the temporary files
may still be in use.

Wha t is  the  te mp o ra ry  d ire c to ry?

The temporary directory is used by the operating system and other programs to store files for a short
period of time. This directory is usually specified by the environment variable T EMP or T MP and is
commonly (but not always) a subdirectory of your Windows directory (eg, C:\WINDOWS\TEMP).

No te

You should ne ve r explicitly store files in the temporary directory.
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4.17 FileName Command

The FileName command allows you to modify the selected file(s) in several ways:

Up p e r Ca se
The file name will be converted to all upper case.

Lo we r Ca se
The file name will be converted to all lower case.

Ca p ita lize  1s t
The first character of the name will be in upper case, the remaining characters will be in lower case.

Ca p ita lize  Initia ls
The first character of each word will be in upper case, the remaining characters will be in lower case.

T ra ns la te
This lets you translate every occurrence of a particular character in a file name to another character. 
For example, you can change all underscores to spaces.

Note that you can translate multiple characters in one pass. Every character in the first string is
replaced by the corresponding character in the second string.

Re mo ve  Sp a ce s
Any spaces in the file name will be removed.

Cha ng e  Exte ns io n
Allows you to change the extension of the selected file(s).

Co d e  Pa g e
This allows you to convert file names between Unicode and ANSI/ASCII character sets. Click here for

details.

Clip b o a rd  Re na me
This will rename the selected files(s) based on the current contents of the clipboard. Click here for

details.

The Mo d ify  option lets you modify the file name further by deleting a fixed number of characters from
the file name, or by inserting a fixed string into the file name. Click here for further details.

Mo d ify  (Re g e x) lets you modify file names using regular expressions. Click here for details.

No te

The "file name" does not include the file name extension. If you want to delete part of the extension, or to
add characters *after* the extension, you must enable Inc lud e  Exte ns io n in the  File  Na me .
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4.18 V and UAC

On the latest Windows Operating Systems (like Vista and Windows 7), users do not (by default) have
enough privilege to perform certain file operations. For example, they cannot modify files in protected
folders (like Program Files or the Windows folder), even if they are an Administrator.

When you  try to modify the contents of a protected folder with V, you will be presented with the following
message stating that the operation failed and asking you if you want to retry the operation with elevated
privilege:

If you decide to retry the operation, you will be presented with the following Windows UAC prompt:

If you press Continue, the file operation will be retried with elevated privilege.

UAC T ime o ut

V handles UAC slightly differently to Windows Explorer, in that it allows a UAC timeout to be specified
(in the Directory Options tab of Preferences). The timeout default to 60 seconds.

When a user first tries to modify the contents of a protected folder, they will be presented with a UAC
prompt. However, any further operations within the timeout period will not result in a UAC prompt.

For example, if you tried to rename 5 files in a protected folder using Windows Explorer, you would
receive 5 UAC prompts. In V, you would only receive a single UAC prompt (as long as the delay from
one rename to the next was not more than 60 seconds).

No te s



The Basics 65

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

Setting the UAC timeout to zero disables the timeout. That is, you will a lwa ys be presented with the
UAC prompt when attempting a privileged operation.

V has several limitations when running under UAC. Click here for details.

4.19 Limitations under UAC

Usually, when V is running under UAC, it will ask to be elevated if it does not have enough permission
to perform the desired operation. However, in the following cases, you will receive an error message
instead of being asked to be elevated:

Unzipping files to a protected folder. If you want to extract files to a protected folder, you will either
have to extract them to a temporary folder and then move them to the protected folder (in which
case you will be asked to be elevated) or run V as Administrator.

Trying to view a folder  that you do not have permission to view. If you want to view the contents of
these folders, you will have to run V as Administrator. 

When doing a search/GREP V is only able to search files that it has permission to access. You will not
get a UAC prompt if V tries to search a file that it does not have permission to access. V must be run as
an Administrator to do this.

To run V as Administrator, simply right-click on the V shortcut (eg, on the Desktop) and select R un A s
A d m inis tra to r.
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4.20 Modifying File Names

4.20.1 Modifying File Names

The FileName->Modify option (on the main File menu) lets you modify a file name by deleting a fixed
number of characters or by inserting a string.

Ho w ma ny cha ra cte rs  to  d e le te
Enter the number of characters to delete from the file name. The Inse rt/De le te  fro m option specifies
where the characters will be deleted from.

Inse rt String  into  File  Na me
Enter a string to be inserted into the file name. The Inse rt/De le te  fro m option specifies where the
string will be inserted.

Inse rt Da te  into  Na me
This is similar to the above Insert String option, however, you can also include date format specifiers
which will be expanded depending on the date/time. Click here for a list of valid date format specifiers.

Pressing the small question mark button next to "Insert Date into Name" will display a list of valid
specifiers.

Inse rt/De le te  fro m
This specifies where the characters will be deleted from or where the string will be inserted. It can be
one of:

Sta rt
The characters will be deleted from (or added to) the start of the file name.

End
The characters will be deleted from (or added to) the start of the file name.

Po s itio n fro m Sta rt
This specifies an index from the s ta rt of the file name. An index of 0 indicates the very start of the file
name. For example, specify an index of 1 to delete/insert from the second character of the file name.

Po s itio n fro m End
This specifies an index from the e nd  of the file name. An index of 0 indicates the very end of the file
name. For example, specify an index of 1 to delete/insert from the second last character of the file
name.

Pro mp t b e fo re  Mo d ify ing
If this option is enabled, the old and new file names will be displayed allowing the user to cancel the
operation.

Click here for details on how to use Regular Expressions to modify file names.

The Pre v ie w se ctio n changes as the above options are modified to displays what the file name will
look like after it has been renamed.

No te

The "file name" does not include the file name extension. If you want to delete part of the extension, or to
add characters *after* the extension, you must enable Inc lud e  Exte ns io n in the  File  Na me .
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4.20.2 Date Format Specifiers

Format specifiers (together with standard text) can be used in the Date string to add elements of the
date/time to the file name.

They will be expanded as follows:

%D 2 digit date (01-31) %d 3 letter day name (Sun-Sat)
%M 2 digit month (01-12) %m 3 letter month (Jan-Dec)
%Y 4 digit year %h 2 digit hour (00-23)
%y 2 digit year %n 2 digit minutes (00-59)

%s 2 digit seconds (00-59)
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4.20.3 Modify Code Page

This is used to convert the characters in a file name from a specified code page to Unicode (UTF-16),
and vice versa.

V will correctly display Unicode file names in the directory listing. In particular, file names containing
foreign characters will be displayed correctly, provided they have been encoded in Unicode.

Select the direction of conversion (ie, "Unicode to Code Page" or "Code Page to Unicode") by clicking
on the arrow to change the direction if necessary.

Co nve rting  File  Na me s fro m a  Co d e  Pa g e  to  Unico d e  (arrow points right)

If files were created on an operating system that does not support Unicode file names (like Windows
95/98) or on a file system that does not support Unicode file names (FAT), the file names would have
been encoded using the character set of a particular code page. In this case, the file names may not be
correctly displayed by V.

If you know the code page that the files names were encoded in, you can use this option to convert the
file names to Unicode - so they can be correctly displayed by V.

Simply select the code page from the Code Page list. V will display what the converted file name will
look like in the "After" box. If this doesn't look right, select another code page.

Co nve rting  File  Na me s fro m Unico d e  to  a  Co d e  Pa g e  (arrow points left)

File names that were created on an operating system supporting Unicode (like XP) and that contain
foreign characters may not be able to be viewed correctly when copied to a file system that does not
support Unicode file names.

In this case, you can use this option to encode the file names in a specific code page, so they can be
displayed correctly on another file system.

Inc lud e  Exte ns io n in the  File  Na me

The encoding of the file name extension is normally not modified. Enable this option if you also want to
re-encode the extension.

No te s

Not all Windows Code Pages will work. In this case, the "After" box will be empty.

If you know what the Windows code page number is, you can enter it after enabling Select Code Page
Identifier (CPID).

Once the file names have been converted to Unicode, they may not be able to be copied back to a file
system that does not support Unicode file names.
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4.20.4 Clipboard Rename

When this option is selected, V will display the current contents of the clipboard (you will not be able to
edit this).

When you press the Mo d ify  button, V will rename the first selected file in the directory listing to the first
line of text in the clipboard. The second selected file is renamed to the second line of text, and so on.

Ke e p  Exis ting  File  Exte ns io n(s)

By default, V will rename the entire file to the corresponding string in the clipboard. Enabling this option
will retain the existing file extension and rename only the name portion.

No te

It does not matter if the contents of the clipboard change after the user has selected this option (and
before pressing Modify). V will use the contents of the clipboard when this option was first selected, and
not the contents when the Modify button was pressed.
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4.20.5 Modify (Regex)

The FileName->Modify (Regex) option lets you modify a file name by using regular expressions.

The part of the file name that matches the regular expression will be replaced with the contents of the
"replace string". This can be a simple text string, but it can also contain 2 types of format specifiers - a 
ca p ture d  sub p a tte rn re fe re nce  and an a uto -incre me nt sp e c ifie r.

Ca p ture d  Sub p a tte rn Re fe re nce
Numbered subpatterns can be created in a regular expression by surrounding them with parentheses.
For example, the regular expression "^(.)(.*)(.)$" contains 3 subpatterns.

A subpattern can be referenced in the replace string by prefixing the subpattern number with a
backslash. Subpattern numbering begins at 1. A subpattern of 0 represents the entire matching string.
Up to 9 subpatterns can be specified.

Exa mp le
If searching for "^(.)(.*)(.)$" in the string "ABCDEFG", the 4 matching subpatterns will be:

\1 A

\2 BCDEF

\3 G

\0 ABCDEFG

Auto -incre me nt sp e c ifie r
An auto-increment specifier can be either %d or %x (for decimal and hex, respectively). They are used
to insert a number in a file name, and are incremented (or decremented) for every file name modified. 
Click here for further details

Click here for examples of regular expressions and replace strings

No te s

Regular Expressions can be very cryptic and great care should be taken when using them, as file
name changes can not be undone.

Always enable Pro mp t b e fo re  Mo d ify ing , to be sure that the regular expression will work as
desired.

If you want to include a % in the replace string, prefix it with a backslash (ie, \%).
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4.20.6 Auto Incrementing (Sequencing Files)

You may use %d  in the replace string to insert a number in the file name.

When renaming multiple files, the first file will use the number specified in "Sta rt numb e ring  fro m".
Subsequent files will increment the number by 1, unless a different increment is specified in "a nd
Incre me nt b y". A negative increment (eg, -1) will decrement the starting number for every file.

The number of digits used for the number can be specified immediately after the % (and before the d ).
For example, %4d  will expand 1 to "    1" . To zero-pad the number, place a 0 (zero) immediately after
the % (and before the number of digits). For example, %04d  will expand 1 to "0001".

Wa rning  - Ove rla p p ing  File  Na me s
When resequencing files, you should be careful that the file names do not overlap during the renaming
process. For example, resequencing the 101 files File 000 ... File 100 so that they are renumbered
File 100 ... File  200 will not work. V will first try to rename File 000 to File 100 but will fail because
File100 already exists.

No te

Using %x (instead of %d) causes the number to be stored as hex instead of decimal. For example, %
04x will expand 100 to "0064".

Click here for examples of regular expressions and replace strings

4.20.7 Some Examples

Below are some examples of how regular expressions can be used. Note that the quotation marks are
not part of the expression.

Replace "ABC" with "XYZ"

This will replace the firs t occurrence of ABC in the file name with XYZ.

Replace "ABC" with ""

This will delete the first occurrence of ABC (if it exists).

Replace "^ABC" with XYZ

This will replace ABC with XYZ only if it is located at the very start of the file name.

Replace "^ABC(.*)$" with "\1ABC"

This will move ABC from the start of the file name (if it exists) and will place it at the end of the file name.

Replace "^(.)(.*)(.)$" with "\2"

This will delete the first and last character of the file name.

Replace "^(.)(.*)(.)$" with "\3\2\1"

This will swap the first and last character of the file name.

Replace ".*" with "File%04d"

This will create files named File0001, File0002, ...
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5 Colors

5.1 Colors

The colors that V uses can be customized by selecting Change Colors from the View menu.

The colors may be customized for the

Directory Listing
Explorer Tree
File View

Click on the above links for further details.

No te

Colors are changed by clicking on a color button and selecting a new color. Default system colors (like
Button Text and Menu Background) can be selected by right-clicking on the button and selecting the
color from the menu.
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5.2 Directory Listing

To customize the Directory Listing colors, disable the Use  De fa ult Co lo rs  option.

This will allow you to click on the buttons that correspond to different components of the directory listing
and change their color. The following colors can be customized:

D ire c to ry  Ba ckg ro und  a nd  T e xt
All d ire c to ry  entries will be displayed in this color.

File  Ba ckg ro und  a nd  T e xt
All fi le s  will be displayed in this color.

Se le c te d  Ba ckg ro und  a nd  T e xt
This is the color used to display selected/highlighted entries. It is the same for both files and
directories.

Co mp re sse d /Encryp te d  T e xt
This text color is used to display any compressed and encrypted files.
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Strip ing /Alte rna te  Co lo rs
Striping is where the lines in the directory listing are displayed in 2 alternating colors. To use striping,
enable the Use  Alte rna te  Co lo rs  option.

When this option is enabled, the Directory and File colors are no longer used for directories and files.
Instead, the first line (and all odd lines) in the listing are displayed in the Directory color and the second
line (and all even lines) are displayed in the File color.

D ire c to ry , File  Ma sk a nd  Drive s
The color of the Directory, File Mask and Drives boxes (just below the toolbar) can also be customized
by disabling the De fa ult b a ckg ro und / te xt  fo r D ire c to ry  ... b o xe s option.

T he me s
If you are running Windows Vista or Windows 7, the directory will be drawn according to the Windows
theme. When using the Windows theme, some colors cannot be changed (even though V will let you).
In particular, the S e le c te d  B a c k g ro und color cannot be changed. Also, when using the Windows theme,
the directory entry below the cursor will always be highlighted. If you want to change the S e le c te d
B a c k g ro und color or disable the cursor tracking, you will have to enable the D isa b le  T he me  option.

No te s

Striping only applies to the Directory Listing. The Explorer Tree cannot be striped.

Hidden files will be displayed using the Hidden Text color in the Explorer Tree options.

Changing the  D is a b le  T he m e option may require V to be restarted before the directory is drawn
correctly.

5.3 Explorer Tree

The colors used to display the Explorer Tree can be different from those used to display the Directory
Listing.
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To customize the Explorer Tree colors, disable the Use  De fa ult Co lo rs  option. The following colors
can be customized:

Exp lo re r Ba ckg ro und  a nd  T e xt
All entries in the Explorer Tree (except for those below) will be displayed in this color.

Se le c te d  Ba ckg ro und  a nd  T e xt
This is the color used to display the selected/highlighted entry.

H id d e n T e xt
Hidden directories will be displayed using this color. This color will also be used for hidden files and
directories in the Directory Listing and also for the Compatibility Files directory entry.

T he me s
If you are running Windows Vista or Windows 7, the Explorer tree will be drawn according to the
Windows theme. When using the Windows theme, some colors cannot be changed (even though V will
let you). In particular, the S e le c te d  B a c k g ro und color cannot be changed. Also, when using the
Windows theme, the directory entry below the cursor will always be highlighted. If you want to change
the S e le c te d  B a c k g ro und color or disable the cursor tracking, you will have to enable the D isa b le
T he me  option.

No te s
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If a hidden directory is selected, it will be displayed using the selected colors, not the Hidden
Text colors.

The Explorer Tree cannot be striped.
Changing the  D is a b le  T he m e option may require V to be restarted before the Explorer is
drawn correctly.

5.4 File View

This section allows you to select the colors that V will use when viewing files.

To customize the File View colors, disable the Use  De fa ult Co lo rs  option. The following colors can
be customized:

No rma l Ba ckg ro und /T e xt
The colors used to display the file.

H ig hlig hte d  Ba ckg ro und /T e xt
These colors are used to display highlighted/selected text. By default, these colors are the inverse of
the text colors.  That is, the background color is the text color and the text color is the background color.
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Se a rch Line  Ba ckg ro und /T e xt
When searching,  the found text is displayed using the above hig hlig hte d  colors.

Only the portion of the line that contains the found text will normally be highlighted. However, the part of
the line that does not contain the found text may also be displayed in a different color to the standard
text color. Doing this makes it easier to distinguish the line which contains the found text, especially if the
found text is scrolled off the screen.

H ig hlig ht All Ba ckg ro und /T e xt
These colors are used to display all string matches when the Highlight All option is enabled in the
Search Bar.

H ig hlig ht All Line  Ba ckg ro und /T e xt
These colors are used to display the non-highlighted portion of all lines that contain a Highlight All
match.

Line  Numb e rs  No rma l/H ig hlig ht All
The first color is used to display line numbers (and addresses in HEX mode). It is also used to display
text in fixed columns.
The second color will be used to display the line number for all lines that contain a Highlight All match.

Curre nt Line  Ba ckg ro und
This color is used to draw the background of the c urre nt line.

Bo o kma rk  Ba ckg ro und
This background color is used to display bookmarked lines.

Grid  Line
This color is used to draw the Grid Lines when right-clicking on the ruler.

Blo ck  Ma rke r
This color is used to draw the start of block marker. A block marker is created by right-clicking on a
position in the file and selecting Mark Block->Start Point.
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6 The Directory View

6.1 The Directory View

The Directory View (or browser mode) basically displays the contents of the current directory. Any
subdirectories are always displayed at the top (in alphabetical order) and are then followed by the files
in the directory (which can be sorted in various ways).

The Directory View lets you easily navigate the file system and select files to view.  Basic file
management operations can also be performed on selected files. Double-clicking on a directory will
display the contents of that directory. Double-clicking on a file name will display the file. Multiple files
may be selected in the standard Windows fashion - by shift-clicking and control-clicking. Commands
executed while multiple files are selected will apply to all selected files (as long as the command is
valid for multiple files).

Select Options from the View menu to customize how the listing is displayed. The colors of the Directory
View can be modified by selecting Change Colors from the View menu.

The font used to display the Directory View can be modified as follows.

The top of the Directory View consists of 3 drop-down list boxes:

D ire c to ry  Bo x
This always displays the name of the current directory. You can also browse a directory by entering the
directory name in the Directory Box and pressing the Enter key. (In fact you can also enter the name of
a fi le  here). The Directory Box also maintains a history of the directories browsed (unless you have
Maintain Directory History disabled). You may browse one of these directories by simply selecting it
from the drop-down list.

When typing a path into the Directory box, V will try to auto-complete what you are typing (based on
valid file system paths and not on the existing entries in the drop-down list).

An environment variable (such as %T EMP%) can also be entered in the Directory box. Once the Enter
key is pressed, the variable will be replaced by the corresponding directory name.

File  Ma sk Bo x
Only files that match this file mask will be displayed in the Directory View. A new mask may be selected
from the drop-down list box or may be entered directly into the box (terminated by pressing the Enter
key).  Once you enter a new mask, it will be retained in the drop-down list (up to 20 masks). If you want to
delete a file mask from the list, you must first select it, clear it from the box (usually by pressing the Del
key) and then press Enter. Note that *.* cannot be removed. Click here for further details on specifying
file masks.

In Dual Pane Mode, two File Mask boxes will be displayed - one for the left pane and one for the right.
You can have both panes share a single box by enabling "Share Masks in Dual Pane" in the Directory
Options tab of Preferences.
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Drive s  Bo x
This contains a list of available disk drives - fixed, removable and network. The current disk drive is
always displayed. To view files on another disk drive, simply select the drive from the drop-down list
box. The Drives box may also contain an icon and/or the drive label by enabling the appropriate
option.

The Drives Box will not be automatically updated if the drives list changes (eg, by creating a new
network drive). To do this, select Re fre sh Drive s  from the View menu.

Fo nts
The font used by the Directory, File Mask and Drives boxes can be modified by right-clicking on the
small down-arrow to the right of the box and selecting S e le c t Fo nt.

Ne two rk  Bro wsing
A network icon (next to the Drives Box) may be pressed to view files on a network. Click here for further
details.

Dua l Pa ne  Mo d e
In Dual Pane Mode, the Directory and Drives boxes will display the directory and drive of the "active
pane". If you click on the other pane, the contents of Directory and Drives will change to reflect the new
directory and/or drive. If you hover the mouse over the Directory box, a tooltip containing the directories
of *both* panes will be displayed.

No te

By default, the Directory View lists a ll files in the current directory - including hid d e n and sys te m files.
You can set the View Options to change this.
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6.2 Directory Options

Several options can be selected from the Op tio ns submenu of the main View menu. The first 2 options
are:

Cla ss ic  Mo d e
Enable this if you want V to operate in Classic Mode.

Ena b le  De scrip tio ns  (4DOS Co mp a tib le )
This must be enabled before 4DOS descriptions can be displayed in the Directory Listing. This can
also be enabled in the Directory Options tab of Preferences.

If in Dual Pane Mode, the remaining options will appear twice - in 2 columns. This allows you to set a
different option for each pane. If you want to set the same option for both panes, you can either set the
corresponding option in both columns, or you can press the SHIFT key when setting the option in one of
the columns.

Use  XP (nume rica l) So rt Me tho d
Files with numbers in their names are sorted differently under Windows XP. For example, Windows
2000 will place X11 before X2 (because 1 is less than 2). However, XP will place X2 first (because 2 is
less than 11).

Use  Exp lo re r So rt Me tho d
V sorts the directory listing slightly differently to Windows Explorer. Enable this option if you want the
directory listing sorted like Explorer. Click here for further details.

So rt D ire c to ry  Entrie s
In the Directory View, only the files are usually sorted. The directory names always appear in
ascending order. Enabling this option also causes the directories to be sorted, however, they still
always appear before the file entries.

Sho w d ire c to rie s  a t b o tto m if so rt o rd e r is  d e sce nd ing
By enabling this option, the directories will appear at the end of the file list (instead of the top) whenever
the sort order is descending.

D isp la y  Ove rla y  Ico ns
Enabling this option will display any overlay icons that a file/folder may have. These are usually small
marks that are displayed over the bottom of the main icon.

This option only applies to the files (and folders) in the Directory Listing - not in the Explorer tree. To
enable overlay icons in the Explorer tree, you need to enable Display Windows Folder Icons in the
Explorer tab of Preferences.

Note that this option can significantly slow down the display of the directory listing.

D isp la y  Alt. Da ta  Stre a ms
This enables the display of Alternate Data Streams . This can also be enabled by selecting Options

from the View menu.

D isa b le  Auto ma tic  re fre sh
The Directory View will be automatically refreshed when V detects that the contents of the directory
have changed. Enable this option if you find this behaviour annoying.
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6.3 Directory Font

By default, the directory listing is displayed in the standard Windows font - usually MS Sans Serif,
unless it has been modified in the Control Panel Display settings.

However, you can override this font by selecting Change List Font from the View menu. This is
particularly helpful if you prefer the font to be larger than the default Windows font.

To revert back to the default Windows font, select Default List Font from the View menu.
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6.4 File Masks

The File Mask box accepts standard Windows/DOS style file masks (like *.zip ), but can also accept
more powerful (and sometimes cryptic) Unix style masks.

The mask may contain one of the following special characters:

"?" Matches any single character (including the NULL character). That is, htm? will match
htm" AND html.

"*" Will match any string (including the NULL string).

"\" Indicates that the next character is to be treated literally. This is normally used to prefix
characters that usually have a special meaning (like * and !).

Multiple characters may also be specified by enclosing them in brackets "[  ] ". For example, 

[abc] will match "a" or "b" or "c"
[a-z] will match any character from a to z
[a-z0-
9]

will match any alphanumeric character

You may use a "!" or "^ " in a character set to indicate a list of characters that you do NOT want
matched. For example, 

[!abc] will match any character EXCEPT "a" or "b" or "c".
[!0-9] will match any non numeric character.

Some examples where you can use these file masks: 

[ab]*[0-9].* All files that begin with A or B and end with a digit
[!ab]* All files that DON'T begin with A or B
*.[ze][ix][pe]Display all zip AND exe files

Note that in the last example, files with extensions of zxe, eie and exp would also be displayed. A better
way of doing this is to use multiple file masks (see below). 

Sp e c ify ing  a  null (e mp ty) e xte ns io n
A null (or empty) extension may be specified by terminating the mask with a single ".".
For example, "a *." specifies all files that begin with "a" and have no extension. It will match abc but will
not match abc.txt.
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Multip le  File  Ma sks
Multiple file masks may be entered by separating them with a comma (no  sp a ce s between commas).
You may also prefix a mask with "!" to indicate that you want files no t matching the mask to be
displayed. 

For example, 

*.zip,*.exe Display all zip AND exe files
!*.bak Display all files EXCEPT bak files
!*.bak,!*.tmp Do not display bak OR tmp files

When specifying multiple file masks, a file will usually be displayed if it matches a ny of the masks.
However, where one of the file masks is negated (ie, contains a "!"), a file will only be displayed if it
matches a ll of the masks. 

No te

The file mask applies to fi le s  o nly . By default, a ll d ire c to rie s  are displayed in the directory listing,
regardless of the file mask. If you would also like to apply the file mask to directories, you will have to
specify a separate directory mask. Click here for details.
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6.5 Using File Masks with Directories

By default, the file mask is only used to filter files, not directories. However, a second file mask can be
entered which will only apply to directories.

The second mask is entered immediately after the first mask separated by a "|". This character is
sometimes called a v e rtic a l b a r, a p ip e or the o r character and is usually found on top of the backslash
key (ie, Shift+Backslash).

For example, using a mask of "*.jpg|D*" will display all .jp g files and only the directories that begin

with "D".

If you leave the directory mask blank (ie, enter nothing after the "|"), no directories will be displayed.
Similarly, leaving the mask empty b e fo re the | will display no files.

Exa mp le s

*.*|A*  Display all files and only directories that begin with A

*.exe| Display all the .exe files and no  directories

|A* Only display directories that begin with A (and no  files)

No te s

This type of file mask can only be used when displaying the directory listing. It cannot be used when 
searching for files (using Find Files/GREP).

If it exists, the ".." entry will a lwa y s be displayed (to indicate the parent directory), regardless of the file
mask used.

6.6 Network Browsing

Pressing the Network icon (next to the Drives box) will display the "Select Network Path" dialog box.

A history of the most recently viewed paths is maintained. A path may be selected from this list, a new
path may be selected by pressing the Bro wse  button, or you may simply enter the UNC path into the
Ne two rk  Pa th field.

Pressing the De le te  button will remove the network path from the history.
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6.7 Single Letter Commands

Single Letter Commands allow you to execute a command by using a single letter for a keyboard
shortcut instead of a Ctrl or Alt key combination. For example, you can enter D  instead of Ctrl D  (to
delete a file) and M instead of Ctrl M (to move a file).

By default, pressing a single letter in the Directory View, will take you to the first entry in the directory
listing that begins with that letter. Pressing the same key again will take you to the next entry that begins
with that letter. 

Naturally, you lose this capability if you enable Single Letter Commands. That is, pressing C will copy a
file instead of going to the first file name that begins with C. However, by also pressing the Shift key, the
command is ignored and the standard behaviour is produced. In the above example, pressing C would
copy the selected file(s) and pressing Shift-C would select the first file that begins with C.

Single Letter Commands are enabled in the Keyboard tab of the Preferences Dialog box.

Click here for a list of the available Single Letter Commands.

No te

Single Letter Commands only work in the Directory Listing, not in the File View. For example, pressing
'C' while viewing a file will not copy the file. However, you can customize the keyboard to assign the C
key to the Copy command.
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6.7.1 Default Commands

The default Single Letter Commands are as follows:

Ke y Co mma nd

A File Attributes
B File Attributes
C File Copy
D Delete
E Launch Editor
F GREP
H View as Hex
I Execute File
K Create Directory
L View From Tail
M Move
N Create File
O View File
P Print
R Rename File
S Send File
T File Touch
U Default User Command
V View File
X Execute File
Z View as Zip
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6.8 The Toolbar

Below is the default toolbar for the Directory View. It can be customized so that the buttons are re-
arranged or deleted (right-click on the toolbar and select Customize). Click here for further details.

Go  Up
Selecting this will display the parent of the current directory.

Go to  Ro o t
This takes you to the root of the current drive (eg, C:\, D:\)

Re fre sh
Redisplays the contents of the current directory. Note that if you do not have the Disable Automatic
refresh option enabled, V will (usually) automatically update the directory listing whenever the directory
is modified in any way. However, there are certain cases where V will not automatically update the
directory. One of these is when a file in the current directory is continually being modified.

Vie w
Press this to view the selected file(s).

Vie w File s  in Bo th Pa ne s
This button is only available in Dual Pane mode - and only if files in *both* panes have been selected.
Pressing this button will display all the files that have been selected in *both* panes. Each file will be
displayed in a separate window.

Se a rch
Search for files or text within files (GREP). Click here for further details.

Co p y
Copies a file(s) to another directory. You will be asked to select a directory where the selected file(s)
will be copied to. 

Mo ve
Similar to Copy, except the files are removed from the original directory. The Copy and Move
commands will also work with directories instead of files. Click here for further details on selecting the
destination path.

Print
Prints the selected file(s).
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De le te
Deletes the selected file(s) or directory. If a directory is selected, you will always be asked to confirm
the deletion, regardless of whether you have disabled the Confirm File Delete option. If the Delete to
Recycle Bin option is set, the file will be moved to the Recycle Bin. The Recycle Bin may be bypassed
by pressing the shift key when selecting the Delete command.

La unch Ed ito r
V is not an editor. That is, you cannot modify the contents of a file with V. In order to edit a file, you need
to specify an editor. The La unch Ed ito r command will launch the specified editor and load the
selected file(s).

Exe cute /Run
The selected file is launched together with it's associated application (if one exists) - just like double-
clicking on a file name in Explorer. For example, if a JPG file was executed, your image viewer would
be launched and the JPG file loaded. This command does not work on multiply selected files.

Co mma nd  Pro mp t
This launches a Command Prompt (or DOS Box) in the current directory. Click here for further details.

Use r Co mma nd
This will execute the Default User Command. Further User Commands may be selected from the
UserCommands menu.

Exp lo re r
This launches Windows Explorer. The right hand side of Explorer will display the contents of the current
directory. This is useful in the case where V cannot perform an operation that Explorer can.

If the Ctrl key is pressed when selecting this command (or if you press Ctrl+Alt+O), a ro o te d  Explorer is
displayed. That is, the root of the Explorer tree is the current directory.

Preferences/Options
This displays the Preferences Dialog Box which allows you to configure most of the program options. 
Click here for further details.

Ab o ut
Displays the About Box which displays the version number of V as well as the Registered User Name.

He lp
Displays the Help File.
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Se le ct Vie w T yp e
This displays a further menu where you can select the format of the directory listing. You may select
one of the following:

La rg e  Ico ns
The files are displayed as rows of large icons with the file name displayed below the icon.

Sma ll Ico ns
The files are displayed as rows of small icons with the file name displayed to right of the icon.

Lis t Mo d e
Similar to the Small Icons format except the files are displayed in columns instead of rows.

De ta ils
The files are displayed (one file per line) together with customizable file details (name, size,
date, ...).

T humb na ils
V tries to display a thumbnail for each file.

Dua l Pa ne  (Sp lit Scre e n)
This displays a further menu where you can modify the Dual Pane settings. You may select one of the
following:

Ve rtica l Sp lit Mo d e
V is split vertically.

Ho rizo nta l Sp lit Mo d e
V is split horizontally.

Re mo ve  Sp lit
Dual mode is disabled. V reverts to a single pane interface.
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T o o ls
This displays a further menu where you may select one of the following:

MD5/CRC32
This calculates the MD5 and CRC32 of the selected file(s).

Wo rd /Line  Co unt
This counts the number of words and lines in the selected file(s). Click here for further details.

Cre a te  D ire c to ry
Creates a sub-directory in the directory currently being viewed.

Cre a te  File
Creates an empty file in the current directory.

Se nd
This will construct an email message using your email client and will attach the selected file(s).
Note that this will only work if MAPI (or Windows Messaging) is installed on your system.

Ma p /D isco nne ct Ne two rk  Drive
Allows you to map to and disconnect from a network drive.
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6.9 Customizing the Directory View

When the Directory View is in Details Mode, the file and/or directory details are displayed in several
columns. The Details Mode can be customized in several ways:

Se le c ting  Co lumns to  D isp la y

The following information may be displayed for each file/directory.

File  Na me
Size The size of the file in bytes
Da te The date the file was last modified
T ime The time the file was last modified (HH:MM)
Se co nd s The seconds portion of the file time will also be displayed in the Time column

(HH:MM:SS)
Acce sse d The date/time the file was last accessed
Cre a te d The date/time the file was created
T yp e The extension of the file name (eg, ZIP, HTML)
MSDOS
Na me

The short (8.3) filename (see below)

4DOS
De scrip tio n

The 4DOS description - if it exists (see below)

Attrib ute s
The file attributes are a sequence of characters that the file system maintains for each file/directory.
The attributes are combination of the following:

A Archive attribute
H Hidden attribute
R Read-only attribute
S System attribute
T Temporary attribute
C Compressed attribute
E Encrypted attribute
D The file is an Alternate Data Stream (ADS)
L Link (the folder is a symbolic link or virtual folder)

MSDOS Na me
This is the 8.3 na me  that the operating system generates for long file names. Note that the MSDOS
Name will only be displayed if it is different from the File Name.

To select which columns you want to display, right click on any of the column headers, and select the
details you want displayed. Note that the filename must always be displayed.

4DOS De scrip tio n

Click here for further details on displaying the 4DOS description
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Re sizing  the  co lumn wid ths

To resize the width of each column, simply position the cursor on the column header at the border
between two columns, click the left mouse button and then drag the cursor left or right to achieve the
required width. Note that if a column isn't wide enough to display the entire contents of a field, it will
display what it can, followed by three dots (...).

Selecting Auto -Size  Co lumns from the View menu, or pressing Ctrl-Plus (on the numeric keypad) will
automatically size each column to the width of the longest entry.

See also: Sorting the File List
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6.10 Sorting the File List

In Details Mode, the file list may be sorted on any of the columns except Attributes. A "+" will appear in
the appropriate column to indicate that the list is sorted in ascending order, and a "-" will indicate that it
is in descending order.

The sorting order may be specified in several ways:

So rt b y  le ft-c lick
The simplest way to specify the sort order is to left-click on the heading of the column corresponding to
the field you want the list sorted on. If you want to invert the order of the sort (ie, go from ascending to
descending, or vice versa), simply click on the column again.

When changing the sort order from one column to another, V switches to the "default" ascending/
descending mode for the corresponding column. For "Name" sort, the default mode is ascending and
for Date/Size sort, the default mode is descending.

That is, if the files are being displayed in ascending name order, switching to sort by size will display
the files in descending size order.

To have V maintain the current ascending/descending mode when changing
sort order, enable the "Maintain sort order when changing sort column" option in the Directory Options
tab of Preferences.

So rt b y  rig ht-c lick
If you right-click on the column header and select the So rt option, you will be able to specify the
desired sort order. This method gives you an extra option - So rt b y  Exte ns io n. In this case the files
are sorted in alphabetical order, based on their file extension only - files with the same extension will be
grouped together. For example, all .DOC files will appear before all .ZIP files.

Pre ss ing  Ctrl+Plus  o r Ctrl+Minus
Pressing Ctrl+ will sort the list in ascending order (of the currently selected column) and pressing Ctrl-
will sort the list in descending order.

Ra nd o m So rt Ord e r
Files may be sorted randomly by selecting Random sort order (right-click on the column header, select
Sort followed by Random). Every time the directory is refreshed, the files will be listed in a different
order. Note that only files will be displayed in random order - directories will always appear at the top of
the listing in alphabetical order.

Why wo uld  I wa nt to  so rt ra nd o mly?
You probably wouldn't! But I found it very useful in generating random play lists for a group of MP3 files.

No te s

Sorting by Date is the same as sorting by Time

Column headings are only available in Details Mode. If you are using one of the icon views,
you can specify the sort options by right-clicking in the Directory View away from a file name or
icon. If you click on a file name, the menu that pops up will not contain a Sort option.

Only the files in the list are sorted. Any directories that may exist are always sorted in
alphabetical order and always appear before any files.

V sorts slightly differently to Windows Explorer. Click here for an explanation.
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See also: Hiding Files and Directories
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6.11 Filename Sorting

V sorts the directory listing slightly differently to Windows Explorer.

V does a s tring sort, whereas Explorer does a wo rd sort. A word sort treats hyphens and apostrophes
differently to other characters. 

For example, the left column shows how V sorts 6 files. The right column is how Windows Explorer sorts
them:

V Exp lo re r

X-A X-A
X-C XB
XB X-C
Y-A.txt Y.txt
Y.txt YA.txt
YA.txt Y-A.txt

XP (nume rica l) So rt
Files with numbers in their names are sorted differently under Windows XP.

For example, Windows 2000 will place X11 before X2 (because 1 is less than 2). However, XP will
place X2 first (because 2 is less than 11).

You can set the sort method that V uses by enabling one of the following options in the S o rt sub-menu
of the main V ie w menu:

Use  Explorer sort

Use XP (numerical) sort

6.12 Hiding Files and Directories

By default, V will display *all* entries in the current directory, even if they are hidden or system files.

You can choose not to display hidden or system entries by selecting the required option from the H id e
sub-menu of the main V ie w menu.

H id e  D ire c to rie s
If this is enabled, only files will be displayed in the list. All directories will be hidden.

H id e  Syste m File s
System files will not be displayed. (System d ire c to rie s will).

H id e  H id d e n File s
Hidden files will not be displayed. (Hidden d ire c to rie s will).

H id e  Syste m All
This will hide all system files and directories.

H id e  H id d e n All
This will hide all hidden files and directories.
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6.13 Viewing Files

From the Directory View, files can be viewed in several ways:

Do ub le -c lick ing

To view a file, simply double-click on the file name. Once in the File View, the Previous/Next File/File
List commands can be used to step through all the files in the directory.

If the file is a ZIP file, the ZIP View will be displayed instead of the File View.

Note that some files will be executed when you double-click on them.

T he  Vie w co mma nd  fro m the  me nu/ to o lb a r

Selecting the Vie w command from the File  menu or toolbar, will cause the selected file(s) to be
viewed. In the case where more than one file is selected, the Next and Previous File commands will be
restricted to the selected files instead of all the files in the current directory.

Vie w He x

The Vie w He x command from the File  menu causes the selected file(s) to be viewed in Hex mode,
regardless of the format of the file.

Vie w T a il

The Vie w T a il command from the File  menu causes the selected file(s) to be viewed from the end of
the file (or tail).
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6.14 Viewing ZIP Files

Files that end with an extension of a supported compressed archive (like ZIP and CAB) will
automatically be opened in the ZIP View. This will display the contents of the ZIP file just like displaying
the contents of a directory.

Not all compressed files will have an extension indicating that they are compressed. For example, self-
extracting executables (SFX) have an extension of ".exe", but are still ZIP files. To view such files in the
ZIP View, select "View as Zip" from the File menu (or press Ctrl-Z).

Alternatively, to view a ZIP file in hex mode, select "View as Hex" from the File menu.

Click here for further details on the ZIP View.

6.15 Selecting Files

Files (and directories) in the Directory View may be selected in the usual ways supported by Windows.
That is:

Left-clicking on a file (using the mouse) will select that file.

To select multiple files, you can select the first file by left-clicking on it and select subsequent files by
left-clicking on them while pressing the Ctrl key (ctrl-left-click).

To select multiple files using the keyboard, select the first file and then hold down the Ctrl key while
moving the Up/Down arrow buttons. Press the SPACE key to select a file (while the Ctrl key is still
pressed). Keep moving with the arrow keys and pressing SPACE to tag files.

Note that this will not work if you enable the Ctrl+Arrows keys to scroll option in the Keyboard tab of
Preferences.

To select a range of files, select the first file by left-clicking on it, and then select the last file in the range
by left-clicking on it while the Shift key is pressed (shift-left-click).

Using the keyboard, you can select a range of files by selecting the first file and then pressing Up/
Down arrow while the Shift key is pressed.

Se le c ting  ALL fi le s

You may press Ctrl-A to select all the files in the directory. Note that this differs slightly from Explorer in
that the directories are not selected.

You may select all the entries (or just all the directories) by selecting the corresponding command from
the Edit menu. You may also invert your selection by selecting the appropriate command from the Edit
menu

No te

By default, files are selected by clicking on the File Name portion of the row. By selecting the Ena b le
Full Ro w Click  option in the Directory Options tab, you may select files by clicking anywhere on the
row. However, the entire row is not highlighted - just the File Name. If you would also like the entire row
to be highlighted you will need to enable Highlight Entire Row.
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6.16 Drag and Drop

By default, any file that is dropped onto the V directory listing will be copied/moved to that directory.

If a p lus  s ig n (+) appears next to the mouse pointer while dragging files, the files will be co p ie d  when
they are dropped. If no plus sign is displayed, the files will be mo ve d  (that is, they will be deleted from
their original directory). You can press the Ctrl key while dragging to hide/show the plus sign (that is,
toggle the copy/move status).

If you drag files to a directory that is on the same drive, V will do a mo ve . If you drag the files to a
different drive, V will do a co p y. This can be overridden by pressing the Ctrl or Shift keys. Pressing the
Ctrl key while dragging will always result in a co p y. Pressing the Shift key while dragging will always
result in a mo ve .

You can modify this behavior by disabling the Explorer Compatibility option in the Explorer Options tab
of Preferences. This will cause V to always mo ve  a file that is being dragged, regardless of where it is
being dragged to (or copied if the Ctrl key is pressed).

If you have started dragging the files and decide that you don't want to drop them anywhere, simply
press the ESCAPE key to cancel.

Drag and Drop can be used to quickly move/copy files from the current directory to a sub-directory or
to the other pane in Dual Pane Mode. Simply select the files to be moved or copied and drag them to
the appropriate directory name or to the other pane.

Us ing  the  rig ht mo use  b utto n

If you press the right mouse button while you are dragging files, a menu will appear when you drop the
files that will ask you whether you want to copy or  move the selected files. This menu may also contain
several other options that have been installed by third party programs. Simply select the desired
operation.

Cre a ting  Sho rtcuts

The "right-drag" menu will usually contain a Cre a te  Sho rtcut(s ) option. If this option is selected, a
shortcut to the selected file(s) is created.

Vie wing  Dro p p e d  File s

If the Move/Copy dropped files option is not enabled in the Directory Options tab of Preferences, V will
v ie w any file that is dropped onto it (instead of moving/copying it).
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6.17 Moving Files using Cut and Paste

Explorer allows you to move/copy files (and directories) by using "cut and paste". V also supports this.

To move files, select them and press Ctrl-X (cut). To copy, press Ctrl-C (copy) instead of Ctrl-X. 

When moving files, the file icons of the files to be moved will dim slightly.

You can then move to another directory and press Ctrl-V (paste) to perform the copy/move. 

No te s

You may also select Cut/Copy/Paste from the Edit menu.

The copy/move does not take place until Ctrl-V is pressed. If you make a mistake in cutting files, you
can simply reselect them and cut/copy them again. The second cut/copy will replace the first.

The previous meanings of the control keys (Ctrl-X/C/V) have now been replaced. If you want to maintain
the old functionality of the keys (ie, execute, copy and view), you can disable the Ctrl-X/C/V keys by
enabling the D isa b le  Ctrl-X/C/V option in the Directory Options section of Preferences. You may still
perform cut/copy operations by selecting them from the Edit menu. 

6.18 Send To Menu

The Send To menu in V works just like the Send To menu in Explorer. That is, all selected files are
se nt to  the selected destination.

The Send To menu may be selected from the File menu or by right clicking on the directory listing.
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6.19 Explorer Context Menu

When you right-click on a file in V, a popup menu appears that contains may useful commands. The
default V menu is different to the menu that is displayed by Windows Explorer.

The Explorer menu is sometimes useful as it may contain extensions that have been installed by third
party applications - which are not available V's right-click menu.

V can display the Explorer menu by either pressing the Ctrl key when right-clicking or by selecting
E xp lo re r M e nu from the V right-click menu.

If you prefer Explorer's right-click menu to the default V right-click menu, you can enable U s e  the
W ind o ws  E xp lo re r rig ht c lic k  m e nu a s  d e fa ult in the Directory Options tab of Preferences.

Note that this option only affects the right-click menu in the Directory View. You will also need to change
the same option in the Explorer Options tab if you want the same behavior when right-clicking on an
entry in the V's Explorer Tree.

If the Explorer menu has been made the default right-click menu, the V menu can be displayed by
pressing the Ctrl key when right-clicking.

Wind o ws Exp lo re r Ba ckg ro und  Me nu

The W ind o ws  b a c k g ro und  m e nu is displayed by Windows Explorer when you right-click on an e m p ty
part of the Explorer - this menu usually contains an option to create N e w files.

V will also display a background menu when you right-click on an empty part of the directory listing,
however, it will differ slightly from the menu displayed by Explorer. In particular, the V background menu
will not contain the P a s te and P a s te  S ho rtc ut commands.
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6.20 Creating Shortcuts

To create a shortcut, select Cre a te  Sho rtcut from the File menu.

This creates a shortcut to the selected file(s) in the curre nt directory.

If you want to create a d e skto p  shortcut, simply create a shortcut in the current directory and then drag
it onto the desktop.

6.21 4DOS Descriptions

4DOS (from JP Software) is a popular replacement for the Windows Command Prompt
(COMMAND.COM/CMD.EXE).

Among other things, 4DOS lets you assign a description (or comment) to a file/directory.

To display the 4DOS descriptions in the Directory View, you need to Enable 4DOS Support in the
Directory Options tab of Preferences.

Once this is enabled, you can right-click on the column headings and select Sho w 4DOS
De scrip tio n. This will add a De scrip tio n column to the Directory Listing which will display the 4DOS
description for each file (if present).

Mo d ify ing  the  4DOS d e scrip tio n

The 4DOS description can be edited by pressing Ctrl+Shift+R.

You can also edit the description by clicking on it (as long as Disable mouse-click rename has not
been enabled). However, you cannot click on the very start of the description - you need to click at least
3 characters in from the right. (This is a Windows "quirk" which is not worth fixing).

Ma inta ining  4DOS d e scrip tio ns

4DOS descriptions are stored in a file called DESCRIPT .ION.

When V copies, moves, renames and deletes files, it correctly updates the appropriate 4DOS
description files.

For example, if you delete a file, the description is also deleted from DESCRIPT.ION. If you copy a file
into a new directory, the description is also copied into DESCRIPT.ION in the new directory.

No te

Note that the descriptions are only maintained if you perform the file operations with V. If you were to
use any other (non-4DOS aware) program (like Windows Explorer), the descriptions would be lost.

In particular, when copying/moving files using right-click drag and drop, the copy/move is performed by
Windows, not by V, and so the 4DOS descriptions will not be maintained.
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As from Version 14, V also looks for .d e scrip tio n if DESCRIPT .ION is not found.
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6.22 Formatted Directory Listing

Unfortunately, V can not directly print the directory listing. If you select Print while you are viewing a
directory, V will print the contents of the selected file(s) - and not the directory listing.

However, a formatted directory listing can be copied to the clipboard. This can then be pasted into
another document for printing, or can even be viewed (and subsequently printed) by V.

To copy a formatted directory listing to the clipboard, select Directory Listing from the File->Copy To
Clipboard menu. Something like the following will be copied:

dunzips32.dll   167,936   04/08/2005 11:53

dzgt32.dll      139,264   06/12/2001 10:25

libbz2.dll      131,072   03/01/2007 10:00

unrar.dll       158,208   15/06/2004 14:13

Custo mizing  the  Fo rma t o f the  D ire c to ry  Lis ting

The format of the listing can be customized by selecting Directory Listing Setup from the same menu.

The setup dialog will display 12 columns. Simply enable the columns you want printed, and select what
you want to be printed in the Column Name
drop-down list box.

You can use the Up/Down arrows to move the position of the corresponding column, or you can press
the 'X' button to delete the column (and shift all other columns up).

Co lumn Wid th
You can specify a maximum column width (in characters) for each column. If the column text is longer
than this width, it will be truncated. Specifying a width of zero, means that the column width will be the
width of the longest entry in that column.

# Sp a ce s (Pa d d ing )
This is where you enter the number of spaces (if any) that you want copied after the column.

Do  no t use  se p a ra to rs  in fi le  s ize
Enable this option if you do not want separators included in a File Size column. That is, if you want 1234
instead of 1,234.

Inc lud e  D ire c to rie s
If you select Always, directories will always be included in the directory listing. If Only if selected is
enabled, directories will only be included in the directory listing if they were selected prior to issuing the
Formatted Directory Listing command.

Printing  the  D ire c to ry  Lis ting

The formatted listing can not be sent directly to the printer. However, the View Clipboard command can
be used to view the directory listing - and print it.
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6.23 Compatibility Files (Vista/Windows 7)

When using Windows Explorer on Vista/Windows 7, a Co m p a tib ility  F ile s button will sometimes appear
in the toolbar.

This indicates that the directory being viewed has a c o rre s p o nd ing  v irtua l fo ld e r. This virtual folder is
created when some older programs (not designed to run on Vista/Win7) try to create files in certain
protected directories (like C:\P ro g ra m  File s). Instead of breaking the program (by not allowing a file to
be created in the protected directory), Windows redirects the file to a virtual folder where the user has
permission to create it.

Whenever V encounters a directory with corresponding Co m p a tib ility  F ile s, it will include a
<Co mp a tib il ity  File s> directory entry at the top of the directory listing. Double-clicking on
Co m p a tib ility  F ile s will display the corresponding virtual directory (which is not really a subdirectory of
the directory being viewed).

If you are using the dual pane mode, you can display the virtual directory in the other pane by right-
clicking on Co m p a tib ility  F ile s and selecting Op e n in O the r P a ne.

No te s

The Co m p a tib ility  F ile s entry only appears in the Directory Listing - it does not appear in the
corresponding Explorer tree.

The Co m p a tib ility  F ile s entry is drawn using the Hidden text color.

The Compatibility Files feature can be disabled by selecting H id e  Co m p a tib ility  F ile s from the H id e
submenu of the main V ie w menu.
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7 The Explorer Tree

7.1 Explorer

The Explorer tree is displayed to the left of the directory listing, and makes V look much like Windows
Explorer.

By default, the Explorer tree is hidden. To display it, press the "+"  button immediately below the main
toolbar. The Explorer tree may be closed by pressing the small x in the top right hand corner of the tree.

Click here for differences between V Explorer and Windows Explorer.
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7.2 Explorer Implementation

I have tried to make my implementation of the Explorer as fast as possible. In doing so, some things
behave slightly differently to  Windows Explorer.

In particular:

Fo ld e r Ico ns
By default, V will display the same folder icon for every folder in the Explorer tree. Windows Explorer
displays different icons depending on the type of folder (eg, shared, network, system).

If you prefer the Windows-style icons, enable "Display Windows Folder Icons" in the Explorer section of
Preferences.

Exp a nd a b le  Fo ld e rs
The Windows Explorer tree displays a "+"  next to every folder that has any subfolders. There is some
overhead in determining whether a folder has any subfolders, therefore by default, V places a "+"  next
to *every* folder. If you try to expand a folder that has no subfolders, the "+" will disappear. This speeds
up the display of folders when a branch is expanded (although the time saved may not be significant).

If you find this irritating, you can make V act like Explorer by enabling the "Determine if subfolders exist
when branch is expanded" option.

If you enable Expand/Collapse on single click in the Explorer section of Preferences, the Explorer tree
will automatically expand (or collapse) as soon as you click on a folder (instead of having to double-
click or press the "+").

Exp lo re r Re fre sh
Under most circumstances, the Explorer tree will automatically refresh whenever it has been modified.
However, for some removable media and network drives, this may not be possible. To manually
refresh the Explorer, select the part of the tree that you want to refresh (eg, E:\), and press the Refresh
button on the toolbar (or press F5).

Co ntro l Pa ne l
The Control Panel implementation in V is not the same as in Windows Explorer. It simply launches the
Control Panel in a separate Window. I could not justify all the overhead involved in embedding the
Control Panel in V.

Other options relating to the Explorer tree may be configured in the Explorer section of Preferences.
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7.3 Expanding/Collapsing Folders

The E xp a nd /Co lla p s e  Fo ld e rs command is available on the main View menu and when you right-click
on a folder in the Explorer tree. The following options are available:

Exp a nd  All Fo ld e rs
This will completely expand the Explorer tree under the selected folder. That is, every branch under the
selected folder will be expanded. Note that this can take a very long time for deeply nested folders. For
example, at time of writing, it took over one hour to expand my D:\ folder. A dialog box will be displayed
while expanding which will allow you to abort the expansion if it is taking too long.

Exp a nd  All Fo ld e rs  (s ing le  le ve l)
This simple expands each folder in the selected folder. It does not recursively expand any subfolders
(as the above command does).

Co lla p se  All Fo ld e rs
This will completely collapse the folder that is currently selected. All subfolders that are expanded will
also be collapsed.

Co lla p se  Curre nt Ro o t Fo ld e r
This will completely collapse the ro o t of the currently selected folder.

Co lla p se  All Fo ld e rs  in the  Exp lo re r T re e
This will completely collapse e v e ry folder in the Explorer tree.

T o o lb a r b utto ns

E xp a nd  A ll Fo ld e rs  and  Co lla p s e  A ll Fo ld e rs buttons can also be placed on the toolbar. You will need
to customize the toolbar (right-click on the toolbar and select Customize) and place the E xp a nd  A ll
Fo ld e rs or Co lla p s e  A ll Fo ld e rs button at the desired position as these buttons are not in the default
toolbar.

Shift-c lick  o n to o lb a r

If you press the Shift key while clicking on the E xp a nd  A ll Fo ld e rs button, E xp a nd  A ll Fo ld e rs (single
level) will be executed.
If you press the Shift key while clicking on the Co lla p s e  A ll Fo ld e rs button, Co lla p s e  Curre nt R o o t Fo ld e r
will be executed.
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8 Dual Pane (Split) Mode

Dual Pane (or Split) Mode was introduced in V Ve rs io n 8.

It allows you to display 2 directory listings side by side (in Vertical Split Mode), or one on top of the
other (in Horizontal Split Mode). Each of the directory listings can (optionally) have an Explorer tree
associated with them.

The image below shows V in Vertical Split mode. The left pane is in Details mode and the right pane is
in Thumbnails mode.

Split mode may be enabled/disabled by selecting Split from the View menu, by pressing the "Select
View Type" button on the toolbar, or by pressing Alt+S. The type of Split mode (Vertical or Horizontal)
can be selected by pressing the Dual Pane button on the toolbar.

The Explorer tree can be removed from Split mode by pressing the small x immediately above the
Explorer tree.
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8.1 Dual Pane Basics

The Directory box at the top of the Directory Listing (as well as the Drives box) is shared by both panes.
The Directory box should always display the directory of the currently *active* pane. That is, the pane
which currently has focus. Selecting a new Directory from the Directory list will change the directory in
the active pane.

By default, Dual Pane mode contains 2 File Mask boxes - one for each pane. This allows you to use a
different mask for each pane. You may use the same mask for each pane by enabling "Share Masks in
Dual Pane" in the Directory Options tab of Preferences (in which case only one File Mask box will be
displayed).

Note that the "view settings" for each pane are independent of each other. For example, one pane may
be sorted by File Name and the other by File Size. One pane may display all files and directories, while
the other pane may hide all system and hidden files.

R ig ht-c lick ing  o n the  Co lumn He a d e r

Is Dual Pane mode, the right-clicking on the column header gives you an extra 2 options:

D isp la y  in Othe r Pa ne
The directory in the current pane is also displayed in the "other" pane.

Swa p  Pa ne s
This swaps the contents of the 2 panes. That is, the directory in the first pane will be displayed in the
second, and the directory in the second pane will be displayed in the first. Note that this does not also
swap the options (and masks) associated with each pane.

R ig ht-c lick ing  o n the  Sp litte r Ba r
You can left click on the splitter bar and drag it accordingly to the set the size of the dual panes. If you
right-click on the splitter bar, you can set the size to one of several default ratios. For example, select 
50% - 50% to make both panes exactly the same size.
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8.2 Favorites and User Commands

Fa vo rite s

In Dual Pane Mode, Add Directory Pair to Favorites has been added to the Favorites menu. When
selected, it will create a Favorite containing b o th directories. When the Favorite is selected from the
Favorites menu, b o th directories will be displayed in Split mode.

By default, when selecting a single Favorite directory in Dual Pane mode, the directory will be
displayed in the currently active pane. If  the SHIFT key is pressed, the Favorite will always be
displayed in the FIRST pane. If the CTRL key is pressed, the Favorite will always be displayed in the
SECOND pane.

Use r Co mma nd s

User Commands are always executed on the currently active pane. However, it is possible to execute
a User Command which includes files from both panes.

When defining a User Command, the file and directory option specifiers (%F, %D) can be prefixed by
either 1 or 2 to indicate the pane number that the file/directory corresponds to.

For example, if you had a program that compared 2 files, you could create a User Command with
Command Options set to "%1F %2F". If executed from Dual Pane mode, it would pass the selected
file(s) from the first pane *and* the second pane. Note that such a User Command would be invalid if it
was run from Single Pane mode.
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9 FolderTabs

9.1 FolderTabs

FolderTabs are enabled by default. To disable them, right-click on the empty space to the right of the
toolbar or to the right of a FolderTab and select Fo ld e rT a b s. FolderTabs can also be enabled/
disabled from the T o o lb a rs submenu of the View menu.

A FolderTab is a collection of tabs (see image below) with each tab representing a folder. Clicking on a
tab causes the corresponding folder to be displayed.

By default, FolderTabs are multi-row. That is, when the number FolderTabs cannot fit on a single row, a
new row of tabs will be added. If multi-row tabs are disabled (see Global Tab Settings), a left/right arrow
will be displayed to the right of the FolderTab to allow the tabs to be scrolled.

Multi-row FolderTab

Single row FolderTab

V begins with a single tab which always displays the current folder. To create a new tab, right-click on
the tab heading and select N e w T a b. This will open a new tab which also displays the current folder.

You can also right-click on a folder and select Op e n in N e w T a b to open the selected folder in the new
tab. Note that this will only work if you are using the default V right-click menus. If you are using the
Explorer right-click menus, you will have to press the Ctrl key while right-clicking to display the V menu.

Right-clicking on a tab heading displays the following options:

New Tab
This will open a new tab which also displays the current folder.

Close Tab
This will close the current tab. Note that V must always have one tab to display the current folder. Clo s e
T a b will only be enabled if there is more than one tab.

Close Other Tabs
This will close all tabs except the tab that you right-click on.

Lock Tab (Disable Browsing)
This lo c k s the tab. A small lo c k  ic o n will be displayed on the folder tab to indicate that it is locked. Once
locked, no other folder can be displayed in this tab. If you try to view another folder in this tab (eg, by
double clicking on a subfolder), it will be displayed in a new tab.

Lock Tab (Allow Subfolder Browsing)
This is similar to the above option, however, any subfolder of the locked folder can also be displayed
in the tab. If you try to display a folder that is not a subfolder of the locked folder, it will be displayed in a
new tab.
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Goto Root
This option is only displayed if Lo c k  T a b  (A llo w S ub fo ld e r B ro ws ing ) is enabled. Selecting this will
display the root folder of the locked folder subtree.
Double-clicking on the folder tab is equivalent to selecting Go to  R o o t.

Move Left
Moves the tab one position to the left.

Move Right
Moves the tab one position to the right.

Copy To Other Pane
If in Dual Pane mode, this will copy the tab to the other pane.

Move To Other Pane
If in Dual Pane mode, this will move the tab to the other pane.

Tab Properties
This allows you to set some tab properties. Click here for further details.

Global Tab Settings
This sets some further (global) tab properties. Click here for further details.

No te s

In Dual Pane Mode, each pane has its own FolderTab.

FolderTabs are not available when viewing files. 
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9.2 FolderTab Properties

Right-click on a folder tab and select P ro p e rtie s to modify the following:

Fo ld e r Pa th
This is the folder that will be displayed whenever the tab is selected.

D isp la y  Na me
This is the text that will be displayed on the folder tab. If this is empty, the folder name will be displayed.

Re sto re  File  Ma sk
If this is enabled, the specified File Mask will be set (in the File Mask box) whenever the tab is selected.

Sho rtcut Ke y
Enter a shortcut key if you want the folder tab selected whenever the shortcut key is pressed. Press the
Escape key to clear the shortcut key. V will beep to indicate that the entered shortcut is currently in use.
You can use the Keyboard Customization to delete the shortcut and return to the FolderTab Properties
to re-assign it to the folder tab.

By default, the first 9 folder tabs can be selected by pressing Ctrl+1 to Ctrl+9.

Re sto re  So rt Ord e r
If this is selected, the specified sort order will be set whenever the tab is selected.

Lo ck T a b
Enable this option to lo c k a tab. A small lo c k  ic o n will be displayed on a folder tab to indicate that it is
locked. A folder tab can be locked in one of two ways:

D isa b le  Bro wsing
Only the specified folder path can be displayed in this folder tab. If you try to view another folder in the
tab (eg, by double clicking on a subfolder), it will be displayed in a new tab.

Allo w Sub fo ld e r Bro wsing
This is similar to the D is a b le  B ro ws ing option, however, any subfolder of the Folder Path can also be
displayed in the tab. If you try to display a folder that is not a subfolder of the Folder Path, it will be
displayed in a new tab.
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9.3 FolderTab Global Settings

Right-click on a folder tab and select G lo b a l T a b  S e tting s to modify the following:

Multi-ro w/Sing le  ro w
By default, FolderTabs are multi-row. When the number FolderTabs cannot fit on a single row, a new
row of tabs will be added. If single row tabs are selected, a left/right arrow will be displayed to the right
of the FolderTab to allow the tabs to be scrolled if there is not enough room to display them all.

D isp la y  Full Fo ld e r Pa th a s  T a b  He a d ing
If no Display Name is specified in the FolderTab properties, the fo ld e r na m e is displayed as the tab
heading. If this option is enabled, the full fo ld e r p a th is displayed. 

Only  Re sto re  Lo cke d  T a b s o n Sta rtup
By default, all folder tabs are restored when V is started. If this option is enabled, only the locked tabs
are restored.

Se le c t T a b  o n Dro p
Selected files can be dragged and dropped onto a folder tab to move/copy the files to the folder. By
default, dropping files onto a tab does not change the currently selected folder. Enabling this option,
causes the folder tab on which the files are dropped to be selected.

Ma ximum T a b  Wid th (cha ra cte rs)
This is the maximum number of characters to display for a folder tab heading. If the heading exceeds
the maximum number of characters, it will be shortened and three dots inserted (...) where characters
were removed.

Fo ld e rT a b  Fo nt
The font used to display the FolderTab text can be modified by pressing the font button at the bottom of
the dialog.

9.4 Tab Sets

FolderTabs are a great way of bookmarking often visited folders. You can quickly go to a folder by
clicking on its tab. However, FolderTabs can get a bit messy once you start having many folders. This is
where Tab Sets are useful.

Tab Sets allow you to create several different sets of tabs and decide which set to use based on what
you are doing. For example, you can use one set of tabs when you are organizing your photo collection,
another set of tabs for your music, another for your Word documents and spreadsheets and another set
for general use.

Sa ving  a  T a b  Se t

To save the current tabs in a Tab Set, right-click on any tab and select S a v e  a s  T a b  S e t.. Select a Tab
name from the list of existing tabs or enter a new name to create a new Tab Set.

If you are in Dual Pane mode, enabling S a v e  T a b s  in b o th p a ne s will save the tabs in both panes.
When you load this Tab Set, the tabs in both panes will be replaced.

Lo a d ing  a  T a b  Se t
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To load in a new Tab Set, right-click on any of the tabs. Existing Tab Sets can be selected from the 
Lo a d  T a b  S e t. submenu. When you load a Tab Set your existing tabs will be replaced by the tabs you
loaded.

You can also use the /TS:TabSet command line option to specify which TabSet to use.

No te

Tab Sets are stored as .vtabs files in C:\Users\UserName\AppData\Roaming\V\TabSets
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10 Thumbnails

Thumbnails mode can be enabled/disabled from the View menu, by pressing the "Select View Type"
button on the toolbar, or by pressing Alt+0.

The following screenshot shows V in Dual Pane Mode. The left pane is in Details Mode. The right pane
is in Thumbnails Mode.

By default, thumbnails are displayed for the most common graphics file formats (like JPG and BMP).
The list of supported file formats is by no means exhaustive, but should be enough to satisfy most
users. At this stage, I have no plans on supporting any more formats.

The appearance of the thumbnails (size, colors, ...) can be customized in the Thumbnails tab of
Preferences.

It is also possible to display thumbnails for several other non-image files (like videos, and even HTML/
PDF). Click here for further details.

When you move the mouse over an image thumbnail, an InfoTip will pop up displaying some
information about the thumbnail (like image dimensions). Click here for further details.

T humb na ils  o n the  rig ht-c lick  me nu

If you are not in Thumbnails Mode, you can still display the thumbnail of a file by right-clicking on it and
selecting Display Thumbnail from the menu. If you have enabled Use the Windows Explorer right-click
menu as default, you will have to press the Ctrl key when right-clicking.
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10.1 Thumbnails for Non-Image Files

V can display thumbnails for more than just image files (like JPG and BMP). It can also display
thumbnails for some video files (like AVI and MPG) and can also display thumbnails for all files that
Windows Explorer can display thumbnails for.

In order to display thumbnails for other types of files, you must enable "Try to generate thumbnails for
the following types" in the Thumbnails tab of Preferences and add the file name extension(s) to the list
below. For example, to display thumbnails for AVI and MPG files, you would add "AVI MPG" to the list
(without the quotes).

Press the Advanced button to configure the appearance of Video Thumbnails.

T humb na ils  fo r Do cume nts

Depending on your system setup, you may be able to display thumbnails for certain document files -
like DOC HTM(L) and PDF. Simply add the extensions to the list in the Thumbnails tab and try it.

HT M(L) T humb na ils
Users of Windows 2000 should be able to display thumbnails for HTM(L) documents, however, users of
Windows XP (SP1 and SP2) will not. Microsoft has removed this capability in Windows XP for "stability
and performance reasons".

DOC T humb na ils
Thumbnails for Word documents should be able to be displayed - however, you must enable "Save
Preview Picture" when saving the file in Word. You can set this option by selecting Properties from the
File menu (in Word). And of course, you will need to add DOC to the list of file name extensions.

10.2 Advanced Thumbnail Options

V generates the thumbnails for video files differently to Windows Explorer. If you prefer the way that
Windows generates the thumbnails (eg, it might be faster), then enable "Use Windows to generate the
thumbnails for AVI and MPG".

By default, the first frame of the video is displayed as the thumbnail for video files.

If you have not enabled the "Use Windows ..." option, you may specify which frame is displayed as the
thumbnail. This is an a b so lute  fra me  numb e r, and not a "time" position (say in milliseconds). Use a
negative frame number to indicate a frame position from the end of the file.

For example, specifying a frame of -1 will display the last frame in the video.



V Help File118

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

10.3 Thumbnail InfoTips

InfoTips are multiline tooltips that sometimes pop up as you move the cursor over entries in the
Directory Listing. 

When viewing image files in Thumbnails Mode, V will display an InfoTip containing some image
details (like size, width, height and number of colors). For video files it will try to display an InfoTip
containing video details (like the frame rate, number of frames and duration).

EXIF Da ta

Digital cameras usually store extra information with the photos they take. This is called EXIF data -
which stands for Exchangeable Image File Format.

If an image contains EXIF data, V will display some of the data in the InfoTip. Below is an example of
such an InfoTip:

T humb na il Info T ip s  vs  Syste m Info T ip s

Thumbnail InfoTips will only be displayed in Thumbnails Mode. This is different from System InfoTips
which are always displayed, regardless of the display mode (ie, Small Icon, Details, ...). If you have
also enabled System InfoTips, they will not be displayed in Thumbnails Mode if V finds EXIF data in the
image. If you prefer the System InfoTip to V's Thumbnail InfoTip, you can disable Thumbnail InfoTips
by enabling "Do not display InfoTip" in the Thumbnails tab of Preferences.

No te s

InfoTips are disabled by default, and will only work on Windows 200x and XP. They are enabled in the 
Thumbnails tab of Preferences.

System InfoTips for image files will only be displayed if you have installed an appropriate third party
extension.
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10.4 Thumbnail Caching

V does not cache thumbnails.

That is, once a thumbnail is generated, it is not stored anywhere for future use. This has the advantage
that disk space is not wasted in storing thumbnails. However, thumbnail display can be a bit slow as V
will try to generate the thumbnail every time.

The release version of V8 will not have thumbnail caching. However, I will consider it for future versions,
depending on the feedback I receive from users.

10.5 GDIPLUS.DLL Error

Thumbnails Mode requires the presence of GDIPLUS.DLL (a Windows system file). This is installed on
all Windows XP and Vista systems - but may not be present in other versions of Windows (such as
Windows 2000).

When running the V setup program, it checks to see if you have the DLL. If you don't, it installs it in the
same directory as V.EXE.

Users who do not use the V setup program on non XP/Vista systems may find that they get an error
saying that GDIPLUS.DLL is missing when trying to enter Thumbnails Mode.

If this happens, you should download and run the self-installing distribution from:

http:/fileviewer.com/Download.html

Advanced users can simply extract GDIPLUS.DLL from this file (or download it from Microsoft) and
place it in the same directory as V.EXE
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11 Alternate Data Streams

NTFS file systems (and only NTFS file systems) support "Alternate Data Streams" (ADS). These are
basically "invisible" files that attach themselves to existing files. For example, when you enable
"Thumbnails mode" in Windows Explorer, the thumbnail is sometimes stored in an ADS.

Unfortunately, this can take up a lot of disk space - and the user is oblivious to the fact! Windows does
not provide a way to list/view the ADS and the only way to delete the ADS is to delete the entire file. 

11.1 ADS Support in V

As from Version 8, V supports Alternate Data Streams.

By default, ADS support is disabled. You can enable it by selecting D is p la y  A lte rna te  D a ta  S tre a m s
(A D S ) in the Options submenu of the View menu.

As ADS support has significant overhead, it is recommended that you only enable this option when you
specifically want to work with ADS. In particular, enabling ADS may slow down the directory listing.

Note that the ADS option does not need to be enabled to search ADS. It is only required if you want the
ADS to appear in the directory listing.

11.2 What Can I Do With ADS?

With ADS enabled, V will display all streams attached to a file and it will let you view/print/delete them
as if they were normal files.

The file name of an ADS consists of 2 parts. The first part of the file name is the same as the file that it is
attached to. This is always followed by a colon followed by the stream name. For example,
"File.txt:stream1". Note that files can have more than one data stream.

If you have enabled "Custom Colors", the ADS can be displayed in a different color to normal files. To
enable custom colors, select "Change Colors" from the View menu. The ADS are displayed in the
same color as "Compressed/Encrypted" files. In the directory listing, ADS will have a "D" in the
Attributes column.

There are several limitations when dealing with ADS:

You cannot delete an ADS to the Recycle Bin. Once it has been deleted, it cannot be restored.

You cannot copy/move an ADS.

You cannot create an ADS - eg, by copying a file to the ADS of another file. 

Note that points 2 and 3 above are possible, but have not been implemented. I will consider adding
extra ADS functionality based on user feedback.
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11.3 Searching ADS

The data in Alternate Data Streams is "hidden". In particular, when doing a File Search/GREP any data
that is in an ADS is not searched.

There is now a new option in File Search/GREP - "Search Alternate Data Streams".

If this is enabled, V will also search the ADS of a file (if any exist).

If you have an NTFS file system and are interested to see what files have ADS, you can try the
following:

Press the Find Files/GREP button on the toolbar.

Select the File Search tab.

Enter * for "Named" and "C:" for "In Directory"

Enable the "Search Subdirectories" option

Enable "Search Alternate Data Streams (ADS)"

Press the Advanced button so the bottom half of the dialog is displayed

Deselect File Date and File Size

Select File Attributes

Make sure that all the file attributes have a "gray tick" - except for "ADS" which should be
enabled.

Finally, press the Search button 

All files on your C drive that have an ADS will be listed.

Wa rning

Do not delete an ADS unless you know exactly what it is used for - it may contain important data.
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12 The File View

12.1 The File View

The File View is the view in which the file is displayed. The view can be in one of two modes - Text and
Hex, and can be configured in several ways.

The font in which the file is displayed may be selected from the Fonts section of the Preferences Dialog
box. Note that V only supports non-proportional (or fixed pitch) display fonts - like Courier.

Right-clicking on any part of the File View will display a pop-up menu containing most of the available
commands.

The following sections describe the File View in greater detail:

The Toolbar
Text Mode
Hex Mode
Unicode Files
Flat Text Mode
End of Line
Tabs
Start Offset
EBCDIC
The Ruler
Line Numbers
Line Wrapping
Column Fixing
Line Lengths
OEM Character Set
Bookmarks
Scrolling
Searching
Goto
Block Marking
File Chunks
Greenbar Mode
CSV Mode
File Tailing

Click here for details on how to configure V to view multiple files.
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12.2 The Toolbar

The File View toolbar has many buttons in common with the Directory View toolbar. 

Below is the default toolbar for the File View. It can be customized so that the buttons are re-arranged or
deleted (right-click on the toolbar and select Customize). Click here for further details.

D ire c to ry
Return to the Directory View. The file being viewed is closed.

Re fre sh
Refreshes (or reloads) the file. It is possible that the file being viewed is also being modified by another
program (eg, a log file). In order to be able to view any data appended to the file since the file was
opened, you need to refresh it (unless File Tailing is enabled).

Pre v io us/Ne xt
Displays the previous/next file in the file list. If you select several files in the Directory View, the file list
will consist just of the files selected, otherwise the file list will consist of all files in the directory. If you
position the mouse over the Previous/Next buttons, the name of the corresponding file will be
displayed. Note that these buttons work differently from the Back/Forward buttons in a browser.

File  Lis t
This brings up a list box containing all the files in the current file list. As above, if you have selected
several files in the Directory View, this list will only contain the selected files. Otherwise, it will contain all
the file in the current directory. To view another file, simply select it from the file list. Note that this feature
is only available once V has been registered.

Find
Searches for a string.

Find  Ne xt/Find  Pre v io us
Searches for the next (or previous) occurrence of a string.

Go to
Goes to a specified position in the file. Click here for further details.

Clip b o a rd
Copies (or appends) selected text to the clipboard. Click here for further details.
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T e xt Mo d e
Displays the file in Text Mode

He x Mo d e
Displays the file in Hex Mode

Ve rtica l He x Mo d e
Displays the file in Vertical Vertical Hex Mode

Fla t T e xt Mo d e
Displays the file in Flat Text Mode

CSV Mo d e
Displays the file in CSV Mode

Wra p  T o  Scre e n/Wra p  T o  le ng th
Click here for further details on line wrapping.

Line  Numb e rs
Toggles line numbers on/off in Text mode.

EOL
This specifies whether an End  Of Line  character will be displayed at the end of every line. This is
useful when viewing files with trailing spaces. Note that this option is not available in Hex mode. The
character used as the End Of Line terminator may be specified in the Fonts tab of the Preferences
dialog box. The EOL mode can also be toggled by pressing the Ente r key. Note that the EOL
character will not be displayed at the end of a line that has been wrapped. It will only be displayed if it
corresponds to an actual end of line character in the file.

  T a il
This enables File Tailing

 Gre e nb a r
Clicking on this button enables/disables Greenbar Mode. Clicking on the arrow portion of the button
allows you to modify the Greenbar Options.
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T o o ls
Clicking the Tools button displays a further menu where you may select one of the following:

MD5/CRC32
This calculates the MD5 and CRC32 of the file being viewed.

Wo rd /Line  Co unt
This counts the number of words and lines in the file. Click here for further details.

    Zo o m
You may easily increase (or decrease) the size of the current font by using the + and - keys. This
does not do a "bitmap zoom", but simply selects the next point size in the current font. If a larger (or
smaller) point size is not available, nothing will happen. Note that this will not work properly with the
Terminal font.

Se nd
This will construct an email message using your email client and will attach the file being viewed.
Note that this will only work if MAPI (or Windows Messaging) is installed on your system.
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12.3 Text Mode

The Text mode displays the contents of a file exactly as they are stored on disk - much like an editor
does.

The Text mode may be enhanced by adding line numbers, adding a ruler and wrapping lines. These
topics are discussed further in later sections.

When V opens a file, it determines whether it is a text or binary file, and displays the file in Text or Hex
mode respectively. Basically, text files contain only alphanumeric, punctuation and new line characters.
If files contain characters other than these, they will be displayed in Hex mode.

It takes a little bit longer for files to be displayed in Text mode rather than Hex mode. Files that are
loaded in Hex mode will display almost instantaneously - regardless of size (1 byte or 500Mb).
However, displaying files in Text mode is different. To display the file properly (and to handle the scroll
bars correctly), V needs to know the number of lines in the file, and also the length of the longest line. As
files get larger, it naturally takes longer to do this. Normally, you will not notice any delay unless the files
are at least 2Mb in size. Compared to other programs, however, V still does a good job in loading even
large files. If you know of any program that loads files quicker than V, please let me know. 

File  Chunks
To enable fast loading of even ve ry  la rg e  fi le s  (hundreds of Mb to several Gb), V can view files in
chunks, instead of loading the entire file. Click here for further details on file chunks.

File  T a il ing
If you want V to automatically refresh a file as it is being viewed, you need to enable File Tailing.
Click here for further details.

No te s

Binary files (like ZIP and EXE files) can be viewed in Text mode, although it usually doesn't make
sense to do so. If such files are viewed in text mode, many strange characters will be displayed. These
strange characters correspond to non-printable (or control) characters and will differ depending on
which font is selected.

Sometimes V can incorrectly decide that a text file is a binary file, and display it in Hex mode. This
usually happens if a file contains an unexpected control character (eg, line drawing characters). In this
case, just click on the Text icon on the toolbar (or press Alt-H) to display the file in Text mode. If you
find that V is incorrectly displaying most of your text files in Hex mode, you can force V to always view
them in text mode by enabling the Always Open as Text option in the Preferences Dialog box.
However, by enabling this option, even ZIP and EXE files will initially be displayed as text.
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12.4 Unicode Files

Most text files are stored using ASCII characters - each character is encoded using one byte (8 bits).
This means that we can have a maximum of 256 different characters.  This isn't a problem in most
English speaking environments, but it does become a problem once you start encoding characters in
different languages.

Unicode is a standard for encoding characters that tries to address the problem of encoding all
possible international characters into a single, unified format.

As with most standards, there are several flavors to choose from. V supports UCS-2 and UTF-8. (See
the note below regarding UTF-16)

Sta tus  Ba r Ind ica to r

V will automatically detect most Unicode files and display them accordingly, including files with foreign
characters. UNI will be displayed in the status bar to indicate that the file is a Unicode file. ANS (for
ANSI) will be displayed in the status bar when the file is not a Unicode file.

If V does not guess the correct encoding, you can click on the UNI/ANS indicator in the status bar and
select the correct encoding (assuming that you know what it is). 

Fo nt Sub stitutio n

V does not support font substitution (or font fallback). Under font substitution, if the selected font does
not contain a particular character, the program will try to use another font to display that character.
Since V does not do font substitution, it is very important to use a font that contains all the characters to
be displayed. In particular, the standard Courier font should not be used to display Unicode files -
Courier New should be used instead.

UCS-2 vs  UT F-16

Strictly speaking, V does not fully support UTF-16 - it only supports UCS-2 (which is the outdated
predecessor to UTF-16).

UCS-2 is a fixed length encoding that encodes all characters to a 16 bit value (from 0 to FFFF). UTF-16
is a variable length encoding capable of encoding the entire Unicode range of characters. In particular,
UTF-16 can be used to encode characters greater than FFFF.

However, in most cases, UCS-2 and UTF-16 are identical. If users encounter any problems viewing
Unicode files, please contact v@fileviewer.com (preferably attaching a copy of the Unicode file).

No te s

V does not support UTF-32

V does not support RTL (Right To Left) display

mailto:v@fileviewer.com
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12.5 Flat Text mode

This is a cross between text and hex modes.

The file is displayed as text, however, control characters like line feeds and tabs are not expanded,
and the file is always wrapped at the specified wrap length. 

This is useful for displaying files of fixed length records, where records may contain control characters
(eg, packed decimal fields). 

See the Wrap Here section for details on how to quickly wrap lines at different line lengths.
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12.6 End of Line (EOL)

When displaying files in text mode, V will automatically start a new line whenever a line terminator is
encountered (unless the file is displayed in Flat Text or Wrap to Length mode).

Most files created on Windows use a Carriage Return/Line Feed pair as a line terminator (CR/LF) . That
is, a Carriage Return followed by a Line Feed. However, some files use a single CR or a single LF as a
line terminator. V will also start a new line whenever a single CR or LF is encountered.

The End  o f Line  submenu (on the View menu) allows you to configure how you want V to handle line
terminator characters.

D isp la y  EOL Ma rke r
Enabling this will display the End Of Line marker at the end of every line. This is equivalent to pressing
the End of Line button on the toolbar. The character displayed as the EOL marker can be set in the
Fonts section of Preferences.

Ig no re  Fo rm Fe e d s
Form feed characters (ASCII 12 or Ctrl-L) are generally used to signify a page break. V uses form feeds
to start a new page when printing, and also treats a form feed as a line terminator (since a new page
implies a new line.

If you do not want V to treat a form feed as a line terminator, you can enable this option. The form feed
character will still be displayed, but a new line will not be started. Note that this option only applies to 
v ie wing files. If you also do not want V to start a new page when p rinting, you need to enable "Ignore
Form Feeds" on the Print dialog box.

Custo mize  EOL Op tio ns
If you want to change any of the default EOL options, select Cus to m ize  E OL Op tio ns from the E nd  Of
Line submenu.

Select Use  De fa ult EOL Op tio ns  to revert to the default EOL behavior.

The following options are available:

Ig no re  Sing le  CR (witho ut LF)
This requires a CR to be following by a LF for it to be treated as a line terminator.

Ig no re  Sing le  LF (witho ut CR)
This requires a LF to be following by a CR for it to be treated as a line terminator.

Ig no re  Co nse cutive  CRs
Some files have a strange EOL combination - CRCRLF. That is, 2 carriage returns followed by a line
feed. Some users want this displayed as 2 lines, others as one. By default, V will treat this a 2 line
terminators. If you enable this option, V will ignore the first CR and treat CRCRLF as a single line
terminator.

You can also enable this option from the command line by using /ICRCR.
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Use  the  fo llo wing  Custo m EOL cha ra cte rs(s)
Enable this option if you want to set custom EOL characters. Simply enter the characters in the space
provided. V will start a new line whenever it encounters any of these characters. Multiple EOL
characters are allowed, but e a c h character will be treated as an EOL. That is, multiple characters will
not be treated as a multiple character EOL combination.

D isa b le  d e fa ult EOL cha ra cte rs
When setting custom EOL characters, the default EOL characters (CR, LF) will still be treated as line
terminators. Enable this option if you do not want CR and LF to be treated as line terminators.
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12.7 Tabs

When displaying text files, tabs will be expanded according to the number of characters specified in 
Tab Size.

Specifying a Tab Size of 1 causes tabs to be treated as spaces.

Tabs may also be made visible by selecting "Tabs->Show Tabs" from the View menu. In this case, a
tab will not be expanded and will be displayed according to the corresponding character in the
selected font.

12.8 Start Offset

V allows you to specify a non-zero s ta rt o f fi le  position - any data before this position will be ignored. 

To set the start offset, right-click on the position in the file where you want to start viewing from and
select Vie w/La yo ut->Sta rtOffse t->Sta rtFro mHe re  

Alternatively, you can specify an absolute position by selecting Se t Offse t from the above right-click
menu or from the main Vie w->Sta rtOffse t menu. 

A solid blue line will appear at the top of the file, indicating that a non-zero start offset is being used. 

Note that the start offset is not "sticky". That is, it is reset to zero once a new file is viewed. 

This is useful if you want view files with fixed line lengths, but the fixed lines do not begin from the start of
the file. 
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12.9 The Status Bar

The status bar of the File View usually consists of 3 panes:

Pa ne  1 - Curre nt Po s itio n

Usually this will contain the current line number. If you press the left mouse button at any position and
keep it pressed, the corresponding line number and column will be displayed. If you have enabled 
"Hex offset in status bar" (in the File Options tab of Preferences), the hex offset of the position will also
be displayed.

In Hex mode, the corresponding file offset will be displayed. Also, as a block is being highlighted, the 
start and end positions of the block are displayed, as well as the number of characters highlighted.

The offsets are displayed in both hex and decimal. For example,
"Offse t: 669h->8e 8h (1641d ->2280d ) Le n=640 (280h)"

Note that as long as a block of text remains highlighted, its details will be displayed in this pane - even if
the block has been scrolled out of view.

Pa ne  2 - Po s itio n a s  Pe rce nta g e

This displays a number between 0 and 100 and represents the current line (ie, the last line in the view)
as a percentage of the number of lines in the file.

If the file is paginated, the current page number and the total number of pages will be displayed instead
of the percentage.

Pa ne  3 - File  De ta ils

This displays the file size, the number of lines in the file and the date and time the file was last modified.

Unicode and EBCDIC

When V displays Unicode or EBCDIC files, UNI or EBC will be displayed in the status bar. You may
click on this area of the status bar to display a menu of available options.

No te s

When the file is being displayed as chunks, a fourth status pane appears which displays which chunk is
currently being viewed.

Left-clicking on a character while viewing a file displays the hex offset of the character on the status bar
(providing the Hex Offset option is enabled in Preferences).
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12.10 EBCDIC Mode

EBCDIC stands for Extended Binary Coded Decimal Interchange Code, and is the character set used
by most IBM mainframes to store documents (in preference to the more commonly used ASCII
character set).

If you try to view an EBCDIC file with a standard ASCII file viewer/editor (eg, notepad), the text will
appear as a stream of unprintable control characters. For example, the EBCDIC code for the number
zero is he x F0, which is not a printable character in ASCII.

When V opens a file, it automatically tries to determine if it is ASCII or EBCDIC. If a file is EBCDIC, EBC
will be displayed on the bottom status bar.

If an EBCDIC file is incorrectly displayed as ASCII, you can view it as EBCDIC by pressing Alt+B (or
selecting EBCDIC from the View menu).

Once in EBCDIC mode, you may modify EBCDIC viewing options by selecting EBCDIC Op tio ns  from
the View menu, or by clicking on EBC in the status bar.

V views EBCDIC files by mapping each EBCDIC character to the ASCII equivalent before displaying.
However, there are at least 6 incompatible versions of EBCDIC (all having non-contiguous letter
sequences and missing punctuation characters). In order to support all of these mappings (and more), 
V defines a default mapping which can then be modified in the EBCDIC tab of the Preferences.

V  supports files with variable length records (RECFM=V) and fixed length records (RECFM=F).

Click here for further details on viewing EBCDIC files.
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12.11 The Ruler

The ruler makes it easy to determine the position of a particular character - you will no longer leave
finger prints on your monitor as you count!

The ruler is displayed at the top of the File View and its format depends on the mode of the view.
 
T e xt Rule r

If the view is in Text mode, the ruler consists of a sequence of incrementing numbers (starting at 1) which
indicate the column number of the character below. In this case, the length of the ruler is determined by
the length of the longest line in the file.

He x Rule r

If the view is in Hex mode, the ruler always consists of 16 hex offsets (from 00 to 0F) which indicate the
offset from the start of the line of the corresponding hex bytes displayed below.

Flo a ting  the  Rule r
The ruler may be dragged over any part of the file. The floating ruler may be removed by either double-
clicking on it or by dragging it back to the top.

Sta rting  Co lumn
The ruler numbering usually starts at 1. To start from 0, right-click on the ruler with the Control key
pressed and select the required option. Alternatively, you can press Ctrl+Alt+R to toggle the starting
column.

Multip le  Rule rs
Up to 10 floating rulers may be displayed while viewing a file. To create a new ruler simply drag it from
the top (fixed) ruler. To close a ruler, double click on it. To close all rulers (but to remember their
position), double click on the fixed ruler. To redisplay the floating rulers in their last position, double
click again on the fixed ruler. 

D isp la y ing  Grid  Line s
Right-clicking (or shift-clicking) on the ruler will cause a vertical grid line to be drawn at the clicked
column position. The grid line will disappear once the button is released. 

The color of the grid line can be customized in the File View section of Change Colors (selected from
the View menu).

No te s

In Text mode, the ruler can be shifted by one character to the right (ie, the first column will be
treated as column 0 instead of column 1) by setting the Start Text Ruler at 0 option in the
Preferences Dialog box.

The ruler is always displayed in the same font as the file.

The floating ruler and grid lines only become fully functional once V has been registered.
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12.12 Line Numbers

When viewing the file in Text mode, the corresponding number of the line can be displayed to the left of
the line by enabling the  Line  Numb e rs  option in the View menu. The line numbers display can also
be toggled by pressing the line numbers icon in the toolbar.

Look at the Line Numbers Configuration section for further details on how to customize the line number
display.

Line  Numb e rs  in Chunks

If a file is being viewed in chunks, V will display the correct line numbers as long as consecutive chunks
are loaded. However, if you load a chunk without having viewed the previous chunk, V will start the line
numbers from 1.

For example, if you load the last chunk in the file after having loaded the first chunk, the line numbers in
the last chunk will start from 1. If you need to know the exact line number, you will have to load the entire
file.

No te s

Line numbers always start at 1.

The line numbers are not fixe d . That is, the line numbers are scrolled off the screen when the line is
scrolled horizontally. You can fix the line numbers (so they do not scroll) by enabling Fix Line  N um b e rs
from the Fix LH S submenu of the  V ie w menu.

Although line numbers in Text mode are optional, the hex addresses in Hex mode are always
displayed.
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12.13 Line Wrapping

When a line is too long to fit in the view, horizontal scroll bars appear at the bottom of the view, allowing
you to scroll through the entire line. The horizontal scroll bars will appear when at least one line of the
file being viewed is wider than the width of the view.

Sometimes scrolling through lines is not very convenient, particularly if a file contains many really long
lines. In this case, lines can be wrapped. Lines may be wrapped in several ways:

Wra p  to  Scre e n

The lines are wrapped so that all text fits inside the file view. In this case, the horizontal scroll bars
disappear. Screen wrapping may be toggled by selecting the Wra p  to  Scre e n command from the
Vie w menu, pressing the Wrap to Screen button on the toolbar, or by pressing Alt-W. Wrapping text to
the screen may be permanently enabled by setting the Wrap lines to screen option in the Preferences
Dialog box.

Wra p  to  Le ng th

In this case, the lines are wrapped whenever they reach the wra p  le ng th. Wrapping may be toggled
by selecting the Wra p  to  Le ng th command from the Vie w menu, pressing the Wrap to Length button
on the toolbar, or by pressing Alt-L.

The wrap length may be quickly changed by selecting the Se t Wra p  Le ng th command from the
Vie w menu, or by pressing Ctrl-W. You may enter a new wrap length, or select a previously used
length from the list.

Wra p  o n Wo rd  Bo und a ry

Normally, lines will be wrapped at the exact position where they exceed the width of the view (if
wrapping to screen), or the wrap length - even if it happens to be in the middle of a word. To ensure that
lines are not split mid-word, select the Wrap on Word Boundary option from the Preferences Dialog
box.

Wra p  He re

Flat text mode allows you to display the text file as fixed length records by specifying a record length (or
wrap length).

Using the "Wrap Here" command, you can easily change the wrap length without actually entering a
number.

All you do is right click on the position where you want the firs t record to end (or wrap) and then select
"Wrap Here" from the Wrap menu.

No te

The Wra p  Line s  to  scre e n option in the Preferences Dialog box, does not apply to printing. There is
a separate option in the Print Dialog box which enables line wrapping when printing. However, the
Wra p  o n Wo rd  Bo und a ry  option applies to both printing and display.
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12.14 Column Fixing

When viewing a file, the display may be fixed at a certain column position so that any text to the left of
the fixed column will always be visible (ie, it will not scroll off the screen). To do this, select the Fix
Co lumn option from the View menu. Select Se t Fixe d  Co lumn to specify the column position. 

You may also just fix the line numbers by selecting the Fix Line  Numb e rs  option from the View menu.

No te : Unregistered versions cannot fix the display past column 6.

12.15 DOS/OEM Character Set

Most Windows applications use the ANSI character set to display text. The actual character displayed
depends on the font selected.

Before Windows and GUI programs existed (in the DOS days), special line drawing characters were
used to "draw" simple boxes and frames in standard text files. These special characters were a part of
what was called the OEM or IBM character set.

Windows (True Type) fonts do not usually support these line drawing characters. These characters will
usually be replaced by some strange symbol.

However, some fonts (like Courier New) support both ANSI and OEM character sets. By selecting the 
DOS/OEM Cha r Se t option (from the View menu) the OEM character set will be selected (if
available), and your lines and boxes will be drawn correctly.

Note that this will only work if the selected font supports the OEM character set. If it doesn't, this option
will have no effect. For example, an OEM character set is available for Courier New but not for Courier.

No te : The /OEM and /ANSI options may be used on the command line.

12.16 Display Fonts

The file is displayed using the currently selected Screen Font which is specified in the Preferences.

If you find that you regularly use different fonts, you may create a fonts list and then select the required
font from the Fonts menu.

To create or modify the fonts list, select Fo nts->Org a nize  from the View menu.

Organizing fonts is similar to Organizing Favorites or User Commands.

Once a font has been added to the list, it may be selected from the Vie w->Fo nts  menu.

A shortcut key can also be assigned to a font so that the font will always be selected whenever the
corresponding shortcut key is pressed.

No te : V maintains different fonts for text and hex modes.
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12.17 Greenbar Mode

Files can be viewed (and printed) with a greenbar effect. This is where each alternating line is a
different color. To enable, simply press the Greenbar icon in the toolbar.

Gre e nb a r Op tio ns

The greenbar effect can be customized by clicking on the small arrow next to the Greenbar icon on the
toolbar.

Gre e nb a r Ba ckg ro und  Co lo r
Click on this button to select the Greenbar color. Right-click on the button to select one of several pre-
defined colors. You can select a different greenbar color for display and printing.

Numb e r o f l ine s  to  g re e nb a r
By default, the greenbar color will alternate after every line. This option allows you to increase the
number of consecutive lines that are "greenbarred".

Sta rt g re e nb a r a t l ine  1
Enable this option if you want the greenbar coloring to start from line 1.

Do  no t g re e nb a r l ine  numb e rs
If you enable this option, the greenbar colors will not extend to the line number portion of the line.

Do  no t cha ng e  co lo r fo r wra p p e d  line s
Enabling this option ensures that the greenbar color does not change if it has been wrapped. That is,
the entire line will be displayed in the same color, regardless of how many lines it wraps to.
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12.18 File Attributes / Line Lengths

If the File Attributes command is selected in text mode, the dialog box that displays the file attributes will
contain an extra 4 lines of file details:

Lo ng e st Line
Displays the length (and number) of the longest line in the file.

Sho rte s t Line
Displays the length (and number) of the shortest line in the file -  including empty lines. That is, if the file
contains an empty line, this length will be zero.

Sho rte s t no n-e mp ty
Displays the length (and number) of the shortest non-empty line in the file. That is, this length will never
be zero

Line  T e rmina to r
Displays the character (or character pair) used by the file to delimit lines. Depending on the origin of the
file, the character(s) used to terminate lines are usually one of:

CR The terminator is a single ca rria g e  re turn character (hex 0D). This terminator is uncommon.
LF The terminator is a single l ine  fe e d  character (hex 0A). This is the standard terminator used on

Unix systems.
CR/LF A carriage return followed by a line feed is used to terminate lines. This is the standard

terminator used on PC based systems.
LF/CR As above, but the line feed is placed before the carriage return. This is very uncommon.
CR/CRTwo carriage returns are used to terminate lines. This is also very uncommon.

No te s

This extra information is not displayed if the file is being viewed in hex mode, or if the File Attributes
command has been selected from the Directory View.

If multiple lines share the same length, only the first line in the file with that length is displayed.

If a file chunk is being viewed, the line length information only applies to the lines in that chunk, and not
the entire file.

The number of lines in the entire file (together with the total number of words) may be displayed by
selecting Word/Line Count from the Tools menu.
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12.19 Hex Mode

Use this command to view a file in Hex format.  This mode is generally used for binary (non-text) files,
although text files can also be viewed in Hex mode.

Vertical Hex mode can be enabled by selecting T e xt+Ve rtica l He x from the View menu (or by
pressing Alt+J). This is a cross between Text and Hex modes.

Click here for further details on viewing files in hex (and vertical hex) mode.

12.20 File Tailing

File  T a il ing  refers to the ability to automatically refresh a file as it is being modified.

By default, File Tailing is disabled. To enable it, press the Tail icon on the toolbar (or select Tail from
the File menu).

If data is a d d e d  to the file while you are viewing it, it will automatically be updated. There is no need to
press the Refresh button to see any changes since the file was loaded.

This is particularly useful when viewing log files while they are still being updated.

Because there is some overhead in File Tailing, it is best not to enable it when it is not needed. To
overcome the problem of the user accidentally leaving File Tailing enabled, V always disables File
Tailing on startup.

If you want V to restore its previous Tailing state on startup, enable "Save File Tailing state" (in the File
Options tab of Preferences).

T a il ing  o n Ne two rk  Drive s

Tailing relies on notifications from the operating system whenever a file has been modified. These
notifications are not always sent for network drives. In particular, they are usually not sent for Unix
network drives. Under such circumstances, file tailing will not work.

No te

File Tailing only applies if data is added to the end of the file. If any other part of the file is updated, V
will not automatically update it.
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12.21 Viewing the Clipboard Contents

The File menu contains a  View Clipboard submenu that displays the different types of data that are
stored in the Windows clipboard (if any). Selecting the various data types will cause V to view the
corresponding data just like it was viewing a file.

No te s

V can only view the clipboard data as text/hex. It cannot launch another program to view the clipboard
data. For example, it cannot launch your image viewer to view bitmap data. However, you can save the
data to a file and then use your image viewer to view that file.

Some data types cannot be viewed. If this is the case, the data type will be disabled on the menu.

The clipboard contents can be printed - just like a normal file.
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13 Split File View

13.1 Split File View

The File window can be split in two by clicking on the Split Screen button on the toolbar and selecting
Horizontal or Vertical  Split Mode. It can also be split from the Split submenu of the View menu, or by
pressing Alt+S. This allows you to view different parts of the same file in different windows. Below is an
example of a file which has been split horizontally.

Synchronized scrolling is enabled by default. Click here for further details on synchronized scrolling.

Note that both windows must use the same display mode. For example, you cannot have one window
in hex mode and the other in text mode. Also, if you enable line wrapping, the wrapping will apply to
both windows.
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13.2 Synchronized Scrolling

By default, synchronized scrolling is enabled when the file view is split.

For example, if the file is split horizontally, you can use either of the horizontal scrollbars to scroll both
views simultaneously (the vertical scrollbars work independently of each other). Similarly, if the file is
split vertically, either of the vertical scrollbars can be used to scroll both views vertically.

You can disable synchronized scrolling by pressing the S p lit S c re e n button on the toolbar and
selecting S p lit Op tio ns. This allows you to modify the following options:

D isa b le  Ho rizo nta l Synchro nize d  Scro ll ing  (in Ho rizo nta l Sp lit Mo d e )
This disables horizontal synchronized scrolling when the file view is split horizontally. When enabled,
the horizontal scrollbars will work independently of each other. Note that vertical scrolling is never
synchronized when the file view is split horizontally.

D isa b le  Ve rtica l Synchro nize d  Scro ll ing  (in Ve rtica l Sp lit Mo d e )
This disables vertical synchronized scrolling when the file view is split vertically. When enabled, the
vertical  scrollbars will work independently of each other. Note that horizontal scrolling is never
synchronized when the file view is split vertically.
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14 Multiple File Windows

Up until Version 8, V was always a "one window" program. When you viewed a file, the directory listing
would be *replaced* by the file window. If you wanted to view the file in a separate window, you would
have to launch another instance of V. One instance of V would display the directory listing and the other
would display the file.

As from Version 8, you can have more than one file open at once - and the directory listing will still be
visible while you are viewing the file.

CLASSIC Mo d e

V can still operate as a "one window" program - this is now called CLASSIC mode. You can enable
CLASSIC mode from the Window Layout tab of Preferences or by selecting Options from the View
menu.

Click here for further details on viewing multiple files.

14.1 Viewing Multiple Files

By default, every file you view will be displayed in a separate window. If you prefer to only have one file
window open at a time, enable "Use existing File window to view new file" in the Window Layout tab of
Preferences.

If you enable this option, you can still view files in a separate window by pressing the SHIFT key when
you view the file.

If more than one file is selected, pressing the V button on the toolbar (or selecting View from the File
menu) will result in each selected file being displayed in a separate window. You can disable this
behavior by enabling "Do not view multiple files in separate windows" in the Windows Layout tab.

In Dual Pane mode, the selected files in *both* panes can be viewed by pressing the V2 button on the
toolbar (or selecting "View (Both Panes)" from the File menu).

The following image shows V viewing 2 files - with the Directory window still visible.
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14.2 Viewing Multiple Files from the Command Line

You can  view multiple files from the command line - each of the specified files will be opened in a
separate window.

For example, "V File 1.txt File 2.txt" or "V *.txt".

However, this will only work if V is already running and installed in the System Tray.

To install in the Tray, you will need to enable the following options in the More Options tab of
Preferences:

Minimize to System Tray

Always use Tray Instance 

14.3 Arranging File Windows

By default, when you view multiple files, the file windows will be positioned so that the new file window
slightly overlaps the previous window. If you rearrange the multiple window position, V tries to maintain
this position when it opens multiple files.

You can tile the files by selecting the desired tiling option from the Window Layout menu (Vertical,
Horizontal or Auto-Arrange). If you tile the files vertically, each file window will have the same height as
the screen. Each window will have the same width and be placed next to each other so they completely
fill up the screen.

The image below shows 2 file windows, tiled vertically.

Auto ma tic  T il ing

Multiple file windows can be automatically tiled by enabling "Automatically Tile multiple file windows" in
the Window Layout tab of Preferences. That is, once a second (and subsequent) file is opened, V will
automatically tile all the file windows. 

File windows can also be "Auto-Arranged". Click here for further details.
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14.4 Auto-Arranging File Windows

File windows can be auto-arranged based on a "grid size" which you define in the Window Layout tab
of Preferences.

To see how auto-arranging works, consider a grid size of 3 x 3. With 2 or 3 windows open, they will be
tiled vertically. When the user opens up a fourth file, they will be displayed in a 2 x 2 grid (as in the
image below). When a user opens up a fifth and sixth file, the first 3 files will be displayed on the top and
the remaining 2 (or 3) files will be displayed on the bottom. If the user opens up a seventh file, V will
display the files in 3 rows of windows. The first 2 rows will contain 3 windows each, and the third will
contain the seventh file. The eighth and ninth file will also be displayed on the 3rd row.

Because the grid size is only 3 x 3, the automatic arranging will stop with the ninth file. Should the user
open up a tenth file, it will be displayed in a normal overlapping window.

14.5 Synchronized Scrolling

When multiple files are open, scrolling can be s y nc hro nize d by right-clicking on the scrollbar and
selecting S y nc hro nize  S c ro lling. Once enabled, whenever one window is scrolled (either via the
keyboard or the mouse), all other file windows are also scrolled by the same amount.

Horizontal and vertical scrolling are s e p a ra te. Enabling synchronized scrolling by right-clicking on the
vertical scrollbar will only synchronize vertical scrolling. If you also want horizontal scrolling to be
synchronized, you also need to right-click on the horizontal scrollbar and select S y nc hro nize  S c ro lling.

No te s

Synchronized scrolling only applies to multiple file windows - it does not apply to the directory listing.

This is different to the synchronized scrolling which is available when the file view is split.



Hex Mode 147

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

15 Hex Mode

Files displayed in hex mode look something like this:

Hex mode displays a file as a series of hexadecimal (base 16) numbers together with the
corresponding ASCII character equivalent (this is also known as De b ug  Fo rma t).

The first 8 digits on each line represents a hex address which indicates the position (or offset) of the
corresponding line in the file. This is followed by up to 16 hex numbers (or bytes) which correspond to
the file data.

The right hand side of the view consists of the ASCII character representation of the corresponding file
data If the hex byte does not correspond to a p rinta b le  ASCII character, it is displayed as a " ."  (dot).

If the Display ALL hex codes option is enabled, all codes will be displayed on the right hand side
instead of a dot. The character displayed depends on the selected font, and will usually not be unique
for each control character.

Click here for a description of the various hex formats available.

No te

By default, each line displays 16 bytes of data, although the line length can be changed
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15.1 Hex Formats

When in Hex Mode, the file may be viewed in one of several hex formats which are selected from the
View menu  (under Hex Formats) or from the right-click menu (Layout->Hex Formats).

The left side of the hex display contains a hex representation of the file data . The right side shows the
corresponding text character. If a character is unprintable (eg, a null) a dot (" ." ) will be displayed.

The available formats are:

Byte
This is the default format. Each character in the file is displayed as an individual hex code (from 00 to
FF).

Wo rd
The data in the file is displayed as 16-bit words (always in hex)

DWo rd
The data is displayed as 32-bit double words (in hex)

Do ub le  DWo rd
The data is displayed as 64-bit quad-words (in hex)

Unicode (Word/UTF-16)
This is the same as the Word format except that the right side of the line is displayed as 16 bit Unicode
characters (instead of 8 bit ASCII).

De cima l
Similar to the Byte format, except each byte is displayed in DECIMAL (from 0 to 255).

Octa l Byte
As above, but each byte is displayed in OCTAL (from 0 to 377).

Octa l Wo rd
As above, but the data is displayed as octal wo rd s  instead of bytes (from 0 to 177777).

Flip  End s
This only applies when in Word, DWord or Double DWord mode. The "ends" of each "word" are
"flipped". This makes it easier to view data that is stored in little-endian format.

By default, each line displays 16 bytes of data, although the line length can be changed.

No te

The file offsets are always displayed in Hex.
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15.2 Hex Line Length

By default, each line in hex mode contains 16 bytes.

This can be changed by selecting "Hex Formats"->"Set Hex Line Length" from the View menu (or
pressing Ctrl-W).

The line length must be a multiple of the format size.

For example, if the data is being displayed as "words", the length must be a multiple of 2 (the size of a
word).

No te

The hex line length cannot exceed 32 if the program is unregistered

15.3 Hex Font

A different font can be used to display files in text and hex modes, although by default, these fonts are
the same.

If you change the font in hex mode, the font will not be changed in text mode.

15.4 Vertical Hex Mode

Vertical Hex Mode is enabled by pressing Alt+J (or selecting T e xt + Ve rtica l He x from the View
menu). Vertical Hex mode looks as follows:

 
The file is displayed one line at a time (just as in text mode). However, each line is followed by 2 lines
containing the hex code of each character in the line.

The 2 lines need to be read ve rtica lly . That is, the first line contains the first nibble (4 bits) of the code
and the second line contains the second nibble.

In the example above, the first character in line 1 is ZERO, which is 30 in hex. Therefore, the first
character in line 2 is 3 and the first character in line 3 is 0.
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16 CSV Mode

CSV files (Comma Separated Values) are typically used to represent tabular data, where each line in
the file represents the row of a table. Each line contains the text of each column in the row, separated by
a comma (although other characters can also be used as the delimiter - eg, a TAB).

By default, V will automatically recognize CSV files and will display them as a table - where all the
columns have the same width (much like a spreadsheet). Although unlike a spreadsheet, the column
widths in V are fixed (determined by the longest entry in the column) and cannot be resized.

You can press the arrow button next to the CS V  M o d e button in the toolbar to customize the CSV
behavior. Press here to see what CSV options are available.

Press the CS V  M o d e button on the toolbar to toggle between CSV mode and standard text mode.

If V recognizes a file as a CSV file it will display it as a table (in CSV mode). For V to recognize a file as
a CSV file, the first 2 lines in the file must contain the sa me  numb e r o f d e limite rs . This means that a
file containing a single line will never be (automatically) recognized as a CSV file. To display single line
CSV files, you will have to use Force CSV.

If V does not recognize the file as a CSV file, you can enable CSV mode manually by pressing the CSV
Mode button on the toolbar. This will allow you to view CSV files with lines containing varying numbers
of delimiters.

If V still thinks that the file is an invalid CSV file, you can try forcing CSV mode by clicking the arrow next
to the CS V  M o d e button on the toolbar and selecting Force CSV. You will then have to enter the
character that the file uses as a delimiter. 

The following is an example of what CSV mode looks like

and the following is the same file viewed in standard text mode
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16.1 CSV Options

The CSV options can be modified by pressing the arrow button next to the CS V  M o d e button in the
toolbar.

When displaying CSV files in CSV mode, each line will be expanded so that the corresponding fields in
each line start at the same column.

CSV Mode can be automatically enabled whenever a CSV file is viewed or it can be enabled/disabled
by pressing the CS V  M o d e button in the toolbar or by clicking on CSV in the bottom right of the status
bar.

The following CSV options are available:

Auto ma tica lly  re co g nize  a nd  d isp la y  a ll CSV fi le s  in CSV mo d e
This is the default behavior. If V recognizes any file as a CSV file, it will display it in CSV mode.

D isa b le  a uto ma tic  CSV mo d e  (o nly  e na b le  CSV mo d e  fro m the  to o lb a r)
If this mode is enabled, V will always open CSV files in standard text mode. The user can then enable
CSV mode by pressing the CS V  M o d e button on the toolbar.

Only  re co g nize  CSV fi le s  with the  fo llo wing  e xte ns io ns
If this option is enabled, you can enter a list of file extensions, separated by spaces (eg, CSV DAT
TXT). V will only attempt to display files with these extensions in CSV mode.

Re co g nize  a ll fi le s  EXCEPT  tho se  with the  fo llo wing  e xte ns io ns
Similar to the above option, except that V will only attempt to display a file in CSV mode if the files's
extension is no t in the list of extensions.

Allo w multi-l ine  fie ld s
Enable this option if you want fields in CSV files to span multiple lines. Click here for further details on
multi-line fields.

Do  no t s trip  q uo te s  fro m fie ld s
If this option is enabled, V will not strip the double quote characters from fields that are quoted.
Note that V only strips quotes from the start and end of a field - it does not strip quotes from the b o d y of
a field. For example, two quotes are generally used inside a quoted field to represent a single quote. In
this case, V will not strip the extra quote - it will always display both quotes.

Do  no t d ra w ho rizo nta l g rid  l ine s
If this is enabled, V will not draw the horizontal grid lines.

Grid  l ine  co lo r
This lets you specify the color of the grid lines
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16.2 Multi-line fields

There is no official specification for the CSV format, but it is generally considered that if you use double
quotes, commas or line breaks in a field, the e ntire  fie ld  should be enclosed in quotes.

Because V supports multi-line fields, it is important that quotes are used correctly. In particular, if a field
begins with a quote, it must also end with a quote. If it doesn't, the file may not be displayed correctly.

By default, parsing of multi-line CSV fields is disabled.

This is because multi-line fields are rare and incorrect use of quotes is common. If multi-line fields were
enabled, and V encountered a field which did not use quotes correctly, it could treat that field as a multi-
line field and subsequent lines would not be displayed correctly.

Multi-line fields can be enabled by setting Allo w multi-l ine  fie ld s  in the CSV Options.

If you find some CSV files are not being displayed correctly, please disable this option to see if it fixes
the problem.

16.3 Forcing CSV Mode

V will automatically try to determine the delimiter used by a CSV file. If it fails, you can manually specify
the delimiter and V will try again to view the file in CSV mode.

To manually specify the delimiter, click on the arrow next to the CS V  M o d e button in the toolbar and
select Fo rc e  CS V.

If V still cannot display the file in CSV mode, there is probably a problem with the CSV structure of the
file.

If you think that the file is a valid CSV file, please send a copy to v@fileviewer.com

No te s

Once a new delimiter has been successfully used, V will always check for that delimiter whenever it
tries to detect CSV files.

When using the command line, you can force CSV mode by using the /CVS:delimiter option (eg, V

file.csv /csv:,)

mailto:v@fileviewer.com
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16.4 Customizing the CSV column names

V assumes that the first line of a CSV file always contains the column headings. As this is not always the
case, the first line will also be displayed as the first line of data. There is no option to disable this
behavior. 

If you regularly view the same CSV file, it is possible to customize the column headings.

To do this, select E d it Grid from the Grid Line s menu while you are viewing the file. Then right-click on
each of the column headings and edit the column names.

Finally, select S a v e  Grid from the Grid Line s menu and save the .vgrid file to the same directory as the
CSV file (or to the Default Grid Directory if you have one).

Also, make sure that you enable Auto-Load Grids on the Grid  Op tio ns submenu of the Grid Line s menu.

The next time you view the CSV file, the grid in the .vgrid file will be displayed instead of the first line of
the CSV file. 

16.5 Limitations of CSV Mode

Asia n cha ra cte rs

Unfortunately, V will not correctly display CSV files containing Asian characters. If you try to view a CSV
file which contains Asian characters, the Asian characters will usually be displayed as question marks.

Please let me know if this is something that you would like fixed. If enough users want to see this
implemented, I will try to give it some priority.
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17 Searching/Moving around the File

17.1 Searching

The Find  command allows you to search for a string (or sequence of bytes) in the file being viewed. It
may be selected from the toolbar, the Edit menu, from the right-click menu or from a keyboard shortcut.

When you select the Find command, you will be presented with the Find dialog box, where you can
specify your search. The Find dialog box contains the following:

Note that a Search Bar can also be displayed at the bottom of the file window. Click here for details.

Se a rch fo r
Enter the string to search for.
Click here for several different ways of entering the search string.

Ma tch Ca se
Usually V will ignore case (upper and lower) when searching for strings. Check this option if you only
want V to find strings that exactly match the case of the string entered. Note that this option is disabled if
the Bina ry  Da ta  option is checked.

Who le  Wo rd  Only
Check this option if you are only interested in matching the entered text when it appears as a word. For
example, searching for the string "so ft"  will usually find a match in "so ftwa re " . Setting this option, will
not find a match in "software".

Re g ula r Exp re ss io n
This option indicates that the string specified in "Search For" is a regular expression. Click here for an
explanation of regular expressions.
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Bina ry  Da ta  (He x)
This option indicates that the search string is a sequence of hex bytes rather than a text string.

T yp e  o f Se a rch
This listbox is only displayed if B io Info rm a tic s /D N A  s e a rc h func tio na lity is enabled in the Search
Options and lets you specify if the search string is to be treated as an amino acid string or a string of
IUPAC codes. S ta nd a rd  S e a rc h should be selected to indicate that the string is a plain string of text.

D ire c tio n
This specifies the direction of the search. If Fo rwa rd  is selected, the file is searched from the beginning
to the end. If Ba ck is selected, the search begins from the end of the file and goes backwards.

Unico d e
This will search for the Unicode equivalent of the specified string. This is useful if you want to search for
strings in a Win32 executable. If the file being viewed is a Unicode file, there is no need to enable this
option.

Se a rch fro m
Specifies from where the search is to commence. If Sta rt is selected, the search will begin from the start
of the file. If Curre nt is selected, the search will begin from the current line. If the direction of the search
is backwards, the Start option will be replaced with End. By selecting End , the search will commence
from the end of the file.

Co lumns
You may restrict the search to a particular column or range of columns. Click here for further details on
specifying column ranges.

Flip  Se a rch String
When viewing hex files in flipped mode, the this option is available to also flip the entered search string
before searching.

D isp la y  Se a rch Ba r a t b o tto m o f the  fi le  wind o w
This will display a Search Bar at the bottom of the file window that can be used instead of the Search
dialog for searching.

Press the Co unt All button to count the number of times the search string appears in the file.

Press the Bo o kma rk  button to bookmark the lines that contain the search string.

Press the Op tio ns  button to modify the search options.

The Se a rch Ag a in command (or Find  Ne xt) will search for the next occurrence of the entered text.
Use Alt+A to continue the Find Next onto the next file.
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Ca nce lling  the  Se a rch

If V has not found the specified string within 5 seconds, it will display a dialog box which will let you
cancel the search by pressing the "Cancel" button.

No te s

The Find Next command will always search forwards even if the previous search was backwards.

Ctrl+F3 can be used to search for the next occurrence of any highlighted text.

The search history is limited to 5 strings if V is not registered.
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17.2 Search String

In its simplest form, a search string consists of a sequence of text characters.

By enabling the Bina ry  Da ta  (He x) option, the search string is treated as a sequence of hex bytes
(eg, FF096C3A). Do not enter any spaces between the hex bytes.

You can also use specify hex characters within a text string by using the \x he x no ta tio n. For example,
the above sequence of hex bytes can also be entered as:

"\xff\x09\x6c\x3a"

If you use the \x notation, you will need to first enable "Allow hex characters in text search string" in the
Search Options.

No te s

Case is not significant when entering hex data

When using \x notation, do not enable the Binary Data option

If \x notation is enabled and you actually want to search for "\x", you will need to enter "\\x"

The search string may also be selected from the drop-down list box which maintains a history of the
most recently used strings. The search history can be configured (and disabled) in the History section
of Preferences.
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17.3 Search Options

Pressing the Op tio ns  button in the Find dialog box will allow you to modify several search options. The
same options may be modified in the Search tab of Preferences.

Find  Ne xt fro m Curre nt Po s itio n
The Find  Ne xt (or Previous) command will find the string immediately after (or before) the last string
found - even if you have changed the file position. Enable this option to commence the search from the
current file position (instead of the previous match).

Find  Ne xt fro m ne xt l ine
By enabling this, V will ignore the rest of the line when doing a "Find Next" and will begin searching from
the start of the next line.

Wra p  to  Sta rt
By enabling this, V will continue searching from the start of the file once the end of the file is reached.

Do  no t ce nte r fo und  te xt
This causes found text to always be displayed on the top line of the window - instead of being centered.

Do  no t ce nte r fo und  te xt if i t is  a lre a d y o n scre e n
By enabling this option, if the string you are searching for is already visible, the window will not be
scrolled when the string is highlighted.

Only  "b e e p " if se a rch fa ils
Enabling this will stop V displaying a "String not Found" message when no match is found.
Instead, a short beep will sound.

Alwa ys Sta rt Ctrl-F se a rch fro m the  b e g inning
By default, pressing Ctrl-F (or starting a search) will start the search from the current position. Enabling
this option will cause the search to always start from the beginning of the file.

Allo w he x cha ra cte rs  in te xt se a rch s tring
This enable the use of the \x prefix to indicate a hex character when entering text strings.

D isa b le  "Ma tch Ca se  T o g g ling "  (us ing  the  \  ke y)
This disables Match Case Toggling. That is, the \  key behaves just like the /  key.

Ena b le  Bio Info rma tics /DNA se a rch functio na lity
This option must be enabled for the Bioinformatics/DNA search options to become available.
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17.4 Search Count

Pressing the Co unt button in the Find dialog box will count the number of times the search string
appears in the file.

The number of matches found will be displayed on the screen as V is counting. Press the Cancel button
to stop the count.

If any text is selected before starting the count, the number of times the search string appears in the
selection will also be displayed 

No te : Each instance of the specified string is not highlighted after the count is complete.

17.5 Search Skip

Pressing the Sk ip  button in the Find dialog box lets you skip over a specified number of matches.

For example, you can use this to find the 100th occurrence of a string in a file or to skip over 100
matches before continuing your search.

When the button is pressed, simply enter the number of matches to skip and press OK.

17.6 Column Search

When searching a file for text, you may restrict your search to a column or range of columns. 

To do this, you must enable the Co lumns checkbox and enter the column (or range) in the space
provided. The most recently used columns may be selected from the drop-down list box.

Only text that begins in the column (or lies in the column range) will be matched. 

You may specify a column range in one of 2 ways: 

n-m Match strings that start anywhere between columns n and m
n- Match strings that start anywhere after (and including) column n 

You may also specify more than one column range by separating them with commas. The following are
examples of valid column specifiers: 

1 Match if text starts at column 1 (ie, start of the line)
1-10 Match if text starts in columns 1 to 10
1,12,80 Match if text starts in column 1 or 12 or 80 
1-5,20-29,80- Match if text starts in columns 1 to 5, or columns 20 to 29, or starts anywhere after

(and including) column 80
 

Us ing  Re g ula r Exp re ss io ns to  se a rch fo r d a ta  in co lumns

Regular expressions can also be used to search for text in columns (and even for text not in a certain
column). Click here for further details.
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17.7 Bioinformatics/DNA Search

A Bioinformatics/DNA search option was introduced in V13 which lets you search for amino acid strings
and IUPAC codes in files containing DNA sequences.

When doing a search, two new options are available - Amino Acid Search and IUPAC Search. When
one of these options is selected, the search string is treated as either a string of amino acid codes or
IUPAC nucleotide codes.

Only exact matches are found. Imperfect matches (as in BLAST searches) are not supported.

Amino  Ac id  Se a rch

When the Amino Acid Search option is selected, the search string is treated as a sequence of amino
acid codes.

There are 20 valid codes which represent the 20 standard amino acids
(ACDEFGHIKLMNPQRSTVWY). An X is used to indicate any amino acid and a * is used to indicate a
stop codon.

V will search the file (containing DNA sequences) and will match any sequence that corresponds to the
entered amino acid string.

IUPAC Se a rch

When the IUPAC Search option is selected, the search string is treated as a sequence of IUPAC
nucleotide codes.

There are 15 valid codes which correspond to the valid characters in the DNA/RNA alphabet
(ACGTURYMKSYNDHV), and N is used to indicate any nucleotide.

No te s

The Bioniformatics/DNA options are hidden by default. They will only appear if  the Bioniformatics/DNA
search functionality has been enabled in the Search section of Preferences.

This functionality is still very much und e r co nstruc tio n and I am looking for user feedback to drive
development. 
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17.8 Tips on using the Keyboard

The following keys can be used to initiate a search:

No rma l Find
/  and Ctrl+F.
You can also use F if Single Letter Commands are enabled.

Find  Ne xt
F3, A, Ctrl+L, Ctrl+N
You can also use the SPACE key if Use SPACE as Find Next is enabled in the Keyboard tab of
Preferences.

Ctrl+F3 can be used to search for the next occurrence of any highlighted text.
Alt+A (and Alt+F3) will continue searching the "next file" if no further matches are found in the file being
viewed.

Find  Pre v io us
To search backwards, use any of the Find Next keys with the SHIFT key pressed.

Ba ckwa rd s Se a rch
Using ? will always initiate a backwards search. That is, a normal search with the Direction option set to
Back.

Ma tch Ca se  to g g le
Using  \  will initiate a search with the default "Match Case" option toggled.

That is, if you perform a normal search (eg, using /) with the Match Case option disabled, pressing  "\"
will initiate a search with the Match Case option disabled. If you perform a normal search with the Match
Case option enabled, using "\" will disable the Match Case option.

You can disable this behavior by enabling Disable "Match Case Toggling" (using the \ key).



V Help File162

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

17.9 Scrolling

The File View may be scrolled in the standard ways - via the keyboard or the scroll bars.

Us ing  the  ke ys

Pa g e Up  a nd  Pa g e Do wn
Scroll the view one screen-full at a time in the specified direction.

Up Arro w a nd  Do wnArro w
Scroll the view vertically one line at a time.

Le ftArro w a nd  R ig htArro w
Scroll the view horizontally, one column at a time.

Ctrl-Le ftArro w a nd  Ctrl-R ig htArro w
Scroll the view horizontally by the width of the view.

Ctrl-Ho me  a nd  Co ntro l-End
Ctrl-End  scrolls the window so the end of the current line is visible. Ctrl-Ho me  scrolls the window to its
leftmost position.

Ho me /End
The Ho me  key goes to the start of the file and the End  key goes to the end of the file.

If the Use Space as PgDown option is enabled, the SPACE key will behave like Pa g e Do wn and
Shift-SPACE will behave like Pa g e Up .

Us ing  the  scro ll b a rs
If you click on the arrows on either side of the scroll bars (vertical or horizontal), the view is scrolled by
one line (or column) in the appropriate direction. Clicking on the area below the vertical scroll box (or
slider) is equivalent to pressing Pa g e Do wn and clicking on the area above the scroll box is the same
as pressing Pa g e Up . Similarly, clicking to the right of the horizontal scroll box will scroll the view to the
right by the width of the view and clicking to the left will scroll the view to the left.

Dragging the vertical slider allows you to quickly move the file position. You may enable smooth
scrolling in order to improve the file display while dragging.

Curre nt Line  Ma rke r

Pressing the Up/Down arrow keys will move the current line marker (instead of scrolling the window).
The window is only scrolled when the line marker reaches the bottom (or top) of the window. If you
would like the window  to always scroll on an arrow key, enable Always scroll window when using arrow
keys in the File Options tab of Preferences.

If the window is scrolled using the scroll bars (with the mouse), V will automatically move the current line
marker accordingly. If you prefer the current line marker to stay where it is, enable Do not move current
line marker when using scroll bars.
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Co ntinuo us scro ll ing
The view may also be scrolled continuously in the vertical direction. This is basically equivalent to
continually pressing the UpArrow or DownArrow key.

To commence continuous scrolling, simply press Ctrl+Shift+Do wnArro w or Ctlrl+Shift+Up Arro w
depending on the direction in which you want to scroll. The view will then start to scroll automatically.
The speed of the scrolling may be increased by pressing the + (PLUS) key and decreased by
pressing the - (MINUS) key.

Continuous scrolling may be stopped by pressing the ESC key and paused by pressing SPACE.
Once paused, the scrolling may be re-started by pressing SPACE again, or terminated by pressing
ESC.The scrolling will stop when the top (or bottom) of the file is reached.

Inte ll iMo use  Sup p o rt
V makes full use of the Microsoft IntelliMouse. Click here for details.

Custo mizing  the  ke ys

All of the cursor keys can be customized by selecting Customize Keyboard from the Tools menu. For
example, you can change the behavior of the Home/End keys so they go to the start/end of the line
instead of the start/end of the file. The commands corresponding to the cursor keys (such as Line Up/
Line Down) can be found in the Othe r submenu of the FILE commands.



V Help File164

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

17.10 Smooth Scrolling

The slider on the vertical scrollbar may be dragged to quickly change the position of the file. V will
continually try to redisplay the file as the scrollbar is being dragged.

If you find the screen refresh during scrolling annoying, you may try to make it "smoother" by enabling
"Smooth Scrolling" in the File Options section of Preferences.

To do this, you must specify a Smo o th De la y  which will be used to "slow down" the speed of the
scrolling. Typically, a delay of between 50 and 200 will be used. If no delay is entered, V will use a
delay of 180.

The delay specified will depend on the speed of your system. If you find the scrolling too slow, enter a
smaller delay. If the screen "flashes" too quickly during scrolling, enter a larger delay.

No te

The V smooth scrolling is different from, and independent of the "smooth scrolling" which is available in
programs like Internet Explorer.

17.11 IntelliMouse Support

The Microsoft IntelliMouse is a mouse with a small wheel between the two mouse buttons. The wheel
can be used to scroll windows without having to move the cursor over the scroll bars.

V supports the IntelliMouse as follows:

When viewing a file, scrolling the IntelliMouse wheel will scroll the document three lines at a time.

If the SHIFT key is pressed while scrolling the wheel (or if the wheel itself is pressed), the
document will be scrolled a screen at a time.

If the wheel is scrolled while it is pressed and the SHIFT key is also pressed, continuous
scrolling will begin. Pressing the wheel will pause/restart the scrolling. Pressing the wheel while
the SHIFT key is pressed will stop the scrolling.

If the CONTROL key is pressed as the wheel is scrolled, the Previous/Next document in the File
List is displayed.

No te

In order for the operations requiring a wheel press to work correctly, you must "Turn on the wheel
button" in the IntelliMouse setup (in the Control Panel) and set the "Button Assignment" to "Default".
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17.12 Goto

The Goto dialog box allows you to specify a location in the file to jump to. The specified location will be
displayed at the very top of the File View. You may enter the location either as a Line  Numb e r,
Co lumn Numb e r, Offse t, Pa g e #, Re co rd # or Chunk by selecting the appropriate option.

Note that Pa g e # is only enabled if the file is paginated.

Re co rd  Numb e rs

A re co rd  is different from a line  in that it is always a fixed length (and it doesn't have to end with a
newline character).

If the file being viewed consists of fixed length records, the record length will automatically be placed in
the Le ng th field. If the file does not consist of fixed length records, you may specify your own record
length (although it probably wouldn't make much sense to do this). 

The other options in the Goto dialog box are:

He x
This specifies that the Offset entered is in hex instead of decimal. 

Fro m End  o f File
This indicates that the specified location is to be treated as being from the end of the file. For example,
if you enter a Line Number of 100, V will position the view 100 lines from the end of the file.

No te s

It is quite valid to goto a file offset while in text mode. In this case V will simply goto the line which
corresponds to the offset entered.

On the other hand, it is not possible to goto a particular line number if the file is opened in Hex mode
(unless the file has also been opened in Text mode). In this case, the Line Numbers option in the Goto
dialog box is disabled.

If the file is being displayed in chunks, the numbers in the Goto dialog box are relative to the s ta rt of the
file. Click here for further details.
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17.13 Goto and Chunks

All entries in the Goto dialog are relative to the s ta rt of the file, regardless of which chunk is currently
being viewed.

For example, if you were viewing the last chunk of a file, going to line 1 will take you to the very first line
of the file (not the first line of the chunk).

You can also enter numbers outside the current chunk.

For example, if you were viewing the first chunk (which contained 1000 lines), you could enter line 5000
in the Goto dialog.

In this case, V would load the chunk that contained line 5000.

Note that V may take some time to locate the required position (especially if you are viewing a very
large file). If the time taken is more than five seconds, a Cancel button will be displayed which will allow
you to stop the goto operation.

No te

This behavior was introduced in Version 7. In prior versions, the line number was restricted to the
current chunk.
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17.14 Bookmarks

Bookmarking allows you to remember the current file position so that you can easily return to it.

V implements two types of bookmarking - numb e re d  and tra d itio na l.

Numbered bookmarking allows you to create up to 10 bookmarks (numbered from 0 to 9). Click here for
further details.

Traditional bookmarking allows you to bookmark a line by pressing Ctrl+F2. Pressing Ctrl+F2 again
will clear the bookmark. Unlike numbered bookmarks, there is no limit to the number of traditional
bookmarks you can have.

Bookmarked lines will be displayed in a different color. When multiple lines have been bookmarked,
pressing F2 will take you to the ne xt bookmark in the file and pressing Shift+F2 will take you to the
p re v io us bookmark in the file. All bookmarks in the file can be cleared by pressing Ctrl+Shift+F2 or by
selecting B o o k m a rk s ->Cle a r A ll B o o k m a rk s from the Edit menu.

Se a rch a nd  Bo o kma rk

The Search dialog box contains a B o o k m a rk button. Pressing this button will bookmark all lines that
contain the search string. If you are using the Search Bar, you can right-click on the Find  N e xt button
(down arrow) to bookmark lines containing the search string. The number of bookmarked lines will be
displayed in the status bar.

All bookmarked lines can be c o p ie d  to  the  c lip b o a rd   by selecting Co p y  B o o k m a rk e d  Line s from the
B o o k m a rk s submenu of the E d it menu. All bookmarked lines can be saved to a file by selecting S a v e
B o o k m a rk e d  Line s from the same submenu.

By default, V will clear all bookmarks when it exits. If you want the bookmarks saved so they will be
available every time you view the file, enable Save Bookmarks on Exit in the File Options tab of
Preferences.

No te

The color of the bookmarked lines can be changed by selecting Customize Colors from the Tools
menu.
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17.15 Numbered Bookmarks

Up to 10 bookmarks (numbered from 0 to 9) may be set by either selecting the appropriate bookmark
number from the Ed it->Bo o kma rk->Se t Numb e re d  menu, or by pressing Alt-0 to Alt-9 (for
bookmarks 0 to 9 respectively). Bookmarked lines are displayed in a different color.

Once a numbered bookmark has been set, it may be restored by selecting it from the Ed it-
>Bo o kma rk-> Go to  Numb e re d  menu. Alternatively, it may be restored by pressing Ctrl-0 to Ctrl 9.

Numbered bookmarks are g lo b a l. That is, you can save a bookmark in one file and restore it while you
are viewing another file.

No te s

Numbered bookmarks not only save the current file position, but they also save the current file mode
(ie, text or hex).

Unlike traditional bookmarks, numbered bookmarks can not saved when you exit V. That is, every time
you start V, all numbered bookmarks will be cleared. If you want to save a numbered bookmark, you
should use Favorites and assign a shortcut key to the Favorite created..

17.16 Sending selected text to your browser

V does not underline hyperlinks in files - such as http://www.fileviewer.com/, or create clickable
hotspots like a browser does.

However, if a text file contains a URL, you may open the URL in your browser (not in V) by highlighting
the text that forms the URL, right-clicking and selecting Op e n Se le c tio n in Bro wse r.

You may also simply right-click over the URL (without selecting the actual text).

No te s

You do not have to highlight the entire URL - any part of the URL (even just one character) is sufficient.

If you only want to send p a rt of the URL to the browser, simply select exactly what you want sent, and
then press the Shift key when selecting Op e n Se le c tio n in Bro wse r.

17.17 Open Selection in V

While viewing a file, you may highlight some text and then select "Op e n Se le c tio n in V" from the File
menu. The selection will be treated as a file name, and if it exists, will be viewed by V.

If you have enabled Multiple File Windows, the file will be viewed in a separate window.

Alternatively, you can simply right-click on any part of the file name (without having to highlight anything)
and then select "Open Selection in V". Note that this will only work if the file name does not contain any
spaces. If it does, you will need to highlight the entire file name.

No te : If you select a directory name instead of a file name, the directory will be displayed in the
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Directory View.

17.18 Maintaining File Position

When viewing a file, the file position when last viewed is restored. This means that if you are quickly
swapping between 2 files (using the Previous/Next commands), the file positions will not be reset to the
beginning of the file.

You can disable this behaviour by enabling the Do not restore file position option in the File Options tab
of Preferences.

Note that the file positions are only remembered while V is active - they are not saved when you exit V.

17.19 Paginated Files

A p a g ina te d  file is one that contains form feeds (ASCII 12).

V will automatically paginate files that contain form feeds, displaying a page marker (dotted line)
before the first line in each page.

By enabling Page Up/Down go to start of page in the Keyboard tab of Preferences, V will always scroll
to the first line in a page when pressing Page Up/Down.

If you press Ctrl+Shift+Page Up/Down, V will scroll to the next page, but maintain the current position in
the page. For example, if you are currently on line 10 of page 1, pressing Ctrl+Shift+Page Down will take
you to line 10 of page 2.

Do not enable this option if you want Page Up/Down to behave normally (ie, scroll by the length of the
window).

Line  Numb e rs
By default, V will increment the line number for each line in the file. If you want the line number of each
page to always start at 1, enable the Reset Line Numbers on New Page option.

No te

If you don't want V to paginate the files, select End Of Line->Ignore Form Feeds from the View menu.
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17.20 The Search Bar

The Search Bar is displayed at the bottom of the file window.

If it is disabled, it can be enabled by pressing the Search Bar icon (binoculars) in the bottom left of the

Status Bar: 

The Search Bar can also be enabled by setting the Display Search Bar at bottom of the file window
option located at the bottom of the Search dialog box.

If the Search Bar is displayed, it will be used for searching instead of the Find dialog. To search, simply
enter the search string in the "Find" box and press the Enter key. You can also click on one of the arrow
buttons to search in the required direction (forwards or backwards).

If the search bar is not wide enough to display all of the search options, you can right-click on any
empty area of the search bar to select the required option. This right-click menu also allows you to
modify several other search options.

After doing a search, you can click on the arrow buttons to do a Find Next (down arrow) or Find Previous
(up arrow).

String  Co unt

Right-click on the Find  N e xt M a tc h button (the down arrow) and select Co unt A ll to count the number of
times the search string occurs in the file.

Bo o kma rk ing

Right-click on the Find  N e xt M a tc h button and select one of the Bookmark options to bookmark all the
lines that contain the search string.

Fa vo rite  Se a rche s

By clicking on the "Favorites Searches" button and selecting "Add Search", the current search is
added to the list of Favorite Searches. The user can them perform this search by simply clicking on the
Favorite Searches button and selecting the search from the list.

Organize/Configure can be selected from the Favorite Searches menu to modify the search or
customize the menu (similar to how Favorites are organized).

H ig hlig ht All

Enabling Highlight All will cause V to highlight e ve ry  occurrence of the selected text (this does not work
in hex mode or for multiline selections). For example, if you double-click on a word, a ll occurrences of
that word will be highlighted. Note that the Highlight All selections are not sticky. That is, they will
disappear as soon as you click the mouse to clear the text selection. The lines containing highlighted
text can be colored differently so that they stand out more. See below.

Se a rch Ba r Op tio ns
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You can customize some of the Search Bar functionality by right clicking on the Search Bar and
selecting "Search Bar Options" or by clicking on the two small arrows at the very right of the search bar.
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Only  d isp la y  a fte r firs t se a rch
By default, if the Search Bar is enabled, it will be displayed as soon as a file is viewed. By enabling this
option, the Search Bar will be hidden when the  user first views the file, and will only be displayed once
the user starts searching (by clicking the Find button in the toolbar or by using a search key).

Do  no t use  whe n se a rching  fro m to o lb a r
If the Search Bar is enabled, clicking on "Find" in the toolbar will move the cursor to the Search Bar for
the user to enter the search text (instead of displaying the dialog box). By enabling this option, the
default Find dialog will be displayed instead. If a search key is used (like '/' or Ctrl+F), the cursor will still
be moved to the Search Bar.

Auto ma tica lly  Se a rch fro m Fa vo rite s
Selecting a search from Favorite Searches only updates the search bar with the search text/options.
The user still needs to click on a search button to perform the search. By enabling this option, the
search is performed as soon as the favorite is selected.

Auto ma tica lly  a p p ly  whe n fi le  is  lo a d e d
If Highlight All is enabled, enabling this option will automatically start highlighting text as soon as the file
is loaded (using the most recent search string). If this option is not enabled, highlighting will only
commence after the user does a search (or clicks on the Refresh button).

Co lo rs

Five colors can be defined in the Search Bar Options. These colors can also be set by selecting 
Change Colors from the View menu.

T e xt/Ba ckg ro und
This is the color that will be used to display the "highlight all" text.

Line  T e xt/Ba ckg ro und
This color will be used to display any non-matching text on lines that contain highlighted text. This
makes it easy to see what lines contain matches.

Line  Numb e rs
This color will be used to display the line number of all lines that contain highlighted text.



Searching/Moving around the File 173

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

17.21 Continuing Search onto Next File

By default, V only searches the file being viewed for the search string. In particular, doing a Find Next
will fail to find anything if no further matches of the search string can be found.

However, doing a Find Next using Alt+A (or Alt+F3), will cause V to continue searching the "next file" for
further matches. If it finds any, it will load the new file and display the next match.

Wha t is  the  "ne xt fi le "?

You can always tell what the "next file" will be by placing your mouse over the Next File icon in the
toolbar (the icon with the small right-arrow). Alternatively, you can click on the File List icon (small down-
arrow) to display an ordered list of the files.

If you viewed the current file by selecting it from the V directory listing, the next file will be the next file in
the directory listing.

If you viewed the current file by selecting it from the Search (GREP) results, the next file will be the next
file in the search results.

If you launched V from the command line with more than one file (eg, V *.txt), the file list contains all the
files specified on the command line.

If you launched V from another program (like Windows Explorer), there is no next file.

No te

You cannot search backwards across files.
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18 Block marking / Text highlighting

18.1 How to mark blocks

Several very useful operations can be performed on marked blocks (or selected text).

See the following sections for further details:

Status Bar
Selecting Words
Marking Columns
Adding Columns
Copying to the clipboard
Copying to a file

Blocks can be marked in several ways:

Us ing  the  Ke yb o a rd
Click here for further details.

Ma rk  with mo use
A block may be marked in the usual method of holding down the left mouse button and dragging it over
the text to be selected, releasing the button when the required text has been highlighted.

Sp e c ify ing  the  s ta rt a nd  e nd  p o s itio ns
This method is useful when marking very large blocks, or in hex mode, when you want to mark a
specific address range.

To mark the start of a block, simply right-click on the corresponding character (or hex bytes) and select 
Ma rk  Blo ck->Sta rt Po int. To select the end of the block, scroll to the appropriate position in the file,
right click on the corresponding character and select Ma rk  Blo ck->End  Po int. Once the start and
end points have been specified, V will highlight the appropriate area.

Note that the end of the block may be marked before the start. Also, once a block is marked, it may be
modified by choosing a new start or end point.

V will draw a marker around the start (or end) of a character to indicate the start (or end) marker. This
marker will remain visible until it is cleared (by right-clicking and selecting Ma rk  Blo ck->Cle a r) or
moved (by selecting a different position).

Note that the color of the marker may be specified by selecting Change Colors from the View menu.

Ma rk ing  to  End  o r Sta rt
This method is similar to the above, except you only need to specify one point in the file (by right
clicking at the appropriate location). The second point will either be the end or the start of the file. To
mark a block from a character position to the end of the file, right click on that character position and
select Ma rk  Blo ck->T o  End . Similarly, to mark a block from the start of the file to a character position,
right-click on the end character position and select Ma rk  Blo ck->T o  Sta rt.

Offse t fro m curre nt p o s itio n
You may mark an exact number of characters from a file position by right-clicking on the file position,
choosing Ma rk  Blo ck->Plus  Offse t (or Minus Offset) and then specifying the number of characters to
mark.
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Ma rk ing  the  e ntire  fi le
The entire file may be marked by selecting Se le c t Blo ck->Entire  File  from the Ed it menu, or by
right-clicking and selecting Ma rk  Blo ck->Entire  File . The entire file may also be selected by
pressing Ctrl-A. 

Se le c ting  a  wo rd  o r l ine
To highlight an entire word, simply double-click anywhere on the word. Usually, only alphanumeric
characters and the underscore are used to determine what constitutes a word. To use a more extended
character set to select a word, press the shift key while you double-click. For example, double-clicking
at the start of "http :/ /www.fi le v ie we r.co m/" will only highlight "http ". However, by also pressing the
shift key, the entire URL is highlighted. Click here for further details on how to customize this behaviour.

To select the entire line, simply press the co ntro l key while you double click anywhere on the line.

If you double-click on a word (to select it) and then move the mouse before releasing the left mouse
button (to select further text), V will always end the selection at the end of a word.

Exte nd ing  the  se le c te d  te xt
Once text has been selected, it can be extended (or shortened) by shift-c lick ing  on the new end (or
start) position. That is, click on the new end position while the shift key is pressed.

Ma rk ing  Co lumns
Click here for details on how to select text in a particular column range.

No te s

Pressing Ctrl+F3 will search for the next occurrence of any highlighted text.

When HEX data is highlighted, both the Hex and Character views of the file are highlighted.

Clicking the left mouse button on any part of the file view will clear any marked block (but it will
not clear any block marker).
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18.2 Using The Keyboard

Text selection via the keyboard is achieved as in most text editors - and usually involves using the
cursor keys together with the Shift key. In particular:

Shift+Do wnArro w will select the current line.
Shift+R ig htArro w will will increase the text selection by one character.
Shift+End  will select to the end of the current line
Shift+Pa g e Do wn will select an entire "page" of text

Se le c te d  T e xt a nd  Scro ll ing

Unlike most text editors, V does not clear any selected text when the keyboard is used for scrolling.
That is, as you scroll the file with the arrow keys, any selected text remains selected. The selected text
will remain selected until you either start a new text selection or you left-click on the file with the mouse.

The selected text can also be cleared by pressing the key associated with the Cle a r S e le c te d  T e xt
command. There is no default keyboard shortcut to do this, but you can customize the keyboard to
assign a key to Cle a r S e le c te d  T e xt  (which is in the Othe r submenu of FILE).

18.3 Status Bar

The bottom left section of the status bar will display details of the selected text as it is being highlighted.

In te xt mo d e  it wil l  d isp la y :

The line and column number of the start and end positions of the selected text

The total number of characters in the selected text (in decimal and hex)

If the Hex offset in status bar option is enabled, the hex offsets corresponding to the start and end
of the selected text will also be displayed.

If highlighting a column, V will also display the sum of the column data if the column consists of
numbers.

In he x mo d e  it wil l  d isp la y :

The start and end offsets of the selected text (in hex)

The number of characters in the selected text (in decimal and hex)
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18.4 Selecting words

While viewing a file, V will highlight an entire word by double-clicking anywhere on the word. By default,
a word is defined to consist of alphanumeric characters (ie, a-z, A-Z, 0-9) and an underscore . 
Pressing the shift key while double-clicking on a word uses an extended character set to determine
what characters to highlight. By default, the extended character set consists of all alphanumeric
characters and any character no t contained in the following: 

     "'!$=;<>{}[](),

The More Options section of the Preferences dialog box allows you to define your own wo rd se ts  to be
used when highlighting words. Simply enter the characters that you want to be included in the
appropriate wordset field. Note that all wordsets include alphanumeric characters and the underscore.
These do not need to be specified and cannot be removed from a wordset. 

If you are happy with the default settings, simply leave these fields empty. 

18.5 Marking Columns

Usually when marking blocks that span several lines, complete lines in the block are highlighted -
except for maybe the first and last line in the block, which may be partially highlighted.

Sometimes you may only want to highlight text that appears in certain columns. You may do this by
pressing the Co ntro l key as you drag the mouse over the text to be selected. In this case, the
highlighted area will form a rectangle consisting of only the required columns. Note that it is not
necessary to continue pressing the Co ntro l key as you are marking the text - only when you begin to
mark the text.

When you copy the column selection to the clipboard (or save it to a file), only the text in the highlighted
columns is copied/saved.

No te s

Column marking is not available in HEX mode.

Once a column is marked, it may be extended by shift-clicking, as described in the How to mark
blocks section.

If the columns contain numbers, you can have V add them together and display the sum in the
status bar.

Although it is possible to mark columns if V is unregistered, you may only copy the selected text
to the clipboard (or save it to a file) once V has been registered.
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18.6 Adding Columns

When selecting columns which contain numbers, V can add these numbers and display the sum in the
status bar.

To do this, right-click on the bottom left of the status bar and select Sum Co lumn Da ta .

If you want V to automatically display the sum as you are selecting the column, right-click on the status
bar and enable Auto -Sum. You may copy the sum to the clipboard by right-clicking on the status bar
and selecting Co p y Sum to  Clip b o a rd .

By default, V looks for valid decimal numbers to add. If the numbers in the column are in hex, also press
the SHIFT key.

No te s

Any lines in the selection that do not contain valid numbers will be ignored.

This only applies to selected columns. That is, text that has been selected with the Ctrl key
pressed.

When selecting very large columns of data, the auto-sum option may slow down the selection
process.

18.7 Copying text to the clipboard

The selected text may be copied to the clipboard by either pressing Ctrl-C, by selecting Co p y/Cut
from the Ed it menu (the right-click menu) or by clicking on the Clipboard toolbar button.

If you are displaying the file with line numbers, they will not usually be copied to the clipboard. If you
would like the line numbers included, you have to enable the Include line numbers on copy to
Clipboard option in the Preferences Dialog box.

Co p y ing  in He x mo d e
In hex mode, the data to be copied to the clipboard depends on how the data is selected. If the data is
selected by drawing the mouse over the right side of the display, then only the data bytes will be
copied (nulls will be ignored).

If the data is selected by moving the mouse over the left side of the display, the actual hex
representation of the data (including the hex address) will be copied.

No te s

The selected text will usually remain highlighted once it has been copied to the clipboard (or
copied to a file). If you want the selection to be cleared once the selection has been copied, set
the Unmark block after copy option in the File Options tab of the Preferences dialog box.

When selecting the left side of a view In Hex mode, only complete lines are copied to the
clipboard, regardless of how much of the line is highlighted. Even if only one byte in a line is
highlighted, the entire line (and address) is copied to the clipboard. (This does not apply when
selecting the right side of the view)

The selected text may also be appended to the current clipboard contents by pressing the
SHIFT key while doing the copy.
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18.8 Appending to the cliboard

The selected text may be a p p e nd e d  to the clipboard by pressing the SHIFT key while doing the
copy. That is, press SHIFT while clicking on the clipboard toolbar button, or by pressing Ctrl-Shift-C
instead of Ctrl-C.

18.9 Copying to a file

The selected text may be copied to a file by selecting Se le c t Blo ck->Write  to  File  from the Ed it
menu or by selecting Ma rk  Blo ck->Write  to  File  from the right-click menu.

Copying selected text to a file is similar to copying to the clipboard, however you are asked to specify a
file name to copy the text to. If the file already exists, you have the option of appending to the file instead
of over-writing it.

This feature makes it easy to extract several small portions from a large file and save them to a much
smaller file (perhaps to be printed).

File  Enco d ing

When saving text files, select the type of encoding from the "File Encoding" drop-down list box. The File
Encoding will default to Unicode. The encoding should be set to ANSI/ASCII to save the text in the more
common single-byte ASCII format.

Co p y ing  in He x mo d e

Unlike copying to the clipboard, copying to a file in Hex mode does not copy the hex data as it is
displayed, but as it is stored. That is, if you highlight 6 hex bytes and copy them to a file, the resulting file
will contain exactly 6 bytes.
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19 File Searching / Text Searching (GREP)

19.1 File Searching / Text Searching (GREP)

Apart from searching for text while you are viewing a file, V can also search your entire PC (or network). 

You may search for files based on several criteria (name, size, date/time and attributes) as well as
search for files containing specified text.

File and Text searching is started by pressing the FindFiles/GREP toolbar button or by pressing Ctrl-F
in the Directory View and Ctrl-Shift-F in the File View.

You may perform a file search or text search by selecting the appropriate tab.

The following sections further describe the search functionality:

File Search

Text Search (GREP)

Advanced Search Criteria

Searching ZIP Files

Searching a List of Files

Multiple String Searching

Search Options

Advanced Options

Displaying the Search Results

Cancelling/Pausing the Search

GREP Favorites

Co mma nd  Line  Se a rch

Note that searching can also be initiated from the command line. Click here for the command line
syntax.
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19.2 File Search

The File Search lets you search for files by file spec - much like the "Search" command on the
Windows Start menu. 

You will need to specify the following details and then press the Se a rch button to start the search. The
results of the search will be displayed in the Results tab.

Na me d
This specifies the file name you want to search for. This can be a single file name or a file mask (like 
*.b a k). You may use the same rules here as you can when specifying a file mask in the V Directory
View. In particular, you can select multiple file masks by separating them with a comma (as long as 
R e g ula r E xp re s s io n is not enabled).

3 options appear under N a m e d which determine how the name/mask will be treated:

A llo w P a rtia l N a m e  M a tc h
By default, V will only find files that e xa ctly  match what is in N a m e d. For example, with this option
enabled, searching for T EMP will match files T EMP1, T e mp file .txt and File .te mp . Without this
option enabled, only files named T EMP (with no extension) will be matched.

R e g ula r E xp re s s io n
This indicates that the file mask is a regular expression. Note that multiple file masks can not be
specified if this option is enabled.

R E  to  m a tc h p a th (ins te a d  o f na m e )
This option matches the Regular Expression mask against the fully qualified file path instead of just the
path name.
For example, with this option enabled, searching for .*\\2012.*\\.*\.dat will find all .d a t files that are
in directories whose name begins with 2012.(That this option is only available if the above R e g ula r
E xp re s s io n option is enabled).

In D ire c to ry
This specifies what directory to start searching from.
You may enter multiple directories by separating them with a comma (eg, "C:\ ,D :" ), but there is no way
of telling V to *exclude* a directory from the search. 
A directory can also be enclosed in double quotes. This will only be necessary if you want to search a
directory that contains special characters. For example, if the directory name you wanted to search
contained a comma, you would enclose the entire name in double quotes, otherwise, V would think that
you were trying to search two directories.

You may also enter an environment variable. In this case, V will search all directories contained in the
path specified by the environment variable. To specify an environment variable, enclose it within
percents (eg, %INCLUDE% or %PAT H%).
You may use ' .'  to search the "current" directory, however, this has several limitations. Click here for
further details.

Se a rch Sub d ire c to rie s
If this option is enabled, V will also search all subdirectories of the "In Directory". To search the entire C
drive, you would enable this option and enter "C:"  in In D ire c to ry .

Se a rch Ins id e  Archive s
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If this is enabled, V will also search the contents of any ZIP file that it encounters. Click here for further
details on Searching ZIP Files.
You can limit the types of archives that are searched in the Advanced tab.

Inc lud e  Alte rna te  Da ta  Stre a ms (ADS)
If this is enabled, V will also search Alternate Data Streams. Note that you do not need to enable ADS
support to search ADS.
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Limit Se a rch to
If this is enabled, the In D ire c to ry  becomes disabled and the search is applied to one of the following:

Curre nt D ire c to ry : V will search the directory currently being viewed. 
Se le c te d
Dire c to rie s :

V will only search the directories that were highlighted (in the Directory View)
when the search was launched.

Unse le c te d
Dire c to rie s :

Same as above, except that the directories that were no t highlighted are
searched.

You may further narrow the search by also specifying several Advanced Search Criteria.

Eve ry thing  Se a rch

If Everything Search is installed (and running) on your system, an E v e ry thing  S e a rc h option will be
displayed just above the Search button. Click here for further details.
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19.3 Text Search (GREP)

The Text Search (GREP) searches the files specified by In fi le s  na me d  for the string in Se a rch fo r.
The search begins in the In D ire c to ry .

To search a ll fi le s , simply leave In fi le s  na me d  blank, or set it to *.*

You may specify a "file list" in the In fi le s  na me d  field. A file list is simply a text file which contains a list
of file names to be searched. When entering a file list, you must prefix the file name with "@", so V does
not confuse it with a mask. Click here for further details on file lists.

You may also search for multiple strings instead of a single string. Click here for details.

The search options (match case, hex, ...) are the same as those used when searching for text while
viewing a file.

Basically, the Text Search is the same as the File Search, except that the matching files are also
searched for the specified string. In particular, you can use the Advanced Search Criteria to further
reduce the scope of the files searched.

For example, you could limit the search to all files that were modified in the previous 60 minutes.

All matches will be displayed in the Results tab.

By enabling Limit Se a rch to , the search is limited to one of the following.

Enabling Ig no re  Bina ry  File s  will restrict the search to text files.

Click here for details on more GREP options.

Eve ry thing  Se a rch

If Everything Search is installed (and running) on your system, an E v e ry thing  S e a rc h option will be
displayed just above the Search button. Click here for further details.

Se a rch Limita tio ns

The text search is primarily used to search text files for strings.

In order for the text to be found in a file, it must be stored in the file as plain text. The text search will not
find the string if it is somehow compressed or not encoded as plain text (with the exception of searching
ZIP archives).

In particular, V can not search for text in PDF files.
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19.4 Limit Search to

If you enable the Limit Se a rch to  option, the In D ire c to ry  becomes disabled and the search is
applied to one of the following:

Curre nt D ire c to ry
V will search the directory currently being viewed. 

Se le c te d  File s
V will only search the files (and directories) that were highlighted (in the Directory View) when the search
was launched.

Unse le c te d  File s
Same as above, except that the entries that were no t highlighted are searched.

All File s  in Re sults
The search is applied to all the files in the Results List. That is, to all the files that matched the last
search.

Se le c te d  fi le s  in Re sults
The search is only applied to the files that are selected (highlighted) in the Results List.

Unse le c te d  fi le s  in Re sults
The inverse of the above option.

Curre nt File
The search is restricted to the file currently being viewed. This only makes sense if GREP was
selected while viewing a file.

Archive
This option is automatically selected if the GREP was initiated while viewing a ZIP file. The search will
be restricted to the contents of the ZIP file.

19.5 Using . for the Search Directory

A single dot (' .' ) can be used as the In D ire c to ry  to indicate that the "current" directory is to be
searched.

This will work in most cases, however, it may not work where the current directory is on a network drive.

To get around this problem, you should always use the Limit To->Current Directory option whenever
you want to search the current directory.



V Help File186

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

19.6 Advanced Search Criteria

If the Ad va nce d  button is pressed, the search dialog box is expanded to display some extra search
criteria which may be used to further narrow the scope of the search.

You may restrict the files searched by specifying a file size, date/time and/or file attributes. 

For example, you could search for all files modified today, all files that are over 2Mb, or even all files
that were modified today that are over 2Mb.  Simply enable the required advanced option and enter the
appropriate details.

Press the Ba s ic  button if you do not want to apply any advanced criteria to the search.

Exa mp le s
By using a combination of the advanced search criteria, you can perform some very powerful (and
useful) searches. For example, you could

1. Search for all files that were created today

2. Search for all ZIP files that are larger than 1Mb

3. Search for text in all CPP files that were modified in the last hour
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19.7 Searching ZIP Files

If the Se a rch Ins id e  Archive s  option is enabled, V will also search the contents of all ZIP files (and
other supported archives) when doing a File or Text search.

If any ZIP files are encountered while searching, V will open the ZIP file and search its contents for the
specified file/text. You can limit what archives are searched in the Advanced tab.

Limita tio ns

Unfortunately, ZIP file searching has several limitations. These are:

V d o e s no t se a rch a rchive s  ins id e  a rchive s
V will not recursively search inside archives. For example, it will not search a ZIP file which itself is
contained inside a ZIP file. This also means that V cannot search the contents of .tg z and .ta r.g z files.

Yo u ca nno t se a rch fo r d ire c to rie s  ins id e  a rchive s
You can only search for files inside archives. If an archive contains files in several directories, you will
not get any matches if you search for the directory names.

Se a rching  e ncryp te d  a rchive s
When searching for text, V will not search encrypted (password protected) archives. However, it will
search encrypted archives when searching for file names. This is because encrypted archives don't
actually encrypt the file names - only the file contents.

Ca nno t se a rch a ll ZIP fi le s  b y  sp e c ify ing  *.zip
You cannot search for text in multiple ZIP files by entering the text in Se a rch fo r  and *.zip  in In fi le s
na me d .

Doing this will cause V to look for all *.zip  files in the search directory - it will not restrict the search to
*.zip . The best way to understand this is to think of an archive as a special type of fo ld e r inside the
current directory - not as a file.

If you want to search for text inside all ZIP files, you will have to leave In fi le s  na me d  blank (or *.*), and
enable S e a rc h Ins id e  A rc hiv e s. However, this will search a ll files in the search directory, not just the ZIP
files.
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19.8 Searching a List of Files

When searching for text, you may always want to search a particular group of files, instead of  searching
an entire directory. These files may be in the same directory, or could be scattered all over your disk
(or network).

V lets you search such a list of files by specifying a fi le  l is t in the In fi le s  na me d  field of the Text
Search (GREP) section.

A "file list" is simply a text file where each line consists of a file name.

Instead of specifying a file mask (like *.*, or *.cpp), you may specify a file list by entering a "@" followed
by the file name. For example, "@ File Lis t.d a t".

V will then search all files in "FileList.dat" for the specified text.

If you do not specify a fully qualified path name for the file list, V will look for it in the directory specified in
the "In Directory" field.

If the file names in the file list do not include a directory, V will look for them in the "In Directory". If any of
the specified files in the files list do not exist in the "In Directory" and the "Search Subdirectories" option
is enabled, V will continue searching any subdirectories to find the files. Note that once it finds the file, it
will not continue searching subdirectories for other files with the same name.

Se a rching  Unico d e  File  Na me s
If you want to search Unicode file names (eg, containing foreign characters), the file list must be saved
in UTF8 format, and the UTF8 Byte Order Marker (BOM) must be present. The Save As UTF8 option on
Notepad will produce such files. The search will not work if you save the file list as UTF-16.

No te

You may include comments in a file list by beginning a line with a semi-colon (;).
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19.9 Multiple String Searching

By default, GREP allows you to search multiple files for a single string.

V also lets you specify multiple strings to search for. For example, you can search all files on your PC
for the strings "Virus" or "Worm". The search is done in a single pass, so it is much quicker to do a
single multiple search than it is to do multiple single searches.

Note that the search is an OR search - not an AND search. That is, it will match any one of the strings
specified. If you want to find all files that contain String1 AND also contain String2, you have to do a
single search for String1, and then do a search for String2 limiting the search
to the results of the first search.

Ho w to  se a rch fo r multip le  s tring s
In order to search for multiple strings, you need to create a file which contains one search string per line
of the file.

If a line starts with a semi-colon (;) it is ignored, so you can use this to place comments in your search
file to make it more readable.

To enable multiple string searching, you will need to select the new "Advanced" tab and enable the "@
Prefix" option. This tells V that if the "Search for" string begins with a "@", it is treated as a file name
containing search strings. For example, "@C:\Search\Strings.txt".

Multip le  Se a rch Op tio ns
The search options (match case, whole word, ...) apply to *all* the strings in the file. You cannot have
different options for different search strings. Also, "regular expressions" can not be used for multiple
searches.

You can specify the search options to be used for the strings in the search file itself. If you do this, the
search options on the GREP dialog box are ignored and are replaced by the options specified in the
file.

If the first non-comment line in your search string file begins with a colon (":"), the characters that follow
specify the search options to use for the search.

This overcomes the problem of forgetting to change any options when selecting a new search string
file. In particular, you can specify that the file consists entirely of binary strings without having to
remember to enable the Binary Option.

The valid characters after the colon are:
 
C Match Case
W Word Only
H Hex/Binary
U Unicode
E EBCDIC

For example, to specify that the file consists of binary strings, you would include
:H

as the first non comment line in the file.

If you didn't want *any* of the search options enabled, you would simply include a line consisting of a
single colon.
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Se a rching  fo r Unico d e  String s
If you want to search for Unicode strings (eg, containing foreign characters), the strings file must be
saved in UTF8 format, and the UTF8 Byte Order Marker (BOM) must be present. The Save As UTF8
option on Notepad will produce such files.

Limita tio ns
There are several limitations on multiple string searching:

You cannot search for regular expressions
You cannot do a column search

19.10 File Size

This option is used to search for files based on their size.

The size may be specified in Byte s , Kb , Mb  or Gb  by selecting the appropriate size type from the
drop-down list box.

Note that V defines 1K as 1024 bytes, not 1000.

You also need to select the type of size comparison, which can be one of:

At le a st (>=)
This will match all files that are a t le a st as large as the size specified.

At mo st (<=)
Will match all files whose size is no t la rg e r than the size specified.

Exa ctly  (=)
Will match all files whose size is e xa ctly  the size specified.

For example, you could use this option to find all files of zero size, or all files that are greater than 2Mb.
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19.11 File Date

This option is used to search for files based on their date/time.

The date/time can refer to one of the following times:

Mo d ifie d
The time the file was last modified. 

Acce sse d
The time the file was last accessed.

Cre a te d
The time the file was created.

You then need to specify a date by selecting one of:

T o d a y
Will match all files with today's date

Be twe e n
Will match all files that are between the 2 dates you enter (including the 2 end dates). If you leave the
second date blank, all files since the first date will be matched.

Pre v io us
You need to further enter a time period which can be specified in either minute s , ho urs , d a ys,
mo nths  or ye a rs .

If you enable the Inve rt option, the date comparison is reversed. That is, all files no t matching the file
date will be matched.

For example, if you enable Inve rt while T o d a y is selected, all files that were no t modified today will
be matched. If you select "Pre v io us 1 ye a r" and enable Inve rt, all files that were no t modified in the
last year will be matched.

No te s

The Accessed and Created dates will only work if they are supported by the file system. In
particular, FAT partitions created under DOS do not support these times.

You can use the Accessed time to determine what files have not been accessed for a certain
period of time (like say a year), thereby making it easy to delete any files that are no longer in
use. 

(You would do this be enabling File Date and then selecting Accessed, Previous, 1 Year and
checking Invert).
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19.12 File Attributes

This option is used to search for files based on their attributes.

Each individual attribute may have one of 3 states. If it is enabled (with a tick in it), V will only match files
that have that attribute set. If the attribute is not set (no tick in it), V will match all files that do not have the
particular attribute set. 

By default, the attributes are "grayed", indicating a "don't care". This means that V doesn't care about
this attribute and will not use it in deciding whether to match the file.

Exa mp le s

To find all read-only files, the "Read-Only" attribute should be checked and all other attributes should
be grayed.

If you only wanted to display directory names (not file names), you would check the "Directory" attribute
and leave all others grayed.

19.13 Search Options

The Options tab allows you to specify several search options that control how far you want the 
search to go.

In each case, you must enable the option and specify a number (referred to as "n", below).

The options are: 

Only  d isp la y  firs t "n"  fi le  ma tche s in e a ch d ire c to ry
Usually, a File Search will match all files it finds. By enabling this option V will stop searching a directory
once it finds "n" matches. 

Only  d isp la y  firs t "n"  te xt ma tche s in e a ch fi le
By default, a Text Search will search the entire file to find all text matches. By enabling this option, V will
stop searching the file once it finds "n" matches. 

Only  d isp la y  firs t "n"  te xt ma tche s in e a ch d ire c to ry
V will search all files in a directory for the specified text. By enabling this option, V will stop searching
the directory once it has matched text in "n" files. 

Sto p  a fte r "n"  ma tche s in T OT AL
By enabling this option, V will stop searching once it has found "n" matching files. 

Inc lud e  in Co p ie d  T e xt
Select whether you want the File  Pa th and/or the Line  numb e r/o ffse t included when the search
results are copied/saved.
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19.14 Advanced Options

This tab contains the following options:

Ena b le  @ Pre fix in T e xt Se a rch
Enable this option to enable multiple string searching. This will cause any string beginning with "@" to
be treated as a file name instead of a search string. If this is enabled and you want to search for a string
that starts with "@", simply prefix it with a backslash ("\@").

Auto ma tica lly  Se a rch EBCDIC fi le s
You should enable this option if you want EBCDIC files to be searched. If you do not enable this option,
EBCDIC files will be treated as ASCII binary files (instead of EBCDIC text files). Note that enabling this
option will most likely increase the search time.

Do  no t se a rch Co mp a tib il ity  File s  (Vis ta /W in7)
Enable this if you do not want any corresponding Compatibility Files searched.

Se a rch the  fo llo wing  e xte ns io ns whe n Se a rching  Ins id e  Archive s
If the S e a rc h Ins id e  A rc hiv e s option is enabled, V will search all supported archives, including EXE files
(to see if they are self extracting archives). You can enter a list of file extensions here to limit the
archives that V will search. For example, if you didn't want EXE files to be searched, remove EXE from
the file list.

Sa ve  the  na me s o f the  fi le s  tha t co uld  no t b e  se a rche d  to :
V can sometimes fail to open a file that it needs to search when doing a GREP. For example, it may be
a system file that it does not have permission to open.

If this option is enabled, V will write the name of the file(s) that it cannot search to the specified file.
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19.15 Displaying the Search Results

As soon as the search is started, V will switch to the Results tab in order to display the matches. The
ST OP button on the toolbar will flash while the search is in progress.

The Results tab is very much like the directory listing in the Directory View. It will display the search
results as a table consisting of several columns (file name, date, size, ...).

You may choose which columns to display by right-clicking on the column header and selecting the
appropriate columns.

You may also operate on files in the Results tab much the same way as you operate on files in the
Directory View (view, copy, delete, print, execute, ...).

The Results tab for a Text Search is different from a File Search in that it also displays details of the
lines found containing the matching text.

For a Text Search, the Results tab will contain one entry for e a ch line  that matches the specified text.
The entry will include the matching line and the corresponding line number (or file offset).

Re s izing  the  co lumn wid ths
The columns in the Results tab may be re-sized by clicking between the column headers (just as in the 
Directory View).

The columns may also be "auto-sized" by selecting Auto -Size  Co lumns from the Vie w menu, or by
pressing Ctrl-Plus (on the numeric keypad).

See also Sorting the Results and Removing Results.
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19.16 Sorting the Results

The results of the search are displayed in the Results tab in the order that they are found - that is they
are no t so rte d  in any particular way.

You may ma nua lly  sort the results by clicking on the appropriate column header or by selecting the
column from the Vie w->So rt menu.

However, if the results are sorted while the search is still in progress, any new results will be added to
the e nd  of the list (and therefore the entire list will no longer be sorted).

To re-sort the list, simply click on the column header again.

19.17 Removing Results

When doing a search, you might find more matches than you anticipated.

If you are not interested in some of the matches, you can remove them from the list by right-clicking on
the selected matches and selecting Re mo ve  fro m Lis t.

Note that this does not delete the corresponding file.

19.18 Saving the Search Results

The results of a text search may be saved to the clipboard or to a file by selecting the appropriate
option from the Co p y Se a rch Re sults  menu (off the File menu).

You may save ALL the results or just the selected ones.

Each search result will be saved as one line in the following format:

Filename, line number: text

For example,

C:\Directory\File.html,1: <HTML>

You may remove the file name and/or line number from the line by setting the appropriate option in the 
Search Options.
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19.19 Cancelling/Pausing the Search

The ST OP button on the toolbar will flash while the search is in progress. Pressing the STOP button will
terminate the search. 

Note that you can change the search tab while the search is in progress. For example, you can change
from the Results tab to the File Search tab and back to the Results tab without disturbing the search. 

You may also go back to V and continue viewing other files while the search is in progress. 

Pa us ing  the  Se a rch

The search may now be paused by right clicking on the STOP button and selecting "Pause". 

19.20 GREP Favorites

The Find Files/GREP dialog contains a small Fa v o rite s  S e a rc he s button (below the Exit button) which
behaves just like the Favorite Searches button in the Search Bar.

By clicking on this button and selecting A d d  S e a rc h, the current search is added to the list of GREP
Favorites.

The user can them perform this search by clicking on the Fa v o rite  S e a rc he s button and selecting the
search from the list. Note that the search does not automatically start when the Favorite Search is
selected - the user must still press the Search button. This gives the user the opportunity to further
modify the search.

Org a nize /Co nfig ure can be selected from the Favorite Searches menu to modify a search or to
customize the menu.

Organizing Favorite Searches is very similar to Organizing Favorites.

A search may be moved to a new position by simply dragging it and dropping it into its new position.

Searches may be created by pressing the Ins e rt F ile  S e a rc h or Ins e rt T e xt S e a rc h buttons. Press the
Ins e rt button and select Co p y to create a copy of the currently highlighted search. Select  S e p a ra to r  to
insert a separator into the Favorite Searches menu.

Org a nizing  into  Sub me nus
If you want to save many searches, you will probably find it useful to organize them into submenus. To
create a new submenu, press the Insert button and select S ub m e nu.

To move a search into an empty submenu, simply drop it onto the submenu name. If the submenu is not
empty, it will expand so you can drop the search into the required position. The dropped search will be
placed *before* the entry it is dropped on. If you want to place the search at the *end* of the submenu,
drop it onto the submenu name you want it placed under.

If you want to move a search so that it is positioned just before a submenu, you need to press the
SHIFT key as you drop the search onto the submenu you want it to precede. If you do not press the
SHIFT key, the search will be placed inside the submenu.

Pressing the Mo re  button displays a menu that allows you to sort, export and import.
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No te : You cannot create a submenu within a submenu.

19.21 Sorting GREP Favorites

Pressing the M o re button and selecting the S o rt option will display a dialog box, allowing you to sort the
GREP Favorites.

By default, the Favorites will be sorted alphabetically on their description, regardless of whether  they
are a file search, a directory search or a submenu. The following options can be set to modify the
default behavior.

Pla ce  File  se a rche s b e fo re  D ire c to ry  se a rche s
If this is enabled, all files will be placed at the top of the list.

Pla ce  D ire c to ry  se a rche s b e fo re  File  se a rche s
Enable this to place all directories at the top of the list.

Pla ce  Sub me nus a t to p
Enable this, to place all submenus at the top.

Pla ce  Sub me nus a t b o tto m
Enable this, to place all submenus at the bottom.

So rt Sub me nu co nte nts
By default, submenu contents will not be sorted. Enable this option to also sort submenus.

19.22 Exporting/Importing GREP Favorites

Pressing the M o re button and selecting the E xp o rt option will display a dialog box allowing the GREP
Favorites to be exported to a file.

The exported file can then be imported by another user by selecting the Im p o rt option and specifying
the imported file.
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19.23 What does GREP mean?

Searching a group of files for a text string (or pattern) is widely referred to as GREP.

This name originated in the Unix world. The Unix editor e d  allowed you to print all lines containing a
specified pattern by using the following command:

g/re/p

g  stands for g lo b a l (ie, search the entire file)
re  refers to a re g ula r e xp re ss io n
p  specifies p rint (ie, print the results)

Therefore, you could say that GREP stands for Global Regular Expression Print.

Click here for an explanation of regular expressions.
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20 Support for Everything Search

20.1 Everything Search

Everything Search (ES) is a fre e wa re search program that can find files and folders instantly: http://
www.voidtools.com/

If ES is installed (and running) on your system, V gives you the option of using it to perform the search
(by enabling E v e ry thing  S e a rc h just above the Search button). As an indication as to how fast ES is,
searching my 500GB drive for all .b a k files found 1225 files in 86 seconds with ES disabled. With ES
enabled, the same search took under one second!

Note that ES only searches NTFS formatted drives (FAT32 is not supported) and it only searches for
file names (it does not search file contents).

Please refer to the ES web site for further details: http://www.voidtools.com/

If you want to try ES, please download the latest release from the Anno unce me nts  section of the ES
forum. Do  no t d o wnlo a d  the version that is linked to on the home page.

http://www.voidtools.com/
http://www.voidtools.com/
http://www.voidtools.com/
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20.2 Using ES for Text Searches

The E v e ry thing  S e a rc h option is available for both file and text searches (if ES is installed on your
system). However, when doing a te xt search, ES is only used to locate the files to be searched. It is not
used to search the file contents.

If you were searching for text in all .log files in the c urre nt d ire c to ry, you wouldn't see much of a speed
improvement by using the ES option.

However, if you wanted to search a ll the .log files on your disk, using the ES option could speed up the
search considerably.

No te

Enabling the Everything Search option does not automatically mean that you will be searching 
e ve ry thing . The search is still limited to the In D ire c to ry .  If you want to search e ve ry thing , you need
to leave the In D ire c to ry e mp ty .

20.3 Using ES Masks in Searches

ES has its own syntax for specifying file masks. Not only can you specify a simple file mask (like *.jpg),
but you can also create fairly complicated masks using boolean operators and regular expressions.

V d o e s no t sup p o rt the ES syntax for file masks (and vice versa).

For example, to search for .bmp and .jpg files with V, you would use a mask of *.bmp,*.jpg, whereas

with ES you would use *.b mp |*.jp g . When the ES option is enabled, V will try to convert the specified
file mask into a format that ES can understand, however, it may not always be able to do this.

If you want to use anything but a simple file mask with the ES option enabled, it is recommended that
you specify the file mask using the appropriate ES syntax - and prefix the mask with a co lo n (:). This
tells V to pass the mask to ES unmodified.

For example, you can use the following mask in ES to search for all .jpg files that begin with 1 or 2: 
re g e x:^ [12] .*.jp g $. To use this mask in V (in the Named field of a search), you should prefix it with a
colon. That is, use :re g e x:^ [12] .*.jp g $

Note that ES file masks (prefixed by a colon) can only be used when the ES option is enabled.

Pa rtia l Na me  Ma tch

All ES searches are p a rtia l na m e  m a tc h searches (even if A llo w P a rtia l M a tc h is not enabled). For
example, searching for thing  with ES will match files like e v e ry thing, s o m e thing .d a t and no thing .d o c,
whereas V will only match thing . If you want to search for an e xa c t file name with ES, you will have to
enable the R e g ula r E xp re s s io n option and use a ^  and $ to indicate the start and end of the file name.
For example to find all files named thing , you would need to search for ^ thing $ (with R e g ula r
E xp re s s io n enabled).

No te

The same mask can mean different things to V and ES. If you find that ES searches are returning
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unexpected results, please check that the mask being used is a valid ES mask. You should check it by
entering it directly into E v e ry thing  S e a rc h to make sure it will work as expected.

20.4 ES and UAC

ES requires administrator privileges to run.

This means that if you are running Vista or Windows 7, you will probably receive a UAC prompt when
you run ES. The FAQ section of the ES web site describes how you can disable the UAC prompt.

Since V is usually not running with administrator privileges, you will also receive a UAC prompt every
time you do a ES search with V. However, if you have V installed in the System Tray, you will only
receive a UAC prompt the very first time you do a ES search with V. Subsequent ES searches with the
same tray instance of V will not display the UAC prompt.
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21 Regular Expressions

21.1 Regular Expressions

In their most basic form, regular expressions are a simple search string (or pattern).

However, special characters (operators) can be used that turn regular expressions into very powerful
(and sometimes very complex) search mechanisms.

For example, you could use regular expressions to search for:

A string beginning with A or B and ending with 0 or 9: "[AB].*[09]"

A blank line: "^$"

A full stop at the very end of a line: "\.$"

A string of at least 5 zeros: "0{5,}"

A word of 7 characters: "\b\w{7}\b"

A line that starts and ends with the same character: "^(.).*\1$"

A line that starts and ends with the same word: "^(\w+)\b.*\b\1$"

A line that does not contain "string": "^((?!string).)*$"

Regular expressions in V are implemented using the PCRE library, written by Philip Hazel.

PCRE implements a Perl-like syntax for regular expression which differs slightly from the more
traditional Unix-like syntax. However, for most operations, the two are the same.

The description of regular expressions in this Help file is largely derived from the PCRE
documentation.

The regular expression documentation may also be viewed in HTML format at:

http://www.fileviewer.com/Regexp.html

This URL also contains a few links to other regular expression resources on the web.

21.2 Implementation and Limitations

The implementation of regular expressions in V is line based. That is, regular expressions are
searched for line by line.

This means that you cannot search for something that spans more than one line. For example,
searching for "123\nABC" will never work.

The "Binary (Hex)" option is disabled when using regular expressions. If you want to search for binary
data, you will have to use the regular expression notation for hex data (eg, \xff).

You may still search for regular expressions containing binary data (eg, " \xff.*\xff" ), however, since the

http://www.pcre.org/
http://www.fileviewer.com/Regexp.html
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search is line based, a match will never contain a newline character (CR or LF), or a form feed character
(hex 0C).

Note that this is a limitation of the V implementation, and not of the PCRE library.

21.3 Differences from Perl

The following section is probably only of interest to experienced Perl users.

The PCRE library is a set of functions that implement regular expression pattern matching using the
same syntax and semantics as Perl 5, with just a few differences (see below). The current
implementation corresponds to Perl 5.005.

The differences are:

1. By default, a whitespace character is any character that the C library function isspace() 
recognizes, though it is possible to compile PCRE with alternative character type tables.
Normally isspace() matches space, formfeed, newline, carriage return, horizontal tab, and
vertical tab. Perl 5 no longer includes vertical tab in its set of whitespace characters. The \v
escape that was in the Perl documentation for a long time was never in fact recognized.
However, the character itself was treated as whitespace at least up to 5.002. In 5.004 and 5.005 it
does not match \s.

2. PCRE does not allow repeat quantifiers on lookahead assertions. Perl permits them, but they do
not mean what you might think. For example, (?!a){3} does not assert that the next three
characters are not "a". It just asserts that the next character is not "a" three times.

3. Capturing subpatterns that occur inside negative lookahead assertions are counted, but their
entries in the offsets vector are never set. Perl sets its numerical variables from any such
patterns that are matched before the assertion fails to match something (thereby succeeding),
but only if the negative lookahead assertion contains just one branch.

4. Though binary zero characters are supported in the subject string, they are not allowed in a
pattern string because it is passed as a normal C string, terminated by zero. The escape
sequence "\0" can be used in the pattern to represent a binary zero.

5. The following Perl escape sequences are not supported: \l, \u, \L, \U, \E, \Q. In fact these are
implemented by Perl's general string-handling and are not part of its pattern matching engine.

6. The Perl \G assertion is not supported as it is not relevant to single pattern matches.

7. Fairly obviously, PCRE does not support the (?{code}) construction.

8. There are at the time of writing some oddities in Perl 5.005_02 concerned with the settings of
captured strings when part of a pattern is repeated. For example, matching "aba" against the
pattern /^(a(b)?)+$/ sets $2 to the value "b", but matching "aabbaa" against /^(aa(bb)?)+$/
leaves $2 unset. However, if the pattern is changed to /^(aa(b(b))?)+$/ then $2 (and $3) get set.

In Perl 5.004, $2 is set in both cases, and that is also true of PCRE. If in the future Perl changes to
a consistent state that is different, PCRE may change to follow.

9. Another as yet unresolved discrepancy is that in Perl 5.005_02 the pattern /^(a)?(?(1)a|b)+$/
matches the string "a", whereas in PCRE it does not. However, in both Perl and PCRE /^(a)?a/
matched against "a" leaves $1 unset.

10.Although lookbehind assertions must match fixed length strings, each alternative branch of a
lookbehind assertion can match a different length of string. Perl 5.005 requires them all to have
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the same length.

21.4 Regular Expression Details

A regular expression is a pattern that is matched against a subject string from left to right. Most
characters stand for themselves in a pattern, and match the corresponding characters in the subject. As
a trivial example, the pattern

T he  q uick  b ro wn fo x

matches a portion of a subject string that is identical to itself. The power of regular expressions comes
from the ability to include alternatives and repetitions in the pattern. These are encoded in the pattern
by the use of meta-characters , which do not stand for themselves but instead are interpreted in some
special way.

There are two different sets of meta-characters: those that are recognized anywhere in the pattern
except within square brackets, and those that are recognized in square brackets.

Outs id e  sq ua re  b ra cke ts , the meta-characters are as follows:

\ general escape character with several uses
^ assert start of subject
$ assert end of subject
. match any character
[ start character class definition
| start of alternative branch
( start subpattern
) end subpattern
? extends the meaning of (

also 0 or 1 quantifier
also quantifier minimizer

* 0 or more quantifier
+ 1 or more quantifier
{ start min/max quantifier

Part of a pattern that is in sq ua re  b ra cke ts  is called a character class. In a character class the only
meta-characters are:

\ general escape character
^ negate the class, but only if the first character
- indicates character range
] terminates the character class

The following sections describe the use of each of the meta-characters.
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21.5 Backslash

The backslash character has several uses. Firstly, if it is followed by a non-alphanumeric character, it
takes away any special meaning that character may have. This use of backslash as an escape
character applies both inside and outside character classes.

For example, if you want to match a "*" character, you write "\ *" in the pattern. This applies whether or
not the following character would otherwise be interpreted as a meta-character, so it is always safe to
precede a non-alphameric with "\" to specify that it stands for itself. In particular, if you want to match a
backslash, you write "\\".

A second use of backslash provides a way of encoding non-printing characters in patterns in a visible
manner. There is no restriction on the appearance of non-printing characters, apart from the binary zero
that terminates a pattern, but when a pattern is being prepared by text editing, it is usually easier to use
one of the following escape sequences than the binary character it represents:

\a alarm, that is, the BEL character (hex 07)
\cx "control-x", where x is any character
\e escape (hex1B)
\f formfeed (hex 0C)
\n newline (hex 0A)
\r carriage return (hex 0D
\t tab (hex 09)
\xhh character with hex code hh
\ddd character with octal code ddd, or backreference

The precise effect of "\cx" is as follows: if "x" is a lower case letter, it is converted to upper case. Then
bit 6 of the character (hex 40) is inverted. Thus "\cz" becomes hex 1A, but "\c{" becomes hex 3B, while
"\c;" becomes hex 7B.

After "\x", up to two hexadecimal digits are read (letters can be in upper or lower case).

After "\0" up to two further octal digits are read. In both cases, if there are fewer than two digits, just those
that are present are used. Thus the sequence "\0\x\07" specifies two binary zeros followed by a BEL
character. Make sure you supply two digits after the initial zero if the character that follows is itself an
octal digit.

The handling of a backslash followed by a digit other than 0 is complicated. Outside a character class,
PCRE reads it and any following digits as a decimal number. If the number is less than 10, or if there
have been at least that many previous capturing left parentheses in the expression, the entire
sequence is taken as a back reference. A description of how this works is given later, following the
discussion of parenthesized subpatterns.

Inside a character class, or if the decimal number is greater than 9 and there have not been that many
capturing subpatterns, PCRE re-reads up to three octal digits following the backslash, and generates a
single byte from the least significant 8 bits of the value. Any subsequent digits stand for themselves.
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For example:

\040 is another way of writing a space
\40 is the same, provided there are fewer than 40 previous capturing subpatterns
\7 is always a back reference
\11 might be a back reference, or another way of writing a tab
\011 is always a tab
\0113 is a tab followed by the character "3"
\113 is the character with octal code 113 (since there can be no more than 99 back references)
\377 is a byte consisting entirely of 1 bits
\81 is either a back reference, or a binary zero followed by the two characters "8" and "1"

Note that octal values of 100 or greater must not be introduced by a leading zero, because
no more than three octal digits are ever read.

All the sequences that define a single byte value can be used both inside and outside character
classes. In addition, inside a character class, the sequence "\b" is interpreted as the backspace
character (hex 08). Outside a character class it has a different meaning (see below).

The third use of backslash is for specifying generic character types:

\d any decimal digit
\D any character that is not a decimal digit
\s any whitespace character
\S any character that is not a whitespace character
\w any "word" character
\W any "non-word" character

Each pair of escape sequences partitions the complete set of characters into two disjoint sets. Any
given character matches one, and only one, of each pair.

A "word" character is any letter or digit or the underscore character, that is, any character which can be
part of a Perl "word".

These character type sequences can appear both inside and outside character classes. They each
match one character of the appropriate type. If the current matching point is at the end of the subject
string, all of them fail, since there is no character to match.

The fourth use of backslash is for certain simple assertions. An assertion specifies a condition that has
to be met at a particular point in a match, without consuming any characters from the subject string. The
use of subpatterns for more complicated assertions is described below. The backslashed assertions
are

\b word boundary
\B not a word boundary

These assertions may not appear in character classes (but note that "\b" has a different meaning,
namely the backspace character, inside a character class).

A word boundary is a position in the subject string where the current character and the previous
character do not both match \w or \W (i.e. one matches \w and the other matches \W), or the start or end
of the string if the first or last character matches \w, respectively.
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21.6 Circumflex and Dollar

Outside a character class, in the default matching mode, the circumflex character (^) is an assertion
which is true only if the current matching point is at the start of the subject string. Inside a character class,
circumflex has an entirely different meaning (see below).

Circumflex need not be the first character of the pattern if a number of alternatives are involved, but it
should be the first thing in each alternative in which it appears if the pattern is ever to match that branch.
If all possible alternatives start with a circumflex, that is, if the pattern is constrained to match only at the
start of the subject, it is said to be an "anchored" pattern. (There are also other constructs that can
cause a pattern to be anchored.)

A dollar character ($) is an assertion which is true only if the current matching point is at the end of the
subject string, or immediately before a newline character that is the last character in the string (by
default). Dollar need not be the last character of the pattern if a number of alternatives are involved, but
it should be the last item in any branch in which it appears. Dollar has no special meaning in a character
class.

21.7 Full Stop (period, dot)

Outside a character class, a dot (.) in the pattern matches any one character in the subject, including a
non-printing character, but not (by default) newline. The handling of dot is entirely independent of the
handling of circumflex and dollar, the only relationship being that they both involve newline characters.
Dot has no special meaning in a character class.
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21.8 Square Brackets

An opening square bracket ([) introduces a character class, terminated by a closing square bracket (]).
A closing square bracket on its own is not special. If a closing square bracket is required as a member
of the class, it should be the first data character in the class (after an initial circumflex, if present) or
escaped with a backslash.

A character class matches a single character in the subject; the character must be in the set of
characters defined by the class, unless the first character in the class is a circumflex, in which case the
subject character must not be in the set defined by the class. If a circumflex is actually required as a
member of the class, ensure it is not the first character, or escape it with a backslash.

For example, the character class [aeiou] matches any lower case vowel, while [^aeiou] matches any
character that is not a lower case vowel. Note that a circumflex is just a convenient notation for
specifying the characters which are in the class by enumerating those that are not. It is not an assertion:
it still consumes a character from the subject string, and fails if the current pointer is at the end of the
string.

When caseless matching is set, any letters in a class represent both their upper case and lower case
versions, so for example, a caseless [aeiou] matches "A" as well as "a", and a caseless [^aeiou] does
not match "A", whereas a caseful version would.

The minus/ hyphen character (-) can be used to specify a range of characters in a character class. For
example, [d-m] matches any letter between d and m, inclusive. If a minus character is required in a
class, it must be escaped with a backslash or appear in a position where it cannot be interpreted as
indicating a range, typically as the first or last character in the class.

It is not possible to have the literal character "]" as the end character of a range. A pattern such as [W-]
46] is interpreted as a class of two characters ("W" and "-") followed by a literal string "46]", so it would
match "W46]" or "-46]". However, if the "]" is escaped with a backslash it is interpreted as the end of
range, so [W-\]46] is interpreted as a single class containing a range followed by two separate
characters. The octal or hexadecimal representation of "]" can also be used to end a range.

Ranges operate in ASCII collating sequence. They can also be used for characters specified
numerically, for example [\000-\037]. If a range that includes letters is used when caseless matching is
set, it matches the letters in either case. For example, [W-c] is equivalent to [][\^_`wxyzabc], matched
caselessly.

The character types \d, \D, \s, \S, \w, and \W may also appear in a character class, and add the
characters that they match to the class. For example, [\dABCDEF] matches any hexadecimal digit. A
circumflex can conveniently be used with the upper case character types to specify a more restricted
set of characters than the matching lower case type. For example, the class [^\W_] matches any letter
or digit, but not underscore.

All non-alphanumeric characters other than \, -, ^ (at the start) and the terminating ] are non-special in
character classes, but it does no harm if they are escaped.
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21.9 Vertical Bar (or)

Vertical bar characters are used to separate alternative patterns. For example, the pattern

gilbert|sullivan

matches either "gilbert" or "sullivan".

Any number of alternatives may appear, and an empty alternative is permitted (matching the empty
string). The matching process tries each alternative in turn, from left to right, and the first one that
succeeds is used. If the alternatives are within a subpattern (defined below), "succeeds" means
matching the rest of the main pattern as well as the alternative in the subpattern.
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21.10 Subpatterns

Subpatterns are delimited by parentheses (round brackets), which can be nested. Marking part of a
pattern as a subpattern does two things:

1. It localizes a set of alternatives. For example, the pattern

cat(aract|erpillar|)

matches one of the words "cat", "cataract", or "caterpillar". Without the parentheses, it would match
"cataract", "erpillar" or the empty string.

2. It sets up the subpattern as a capturing subpattern (as defined above). Opening parentheses are
counted from left to right (starting from 1) to obtain the numbers of the capturing subpatterns.

For example, if the string "the red king" is matched against the pattern

the ((red|white) (king|queen))

the captured substrings are "red king", "red", and "king", and are numbered 1, 2, and 3, respectively.

The fact that plain parentheses fulfill two functions is not always helpful. There are often times when a
grouping subpattern is required without a capturing requirement. If an opening parenthesis is followed
by "?:", the subpattern does not do any capturing, and is not counted when computing the number of
any subsequent capturing subpatterns.

For example, if the string "the white queen" is matched against the pattern

the ((?:red|white) (king|queen))

the captured substrings are "white queen" and "queen", and are numbered 1 and 2. The maximum
number of captured substrings is 99, and the maximum number of all subpatterns, both capturing and
non-capturing, is 200.

As a convenient shorthand, if any option settings are required at the start of a non-capturing subpattern,
the option letters may appear between the "?" and the ":". Thus the two patterns

(?i:saturday|sunday)   (?:(?i)saturday|sunday)

match exactly the same set of strings. Because alternative branches are tried from left to right, and
options are not reset until the end of the subpattern is reached, an option setting in one branch does
affect subsequent branches, so the above patterns match "SUNDAY" as well as "Saturday".
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21.11 Repetition

Repetition is specified by quantifiers, which can follow any of the following items:

a single character, possibly escaped
the d o t metacharacter
a character class
a back reference (see next section)
a parenthesized subpattern (unless it is  an  assertion  - see below)

The general repetition quantifier specifies a minimum and maximum number of permitted matches, by
giving the two numbers in curly brackets (braces), separated by a comma. The numbers must be less
than 65536, and the first must be less than or equal to the second.

For example:

z{2,4}

matches "zz", "zzz", or "zzzz". A closing brace on its own is not a special character. If the second number
is omitted, but the comma is present, there is no upper limit; if the second number and the comma are
both omitted, the quantifier specifies an exact number of required matches. Thus

[aeiou]{3,}

matches at least 3 successive vowels, but may match many more, while

\d{8}

matches exactly 8 digits. An opening curly bracket that appears in a position where a quantifier is not
allowed, or one that does not match the syntax of a quantifier, is taken as a literal character.

For example, {,6} is not a quantifier, but a literal string of four characters.

The quantifier {0} is permitted, causing the expression to behave as if the previous item and the
quantifier were not present.

For convenience (and historical compatibility) the three most common quantifiers have single-character
abbreviations:

* is equivalent to {0,}
+ is equivalent to {1,}
? is equivalent to {0,1}

It is possible to construct infinite loops by following a subpattern that can match no characters with a
quantifier that has no upper limit, for example:

(a?)*

Earlier versions of Perl and PCRE used to give an error at compile time for such patterns. However,
because there are cases where this can be useful, such patterns are now accepted, but if any repetition
of the subpattern does in fact match no characters, the loop is forcibly broken.
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By default, the quantifiers are "greedy", that is, they match as much as possible (up to the maximum
number of permitted times), without causing the rest of the pattern to fail. The classic example of where
this gives problems is in trying to match comments in C programs. These appear between the
sequences /* and */ and within the sequence, individual * and / characters may appear. An attempt to
match C comments by applying the pattern

/\*.*\*/

to the string

/* first command */  not comment  /* second comment */

fails, because it matches the entire string due to the greediness of the .* item.

However, if a quantifier is followed by a question mark, then it ceases to be greedy, and instead
matches the minimum number of times possible, so the pattern

/\*.*?\*/

does the right thing with the C comments. The meaning of the various quantifiers is not otherwise
changed, just the preferred number of matches.

Do not confuse this use of question mark with its use as a quantifier in its own right. Because it has two
uses, it can sometimes appear doubled, as in

\d??\d

which matches one digit by preference, but can match two if that is the only way the rest of the pattern
matches.

When a parenthesized subpattern is quantified with a minimum repeat count that is greater than 1 or with
a limited maximum, more store is required for the compiled pattern, in proportion to the size of the
minimum or maximum.

When a capturing subpattern is repeated, the value captured is the substring that matched the final
iteration. For example, after

(tweedle[dume]{3}\s*)+

has matched "tweedledum tweedledee" the value of the captured substring is "tweedledee". However,
if there /are nested capturing subpatterns, the corresponding captured values may have been set in
previous iterations. For example, after

/(a|(b))+/

matches "aba" the value of the second captured substring is "b".
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21.12 Back References

Outside a character class, a backslash followed by a digit greater than 0 (and possibly further digits) is
a back reference to a capturing subpattern earlier (i.e. to its left) in the pattern, provided there have
been that many previous capturing left parentheses.

However, if the decimal number following the backslash is less than 10, it is always taken as a back
reference, and causes an error only if there are not that many capturing left parentheses in the entire
pattern. In other words, the parentheses that are referenced need not be to the left of the reference for
numbers less than 10. See the section entitled "Backslash" above for further details of the handling of
digits following a backslash.

A back reference matches whatever actually matched the capturing subpattern in the current subject
string, rather than anything matching the subpattern itself. So the pattern

(sens|respons)e and \1ibility

matches "sense and sensibility" and "response and responsibility", but not "sense and responsibility".
If caseful matching is in force at the time of the back reference, then the case of letters is relevant. For
example,

((?i)rah)\s+\1

matches "rah rah" and "RAH RAH", but not "RAH rah", even though the original capturing subpattern is
matched caselessly.

There may be more than one back reference to the same subpattern. If a subpattern has not
actually been used in a particular match, then any back references to it always fail. For example, the
pattern

(a|(bc))\2

always fails if it starts to match "a" rather than "bc". Because there may be up to 99 back references, all
digits following the backslash are taken as part of a potential back reference number. If the pattern
continues with a digit character, then some delimiter must be used to terminate the back reference.

A back reference that occurs inside the parentheses to which it refers fails when the subpattern is first
used, so, for example, (a\1) never matches. However, such references can be useful inside repeated
subpatterns. For example, the pattern

(a|b\1)+

matches any number of "a"s and also "aba", "ababaa" etc. At each iteration of the subpattern, the back
reference matches the character string corresponding to the previous iteration. In order for this to work,
the pattern must be such that the first iteration does not need to match the back reference. This can be
done using alternation, as in the example above, or by a quantifier with a minimum of zero.
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21.13 Assertions

An assertion is a test on the characters following or preceding the current matching point that does not
actually consume any characters. The simple assertions coded as \b, \B, ^ and $ are described
above. More complicated assertions are coded as subpatterns. There are two kinds: those that look
ahead of the current position in the subject string, and those that look behind it.

An assertion subpattern is matched in the normal way, except that it does not cause the current
matching position to be changed. Lookahead assertions start with (?= for positive assertions and (?! for
negative assertions. For example,

\w+(?=;)

matches a word followed by a semicolon, but does not include the semicolon in the match, and

foo(?!bar)

matches any occurrence of "foo" that is not followed by "bar". Note that the apparently similar pattern

(?!foo)bar

does not find an occurrence of "bar" that is preceded by something other than "foo"; it finds any
occurrence of "bar" whatsoever, because the assertion (?!foo) is always true when the next three
characters are "bar". A lookbehind assertion is needed to achieve this effect.

Lookbehind assertions start with (?<= for positive assertions and (?<! for negative assertions. For
example,

(?<!foo)bar

does find an occurrence of "bar" that is not preceded by "foo". The contents of a lookbehind assertion
are restricted such that all the strings it matches must have a fixed length. However, if there are several
alternatives, they do not all have to have the same fixed length. Thus

(?<=bullock|donkey)

is permitted, but

(?<!dogs?|cats?)

causes an error at compile time. Branches that match different length strings are permitted only at the
top level of a lookbehind assertion. This is an extension compared with Perl 5.005, which requires all
branches to match the same length of string. An assertion such as

(?<=ab(c|de))

is not permitted, because its single top-level branch can match two different lengths, but it is acceptable
if rewritten to use two top-level branches:

(?<=abc|abde)

The implementation of lookbehind assertions is, for each alternative, to temporarily move the current
position back by the fixed width and then try to match. If there are insufficient characters before the
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current position, the match is deemed to fail. Lookbehinds in conjunction with once-only subpatterns
can be particularly useful for matching at the ends of strings; an example is given at the end of the
section on once-only subpatterns.
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Several assertions (of any sort) may occur in succession. For example,

(?<=\d{3})(?<!999)foo

matches "foo" preceded by three digits that are not "999". Furthermore, assertions can be nested in any
combination. For example,

(?<=(?<!foo)bar)baz

matches an occurrence of "baz" that is preceded by "bar" which in turn is not preceded by "foo".

Assertion subpatterns are not capturing subpatterns, and may not be repeated, because it makes no
sense to assert the same thing several times. If an assertion contains capturing subpatterns within it,
these are always counted for the purposes of numbering the capturing subpatterns in the whole pattern.
Substring capturing is carried out for positive assertions, but it does not make sense for negative
assertions.

Assertions count towards the maximum of 200 parenthesized subpatterns.
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21.14 Once-only Subpatterns

With both maximizing and minimizing repetition, failure of what follows normally causes the repeated
item to be re-evaluated to see if a different number of repeats allows the rest of the pattern to match.
Sometimes it is useful to prevent this, either to change the nature of the match, or to cause it fail earlier
than it otherwise might, when the author of the pattern knows there is no point in carrying on.

Consider, for example, the pattern \d+foo when applied to the subject line

123456bar

After matching all 6 digits and then failing to match "foo", the normal action of the matcher is to try again
with only 5 digits matching the \d+ item, and then with 4, and so on, before ultimately failing. Once-only
subpatterns provide the means for specifying that once a portion of the pattern has matched, it is not to
be re-evaluated in this way, so the matcher would give up immediately on failing to match "foo" the first
time. The notation is another kind of special parenthesis, starting with (?> as in this example:

(?>\d+)bar

This kind of parenthesis "locks up" the  part of the pattern it contains once it has matched, and a failure
further into the pattern is prevented from backtracking into it. Backtracking past it to previous items,
however, works as normal.

An alternative description is that a subpattern of this type matches  the string of characters that an
identical standalone pattern would match, if anchored at the current point in the subject string.

Once-only subpatterns are not capturing subpatterns. Simple cases such as the above example can
be thought of as a maximizing repeat that must swallow everything it can. So, while both \d+ and \d+?
are prepared to adjust the number of digits they match in order to make the rest of the pattern match, (?>
\d+) can only match an entire sequence of digits.

This construction can of course contain arbitrarily complicated subpatterns, and it can be nested.

Once-only subpatterns can be used in conjunction with lookbehind assertions to specify efficient
matching at the end of the subject string. Consider a simple pattern such as

abcd$

when applied to a long string which does not match it. Because matching proceeds from left to right,
PCRE will look for each "a" in the subject and then see if what follows matches the rest of the pattern. If
the pattern is specified as

.*abcd$

then the initial .* matches the entire string at first, but when this fails, it backtracks to match all but the last
character, then all but the last two characters, and so on. Once again the search for "a" covers the entire
string, from right to left, so we are no better off. However, if the pattern is written as

(?>.*)(?<=abcd)

then there can be no backtracking for the .* item; it can match only the entire string. The subsequent
lookbehind assertion does a single test on the last four characters. If it fails, the match fails immediately.
For long strings, this approach makes a significant difference to the processing time.
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21.15 Conditional Subpatterns

It is possible to cause the matching process to obey a subpattern conditionally or to choose between
two alternative subpatterns, depending on the result of an assertion, or whether a previous capturing
subpattern matched or not. The two possible forms of conditional subpattern are

(?(condition)yes-pattern)   (?(condition)yes-pattern|no-pattern)

If the condition is satisfied, the yes-pattern is used; otherwise the no-pattern (if present) is used. If there
are more than two alternatives in the subpattern, a compile-time error occurs.

There are two kinds of condition. If the text between the parentheses consists of a sequence of digits,
then the condition is satisfied if the capturing subpattern of that number has previously matched.
Consider the following pattern, which contains non-significant white space to make it more readable
and to divide it into three parts for ease of discussion: 

( \\( )?    [^()]+    (?(1) \\) )

The first part matches an optional opening parenthesis, and if that character is present, sets it as the first
captured substring. The second part matches one or more characters that are not parentheses. The
third part is a conditional subpattern that tests whether the first set of parentheses matched or not. If they
did, that is, if subject started with an opening parenthesis, the condition is true, and so the yes-pattern is
executed and a closing parenthesis is required. Otherwise, since no-pattern is not present, the
subpattern matches nothing. In other words, this pattern matches a sequence of non-parentheses,
optionally enclosed in parentheses.

If the condition is not a sequence of digits, it must be an assertion. This may be a positive or negative
lookahead or lookbehind assertion. Consider this pattern, again containing non-significant white space,
and with the  two alternatives on the second line:  

(?(?=[^a-z]*[a-z])
  \\d{2}[a-z]{3}-\\d{2}  |  \\d{2}-\\d{2}-\\d{2} )

The condition is a positive lookahead assertion that matches an optional sequence of non-letters
followed by a letter. In other words, it tests for the presence of at least one letter in the subject. If a letter
is found, the subject is matched against the first alternative; otherwise it is matched against the second.
This pattern matches strings in one of the two forms dd-aaa-dd or dd-dd-dd, where aaa are letters and
dd are digits.
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21.16 Searching Columns with Regular Expressions

The following is a small guide on how to use regular expressions to search for text in columns.

In many cases, using regular expressions can be quicker than doing a standard search with the 
Co lumn option enabled.

Consider the following examples:

Find  a  l ine  tha t ha s  a n A in co lumn 20

Use the following regular expression:

^.{19}A

The "^ "  refers to the beginning of a line and the " ."  refers to any character.  " {19} "  indicates that the
previous character must be matched 19  times. 
"^ .{19} "  will therefore match the first 19 characters in any line. Adding an A to the end of the expression
will match a line if the first 19 characters are followed by an A. In other words, if there is an A in column
20.

Note that if the search is successful, the first 20 characters in the line will be highlighted - not just the A in
column 20.

Find  a  l ine  tha t *d o e s no t* ha ve  a n A in co lumn 20

^.{19}[^A]

This is very similar to the previous expression, but " [^ A]"  will match any character that is not an A.
Therefore, the expression will match any line where the first 19 characters are not followed by an A.

Find  a  l ine  tha t d o e s no t ha ve  ABC s ta rting  a t co lumn 20

^.{19}(?!ABC)

Once again, the first part of the regular expression is the same as before ("^ .{19} ").

" (?!ABC)"  is a negative lookahead assertion. It doesn't match anything, but asserts that "ABC" should
*not* follow what has already  been matched.

Therefore, the above regular expression will match the first 19 characters in the line as long as they are
not followed by "ABC".

No te s

In the above examples, the Re g e x search option should be checked and the Co lumn search option
should be unchecked.

The above examples will not work on lines that contain tabs.

The above examples will only work on files whose lines are terminated with a CR/LF (or any
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combination thereof). They will not work on files with fixed length records (and no record delimiter).

21.17 Comments

The sequence (?# marks the start of a comment which continues up to the next closing parenthesis.
Nested parentheses are not permitted. The characters that make up a comment play no part in the
pattern matching at all.

21.18 Performance

Certain items that may appear in patterns are more efficient than others.

It is more efficient to use a character class like [aeiou] than a set of alternatives such as (a|e|i|o|u). In
general, the simplest construction that provides the required behaviour is usually the most efficient.

21.19 Author

PCRE was written by Philip Hazel.

PCRE is Copyright (c) 1997-2010 University of Cambridge. 

The latest PCRE source code can be downloaded from:

http://www.pcre.org/

http://www.pcre.org/
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22 GridLines

22.1 GridLines

A Grid  consists of vertical lines (Grid Line s) and column headings that can be displayed while viewing
a file. It behaves just like a ruler. It can be displayed at the top of the file and it can be floated over any
part of the file.

A Grid may be displayed by manually selecting it from the GridLines menu, or it can be automatically
loaded whenever a particular file is viewed.

The state of the current Grid can be toggled by pressing Ctrl+Shift+G or by selecting Toggle Grid from
the GridLines menu.

Note that GridLines are only useful when the data in the file consists of fixe d  le ng th re co rd s  which are
properly a lig ne d  into columns.

GridLines will not work on delimited files (or CSV files), where each field in a record is separated by a
delimiter (like a comma or a TAB). However, it is possible to use a program called T uFix to convert a
delimited file into a fixed record length file. The converted file can then be viewed in V with an
appropriate Grid.

Tufix can be downloaded from:

http://www.fileviewer.com/TuFix.html

Click on the following sections for further details on GridLines:

Creating Grids
Organizing Grids
Wrap Options
Automatically Loading Grids
Associating Grids with a File Extension
Exporting Grids
Importing Grids
Exporting Data to a CSV File

No te

GridLines can be printed by using %g in the header/footer

http://www.fileviewer.com/TuFix.html
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22.2 Creating Grids

To create a Grid, select Ed it/Cre a te  Grid  from the GridLines menu. This will display a blank Grid.
After making the necessary modifications, you need to save the Grid before exiting.

To make modifications, rig ht-c lick  on the Grid and select the desired option. The following options
are available:

Ad d  Grid  Line  He re
Right-click at the position where you want to add a Grid Line and select this option. You can then use
"Edit Column Name" to give the column a meaningful name. If you place the Grid Line at the incorrect
position, you can simply left-click on the end of the column and drag it to the required position.

Note that you can also add a Grid Line by Shift-Le ft-Click ing  at the required position.

Ed it Co lumn Na me
Right-click on the appropriate column, then enter the column name (followed by the Enter key). You can
leave the column name unchanged by pressing the ESCape key.

Ed it Co lumn Le ng th
Right-click on the column and enter the new length. In most cases it would be easier to set the column
length by simply left-clicking on the end of the column and dragging to the desired position.

Se le c t Fo nt
This lets you specify the Font to display the Column names. Note that all columns are displayed using
the same font.

Inse rt Co lumn
This always inserts a column of 10 characters just before the column that you right-click on. You can
then drag the new column to the required position. In most cases, it would be easier to use "Add Grid
Line Here".

De le te  Co lumn
Deletes the column that you right-click on.

H id e  Grid  Line s
This specifies that the vertical Grid Lines will not be drawn over the file. Only the Grid header will be
displayed.

Ce nte r Co lumn Na me s
The column names will be centered instead of starting at the left.

Se t Wra p  Op tio ns
This allows fixed length record files to automatically wrap to the correct record length when a Grid is
loaded. Click here for further details.

Sa ve
This saves the Grid.  If you are saving a newly created Grid (instead of an edited Grid), the Organize
Grid dialog will be displayed, allowing you to enter a name for the Grid. This name will appear on the
GridLines menu.

Sa ve  As
This lets you save the edited Grid with a new name. The Grid originally loaded will not be modified.
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Exp o rt
This lets you export the Grid to a .vgrid file. Click here for further details.
Note that exported Grids do not appear on the GridLines menu. If you want the Grid to also appear on
the GridLines menu, you will have select Organize/Configure from the GridLines menu and then import
the Grid.

Se t Exp o rt Da ta
This lets you specify additional data that will be exported to the .vgrid file.
Click here for further details.

Clo se  Me nu
Select this if you do not want to make a selection from the right-click menu.

Exit Ed it Mo d e
Terminates the Grid edit. If you have not saved a modified Grid, you will be asked if you want to save it
before exiting.

No te s

You can also maintain Grids by selecting Organize/Configure from the GridLines menu.

You can only create/edit a grid while you are viewing a file.

Unregistered versions of V cannot save grids that have more than 3 columns.

22.3 Organizing Grids

Select Org a nize /Co nfig ure  from the GridLines menu if you want to re-organize your Grids.

Note that the easiest way of creating a Grid is to select Cre a te  Grid  from the GridLines menu. The
easiest way of modifying a Grid is to first load it, and then to select Ed it Grid  from the GridLines menu.

Using the Organize option to modify a Grid does not give you visual feedback as you are making the
changes. You will need to exit the Organize dialog before any Grid modifications are displayed.

Organize/Configure is best used to make minor changes to the Grid, or to re-organize the Grids on the
GridLines menu.

Organizing Grids is very similar to Organizing Favorites. See the Creating Grids section for an
explanation of the various options in the Organize dialog box. When organizing the grids, a shortcut key
can be assigned so that the grid is selected whenever the corresponding keyboard shortcut is entered.

You can copy a Grid from another user by first exporting the Grid and then importing it.
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22.4 Wrap Options

When viewing files with fixed length records (and no line terminator), you need to manually enter the
correct record length (or wrap length) for the file to be displayed correctly.

By entering the Wrap Options for a Grid, the file will be automatically wrapped to the specified record
length when the Grid is loaded.

To enter the Wrap Options while creating/editing a Grid, right-click on the Grid header and select Se t
Wra p  Op tio ns. The wrap options consist of the following:

Wra p  Line s  a t Co lumn
This is length at which all lines will be wrapped (ie, the record length).

Re sto re  wra p  se tting s  whe n Grid  is  re mo ve d
By default, V will maintain the current wrap settings when the Grid is removed - even when you view a
different file. If the wrap options do not apply to this file, you will need to disable (or change) them.

By enabling this option, V assumes that the wrap options only apply to the file being viewed and will
restore the original wrap settings when the Grid is removed (or the file is closed).

22.5 Automatically Loading Grids

A Grid is usually manually loaded by selecting it from the GridLines menu. If you always want a
particular grid to be displayed when a file is loaded, you need to export the grid to a file name that is the
same as the file with a .vg rid  extension.

For example, to always display a grid with File na me .d a t, you need to create a grid file with the name
File na me .d a t.vg rid .

The .vg rid  file needs to be in the same directory as the file being viewed - or in the Default Grid
Directory (see below).

Cre a ting  a  .vg rid  File
After you have created a Grid, you can export it by selecting Export from the right-click Grid menu. Note
that an exported Grid will not appear on the GridLines menu. If you want the Grid displayed in the
GridLines menu, you will also need to Save it.

If you export the Grid to a file named .vg rid  (just an extension, with no file name), that Grid will be used
for a ll fi le s  in that directory.

De fa ult Grid  D ire c to ry
You can specify a Default Grid Directory by selecting Default Grid Directory from the GridLines menu. If
a .vgrid file does not exist in the current directory, V will also look in this directory.

You can use rules based loading to load a grid based on part of the file name. This makes it possible
to load the same grid for multiple files without having to create multiple .vgrid files.

No te : In order to load grids automatically, you need to enable the Auto -Lo a d  Grid s  option on the
GridLines->Options menu.
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22.6 Using Rules (Regular Expressions) to Load Grids

If Ena b le  Grid  Rule s  is enabled (on the GridLines->Options menu), V will look for a .rule s  file which
contains a list of file expressions and corresponding .vgrid files to load if the currently viewed file
matches that expression.

You will need to create a file called .rule s  in the Default Grid Directory (select Set Default Grid
Directory from the GridLines menu). This file must be created manually with an editor (you cannot use V
to create it).

Each line in this file (.rules) consists of a regular expression followed by a replacement string
(separated by a "/").

When viewing a file, V will try to match the file name against each expression in .rules. If it finds a match,
it tries to load the .vgrid file specified by the replacement.

For example, let's say that a directory consisted of many files named Test1-YYYY-MM-DD.log and
Test2-YYYY-MM-DD.log where YYYY-MM-DD represented the date the file was created.

You could apply a single .vgrid file for all such files by adding the following line to ".rules":

Test.*\.log/Test.vgrid

This will cause V to load Test.vgrid for any file of the form Testxxxxx.log.

If you wanted to load a different grid for Test1 and Test2 files, you could add the following line to .rules:

Test([0-9]).*\.log/Test\1.vgrid

This would load Test1.vgrid for all file names that started with Test1, Test2.vgrid for all file names that
started with Test2, and so on, up to Test9.vgrid.

No te s

The expressions in .rules must be regular expressions - which are different from simple Windows/DOS
wildcard expressions (like Test*.log  - which will not work).

Any lines in .rules that begin with either # or ; are ignored (they can be used for comments).
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22.7 Associating with a File Extension

By associating a Grid with a File Extension, that Grid will be automatically loaded whenever a file with
that extension is viewed.

To do this, simply create a Grid, and when saving it, make sure that the na me  o f the  Grid  begins with
the file extension.

For example, to associate a Grid with .xyz fi le s , simply name the Grid something like ".xyz (Grid  fo r
XYZ File s)". Any description may follow the file extension (as long as there is a separating space).

You must also enable Auto -Lo a d  Grid  Exte ns io ns on the GridLines menu.

No te

A File Extension Grid must be saved on the GridLines menu. You cannot save it as a .vgrid file in the
current directory or the Default Grid Directory.

22.8 Exporting Grids

Grids can either be exported to .vexp files or to .vgrid files. 

Exp o rting  to  a  .ve xp  fi le

Press the More button and select Export. This will allow you to export either the selected grid(s) or all
the grids to a .vexp file. This is usually done so  the grids can be copied by another user.

Once another user has imported the exported .vexp file, the imported gridlines will appear on their
GridLines menu.

Exp o rting  to  a  .vg rid  fi le

Press the More button and select Export to .vgrid.

A Grid is exported to a .vgrid file so that it can be automatically loaded by V when a file is viewed.

The Se t Exp o rt Da ta  option in the Grid right-click menu is used to specify extra data that will be
appended to e ve ry  l ine  in the exported .vgrid file.

You can also append different data for each line (column) by entering the extra data to be exported in
the Co lumn Le ng th. Simply include the extra data imme d ia te ly  a fte r the length.

For example, if you enter 16, A for the Column Length, ", A" (without the quotes) will be added to the
corresponding exported line.

Note that the comma in this example does not act as a separator. The extra data to be exported begins
at the first non-numeric character after the column length. If you add a space after the column length, the
space will also be exported.

No te
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.vgrid files can only be exported/imported one at a time. Export to a .vexp file if you would like to export/
import multiple grids.
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22.9 Importing Grids

When organizing GridLines, pressing the More button allows you to import GridLines that had
previously been exported. Two different types of import are available.

Imp o rt fro m a  .ve xp  fi le

Selecting the Import option allows you import a previously exported .vexp file. The imported grids will
appear on the GridLines menu.

Imp o rt fro m .vg rid

This allows you to add a Grid to the GridLines menu that has previously been exported to a .vgrid file.

No te

.vgrid files can only be exported/imported one at a time. Export to a .vexp file if you would like to export/
import multiple grids.
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22.10 Exporting Data to CSV

The file being viewed can be exported to a CSV file by selecting E xp o rt to  CS V from the Grid Line s
menu. This option is only available if a Grid has been applied to the file being viewed.

Each line in a CSV file consists of multiple fields separated by a delimiter (typically a comma). Each
field will contain the text in the corresponding grid column.

The following options can be set when exporting to a CSV file:

De limite r
If nothing is specified in the Delimiter box, a comma will be used as the delimiter. If you want to specify
another delimiter (eg, a vertical bar "|"), simply enter it here. Note that the delimiter can contain more
than one character. If you want to use a TAB for the delimiter, enter "\x8" (without the quotes).

Quo te s
By default, V will only place quotes around a field if the field contains a delimiter. You can change this
behavior by specifying one of the following:

Use Quote Always

Use Quotes only if field contains delimiter

Use Quotes only if field contains delimiter or spaces

Do  no t s trip  tra il ing  sp a ce s
By default, V will remove any trailing spaces from a field. Enable this options if you want the trailing
spaces exported.

Do  no t e xp o rt g rid  he a d ing s
V will export the grid headings to the first line of the CSV file. Enable this option if you do not want the
headings exported.

No te

Only the first 500 lines are exported if V is unregistered.
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23 Chunks

23.1 File Chunks

The time taken to load a file (in text mode) increases as the file gets larger. When viewing really large
files, it is likely that you just want to look at the start and/or end of the file. In this case, it is pointless to try
and load the entire file. Why load all of a 100Mb file, when you just want to view the last few lines?

In order to keep the load time to a minimum, V breaks the file into chunks. The size of the chunk is
specified in the More Options tab of the Preferences Dialog box (it defaults to 8Mb). File Chunks are
enabled by default - to disable them, just clear the Enable File Chunks option.

When a file is to be viewed, V checks the size of the file, and if it is larger than the chunk size, will only
load the first chunk in the file (or the last chunk if you are viewing the tail).

An extra toolbar will appear in the top right of the window, which lets you load further chunks, and an
extra status bar pane also appears in the bottom of the window, which displays which chunk is currently
being viewed. You may also click on this area of the status bar to display available chunk options.

Once a chunk is loaded, the scrollbars restrict movement to within the chunk. That is, sliding the vertical
scrollbar all the way to the bottom, will take you to the end of the chunk, not the end of the file. Also, the
displayed line numbers are not always correct when viewing a file in chunks.
Click here for further details on line numbering in chunks.

Searching is not restricted to the current chunk. If a string is found outside the current chunk, then the
appropriate chunk is automatically loaded.

In the Goto Dialog Box, offsets and line numbers are relative to the start of the fi le , not to the start of the
chunk. This means that if you were viewing the last chunk of a file, going to line 1 will take you to the very
start of the file and not to the start of the chunk.
Click here for further details on Goto and chunks.

The buttons on the chunk toolbar have the following function:

Firs t Chunk Loads the first chunk in the file. This will be disabled if the first chunk is the chunk
currently being viewed.

Ne xt Chunk Loads the next chunk in the file.

Pre v io us
C
h
u
n
k

Loads the previous chunk in the file.
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La st Chunk Loads the last chunk in the file. This will be disabled if the last chunk is the chunk
currently being viewed.

Entire  File This will load the entire file, and the chunk toolbar will disappear. Note that this may
take some time, depending on the size of the file. (See note below).
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Pressing the Pa g e Do wn and Line Do wn keys while at the very end of a chunk will automatically load
the next chunk. Pressing the Pa g e Up  and Line Up  keys while at the very start of a chunk will load the
previous chunk.

Chunks in He x mo d e

File chunks do not usually apply in hex mode - the entire file is displayed, even if it is larger than the
chunk size. However, if the file size is extremely large (usually > 2Gb), V will also use chunks in hex
mode. This behaviour depends on available system memory and cannot be disabled.

No te s

The end of a chunk will usually fall somewhere in the middle of a line. V tries to break a chunk
at the end of a line, however, this may not always be possible. Because of this, the last line of a
chunk may sometimes be the same as the first line of the next chunk.

You may go to an absolute chunk number by using the Goto Dialog box.

If V takes more than 5 seconds to load the entire file, it will display a progress dialog that will
allow you to cancel the operation if you think it will take too long.



EBCDIC Files 235

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

24 EBCDIC Files

24.1 EBCDIC Files

When V opens a file, it tries to detect if the file is ASCII or EBCDIC. If it detects an EBCDIC file, it will
automatically display it in EBCDIC mode.

If it incorrectly displays it as ASCII (text or hex), you can switch to EBCDIC mode by selecting EBCDIC
from the View menu (or pressing Alt+B).

Similarly, if an ASCII file is incorrectly displayed as EBCDIC, you can return to ASCII mode by selecting
ASCII from the View menu (or pressing Alt+B).

When a file is displayed in EBCDIC mode, EBC will be displayed on the bottom status bar. Clicking on
EBC will allow you to modify several EBCDIC options.

Click here for details on the various EBCDIC file formats supported
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24.2 EBCDIC File Formats

If V does not display the EBCDIC file correctly, you can click on EBC on the status bar (or select
EBCDIC Options from the View menu) to specify the correct file format.

EBCDIC files are usually in one of 4 formats.

Ca rria g e  Re turn De limite d
These files are just like ASCII files. That is, each line is terminated by a carriage return (or carriage
return + line feed). The only difference is that the file contains EBCDIC characters instead of ASCII
characters.

To display these types of files the No  Fo rma tting  (D isp la y  a s  EBCDIC fi le  with CR/LF) option
should be enabled.

If some EBCDIC characters are not displayed correctly, you can modify the EBCDIC to ASCII mapping
in the EBCDIC tab of Preferences.

Fixe d  Le ng th Re co rd s  (RECFM=F)
Each line (or record) in the file consists of a fixed number of characters. To view these files, enable the
RECFM=F option and enter the fixed record length in the LRECL field.

Click here for further details on viewing RECFM=F files.

Va ria b le  Le ng th Re co rd s  (RECFM=V/VB)
These files consist of variable length lines (or records). Each record is preceded by a 4 byte record
descriptor which specifies the record length. V will automatically decode the records and display the
lines as if they were delimited by a carriage return.

Und e fine d  Fo rma t (RECFM=U)
By strict definition, the format of these files is Undefined (or Unknown). However in V, the meaning is
slightly different. Click here for further details.

Ca rria g e  Co ntro l (CCT YPE)
Click here for details on Carriage Control.

Use  ASCII Cha ra cte r Se t
By default, EBCDIC RECFM files consist of EBCDIC characters. Enable this option if the file consists of
ASCII characters.

T ra il ing  Sp a ce s
It is common for records/lines in EBCDIC files to be padded with trailing spaces - especially when files
with variable length records are stored as RECFM=F.

Enable the Ig no re  T ra il ing  Sp a ce s option if you do not want the trailing spaces displayed.
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24.3 RECFM=F

V will try to "guess" if an EBCDIC file contains fixed length records (RECFM=F) and will try to guess the
fixed record length.

However, it may sometimes get the record length wrong - requiring the user to select the EBCDIC
Options and enter the correct record length.

If you do not want V to guess the record length, you can enable Do not guess EBCDIC fixed record
length (RECFM=F) in the File Options tab of Preferences.

If this is enabled, all fixed record length files will be displayed as Carriage Return Delimited files. To
display as fixed record length files, you will need to:

1. Select EBCDIC Options from the View menu (or click on EBC in the status bar)

2. Disable the No Formatting option

3. Enable RECFM=F

4. Enter the correct record length in LRECL

Use  Wra p  T o  Le ng th

Alternatively, you can make use of the Wrap To Length command to display the file without having to
specify RECFM=F.

You can enable Wra p  T o  Le ng th in one of 3 ways:

1. By pressing the Wrap To Length icon on the toolbar

2. By selecting Wrap->Wrap To Length from the View menu

3. By pressing Alt+L

You will also need to specify the record length by selecting Wrap->Set Wrap Length from the View
menu (or pressing Ctrl+W). V will remember the last wrap length used, so you will only need to set it if it
has changed.

The disadvantage of using Wrap To Length to display RECFM=F files is that all files subsequently
viewed will be wrapped to this length. That is, if they contain lines that are longer than the wrap length,
they will be wrapped. You will need to remember to disable Wrap To Length after you have finished
viewing the fixed record length file.
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24.4 RECFM=U

RECFM=U usually means that the file format is unknown or undefined.

However, I have seen files labeled as RECFM=U  which are very similar to RECFM=V files - the only
difference being that they have a 2 byte descriptor length instead of a 4 byte descriptor length.

V too will refer to these files as RECFM=U.

If you have a file that is in this format (that is, each record in the file consists of a 2 byte length followed
by the record data), just set RECFM to U  and the file should be displayed correctly.

V may not automatically recognize RECFM=U files. If this is the case, you will have to manually set the
format to RECFM=U - which can be done in one of 2 ways:

1. If V inco rre c tly  d isp la ys  the  fi le  a s  a n EBCDIC Ca rria g e  Re turn De limite d  fi le
In this case, you will be able to see most of the data, but the lines will not line up correctly. To display as
RECFM=U:

Select EBCDIC Options from the View menu (or click on EBC on the status bar)

Disable the No Formatting option

Select RECFM=U

2. If the  fi le  is  d isp la ye d  a s  ASCII te xt o r he x
In this case, the data will be unrecognizable.

To display as RECFM=U, you will first need to enable EBCDIC mode by selecting EBCDIC from the
View menu (or pressing Alt+B). Then perform the operations above.

No te : V will display an error message if it does not recognize the file as RECFM=U.
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24.5 Carriage Control

Carriage control is used by some EBCDIC files to indicate line and page breaks.

In files that have carriage control, the first character in each line is used to indicate whether a line or
page break should be placed after (or even before) the line.

Carriage control (sometimes referred to as CCT YPE) can be one of 3 types:

ANSI (CCTYPE=A)

Machine (CCTYPE=M)

ASCII (CCTYPE=Z)

V does not automatically recognize files with carriage control. If your EBCDIC file contains carriage
control, you need to select EBCDIC Options from the View menu (or click on EBC on the status bar) and
select the correct CCTYPE.

If a file contains page breaks, V will paginate it. In particular, V will display a page marker (dotted line)
before the start of each page.

No te s

To specify the carriage control on the command line, append the CCTYPE (A, M or Z) to the /
RECFM option.

Carriage Control is only supported for EBCDIC files - not for ASCII files.

24.6 XMIT and AWS Files

XMIT and AWS files are uncompressed archives (containing multiple files) that are used in IBM
mainframe environments.

V will treat these files just like other supported archives (such as ZIP, RAR and CAB). That is, when you
double click on one of these archives, you will see a listing of the files they contain. You can view a file
by simply  double-clicking on it.

You can also extract any of the files just as you would extract files from a ZIP archive.

Sa ve  a s  ASCII o p tio n

By default, when files are extracted from XMIT/AWS archives, they are extracted in EBCDIC format (ie,
exactly as they are stored in the archive).

If the S a v e  a s  A S CII option is enabled in the Extract dialog,  the file will be saved as ASCII (with trailing
spaces removed from all lines).
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25 The ZIP View

25.1 The ZIP View

The ZIP View is very similar to the Directory View, displaying the contents of a ZIP file (also referred to
as a ZIP archive) much like the Directory View displays the contents of a directory.

Double clicking on a file inside the ZIP View will display that file in the File View.

Most of the commands available in the Directory View are also available in the ZIP View.

In particular, you can print files, execute files and pass files to User Commands, all without having to first
extract the file(s).

If the ZIP file contains installable software - that is, a group of files together with a setup program (usually
SETUP.EXE or INSTALL.EXE), you may also install the software without having to first extract the files.

The following sections describe the ZIP View in greater detail:

The Toolbar
Displaying ZIP Folders
Executing ZIP Files
Searching ZIP Files
User Commands on ZIP Files
Extracting ZIP Files
Installing without Extracting

Sup p o rte d  File  Fo rma ts

The term ZIP is used throughout this documentation to signify a compressed archive. V not only
supports ZIP files, but also supports the following compressed formats:

CAB Microsoft Cabinet Files
JAR Java archives - same as ZIP
T AR Unix archive format (not compressed)
GZ GZip format usually found on Unix
T GZ GZipped TAR file
RAR RAR format from RARLAB
EAR Java archive (same as ZIP)
WAR Java archive (same as ZIP)
BZ2 BZip format



The ZIP View 241

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

25.2 The Toolbar

The ZIP View toolbar is basically a cut-down version of the toolbar in the Directory View. 

Go  Up
This will display the contents of the directory which contains the ZIP archive, unless the archive is itself
stored inside another archive. In this case the contents of the "parent" archive are displayed.

Extra c t
Allows you to extract files from the ZIP archive. Click here for further details.

Use r Co mma nd s
Click here for further details.

Exe cute
Click here for further details.

T he  File  Lis t

The ZIP View also contains a File List which works exactly like the File List in the File View.

The File List contains a list of the files that exist in the same directory as the ZIP file currently being
viewed. The File List lets you move very quickly from one file to the next.

For example, suppose you were viewing a directory that contained 10 ZIP files. You would view the
contents of the first ZIP file by simply double clicking on it.

To view the contents of the next ZIP file, there is no need to go back to the directory listing to select it.
Simply press the Ne xt (right arrow) toolbar button or press Ctrl-PgDown.

Similarly, if you wanted to view another ZIP file in the current directory, there is no need to go back to the
directory listing. Simply select it from the File List.

No te s

The ZIP View cannot be displayed in Thumbnails Mode.

The File List toolbar buttons are only enabled if the ZIP file being viewed has been selected
from the Directory View. In particular, the buttons will be disabled if V has been called from the
Windows Explorer or from the command line .

The File List only becomes fully functional once V has been registered.
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25.3 Displaying ZIP Folders

If a ZIP archive contains folders, the ZIP view may be displayed in one of 2 formats. The type of format
is selected from the View menu, and can be on of the following:

Sho w ZIP Fo ld e rs

This is exactly like the Directory View when displaying the contents of a directory on your disk. If the ZIP
archive contains more than one directory, only the files in the current directory are displayed, together
with the names of all the folders contained in the current directory.

Fla t ZIP Lis ting

In this mode, all the file contents are displayed in the one list, even if the archive contains multiple
directories. No directory icons are displayed in this mode. You will need to display the Folder column in
order to see what files are in what directory.

25.4 Sorting the ZIP View

Just like the Directory View, the ZIP View may be sorted by clicking on the appropriate column header
or by selecting a Sort option from the View menu.

ZIP contents may also be display as unso rte d . This displays the files in the order in which they are
stored in the ZIP archive.

Note that the unso rte d  order only makes sense when the ZIP View is in the Flat ZIP mode. Displaying
in unsorted order in the Show ZIP Folders mode is a little confusing, as the directory icons do not
always appear at the top of the listing.

25.5 Executing ZIP Files

Double clicking on a file in V causes that file to be viewed - unlike Windows Explorer which executes
the file (ie, launches the file with its associated application).

To achieve the same result with V, you need to execute (or run) the file by first selecting it and then
pressing the "Execute/Run" button on the toolbar (or pressing Ctrl-X or Ctrl-I).

For example, if the ZIP archive contained JPG files, you would be able to display the images by using
the Execute command (assuming that your system had an image viewer associated with JPG files).

Similarly, executing an EXE file will run that file. Note that if the EXE program required access to other
files in the ZIP archive, you would have to use Extract All & Run so that all files in the archive can be
extracted prior to the program being executed.

See this warning about executing ZIP file contents.
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25.6 Searching ZIP Files

The contents of the currently viewed ZIP file can be searched by using Find Files/GREP.

This can be selected from the toolbar, the Tools menu or by pressing Ctrl+Shift+F.

25.7 User Commands on ZIP file contents

User Commands may be executed on ZIP file contents in the same way as they can be used on normal
files.

Firstly, V will extract the selected file(s) from the ZIP archive into a temporary directory and then pass
the temporary file to the User Command.

The temporary file(s) created by V in this way will be deleted once the user closes the ZIP View.

25.8 Extracting ZIP Files

Extracting files from a ZIP archive is very much like copying files in the Directory View.

If you want to extract all the files in the archive, select Extra c t All from the Zip menu. If you only want to
extract some files, highlight the files and select Extra c t Se le c te d  from the Zip menu.

If you press the Extract button on the toolbar, V will assume you want to extract the selected files if more
than one file is highlighted, otherwise it will assume you want to extract all the files. You will be able to
change this in the extract options of the Extract dialog box.

The Extract dialog box will then appear where you will be able to select a destination directory to
extract the files to. This is exactly like selecting a destination directory for the Copy/Move commands in
the Directory View.

The selected directory will be placed at the top of the Directory list box in the Directory View. This
allows you to quickly view the extracted files by selecting the directory from the list box.

The dialog box also lets you set the extract options which control the way the contents of the ZIP file are
extracted.
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UAC Limita tio n

If you are running on an OS that has UAC (like Vista or Windows 7), you will not be able to extract the
contents of ZIP files to protected folders (eg, P ro g ra m  File s). When you try to do this, an error message
will be displayed instead of the expected UAC prompt.

If you need to extract the contents of a ZIP file to a protected folder, you will need to do one of the
following:

Extract to a temporary folder and then move the files in the temporary folder to the protected
folder.

Run V as an Administrator. That is, right-click on the V shortcut and select R un A s  A d m inis tra to r. 

No te s

If the ZIP file contains a program that you want to install, it is usually not necessary to extract the
files before installing the program. Instead, you can use the Install/Setup command on the Zip
menu.

The destination directory will be placed at the top of the Directory list box in the Directory View.
This allows you to quickly browse the destination directory by selecting it from the list box.



The ZIP View 245

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

25.9 Extract Options

The following options appear in the Extract dialog box and control the way the ZIP file contents are
extracted.

Select All File s  to extract ALL the files in the ZIP archive or Se le c te d  File s  to only extract the files
highlighted in the ZIP View.

The "Extract type" should be set to one of the following:

Alwa ys
Extracts all the files, regardless of whether they already exist.

Only  if Ne we r
Will only extract a file if the date/time of the file stored in the ZIP archive is later (newer) than the existing
file. If the file does not exist, it will be created.

Fre she n Only
The same as "Only if Newer" with the exception that files that do not already exist will not be created.

Other options include:

Do  no t re s to re  d ire c to ry  s truc ture
If the ZIP file contains directory names, the files extracted will be stored in the same directory structure
(with the selected destination directory as the root). If this option is enabled, a ll the files (regardless of
which directory they are in) will be extracted to the destination directory. You would normally want to
disable this option, unless you only wanted to extract a few files from the ZIP archive.

Ove rwrite  witho ut p ro mp ting
If the file to be extracted already exists, it will be automatically overwritten if this option is enabled.
Otherwise, you will be asked whether you want the current file replaced.

Co nve rt LF to  CR/LF
If this option is selected, each line feed (LF) character will have a Carriage Return (CR) added to it as
the file is extracted. This option is normally used to extract Unix-style text files. You should not use this
option to extract binary files (like .EXE or JPG). 
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25.10 Encrypted ZIP Files

Some ZIP files are e ncryp te d . If they are, you must enter the correct password before you can view
the contents of the ZIP file. This password must be the same as the password used to create the ZIP
file.

If you try to view the contents of an encrypted ZIP file, you will be asked to enter a password. The file will
only be viewed if the password is correct.

You may then view other files in the same ZIP file without having to re-enter the password. However, if
you close the ZIP file and view it again later, you will have to re-enter the password.

The password will usually not be displayed as you are typing it. Enable the "Show Password" option if
you want the password to be visible.

No te s

The contents of the ZIP file may be listed without knowing the password. However, the correct
password must be entered before the contents of the file can be viewed.

A valid password is required for every operation that requires access to the ZIP file contents.
For example, printing, executing, extracting and User Commands.

The "Attributes" column of the ZIP View will display an "E" to indicate that the file is encrypted.
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25.11 Installing without Extracting

Much software (including most shareware programs) is distributed as ZIP archives which contain the
program files and a setup program (usually SETUP.EXE or INSTALL.EXE).

To install the software, the user usually unzips the contents of the ZIP archive into a directory and then
runs the setup program. After the setup has finished, the user deletes the files that were unzipped.

V removes the need to perform all these steps, allowing you to run the setup program directly from the
ZIP view without the need to extract any files.

All you have to do is to select Ins ta ll/Se tup  from the Zip menu (which will only be enabled if the ZIP file
contains a SETUP.EXE or INSTALL.EXE).

You will then be prompted to start the installation. V will extract the entire contents of the ZIP file into a
temporary directory and then run SETUP.EXE or INSTALL.EXE.

To minimize V during the installation, enable the "Minimize during install" option before pressing OK.
The setup program will then start. Once the setup has completed, you should return to V and press the
OK button again to delete the temporary files that it created during installation.

Extra c t All & Run

If the ZIP file contains an installation program which is not named SETUP.EXE or INSTALL.EXE, you
can still perform the installation by selecting the installation executable (eg, MYINSTALL.EXE) and then
selecting Extra c t All & Run from the Zip menu.

No te s

V does not know whether the installation has finished, so make sure it has completed before
telling it to delete all the files. If V tries to delete the temporary files while the setup is still running,
it will no doubt fail to delete all the files, and will probably also cause the setup to fail.

In the event that V does not delete all the temporary files it created (for whatever reason), the
files may be deleted by using the Delete Temporary Files command from the Tools menu.
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25.12 Testing ZIP Files

Select T e st from the Zip menu to test the integrity of the ZIP archive.

ZIP archives may sometimes be corrupted. The Test command will list each file in the archive and
display its status. If an error is found in a file, it will not be able to be extracted.

No te : A ZIP archive may only be tested from within the ZIP View. If the archive is so badly corrupted
that its file list cannot be displayed, you will not be able to te s t it.

25.13 ZIP File Comments

Some ZIP files contain comments. These usually consists of several lines of text describing the
archive.

You may display any comments, together with a few other properties of the ZIP file by selecting 
Pro p e rtie s /Co mme nt from the Zip menu.
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25.14 Creating ZIP Files

V only supports ZIP file viewing. In particular, you cannot create (or modify) ZIP files.

However, you can easily add the ability to create ZIP files to V by using the User Commands and a
third party ZIP utility, like ZIP.EXE from Info -Zip .

The Info-Zip utilities are fre e , and at time of writing could be downloaded from:

http://www.info-zip.org/pub/infozip/Zip.html

Download the latest "ready to run" binaries for Windows (or Win32). The file will be named something
like zip99xN.zip where "99" is the version number.

Once you have extracted ZIP.EXE from the downloaded ZIP file, you can create a User Command as
follows:

Select Organize from the User Commands menu.

Press the Insert Command button

Rename the command to something meaningful - like "Create ZIP File"

Specify the full ZIP.EXE path in Command Path.

Put "-j" in the Command Options (without the quotes). This forces ZIP not to store the directory
details in the ZIP file.

Enable "Prompt for extra options"

You may now create a ZIP file from V!

Simply select the files you want added to the ZIP file in the Directory View and then select "Create ZIP
File" from the UserCommands menu.

You will then be prompted for extra options. You should enter the name of the ZIP file that you want
created. The ZIP file will be created in the current directory being viewed. If you specify the name of an
existing ZIP file, the selected files will be a d d e d  to the ZIP file.

No te s

You may replace ZIP.EXE with any ZIP utility that can accept command line arguments.
Naturally, the above "-j" option would no longer be valid.

The above Info-Zip URL may change without notice.

Future versions of V will have in-built support for creating ZIP files, eliminating the need for User
Commands.
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25.15 Making V the default ZIP file viewer

You may make V your default ZIP file viewer by enabling all the file types that you want to associate
with V in the Setup section of Preferences.

By making V the default ZIP viewer, V will be launched every time you double click on a ZIP file in
Windows Explorer.

It will also cause the V ZIP icon to be displayed for all ZIP files.

25.16 Temporary Files

Wa rning

When executing ZIP file contents (or passing them to User Commands), V automatically extracts the
selected file(s) to a temporary directory and then passes them to the associated program. V will delete
the file(s) once the user closes the ZIP view containing the file(s).

This means that you should always close the associated application which is launched b e fo re  closing
the ZIP view. Otherwise, the (temporary) file(s) which the launched application has loaded will no longer
exist, usually resulting in some kind of error.

25.17 ZIP DLLs

The ZIP functionality in V is contained in DUNZIPS32.DLL
The TAR and GZip functionality is in DZGT32.DLL
The RAR functionality is in UNRAR.DLL
The BZ2 functionality is in LIBBZ2.DLL

These DLLs must either be located in the same directory as V.EXE or in the Windows system directory.
If you do not have these files, you can download them from:

http://www.fileviewer.com/Download.html

No te

The V setup program will automatically copy all the necessary files to the required location.

http://www.fileviewer.com/Download.html
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26 Preferences / Configuration Options

26.1 Preferences

The Preferences Dialog Box is where you configure most of the program options. You may select it
from the toolbar, the Vie w menu, or from various right-click menus.
The tabbed dialog box consists of:

File Options
Directory Options
Explorer Options
Window Layout
More Options
Double-Click
EBCDIC
Line Numbers
Search
Setup
File Types
Thumbnails
Editor/CMD
Fonts
History
InfoTips
Keyboard
Language

These are described in the following sections.

No te

You must press the OK button in order to save the settings that were modified in any of the tabbed
dialog boxes. If you press the Ca nce l button, all the modifications will be lost.
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26.2 File Options

T a b  Size
Specifies the tab length. If you don't want V to expand tabs, leave this field blank (or set it to 1).

Da te  Fo rma t
Specifies what format the date will be displayed throughout the program (including when printing).

Alwa ys Op e n a s  T e xt
When V opens a file, it tries to determine what kind of file it is. If it is a binary file (like a JPG or EXE file)
it will display the file in HEX mode, otherwise it will open it in TEXT mode. Check this option if you
always want the file to be opened in TEXT mode.

Sta rt a t End  o f File
If this is checked, V will start viewing from the end of the file instead of the beginning. Note that you can
also view a file from the end, by selecting the View Tail command from the Directory View.

Wra p  Line s  to  Scre e n
Usually, when displaying files in Text mode, V will not wrap any long lines - you will have to use the
horizontal scroll bar to view lines longer than the width of the window. Check this option if you want V to
wrap the lines to the width of the window. In this case there will be no horizontal scroll bar.

Wra p  o n Wo rd  Bo und a ry
Usually when lines are wrapped they are wrapped at the exact position where the line would exceed
the width of the window - even if it means splitting the line in the middle of a word. When this option is
checked, the line is always wrapped at the end of a word.

Unma rk  b lo ck  a fte r co p y
By enabling this option, any highlighted text will be cleared once it is copied to the clipboard (or saved
to a file).

Do  no t re s to re  fi le  p o s itio n
When V views a file that it has viewed before, it will restore the previous file position. Enable this option
if you want V to always start viewing files from the beginning.

He x o ffse t in s ta tus  b a r
This causes the hex offset to be displayed in the status bar whenever the user clicks the mouse on a
file position, while viewing a file in text mode. The hex code of the corresponding character is also
displayed (in text mode only).

D isp la y  ALL he x co d e s
Replaces any dots (unprintable characters) on the right hand side of the hex dump with the
corresponding symbol in the selected font.

Auto -sum co lumns
Enable this option if you want V to automatically display the sum when selecting columns.

Che ck ST DIN o n s ta rtup
If you specify the /F command line parameter, V checks the "standard input" to see if there is any
redirected output to be displayed. By enabling this option, V will now automatically check for redirected
output when it starts.
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Use  Bo ld  Curso r
V will use a b o ld  cross-hair cursor when viewing a file.

Sa ve  File  T a il ing  s ta te
V always disables File Tailing on startup. Enable this option if you want the previous File Tailing state
restored.
 
Sa ve  Bo o kma rks  o n Exit
By default, all bookmarks are cleared when V exits. Enable this option if you want the bookmarks
saved so they will be available every time you view the file.

Clo s ing  File  W ind o w to  b e ha ve  like  p re ss ing  ESC ke y
While viewing a file, pressing the upper right [x]  button on the window causes V to exit. By enabling this
option, V will now treat the [x]  button like the ESC key. In particular, if you enable the "Browse in File
View" option in the Keyboard tab of Preferences, V will return to the directory listing when pressing [x]
instead of exiting. 

Do  no t scro ll curre nt l ine  ma rke r whe n us ing  scro ll b a rs
If the window is scrolled using the scroll bars, the current line marker is moved so that it remains visible.
Enable this option if you prefer the current line marker to stay where it is.

Alwa ys scro ll wind o w whe n us ing  a rro w ke ys
Pressing the Up/Down arrow keys moves the current line marker. The window is only scrolled when the
line marker reaches the bottom (or top) of the window. Enable this option if you want the window to
always scroll when you press the arrow keys.

D isa b le  Pa g e  Do wn o n Mid d le  Mo use  Butto n
While viewing a file, V treats the middle mouse button as a Page Down key. This can interfere with the
behavior of some mice (like the IntelliMouse) that can use the middle button (or scroll wheel) for
panning. You can disable the default V behavior by enabling this option.

Pro mp t b e fo re  re lo a d ing  mo d ifie d  fi le
V will automatically reload the file it is currently viewing if it has been modified by another program.
Check this option if you want V to warn you before it does this.

Do  no t g ue ss EBCDIC fixe d  re co rd  le ng th (RECFM=F)
When V detects an EBCDIC file, it tries to determine if it contains fixed length records. However, it can
sometimes incorrectly guess the record length. By enabling this option, V will not try to guess the format.
Once the file is displayed, the user will have to select the EBCDIC Options and manually select the
correct format.

Do  no t co p y CR/LF to  c lip b o a rd  fo r wra p p e d  (to  scre e n) l ine s
When wrapping lines to the screen width, V  will include a newline (CR/LF) at the screen wrap position
whenever the lines are copied to the clipboard. Enable this option if you do not want to include a CR/LF
at the screen wrap position. That is, a CR/LF will only be included at the very end of the line.

D isa b le  a uto ma tic  CSV mo d e
This disables the automatic recognition of CSV files. You can still view a file in CSV Mode by pressing
the CS V  M o d e button on the toolbar.

Cre a te  T EMP fi le s  o n ho st
If running the Portable Version, all temporary files (eg, when viewing ZIP files) are created on the
portable device. Enabling this option will create the temporary files on the host PC.
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26.3 Directory Options

Ena b le  Full Ro w Click
In the Directory View, you can only select a file by clicking on its File Name. By enabling this option, you
will be able to select a file by clicking anywhere on the corresponding row (assuming the Directory
View is in Details mode). Although you may click anywhere on the row, only the File Name is
highlighted.

H ig hlig ht Entire  Ro w
Enable this to highlight the entire row (instead of just the file name) when a file is selected.

D isp la y  File  Ico ns
Disabling this option causes V to display the same icon for each file in the Directory View. This may
result in a significant speed improvement - especially if you have a slow PC.

Ad d  ma sk to  wind o w T itle
By enabling this option, the file mask (as well as the directory path) on the
window title by enabling the "Add mask to window title" option in the Directory Options tab of
Preferences. 

Do  no t d isp la y  Drive  ico ns
Enabling this option will result in only the drive letter being displayed in the drives box. This may be
necessary if your system has removable drives. In order for the icon to be displayed, V needs to
access the drive. For removable drives (especially if they are empty), this may take a long time.

Do  no t d isp la y  Drive  la b e l
Enabling this option will only display the drive icon in the drives box (assuming the above option is not
enabled). This may be necessary if you have drives with very long labels, since the width of the drives
box depends on the length of the longest label.

Drive s  Bo x o n le ft
The Drives Box will usually appear on the right hand side of the Directory View. Enable this option if you
prefer it on the left (like Explorer).

Mo ve /Co p y d ro p p e d  fi le s
If this option is disabled, any files that are dropped onto V will be viewed. Enable this option if you want
the files to be copied/moved. Click here for further details.

D isa b le  Ico nHa nd le r
Some programs use an Ico nHa nd le r to draw the directory listing icons for certain file types. One use
of IconHandlers is by graphics programs (like Photoshop) to draw a preview of an image in the icon.
Enabling this option will not call the file's IconHandler (if it exists). This can greatly speed up the display
of the directory listing.

D isa b le  le ft-c lick  d ra g /mo ve
Enabling this stops the user from moving files by left-dragging them with the mouse. You may still move/
copy files by right-clicking on the files and dragging them to their destination.

Ena b le  4DOS Sup p o rt
This must be enabled before 4DOS descriptions can be displayed in the Directory Listing. This can
also be enabled by selecting Options from the View menu.
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Sha re  Ma sks in Dua l Pa ne
By default, Dual Pane mode contains 2 File Mask boxes - one for each pane.  By enabling this option,
only one File Mask box will be displayed - and will be used by both panes.

1KB = 1000 (no t 1024)
When displaying file sizes as Kb, Mb and Gb, V defines 1Kb as 1024 bytes. This means that a file of 1
million bytes will be displayed as 953K instead of 1Mb. If you enable this option, V will now define 1Kb
as 1000 bytes.

H id e  Co mp a tib il ity  File s
When enabled, all Compatibility Files directory entries will not be displayed in the directory listing.

D isp la y  g e ne ric  EXE ico n
By default, V will display a different icon for each EXE file. If this option is enabled, the same (generic)
icon will be displayed for every EXE file. This can greatly speed up the directory listing - especially if
you are viewing many EXE files on a slow network drive.

H id e  D ire c to ry  whe n v ie wing  fi le s
If enabled, the directory listing will be hidden whenever a file is viewed. Once the file is closed, the
directory listing will re-appear.

Ma inta in so rt o rd e r whe n cha ng ing  so rt co lumn
When changing the sort order from one column to another, V switches to the "default" ascending/
descending mode for the corresponding column. For "Name" sort, the default mode
is ascending and for Date/Size sort, the default mode is descending.

That is, if the files are being displayed in ascending name order, switching to sort
by size will display the files in descending size order.

Enable this option to have V maintain the current ascending/descending mode whenever the sort
column is changed.

D isp la y  MSDOS Na me  in lo we r ca se
This option causes the name in the MSDOS column to be displayed in lower case.

Re sto re  d ire c to ry  a fte r v ie wing  se a rch/GREP re sults
While viewing the results of a file search, the directory that V was viewing can be changed. This option
will restore the original directory when the search results list is closed.

Use  the  Wind o ws Exp lo re r rig ht c lick  me nu a s  d e fa ult
Enable this option to have V display the same menu as Windows Explorer when right clicking on a file.
If this option is disabled, you can still display the Explorer menu by pressing the Control key while right
clicking. If this option is disabled, the default V menu is displayed when the Control key is pressed.

Note that there is a separate option which controls what menu is displayed when right clicking on a 
directory in the Explorer Tree.
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Alwa ys re s to re  mo st re ce nt d ire c to ry  o n s ta rtup
By default, V will display the "current" directory if it is started without any command line options.
Enabling this option will cause V to display the directory that V was viewing when it was last used.

Note that if this option is enabled and you run V from the command line, you must specify the current
directory (ie, "V .") in order to display the contents of the directory you are in.

Ne two rk /UNC time o ut (se co nd s)
Previous versions of V would sometimes appear to hang when trying to access a network drive which
was no longer connected. To overcome this problem, V now stops trying to connect to a network drive
after 3 seconds.

If you find that you are having problems accessing network drives, you can either increase the timeout
or set it to 0 to disable it.

UAC/Ele va tio n T ime o ut (se co nd s)
This sets the UAC timeout. Click here for further details.
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26.4 Explorer Options

Disa b le  the  Exp lo re r W ind o w
Enabling this completely disables the Explorer. It removes the Explorer tree and also removes the +
button which is used to display the Explorer when it is hidden.

D isp la y  Wind o ws fo ld e r ico ns (inc lud ing  o ve rla ys)
By default, V will display the same folder icon for every folder in the Explorer tree. Windows Explorer
displays different icons depending on the type of folder (eg, shared, network, system). Enable this
option if you prefer the Windows-style icons.

De te rmine  if sub fo ld e rs  e xis ts  whe n b ra nch is  e xp a nd e d
The Windows Explorer tree displays a "+"  next to every folder that has any subfolders. Because there
is some overhead in determining whether a folder has any subfolders, V displays a "+"  next to *every*
folder. If you try to expand a folder that has no subfolders, the "+" will disappear. 

This speeds up the display of folders when a branch is expanded (although the time saved may not be
significant). If you find this irritating, you can enable this option.

Alwa ys hid e  the  Exp lo re r o n s ta rtup
Enabling this option will cause V not to display the Explorer tree on startup. To display the Explorer
tree, press the "+"  button just below the main toolbar.

Alwa ys e xp a nd  to  the  curre nt d ire c to ry
This option causes the Explorer tree to automatically expand to whatever directory is being displayed
in the directory listing on the right.

Exp a nd /Co lla p se  o n s ing le  c lick
If you enable this option, the Explorer tree will automatically expand (or collapse) as soon as you click
on a folder (instead of having to double-click or press the "+" next to the folder).

Use  Wind o ws Exp lo re r rig ht c lick  me nu a s  d e fa ult
Enable this option to have V display the same right click menu as Windows Explorer instead of the
default V menu. If this option is disabled, you can still display the Explorer menu by pressing the Control
key while right clicking.

Note that this only applies to the Explorer tree. There is a separate option which controls what menu is
displayed when right clicking on a file in the directory listing.

Exp lo re r Co mp a tib il ity  whe n d ra g g ing  fi le s  to  a no the r d rive
Enabling this option will cause V to behave just like Explorer when dragging files. That is, if the files are
being dropped on to a destination that is on the same drive, the files will be mo ve d . If the destination is
on another drive, the files will be co p ie d . Pressing the Ctrl key while dragging will always result in a
co p y. Pressing the Shift key while dragging will always result in a mo ve . If this option is not enabled, V
will always mo ve  dragged files - regardless of where they are being dropped (or co p y if the Ctrl key is
pressed). Click here for further details.

D isa b le  Auto ma tic  Re fre sh o n Ne two rk  Drive s
V tries to automatically refresh the Explorer tree every time a directory is created, deleted or renamed
on a drive. This can sometimes cause problems on network drives. Enable this option if you have a
network drive and are having problems with V slowing down.
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Disa b le  Exp lo re r Se le c tio n De la y
If you scroll the Explorer tree using the arrow keys, V will wait for about half a second before it displays
the contents of the newly selected directory. This lets you quickly scroll the tree without having V log the
contents of each directory as you select it.

Enable this option if you want V to display the directory contents as soon as the directory is selected.

Do  no t d isp la y  H id d e n d ire c to rie s
If this is enabled, hidden directories are not displayed in the Explorer tree. Note that you can customize
the colors so that hidden directories are displayed in a different color to normal directories.

Do  no t sho w My Do cume nts
Enabling this will remove "My Documents" from the Explorer tree.

Do  no t sho w Ne two rk  Ne ig hb o rho o d /My Ne two rk  Pla ce s
Enabling this will remove "Network Neighborhood" (or "My Network Places") from the Explorer tree.

Do  no t sho w Co ntro l Pa ne l
Enabling this will remove "Control Panel" from the Explorer tree.

Do  no t sho w Lib ra rie s
This will remove the "Libraries" entry from the Explorer tree. This option is only available in Windows 7.

Sta rtup  Op tio ns

The following startup options determine what V does when if starts up:

Do  no t e xp a nd  the  Exp lo re r tre e
The Explorer tree will not be expanded on startup.

Re sto re  the  Exp lo re r tre e  fro m the  la s t se ss io n
The Explorer tree will have the same expanded state as it had when it was last used.

Exp a nd  the  Exp lo re r tre e  to  the  curre nt d ire c to ry
The Explorer tree will be expanded to whatever directory is being displayed in the directory listing on
the right.
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26.5 Window Layout

Use  Exis ting  File  wind o w to  v ie w ne w fi le
(unle ss  SHIFT  p re sse d )
By default, every file you view will be displayed in a separate window. Enable this option if you prefer to
only have one file window open at a time. If you enable this option, you can still view files in a separate
window by pressing the SHIFT key when you view the file.

Do  no t v ie w multip le  fi le s  in se p a ra te  wind o ws
If you select multiple files in the Directory Listing and then press the V button on the toolbar (or press
Enter), each of the selected files will be displayed in a separate window. If you enable this option, only
one window will be opened, and the selected files will be placed in the windows's File List.

Auto ma tica lly  T ile  multip le  fi le  wind o ws
(Auto -Arra ng e , Ve rtica l, Ho rizo nta l)
Enable this option if you want multiple file windows to be automatically tiled.

Inc lud e  ZIP wind o ws whe n a uto  ti l ing
By default, ZIP windows will not be tiled together with File windows. Enable this option to treat ZIP
windows the same as File windows for the purpose of automatic tiling.

Auto  Arra ng e  Grid  Size
This defines the grid size used for auto-arranging.
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26.6 More Options

Syste m T ra y

Click here for further details on the System Tray options.

File  Vie wing  Op tio ns

Ena b le  File  Chunks
This indicates that V will display large files a chunk at a time, instead of reading the entire file. This
greatly reduces the time taken for V to load a file.

Chunk Size
This is the size of the file chunk (in Kb). When File Chunks are enabled, V will only load this much of the
file, regardless of how large the file is. The default chunk size is 8192 (ie, 8 Mb). Click here for more
details on File Chunks.

Ena b le  Smo o th Scro ll ing
Enables "smooth" scrolling. Note that this is different from the "smooth scrolling" that programs like
Internet Explorer support.

Smo o th De la y
Typically a number between 50 and 200 (depending on the speed of your system). Click here for further
details on Smooth Scrolling.

De le ting  File s

Co nfirm File  De le te
Check this option if you would like a warning before any file is deleted. Note that when deleting multiple
files or directories, V will always ask for confirmation.

De le te  to  Re cyc le  Bin
Check this option to delete files to the Recycle Bin. If you have set this option, but want to bypass the
Recycle Bin, just press the shift key when you delete the file.

D isa b le  De le te  in File  Vie w
Check this option if you do not want to delete the file when you are viewing it.

Re na ming  File s

D isa b le  mo use -c lick  re na me
This disables V from renaming files by clicking on the file name in the directory listing. Instead, press
Ctrl+R or select Rename from the File menu. 

Do  no t so rt a fte r re na me
By default, the directory listing is re-sorted after a file is renamed. Enable this option if you do not want to
change the file order.

Do  no t se le c t fi le  e xte ns io n
When enabled, only the name portion of the file is selected when you go to rename the file. This makes
it easier to enter a new name for the file without having to re-enter the extension.
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Wo rd  Se ts

You may define your own wordsets which determine what is highlighted when you double-click and
shift-double-click on a word. Click here for further details.

Use  She ll No tifica tio ns  fo r d ire c to ry  re fre sh
This option should only be enabled if you are having problems with the directory listing being
refreshed. For example, if after deleting files, the directory isn't refreshed to indicate that the files have
been deleted, try enabling this option. You will need to restart V for this option to take effect.
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26.7 System Tray

The following options are set in the More Options section and configure the system tray operation.
Usually, all options would be set.

Minimize  to  Syste m T ra y
If this option is enabled, the V icon will appear in the system tray whenever V is run. When V is
minimized, it will be removed from the task bar, but will remain in the tray.

Minimize  o n Clo se
Usually when V is closed (either by pressing ESCape or hitting the top right hand [x]  button), it will
terminate. By enabling this option, V will return to the tray whenever it is closed. To terminate V, you will
have to select the Exit option from the File menu (or press Alt+X). If you enable this option, closing V is
almost identical to minimizing it. The only difference is that if you minimize V in the File View, the file
being viewed will remain open. When you restore V, the File View will be re-activated. However, if you
close V in the File View, the file will be closed. When V is restored, the Directory View will be displayed.

Alwa ys use  T ra y  Ins ta nce
By default, if a second copy of V is launched, it will not be installed in the tray. In this case, you will have
two instances of V running - the one in the tray and the one just launched. Enable this option if you would
like to always activate the tray instance whenever V is launched (whether it be from the command line,
from Explorer or from a shortcut). If at any time you would like to start a separate instance of V, you can
specify the / I command line option. 

Once V is minimized in the tray, you can restore it simply by left-clicking on the V icon in the tray. Right-
clicking on the icon will display a context menu.

No te s

By enabling the Run at Startup option in the Setup section and by also enabling the above
options, V will be automatically installed in your system tray on startup.

Installation in the system tray is only enabled once V has been registered.
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26.8 Double-Click

Unlike Explorer, which executes a file when you double-click on it, V will simply view the contents of the
file.

This section allows you to define what type of files you would like V to execute (instead of view) when
double-clicking on them.

You may select one of the following:

Vie w All File s
This will cause V to view every file that is double-clicked. You can e xe cute  the file by selecting
"Execute/Run" from the toolbar or File menu.

Exe cute  a ll fi le s  with the  fo llo wing  e xte ns io ns
Any file whose extension is contained in the extensions list will be executed instead of viewed.

The extensions list should contain the extensions (without the dot "."), each extension separated by a
space.

Add any extension to this list that you want executed and remove any that you do not.

Exe cute  a ll fi le s  e xce p t tho se  with the  fo llo wing  e xte ns io ns
The inverse of the above option. That is, V will view all files with extensions in the list and execute all
files that are not.

Ad d  a ll v ie we d  fi le s  to  W ind o ws Re ce nt Do cume nts / Ite ms
Enable this option if you want all files that are viewed by V to be added to Windows R e c e nt D o c um e nts
List.

Ad d  a ll e xe cute d  fi le s  to  W ind o ws Re ce nt Do cume nts / Ite ms
Enable this option if you want all files that are executed by V to be added to Windows R e c e nt
D o c um e nts List.

No te

If you want to view the contents of a file that is configured to be executed when it is double-clicked, use
the Vie w button on the toolbar or select Vie w from the File menu.
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26.9 EBCDIC

This allows the mapping of the 256 EBCDIC characters to their corresponding ASCII equivalent to be
modified. This is necessary because not all EBCDIC character mappings are the same - particularly
when it comes to special or control characters.

The current character mapping is displayed in the EBCDIC to  ASCII table. The first column of the
table displays the EBCDIC code, the second displays the ASCII character which it maps to. The code
in the second column is also displayed in the Curre nt Ma p p ing  list box. For example, the EBCDIC
character F0h represents a 0 (zero) which is 30h in ASCII. To modify the ASCII character to which the
EBCDIC character will be mapped, simply select the new character from the Curre nt Ma p p ing  list
box.

If you wish, the mapping table may be sorted on the ASCII code, by selecting the ASCII to  EBCDIC
option. In this case, the first column of the table will contain the ASCII code and the second column will
contain the EBCDIC character which maps to it.

Character codes can be displayed in decimal instead of hex by selecting the D isp la y  a s  He x
checkbox.

The De fa ult Ma p p ing  button can be used to restore the EBCDIC to ASCII mapping to the default.

No te s

If modified, the EBCDIC to ASCII mapping is not saved unless V has been registered.

The EBCDIC end-of-line character should be mapped to a Line Feed (LF = ASCII 0Ah) and not a
Carriage Return (CR = ASCII 0Dh).

26.10 Line Numbers

V gives you several options when it comes to displaying/printing line numbers alongside the file data.

D isp la y  Line  Numb e rs
Check this option if you want V to prefix each line displayed with its corresponding line number. Line
numbers always begin at 1.

D isp la y  Line  Numb e r 1
When an increment is specified, the first line in the file (line 1) will usually not be numbered. Check this
option if you want the line number displayed on the first line. 

Line  Numb e r Incre me nt
This tells V how often to display line numbers. For example, if the increment was 10, the line number
would be displayed every 10 lines (lines 10, 20, 30, ...). If the increment is left blank (or set to 1), every
line will be numbered.

Pa d  with ze ro  (ins te a d  o f sp a ce )
The line numbers are always a fixed length, depending on the size of the file. For example, if the file has
199 lines, the line numbers would contain 3 digits. Usually V will pad unused digits of the line numbers
with spaces. Check this option if you want zeroes used instead. In this case V will display "001"  instead
of "   1" .
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Re se t Line  Numb e rs  o n Ne w Pa g e  (if p a g ina te d )
If the file is paginated, enabling this option will reset the line number to 1 at the start of each page.

Inc lud e  line  numb e rs  o n Co p y to  Clip b o a rd
Enable this option if you also want the line number(s) included when you copy selected text to the
clipboard.

Printing  Line  Numb e rs

The above options also apply when printing a file, however they must be specified separately as they
may differ from the display options. For example,  you may want to display line numbers but not print
them.

The option to enable line numbers when printing is not found in this dialog box, but on the main Print
Dialog Box.

Two extra line number options exist when printing files.

Print Firs t Line  in Pa g e
Check this to print the line number for the firs t line in each page.

Print La st Line  in Pa g e
Check this to print the line number for the la s t line in each page.

No te

These options only apply to T e xt mode. In Hex mode, the hex address is always displayed/printed.
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26.11 Search

The options presented here are the same as those presented when you press the Options button in
the Search Dialog box.

26.12 Setup

This section lets you install and remove V from various part of your system. Simply check the
appropriate options and press the OK button. The following options may be selected:

De skto p
This installs a V shortcut directly onto the Windows Desktop.

Sta rt Me nu (und e r Pro g ra ms)
This will install a V shortcut in your Start menu (under Programs).

Quick  La unch Ba r
This will add a V shortcut to the Quick Launch Bar on the taskbar (usually next to the Start button).

Exp lo re r Se nd  T o  Me nu
This will place V in the Explorer's Se nd  T o  menu. When you are in Explorer, you can view a file with V
by se nd ing  it to V. That is, by selecting Se nd  T o ->V after right-clicking on the file.

Ad d  Exp lo re r Co nte xt Me nus fo r ALL fi le s
This will add a V option to the default Explorer menu which appears when you right-click on any file, and
a Bro wse  with V option to the menu which appears when you right-click on any directory. This option
also has the effect of making V the default file viewer. If you double-click on a file which has no
associated application, V will automatically be used to view it.

Wa rning !
This option interferes with the operation of the Microsoft Office Toolbar. It also might sometimes cause 
V to be launched instead of another program. If this happens, please disable this option.

For further details see the FAQ section.

Ad d  Exp lo re r Co nte xt Me nus fo r Una sso c ia te d  fi le s
This is similar to the above option, except that an Op e n with V option is only displayed when you right-
click on a file which has no associated application. The Bro wse  with V option will still appear when
you right-click on a directory and V will automatically be launched when you double-click on a file with
no association. Unlike the above, this option does not interfere with the Microsoft Office Toolbar.
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Ad d  V D ire c to ry  to  Syste m PAT H
This option adds the V directory to the PATH environment variable. Doing this enables V to be run from
the Command Line. This option may not work if the user is not an Administrator.

Ad d  V D ire c to ry  to  Use r Pa th
Using the above option adds the V directory to the PATH of every user who logs on to  the PC. Using
this option will only add the directory to the PATH of the current user. Note that if you want to use V from
the Command Line, you only need to enable one of these options. You should use this option (instead
of the above option) if multiple users log on to the same PC, or if you do not have Administrator rights.
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26.13 File Types

Asso c ia te  Exte ns io n with V
You can associate V with certain file extensions (like .T XT  or .LOG). This will launch V, together with
the corresponding file, whenever you double-click on a file with that extension in Explorer. Simply enter
the extension you want to associate with V (eg, TXT) and press the Asso c ia te  Exte ns io n button. To
remove an association, enter the extension and press the Re mo ve  Asso c ia tio n button.

Asso c ia te  V with
Enable all the compressed file formats that you want to associate with V. This will make V the default
ZIP file viewer for the extensions selected.

26.14 Thumbnails

T humb na il Size  (p ixe ls )
Enter the thumbnail size in pixels. The default size if 120. (Note that thumbnails are always square).

Dra w T humb na il Bo rd e r
Enabling this draws a small border around the thumbnail.

Ba ckg ro und  Co lo r
If the image is not square, this color is used as the thumbnail background.

Bo rd e r Co lo r
The color of the border (if it is drawn).

Limit co lo rs  to  16 b its  (use s le ss  me mo ry)
This limits the number of colors in the thumbnail to 16 bits (65,536 colors), which can significantly reduce
the amount of memory V uses.

H ig h Qua lity  T humb na ils  (s lo we r)
If this option is enabled, the thumbnail is generated using Bicubic Interpolation. This can considerably
slow down the speed of the thumbnail display - especially if the image files are large. But the
thumbnails will look better!

Ove rla y  Asso c ia te d  Ico n
Enabling this will draw a small icon in the top left corner of the thumbnail corresponding to the program
associated with the image file (usually an Image Viewer).

T ry  to  g e ne ra te  thumb na ils  fo r the  fo llo wing  fi le  typ e s
Enable this option if you want V to display thumbnails for certain non-image file formats. Enter the
extensions of the non-image files in the list below this option (separated by spaces). For example, to
display thumbnails for AVI and MPG files, you would add "AVI MPG" to the list (without the quotes).
Click here for further details.

Ig no re  Orie nta tio n Se tting
Some photos taken with a digital camera contain an orientation setting which indicates the orientation of
the photo (eg, portrait or landscape). V will use this setting to correctly rotate the thumbnail when it is
displayed. Enable this option to stop V rotating the thumbnail.
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Do  no t d isp la y  Info T ip
This disables the display of the Image InfoTip as the user moves the mouse over the thumbnails. Click
here for further details.

D isp la y  Ima g e  De ta ils
This determines what image details (if any) are displayed below the thumbnail.

Image Dimensions The size of the image (width x height) in pixels
Date & Time The date and time that the image file was last modified on the PC
File Size The size of the image file
Use Date Taken (if
available)

If the image was taken with a digital camera, it may contain the date/time that
the photo was taken. If it does, this date/time is displayed instead of the date/
time the image file was last modified.

Background Color The background color of the Image Details
Text Color The text color of the Image Details

Pressing the Ad va nce d  button allows you to set the following options:

Use  Wind o ws (ins te a d  o f V) to  g e ne ra te  the  thumb na ils  fo r AVI a nd  MPG file s
V generates the thumbnails for video files differently to Windows Explorer. If you prefer the way that
Windows generates the thumbnails (eg, it might be faster), then enable this option.

Which fra me  to  d isp la y  a s  the  thumb na il
By default, the first frame of the video is displayed as the thumbnail for video files. If you have not
enabled the above option, you may also specify which frame is displayed as the thumbnail. This is an 
a b so lute  fra me  numb e r, and not a "time" position (say in milliseconds). The first frame is frame 0.
Use a negative frame number to indicate a frame position from the end of the file.

For example, specifying a frame of -1 will display the last frame of the video as the thumbnail.

T ry  to  Ge ne ra te  T humb na ils  fo r Fo ld e rs
If this option is enabled, V  will try to display thumbnails for folders. Typically, the folder thumbnail will
contain a selection of images from within that folder. Note that this option may significantly  slow down
the display of the directory listing.
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26.15 Editor/CMD

V is not an editor. If while you are viewing a file, you decide you want to edit it, you must do so with a
separate editor. Most people will have an editor of choice on their system. If you don't, you can always
use no te p a d .e xe  which should be in your WINDOWS system directory.

The Editor options tell V what editor to use to edit the file. To launch the file in your editor of choice, you
need to select the File->Edit command. There are 2 options you can specify - just click on the
corresponding button to set them.

Pa th The full path name of your editor (usually an EXE file)
Op tio ns The options you want passed to your editor (if any)

The above path and options will be used to construct a command that Windows will execute. The
command will look as follows:

Pa th + Op tio ns  + File Na me

For example,

\b in\e d ito r.e xe  /v  fi le .cp p

Where more than one file has been selected, the file names will be appended onto the end of the
command, separated by spaces.

Ad va nce d  Op tio ns
You can pass further options (like the current line number) by using option specifiers (like %L). An
explanation of the available options specifiers is given in the User Commands section.

He x Ed ito r

If you want a different editor to be called while you are viewing a file in hex mode, simply define a
second editor in the "Hex Editor" section.

Pa ss ing  the  MSDOS File  Na me
Enable the Use  MSDOS file  na me  option in each of the above cases in order to pass the MSDOS
(8.3) file name to the command. This may be necessary if the specified executable is a 16-bit program
which does not support long file names.

Co mma nd  Pro ce sso r

You can use a different Command Processor (to CMD.EXE) to launch a Command Prompt by enabling
"Use the following Command Processor" and clicking on the Path button to select its path.

No te s

If you want to use more than one editor, you can define it as a User Command.

By default, you can use Ctrl+E to launch the editor and Ctrl+Shift+E to launch the hex editor.

To remove the currently defined editor, right-click on the corresponding button and select Cle a r P a th.
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26.16 Fonts

To change the fonts, simply click on the corresponding button.

Scre e n Fo nt
The font used in the File View to display the contents of the file.

Printe r Fo nt
Specifies the font to be used when printing.

2UP Fo nt
Specifies the font to be used when printing in 2UP mode.

End  o f Line  Ind ica to r
You can also specify which character is to be used as the End  Of Line  Ind ica to r. This character will
be displayed at the end of every line if the Show EOL option is set, or will be printed at the end of every
line if the Print End of Line option is selected in the Print dialog box.

Use  DOS/OEM cha ra cte r se t whe n v ie wing  fi le
This is equivalent to the DOS/OEM Char Set option (on the View menu while viewing a file).

Use  DOS/OEM cha ra cte r se t whe n p rinting
The same as above - but for printing. Enable this option if you are printing files that contain line drawing
characters. Note that this will only work if the selected font supports the OEM character set.

No te s

V only allows use of non-proportional (or fixed-pitch) fonts (like Courier) when displaying files.
This makes file display, block highlighting and line wrapping much quicker than would be
possible using proportional fonts (like Arial or MS Sans Serif).

Screen fonts can also be selected from the Fonts menu.

When printing, it is usually best to use the printer's own built in font (if it has any) - it looks much
better than Courier. For HP LaserJet printers, you should be able to select a font called
LinePrinter. Printer fonts have a small printer icon next to them in the Font Selection List.

Proportional fonts may be chosen when printing, however, line wrapping will not work correctly. 
Click here for further details.

Not all fonts share the same character set. Because of this, you may need to reselect the End Of
Line Indicator whenever you select a new font.

The Printer fonts may also be selected from the Print Dialog box.
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26.17 History

In most cases where the user is asked for input (like search strings), V will maintain a history of the data
entered.

When asked for input, the user can either select an entry from the drop-down list box or just type in
something new.

The History tab allows you to enable/disable the various histories as well as set the history size.

Ena b le  MRU File  Lis t
Enable this option if you want V to keep a history of the Most Recently Used (MRU) viewed files.
These files will be listed on the Recent Files menu. You may also specify the number of files to
remember (up to 50).

Ma inta in D ire c to ry  H is to ry
Enable this option if you want V to keep a history of the directories browsed. These directories will be
stored in the Directory drop-down list box which appears at the top left of the Directory View. You may
also specify the number of directories to remember (up to 99).

File  Ma sk H is to ry
The File Mask history is displayed next to the Directory history . Entering a value of 1 will effectively
disable the file mask history (and will cause V to always start with a mask of *.*).

Ena b le  Se a rch H is to ry
Enable this to remember the strings searched for while viewing a file.

Ena b le  GREP String  H is to ry
Enable this to remember the search strings entered when doing a GREP.

Ena b le  GREP File /Ma sk H is to ry
Enable this to remember the file names and file masks when doing a File Search or GREP.

Only  ma inta in Se a rch/GREP his to ry  while  V is  a c tive
Enabling this option will cause V to maintain a search string history only while it is active. As soon as
you exit and restart V, the history will be empty.

Only  ma inta in GREP fi le /ma sk his to ry  while  V is  a c tive
The same as above, but for the file name and file mask history.

Sa ve  e ve ry  lo g g e d  d ire c to ry  in the  D ire c to ry  H is to ry
By default, V  only adds a directory to the directory history if a file in the directory is accessed (ie,
viewed, copied, ...). Enabling this option causes V to add every directory logged to the history.

Use  the  sa me  his to ry  fo r Co p y/Mo ve /Zip  p a ths
Enable this option if you want V to use the same history for Copy, Move and UnZip operations. See
here for further details.

Do  no t a d d  e xe cute d  fi le s  to  the  MRU
"Executed" files are files that are passed onto another program when the user double clicks on them.
For example, HTML files may be viewed by your browser instead of V.
Executed files are added to the MRU so they can be re-executed by being selected from the Recent
Files list. Enabling this option will not added executed files to the MRU.
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Cle a ring  a nd  So rting  the  H is to ry

The history can be cleared at any time by right clicking on the down arrow to the right of the
corresponding list box, and selecting "Clear History". An individual entry may be deleted by selecting
"Delete this entry". Select "Sort History" to alphabetically sort the history list.

No te s

The larger the history sizes, the more information V has to read from the disk on startup and write
to the disk on exit.

Not all history can be sorted.

26.18 InfoTips

InfoTips are multiline tooltips that are sometimes displayed as you move the cursor over entries in the
Directory Listing. Appropriate Shell Extensions need to be installed for InfoTips to be displayed. These
extensions are not part of V.

This section allows you to define how InfoTips will be displayed.

Note that InfoTips are disabled by default, and will only work on Windows 200x and XP.

You may select one of the following:

Do  no t d isp la y  Info T ip s
V will not display InfoTips.

Alwa ys d isp la y  Info T ip s  whe n a va ila b le
InfoTips will always be displayed (if available).

Only  d isp la y  Info T ip s  fo r the  fo llo wing  e xte ns io ns
InfoTips will only be displayed for files whose extension is in the extension list. The extensions list
should contain the extensions (without the dot "."), each extension separated by a space.

For example, "MP3 MPG AVI DOC".

D isp la y  Info T ip s  fo r a ll fi le s  EXCEPT  tho se  with the  fo llo wing  e xte ns io ns
The inverse of the above option. That is, V will display InfoTips for all files whose extension is  no t in
the extensions list.

Only  d isp la y  Info T ip s  if the  SHIFT  ke y is  p re sse d
If this option is enabled, InfoTips will only be displayed if the Shift key is pressed.

Note that if you press the Shift key when you are over a file name, the InfoTip for that file name will not
be displayed. You need to move the mouse over the file name while the Shift key is pressed.

That is, if you want to display the InfoTip for a file, make sure the mouse is *not* over the file name,
press the Shift key and then move over the file name.
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26.19 Keyboard

Dire c to ry  Vie w Ke ys

Sing le  Le tte r Co mma nd s
Specifies whether Single Letter Commands are allowed. For example, you can use D  to delete a file as
well as Co ntro l-D . Note that Single Letter Commands are not available in the File View, but you can
customize the keyboard to achieve the same effect.

Ctrl+Arro w ke ys  to  scro ll
If you enable this option, Ctrl+UpArrow and Ctrl+DownArrow will scroll the directory listing without
changing the selection. This makes it easy to center the listing on the selected entry.

File  Vie w Ke ys

Pa g e  Up /Do wn to  g o  to  s ta rt o f p a g e  if fi le  is  p a g ina te d
If a file is paginated, enabling this option will cause Page Up/Down to scroll to the start of a new page
instead of scrolling the length of the window. Click here for further details on paginated files.

Esca p e  Ke y

The following options determine how the Escape key is treated. Note that some of these options are
mutually exclusive.

Exit (o r minimize ) V if p re sse d  in the  D ire c to ry  Vie w
If pressed in the Directory View, the Escape key will close V. If the Minimize on Close option has been
enabled, V will be minimized.

Exit (o r minimize ) if wa s V s ta rte d  in the  File  Vie w
If V is started in the File View (eg, if it was launched by another program as an external viewer),
pressing the Escape key will close V instead of simply closing the file window and returning to the
Directory View. If Minimize on Close has been enabled, the file window will be closed and V will be
minimized.

Clo se  Wind o w if p re sse d  in the  File  Vie w
Pressing ESC will simply close the file window. If another file window is open, V will give it focus,
otherwise, V will return to the Directory Listing.

Clo se  Wind o w a nd  Re turn to  the  D ire c to ry  Lis ting
Pressing ESC will always return to the Directory Listing, regardless of whether any other file windows
are open. Note that if a Search results window is visible, V will return to the Search results instead of the
Directory Listing.

26.20 Language

The Language tab allows you to select V's user interface language (ie, the language used to display
the menus, dialogs and messages).

No te

V needs to be restarted for the new language to take effect.
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27 Favorites

27.1 Favorites

Favorites provide an easy way to bookmark frequently viewed files and directories for faster retrieval.
Once saved, a favorite may be viewed by selecting it from the Favorites menu.

The currently viewed file or directory may be added to the Favorites by selecting the Add to Favorites
option from the Favorites menu.

When adding a favorite, you can give it  a meaningful description which will be displayed in the
Favorites menu. If you do not, the path name will be displayed.

You can also store the favorite in a "Folder" by highlighting a folder name in the "Create in" list. You can
create a new folder by pressing the "New Folder" button. Favorites stored in folders will appear in
popup menus off the main Favorites menu.

Fa vo rite s  in Dua l Pa ne  Mo d e

In Dual Pane Mode, you can select "Add Directory Pair to Favorites" to create a Favorite containing the
directories in *both* panes. When the Favorite is selected from the Favorites menu, *both* directories
will be displayed in Split mode.

When selecting a single Favorite directory in Dual Pane mode, the directory will be displayed in the 
currently active pane, unless you have specified that the Favorite always be displayed in a particular
pane.

The favorites may be modified by selecting the Organize Favorites option.

No te

Unregistered versions will only be able to select the first 3 favorites.
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27.2 Add To Favorites

Ad d ing  a  D ire c to ry

When adding a directory to the Favorites, you may set the following options:

Re sto re  File  Ma sk
If this is enabled, the current file mask will also be restored when the favorite is selected.

Re sto re  So rt Ord e r
If this is enabled, the current sort order will also be restored when the favorite is selected.

Ad d ing  a  File

You will usually add a file to the Favorites while you are viewing it. When adding a file to the Favorites,
you may set the following option:

Re sto re  File  Po s itio n
If this is enabled, the current file position will be restored whenever the favorite is selected. Otherwise,
the file will be viewed from the start.

Exe cuting  a  Fa vo rite
You can also add a file to the Favorites from the Directory View by highlighting it and selecting "Add
Selection to Favorites" from the Favorites menu. You will then have the option of enabling the Exe cute
option. If this is enabled, the file will be "executed" when selected from the Favorites menu. Otherwise, it
will be displayed.

For example, if you add a "Word Document" to your Favorites, enabling the "execute" option will cause
the file to be loaded in Word when you select it from the Favorites menu (instead of being displayed by 
V).
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27.3 Organizing Favorites

You may add, delete, move and edit favorites by selecting "Organize Favorites" from the Favorites
menu. A favorite may be moved to a new position by simply dragging it and dropping it into its new
position. The favorite will be placed b e fo re  the entry on which it was dropped.

Favorites may be created by pressing the "Insert File" or "Insert Directory" buttons. "Insert Copy" will
create a copy of the currently highlighted favorite. "Insert Separator" will insert a separator into the
Favorites menu.

Org a nizing  into  Sub me nus

If you have many favorites, you will probably find it useful to organize them into submenus. To create a
new submenu, press the "Insert Submenu" button.

To move a favorite into an empty submenu, simply drop it onto the submenu name. If the submenu is
not empty, it will expand so you can drop the favorite into the required position. The dropped favorite
will be placed *before* the entry it is dropped on. If you want to place the favorite at the *end* of the
submenu, drop it onto the submenu name you want it placed under.

If you want to move a favorite so that it is positioned just before a submenu, you need to press the
SHIFT key as you drop the favorite onto the submenu you want it to precede. If you do not press the
SHIFT key, the favorite will be placed inside the submenu.

For further details on modifying favorites, see the following:

Favorite Directories
Favorite Files
Sorting Favorites
Using Numeric Drive Letters  in path names

Pressing the Mo re  button displays a menu that allows you to sort, export and import.

No te

You cannot create a submenu within a submenu.
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27.4 Favorite Directories

The following may be specified for a favorite directory:

D ire c to ry  Pa th
The directory name. Press the "..." button to browse. You can use numeric drive letters in the directory
path which will be expanded depending on the environment in which V is being run. Click here for further
details.

Pressing the small question mark button will display a list of valid drive letters.

File  Ma sk
The file mask to use when the favorite is selected. If this is blank, the current mask will be maintained.

Re sto re  So rt Ord e r
If this is enabled, the specified sort order will be set when the favorite is selected. Otherwise, the current
order will be maintained.

Alwa ys Op e n in Pa ne 1/Pa ne  2
If a Favorite directory is selected in Dual Pane Mode, it will be displayed in the currently active pane (ie,
the pane which has focus). By enabling one of these options the Favorite is always displayed in the
same pane, regardless of which pane has focus. When the Favorite is displayed in the Favorites menu,
a 1 or 2 will appear next to the Favorite name indicating which pane the Favorite will be opened in.

This option is ignored if the Favorite is selected in Single Pane mode. This option is also ignored if the
SHIFT key is pressed while selecting the Favorite. That is, the Favorite will be displayed in the current
pane instead of the pane specified.

Sho rtcut Ke y
You can assign a keyboard shortcut to this Favorite so that is it executed every time the keyboard
shortcut is entered. Simply click in the S ho rtc ut Ke y box and enter the desired key combination. Press
the ESCape key to clear the shortcut key. A beep will sound if the shortcut key is currently assigned.

Bla nk D ire c to ry

The directory name may be left blank. In this case, only the file mask and/or sort order will be modified.

This provides an easy way of changing the file mask and or sort order for the current directory. For
example, you could display all the ZIP files in descending date order by simply selecting a favorite.
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27.5 Favorite Files

The following may be specified for a favorite file:

File  Pa th
The file name. Press the "..." button to browse. You can use numeric drive letters in the file path which
will be expanded depending on the environment in which V is being run. Click here for further details.

T a il
If this is enabled, the file position is set to the end of the file.

He x
The favorite is viewed in Hex mode.

EBCDIC
The favorite is viewed in EBCDIC mode.

Re sto re  File  Po s itio n
If this is enabled, the file position will be restored. Otherwise, the file will be viewed from the start.

The file position consists of:

Line  Numb e r
The line number at which to position the file. If the file is to be opened in Hex mode, this will refer to a
Hex o ffse t instead of a line number.

Co lumn
The column position.

Chunk
The chunk to load (if the file is large enough to be loaded in chunks)

Sho rtcut Ke y
You can assign a keyboard shortcut to this Favorite so that is it executed every time the keyboard
shortcut is entered. Simply click in the S ho rtc ut Ke y box and enter the desired key combination. Press
the ESCape key to clear the shortcut key. A beep will sound if the shortcut key is currently assigned.

Bla nk File  na me

The file name may be left blank. In this case, only the file position and/or mode will be modified.
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27.6 Sorting Favorites

Pressing the More button and selecting the S o rt option will display a dialog box, allowing you to sort the
Favorites.

By default, the Favorites will be sorted alphabetically on their description, regardless of whether  they
are a file, a directory or a submenu. The following options can be set to modify the default behavior.

Pla ce  File s  b e fo re  D ire c to rie s
If this is enabled, all files will be placed at the top of the list.

Pla ce  D ire c to rie s  b e fo re  File s
Enable this to place all directories at the top of the list.

Pla ce  Sub me nus a t to p
Enable this, to place all submenus at the top.

Pla ce  Sub me nus a t b o tto m
Enable this, to place all submenus at the bottom.

So rt Sub me nu co nte nts
By default, submenu contents will not be sorted. Enable this option to also sort submenus.

27.7 Exporting/Importing Favorites

Pressing the More button and selecting the E xp o rt option will display a dialog box allowing the
Favorites to be exported to a file.

The exported file can then be imported by another user by selecting the Im p o rt option and specifying
the imported file.

No te

User Commands and GridLines can also be exported/imported in the same way as Favorites.
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27.8 Using Numeric Drive Letters in Paths

When specifying a file or directory path (in Favorites and User Commands), certain numeric drive
letters can be used to specify various system paths. This is particularly useful when using the portable
version of V - where the actual file paths can be different every time V is run.

The following drive letters are currently defined:

0: The folder from where V is being executed.
1: The Windows folder (usually C:\Windows)
2: The System folder (usually C:\Windows\System32)
3: The Portable Drive (eg, X:\)
4: The folder on the portable drive where the V settings are stored. 
5: The user's My Documents folder
6: The user's Program Files folder
7:  The user's Profiles folder (usually C:\Documents and Settings)

No te

Numeric Drive Letters can also be used when specifying a text editor and a Command Processor.
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28 User Commands

28.1 User Commands

A User Command is any program (usually an EXE file) that the user may wish to execute from V. 

In the Directory View, the currently selected file(s) may be passed to the User Command and in the File
View, the currently viewed file may be passed to the command.

This is a great way to extend V.

For example, V cannot encrypt files. However, if you already have a program which does this, you can
define a User Command which will let you encrypt files using V.

User Commands are created by selecting Organize from the UserCommands menu. Once created,
User Commands are executed by selecting them from the UserCommands menu. 

Ke yb o a rd  Sho rtcuts

The default User Command is the first in the list and can be executed by pressing Ctrl+U. The most
recently executed User Command can also be repeated by pressing Ctrl+Shift+U. Each User
Command can also be assigned its own keyboard shortcut.

Running  a s  Ad minis tra to r

Under Vista or Windows 7,  the User Command can be run as an Administrator by right-clicking on the
command and selecting R un A s  A d m inis tra to r

De b ug  Mo d e

If you right-click on the User Command and select R un in D e b ug  M o d e, the command to be executed
will be displayed before it is run. You will then have the option of running the command or cancelling it.
This is a good way of making sure that the correct file names are being passed to the command.
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28.2 Organizing User Commands

Organizing User Commands is very similar to Organizing Favorites.

You may add, delete, move and edit User Commands by selecting "Organize" from the
UserCommands menu. A command may be moved to a new position by simply dragging it and
dropping it into its new position.

User Commands may be created by pressing the "Insert Command" button. "Insert Copy" will create a
copy of the currently highlighted command. "Insert Separator" will insert a separator into the
UserCommands menu.

Org a nizing  into  Sub me nus
If you have many User Commands, you will probably find it useful to organize them into submenus. To
create a new submenu, press the "Insert Submenu" button.

To move a command into an empty submenu, simply drop it onto the submenu name. If the submenu is
not empty, it will expand so you can drop the command into the required position. The dropped
command will be placed *before* the entry it is dropped on. If you want to place the command at the
*end* of the submenu, drop it onto the submenu name you want it placed under.

If you want to move a command so that it is positioned just before a submenu, you need to press the
SHIFT key as you drop the command onto the submenu you want it to precede. If you do not press the
SHIFT key, the command will be placed inside the submenu.

For further details on modifying User Commands, see the following:

Specifying User Command Options
Using Option Specifiers
Using Numeric Drive Letters in path names

Pressing the Mo re  button displays a menu that allows you to sort, export and import.

No te : You cannot create a submenu within a submenu.
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28.3 User Command Options

To define a User Command you must specify the following information and options:

Co mma nd  Pa th
The full path name of the command to be executed. Press the "..." button to browse.
%A can also be entered as the command path. In this case, it will be replaced by whatever program is
associated with the selected file when the User Command is invoked.

Numeric drive letters can be used in the file path, which will be expanded depending on the
environment in which V is being run. Click here for further details. Pressing the small question mark
button will display a list of valid drive letters.

Sho rtcut Ke y
You can assign a keyboard shortcut to this User Command so that is it executed every time the
keyboard shortcut is entered. Simply click in the S ho rtc ut Ke y box and enter the desired key
combination. Press the ESCape key to clear the shortcut key. A beep will sound if the shortcut key is
currently assigned.

Co mma nd  Op tio ns
The options that will be passed to the command (if any). This will usually look something like /
o p tio n1 /o p tio n2. The options may also contain option specifiers which are expanded when the user
command is run.

Op tio ns  a fte r fi le  na me
Will place the command options after the file name. See the explanation of the Command Format
below.

Sta rt in Co mma nd  Pa th
By default, the working directory of the User Command will be the directly currently being viewed or the
directory of the current file. By enabling this option, the working directory will be set to the directory that
contains the User Command.

Run As Ad min
Enable this (on Vista and Windows 7) to run the command as an Administrator.

W ind o w
This describes the state of the User Command window when it is executed. It may be either No rma l,
Minimize d , or Ma ximize d .

Do  no t p a ss  File  na me s
By default, any selected files (or directories) will be passed to the command. Enabling this option will
cause nothing to be passed to the command (apart from the Command Options).

Pro mp t fo r e xtra  o p tio ns
By enabling this, the user will be prompted for extra options that will be passed to the command. These
options will be appended to any options in Co mma nd  Op tio ns. 

Use  MSDOS na me s
If any files are selected, the MSDOS (8.3) form of the file name will be passed to the command. 
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Do  no t a llo w multip le  fi le s
Enabling this option will ensure that the command is not executed when more than one file is selected. 

Exe cute  co mma nd  fo r e a ch fi le
If multiple files are selected, all the file names will be passed to the User Command, and the command
will be executed once. By enabling this option, the User Command will be executed for each selected
file. 

Wa it fo r co mma nd  to  finish
 When executing a User Command, V simply launches it and then gets back to business - it does not
wait for the command to terminate. In the above case, executing a User Command for each selected
file can result in multiple instances of the same program being active at the same time. By enabling this
option, V will only execute the User Command on a file once the command on the previous file has
finished.

De b ug  Mo d e
If this option is enabled, the User Command will be displayed, and the user asked to confirm if it is to be
executed. This allows the user to experiment with option specifiers without actually having to execute
any commands.

De fa ult Use r Co mma nd

The d e fa ult user command may be executed by pressing Ctrl-U. The default user command is
considered to be the firs t command in the User Command list.

Co mma nd  Fo rma t

By default, the actual command that V will execute will look as follows:

[Command Path ] [Options] [Extra Options] file(s)

If "Options after file name" is enabled the command will look as follows:

[Command Path ] file(s) [Options] [Extra Options]

In the case where more than one file name is selected, all the file names are included on the command
line, separated by spaces. 

No te s

Unregistered versions will only be able to execute the first defined User Command.

If a option specifier is used in the Command Options, any selected file names are not
automatically added to the command line. If the user wants the file name(s) passed to the
command, the appropriate file name specifier (%f or %F) needs to be used.

28.4 Option Specifiers

User commands are constructed by appending the selected file name(s) to the command options.
Although there is an option to place the options last, no further flexibility is available. For example, you



V Help File286

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

cannot place some options before the file name(s) and some after.

Unless you use Option Specifiers.

Option specifiers are entered in the Co mma nd  Op tio ns  and are expanded when the command is
executed. An option specifier consists of a percent sign (%) followed by a single character. The valid
specifiers are as follows (note that case is important): 

F The selected file name(s) - includes fully qualified path
f File name only (no path)
G The fully qualified selected file names(s) with any extension omitted
g File name only with extension omitted
D The name of the current directory - includes fully qualified path
d Directory name only 
Z The name of the ZIP file - fully qualified path (Zip View only)
z ZIP file name only 
T  o r t The currently selected text (File View or Search Results View
U o r u The currently selected (or right-clicked) URL 
W The currently selected (or right-clicked) word (using word set 1)
w using word set 2 
X The column number of the start of the selected text
x The column number of the end of the selected text 
Y The line number of the start of the selected text
y The line number of the end of the selected text
l The number of the current line
L The line number at the top of the display 
n The number of characters highlighted (in decimal)
N (in hex) 
s The start offset of the selected text (in decimal)
S (in hex) 
e The end offset of the selected text (in decimal)
E (in hex) 
P o r p Prompts the user for "extra options" which will be appended to the Command Options

User Commands are always executed on the currently active pane. However, in Dual Pane Mode, it is
possible to execute a User Command which includes files from both panes. When defining a User
Command, the file and directory option specifiers (%F, %D) may now be prefixed by either 1 or 2 to
indicate the pane number that the file/directory corresponds to.

For example, if you had a program that compared 2 files, you could create a User Command with
Command Options set to "%1F %2F". If executed from Dual Pane mode, it would pass the selected
file(s) from the first pane *and* the second pane. The User Command will be invalid if it is run from
Single Pane mode.

No te

A User Command will not be executed if a option specifier cannot be expanded. For example, if %W is
specified and no text has been selected.
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28.5 Sorting User Commands

Pressing the More button and selecting S o rt will display a dialog box, allowing you to sort the User
Commands.

By default, the User Commands will be sorted alphabetically on their description. The following options
can be set to modify the default behavior.

Pla ce  Sub me nus a t to p
Enable this, to place all submenus at the top.

Pla ce  Sub me nus a t b o tto m
Enable this, to place all submenus at the bottom.

So rt Sub me nu co nte nts
By default, submenu contents will not be sorted. Enable this option to also sort submenus.

28.6 Exporting/Importing User Command

Pressing the More button and selecting the E xp o rt option will display a dialog box allowing the User
Commands to be exported to a file.

The exported file can then be imported by another user by selecting the Im p o rt option and specifying
the imported file.

28.7 Using Numeric Drive Letters in Paths

When specifying a file or directory path (in Favorites and User Commands), certain numeric drive
letters can be used to specify various system paths. This is particularly useful when using the  portable
version of V - where the actual file paths can be different every time V is run.

The following drive letters are currently defined:

0: The folder from where V is being executed.
1: The Windows folder (usually C:\Windows)
2: The System folder (usually C:\Windows\System32)
3: The Portable Drive (eg, X:\)
4: The folder on the portable drive where the V settings are stored. 
5: The user's My Documents folder
6: The user's Program Files folder
7:  The user's Profiles folder (usually C:\Documents and Settings)

No te

Numeric Drive Letters can also be used when specifying a text editor and a Command Processor.
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29 Printing Files

29.1 Print Options

When the Print command is selected, the Print Dialog Box will appear (which is different from the
standard Windows Print Dialog Box). The following options may be specified:

Printe r
The name of the printer to send the file to. All available printers will be listed in the drop-down list box.

He a d e r & Fo o te r
Check the appropriate box to print a header and/or footer. The text for the header/footer is entered in
the corresponding edit box. A history of the previous 10 headers is maintained making it easy to select
commonly used headers. Click here for a description of the Headers and Footers formats. If a header/
footer is enabled, but no text entered in the edit box, the default header/footer is printed.
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Ove rrid e  Pa g e  Le ng th
This option is used if you want your page size to have a certain length (in lines). Click here for further
explanation.

Co p ie s
The number of copies that you want printed.

Printe r Fo nt
This button will display the font that V will use for printing. Click here for more details.

Pro file
This allows you to save all current settings in a Printer Profile or to restore the settings in a profile. Click
here for further details.

2Up
Specifies that you want the document printed in 2UP Mode.

He x Mo d e
This option can only be set if the print was initiated from the Directory View and specifies if the file is to
be printed in Hex mode. If the print was initiated from the File View, this option would be disabled and
would indicate the mode in which the file was being viewed.

Ve rtica l He x Mo d e
Prints the file in Vertical Hex Mode

Gre e nb a r
Apply Greenbar to the printed text.

Print Line  Numb e rs
Specifies whether line numbers will be printed with the file. Various options regarding the printed line
numbers are set in the Line Numbers  tab of the Preferences Dialog box. Note that the format of the
printed line numbers can differ from that of the displayed line numbers.

Print End  o f Line
Enable this option if you want an End Of Line (EOL) indicator printed at the end of every line. The
character that is used for the indicator depends on the font used and can be specified in the Fonts tab
of the Preferences dialog box.

Dup le x (lo ng  e d g e ) /  Dup le x (sho rt e d g e )

If your printer supports duplexing (double sided printing), you may also specify if you want to enable
short/long edge binding. Note that the duplex options are always enabled - even if
your printer does not support duplexing.

Wra p  Lo ng  Line s
Click here for an explanation of line wrapping.

Fo rm Fe e d s
This determines how Form Feeds will be handled. Click here for an explanation.

Ma rg ins
Set the size (in inches) of the top, bottom, left and right margins. Click here for further details.
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Po rtra it/La nd sca p e
Specifies if the file is printed in Portrait or Landscape mode. Note that this option is ignored if the file is
to be printed in 2UP mode (which is always printed in Landscape).

Pa g e  #
Select the pages you want printed. Click here for further details.

Line  #
Select the lines you want printed. Click here for further details.

Sid e s
This lets you select if you want all pages printed or just the o d d /e ve n numbered pages (which makes
double sided printing possible).

Se tup
The Se tup  button is used to configure the selected printer. The Print Se tup  command from the File
Menu can be used to configure the default printer.

Mo re
Click here for further details.

No te s

It is always a good idea to do a Preview before printing - especially if the printout is going to be large.

Greenbar may not always preview correctly - but it should print correctly.

Unregistered versions of V have the following restrictions:

Header/Footer history is not saved

A ruler may not be printed as a header/footer

A fixed footer is always printed
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29.2 Wrapping Lines

If a line is too long to fit on the printed page, you can have it wrap to the beginning of the next line by
checking the Wra p  Lo ng  Line s  option. 

You must then select the type of wrapping from the adjacent list box. This can be one of:

R ig ht Ma rg in
In this case, the text is wrapped whenever a line reaches the right margin.

Co lumn
Select this option to have the text wrapped at a specified column position (which you enter in the
adjacent box).

Ne w Pa g e
When this is selected, long lines are wrapped onto a new page. For example, if a page is 100
characters wide, a line of 300 characters will span 3 pages. That is, the first 100 characters will be
printed on the first page, the second 100 on the next and the third 100 on the next.

No te s

If  this option is not enabled, any long lines will be truncated.

If you select column wrapping and the column length is too long to fit on the page, the lines will be
truncated.
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29.3 Print Range

This lets you specify what part of the file you want printed. You may select one of the following:

All
Prints the entire file

Pa g e  #
Prints the range of pages you specify in the Fro m and T o  boxes.

Line  #
Prints the range of lines you specify in the Fro m and T o  boxes.

Se le c tio n
Prints the currently selected text. If no text is selected, this option will be disabled.

Fro m Curre nt Pa g e
Starts printing from the start of the curre nt p a g e  - which is the line that is currently displayed at the top
of the screen. The number of pages to print is specified in Pa g e s. If this is left blank, V will print to the
end of the file.
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29.4 Headers and Footers

User defined headers and footers can be printed on every page. Headers (and footers) each consist
of 3 sections - le ft, ce nte r and rig ht,  which are left justified, centered and right justified, respectively.
To specify a header, you enter each of these 3 sections, separated by a semi-colon. That is -
"le ft;ce nte r;rig ht" (do not include the quotes). 

Each of these sections can contain plain text, special format specifiers or can be empty. The format
specifiers consist of a percent (%) followed by one character, and are expanded upon printing. The
valid specifiers are as follows (note that case is important): 

%f Name of the current file (name only)
%F Full Path Name of current file
%d Current Date
%D Directory Name (ie, %F without the file name)
%e File Date
%t Current Time (24 hour format)
%T Current Time (12 hour format)
%u File Time (24 hour format)
%U File Time (12 hour format)
%p Current Page Number
%P Total pages to be printed
%r Print the Ruler
%g Print the Gridlines
         
If you want to use a "%" or " ;"  in the header text - prefix them with a "%". That is, use "%%" and "%;"
respectively. 

 Examples: (once again, do not enter the quotes) 

"%f;;Pa g e  %
d "

Print the file name on the left and page number on the right

" ;%d ;" Just print the page number (with no text) in the center
" ;;" Prints an empty header/footer
         
If the header/footer field is left blank, it defaults to "%f;%d  %t;Pa g e  %p ". That is, it prints the file name
on the left, the date and time in the center, and the Page number on the right.

No te s

The ruler and gridlines cannot be combined with any other specifier (only each other). For
example, you cannot combine the ruler with a page number. If "%r" is specified, then anything
else that may be entered in the header/footer is ignored (with the exception of %g).

If both a ruler and a grid are specified ("%r %g" or "%g %r"), the grid will always be displayed
after the ruler if printed as a header, and before the ruler if printed as a footer.

The ruler specifier will be ignored unless V has been registered.
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29.5 Form Feeds

Form feed characters (ASCII 12 or Ctrl-L) are generally used in text files to signify a page break.

You may select  one of the following 3 Form Feeds options in the Print Dialog Box:

Ne w Pa g e V will start a new page every time a form feed is encountered.
Dra w Line A page separator (dotted line) will be printed whenever a Form Feed is encountered - a

new page will not be started.
Ig no re The form feed will be treated as a normal character - and will be printed. The appearance

of the printed form feed will depend on the print font.

29.6 Margins

The margins specify the distance from the text to the edge of the page in each direction and are always
specified in inches. For those who are only familiar with centimetres, 1 inch is equal to 2.54cm. 

Modifying the size of the margins affects the size of the page that is available to print the file - the larger
the margins, the smaller the area available to print the file.

29.7 Page Length

Usually, the number of lines that can fit on a page is determined by the physical length of the page, the
size of the margins and the height of the printer font.

At times, files are pre-formatted to a particular page length (usually around 60 lines). That is, the file
usually contains it's own header and/or footer every 60 lines. Printing a file which has been pre-
formatted to 60 lines on a page that is physically 66 lines long will look awkward - headers and footers
will start appearing all over the pages, instead of where they should be!

To overcome this problem, you can override the physical page length by specifying the length of the
printer page. This causes V to start a new page as soon as the specified number of lines has been
printed instead of waiting until the end of the page.

No te s

The page length specified must be less than or equal to the maximum page length allowed by
the printer.

Pre-formatted files usually contain their own header/footer, so you will probably have to disable
V printing any of its own.

If your listing is already formatted to a certain page length which is larger than your printer page
length, you will have to increase the size of the printer page (by reducing the top and bottom
margins and/or disabling the header/footer) or reduce the size of the printer font. 

Some files contain form feed characters (Ctrl-L or ASCII 12 decimal) to indicate a page break. V
will start a new page whenever it encounters a form feed.
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29.8 2UP Printing

2UP printing would probably have to be one of the most useful (and most used)  features of V. At least it
is for me!

2UP printing not only saves paper, but I find the listings actually look better and are easier to read,
since you have more information on the one page.

When files are printed in 2UP mode (also known as book mode), the file is printed in Landscape mode
with two pages being printed (side by side) on each sheet of paper.

2UP printing is ideal for program listings, hex dumps and README files.

No te s

When printing in 2UP mode, you should use a smaller font than you would use for normal printing.
On a HP LaserJet, the built-in LinePrinter font is ideal.

See the Fonts section of the Preferences Dialog box for further information on selecting Printer
fonts.

The Orientation option (Portrait/Landscape) is ignored when 2UP printing is selected - the printer
is always placed in Landscape mode.

29.9 Printer Fonts

The font that V will use for printing will be displayed in a button just above the "Options" group in the
dialog box. You may change the font by clicking on the button and selecting a previously used font from
the list displayed. You may add a font to the list by selecting Ad d  Fo nt.

Select Org a nize  Fo nts  if you want to modify the font list.

When you change printing modes (Hex/Text and 2Up/Normal) V will automatically select the font last
used in that mode.

Pro p o rtio na l fo nts
Proportional fonts may not be selected for displaying files but they may be selected for printing.
Proportional fonts will not work well for program listings and hex dumps since the spacing between
characters is not fixed (it is proportional). However, proportional fonts may be preferable for printing text
files.

Line  Wra p p ing
Line wrapping will not work correctly if a non-proportional printer font is selected. In particular, the lines
will usually wrap well before the end of the page.

If proportional fonts are used, it is suggested that the Wra p  Lo ng  Line s  option not be set.

No te
Selecting Fo nts  from the menu on the More button allows the user to select a new printer font. This is
equivalent to selecting fonts from the Preferences dialog box. However, the font selected will not be
added to the font list which is displayed when clicking on the button displaying the current print font.
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29.10 More Printing Commands

Pressing the Mo re  button allows you to select one of the following:

Fo nts
This allows the user to select a new printer font. The font selected will not be added to the font list that is
displayed when pressing the button displaying the current font.

T e xt Only  Op tio ns
Sets the options for Text Only Printing

Sta rt T e xt Only  Printing
Starts Text Only Printing

Sta rt Ra w/Bina ry  Printing
Starts Raw/Binary Printing

Ap p ly  Se tting s  & Exit
This saves the print options and closes the Print dialog box. Note that pressing the Cancel button will
not save any options that have been modified.

No te

You can start Text Only and Binary printing from the command line by specifying the /PX and /PB
command line options respectively.
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29.11 Text Only Printing

T e xt Only  printing causes V to send text directly to the printer, bypassing the Windows printer driver.
This will normally be used to print to a very old printer that is not supported by Windows. 

There are 2 ways of starting Text Only printing.

The first is to simply select Sta rt T e xt Only  Printing  from the menu that is displayed when you click
on the More button.

The second is to print to a printer that uses the Ge ne ric /T e xt Only  printer driver. This is usually found
under the manufacturer of Ge ne ric  in the Add Printer Wizard. If a generic printer driver is used, V will
bypass the Windows driver and print directly to the printer (unless Text Only printing has been
disabled).
 
Text Only printing may be configured by selecting T e xt Only  Op tio ns  from the menu that is displayed
when the More button is pressed. You will probably need to know certain technical information about
the printer in order to configure it correctly (do you still have the manual?). The following options may be
specified:

D isa b le  T e xt Only  Printing
Enable this if you really want to use the Windows printer driver (which will normally be bypassed).

Pa g e  Size
The page size of the printer in columns and rows. The column size will usually be 80 or 132 and the
number of lines between 60 and 66.

Ma rg ins
The number of columns (or lines) to skip before printing each page. Note that the Page Size should
include the margins. For example, if the page width was 80 columns and the left and right margins were
5 characters, the printable page width would be 70 characters.

Se nd  a fte r e a ch LINE
This tells V what to send to the printer at the end of a new line. It will usually be one of:

CR Carriage Return (Hex 0D)
LF Line Feed (Hex 0A)
CRLF A CR followed by a LF
Othe r You may specify and of end of line character sequence if it is not one of the

above. The format of the character sequence is described below.

Se nd  a fte r e a ch PAGE
What to send to the printer at the end of each page to advance to the next page. It will usually be one of:

FF Form Feed (Hex 0C)
Bla nk Line s Advances to the next page by a series of blank lines (dependant on the page

height).
No thing Send nothing
Othe r Specify your own end of page character sequence.
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Se nd  a t Sta rt o f fi le
Character sequence to send at the start of the file (perhaps to put the printer in condensed mode).

Se nd  a t END o f fi le
Character sequence to send at the end of the file.

De la y  a fte r e a ch LINE a nd /o r PAGE
You may also tell V to wait after printing each line and/or page. The delay is specified in milliseconds.
For example, 500 milliseconds equals half a second.

A delay may be necessary if you find that the printer is losing characters due to its buffer not being large
enough.

Cha ra cte r Se q ue nce  Fo rma t

To specify a character sequence to be sent to the printer, simply type in the characters (if they are
alphanumeric). For control characters, type a % followed by the 2 d ig it he x co d e .

For example,  to send a LF/CR instead of a CR/LF you would specify %0a %0d . To send the ESCAPE
(hex 1b) character followed by the letter A you would specify %1b A.

No te s

See also Raw/Binary Printing

Print Preview will probably not work correctly for Text Only printing.

The above options can also be specified on the V command line.

29.12 Raw/Binary Printing

Text Only printing lets you send the file directly to the printer, bypassing the Windows printer driver. 

This is only really useful for printing *text* files, as V will try to paginate the files. That is, start a new page
depending on how many lines in a page.

Raw/Binary printing, however, does not paginate the file. It sends the file unmodified to the printer.

Raw/Binary printing can be used to print a file that already contains printer control codes, and needs to
bypass the printer driver in order to print correctly.
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29.13 Printer Profiles

A Printer Profile is a collection of printer settings (header, footer, font, margins, orientation, etc).

To save the current printer settings in a profile, click on the Pro file  button and select Save in New
Profile. You will then be asked to enter a profile name. This name will appear in the Profile drop-down
list box in the Print dialog box.

When a profile is selected from this list box, all the printer settings stored in the profile will be restored.

Once a profile has been selected, any settings changes will not automatically be saved back to the
profile. You will need to do this manually by clicking on the Pro file  button and selecting Save in Current
Profile.

When a profile has been modified (without being saved), the Profile list box will display "Profile Name
(Modified)" to indicate that the current settings are different from the saved profile. Note that this will not
happen as soon as the options are modified - but the next time the Print dialog box is displayed.

De fa ult Pro file

A default profile can be defined by clicking on the Pro file  button and selecting Set as Default Profile.

Defining a default profile allows the user to revert to the default profile settings whenever V is started or
after a specified number of minutes from the last print. To configure this, click on the Pro file  button and
select Default Profile Options.

No te s

The /Profile: command line option can be used to specify a printer profile

Profiles cannot be used to save Text Only options

Profiles are stored as .vp ro file  files in the user's Application Data folder - usually in:

    C:\Documents and Settings\UserName\Application Data\V\Profiles\
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30 Portable Version

A portable version of V can be downloaded from:

    http://www.fileviewer.com/Portable.html

This enables a user to take a registered copy of V wherever they go, and run it on any PC which is
running a supported operating system (Windows XP/200x/Vista). All V settings and options are stored
on the portable drive - not on the host PC. 

When the portable version of V needs to create temporary files (eg, when viewing ZIP files), they will be
created on the portable drive. There is a Create TEMP files on host option in the File Options tab of
Preferences that will cause V to create all temporary files on the host PC.

Click here to see how you can install fonts on the portable drive so they can be used if the fonts are not
installed on the host PC.

Ins ta ll ing  the  p o rta b le  ve rs io n

The portable version does not need to be installed. Simply extract the contents of the portable ZIP file
to a folder on the portable device.

No te s

Special numeric drive volumes can be used when specifying paths in Favorites and User Command.
For example, you can use 3: in a file path to refer to the portable drive (which can be different on
different systems).

There is no extra charge to use the portable version. That is, the registration code you receive when
registering V  can be also be used to register the portable version. Your V license allows you to install
V on multiple portable drives - as long as you are the only person using these drives.

http://www.fileviewer.com/Portable.html


Portable Version 301

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

30.1 Portable fonts

A V user may use certain non-standard fonts to view files that may not be available on all host systems.

V will try to load any such fonts from the portable drive by looking in the Fo nts  sub-folder.

The user should use this folder to store any font files (typically .ttf files) that they want to travel with V.
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31 Keyboard Shortcuts

31.1 Keyboard Shortcuts

Most of the Menu and Toolbar commands in V have a keyboard equivalent (and in many cases, more
than one). 

To many, it may seem that a lot of the keys have been selected at random. I'd like to think that there is a
bit more to it than that. Many V users have been using PCs for a long time and they all have their own
preferences when it comes to utilities, and in particular, to editors. 

No one wants to learn a new set of keyboard commands. Windows and CUA was supposed to fix all
this, but try telling someone who uses v i all day (a lot of people still do!) that they have to press "Ctrl-F"
to search, when they are used to typing "/ ". 

Most of the keyboard shortcuts can be customized. This allows the user to define a new keyboard
shortcut or to re-assign an existing one.  Click here for details.
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31.2 Customizing the Keys

The keyboard can be customized by selecting Cus to m ize  Ke y b o a rd from the Tools menu.

A tree will be displayed that will contain the top level menus in each of V's four views (Directory, File,
GREP and ZIP). Commands that do not appear on any menus (like Goto Directory Box in the Directory
View and Page Down in the File View) are listed underneath the Othe r branch of the corresponding
view..

When you expand the tree and click on of the commands, the shortcut keys currently corresponding to
that command (if any) will be displayed underneath S ho rtc uts  fo r S e le c te d  Co m m a nd.

Note that a command can have multiple shortcuts keys assigned to it. A key listed in b o ld  (eg, Alt+0)
indicates that the key cannot be deleted (or re-assigned). However, extra shortcut keys can be defined
for that command.

The above screenshot shows the keys currently assigned to Find Next (A, Ctrl+L, Ctrl+N and F3).

The s e le c te d  s ho rtc ut is  us e d  in  indicates that the selected key (A) is currently only defined in the File
view.
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The s e le c te d  c o m m a nd  is  a v a ila b le  in   indicates that the Find Next command is only available in the
File view.

Click on the following for further details:

Adding/Deleting Keys
List of Keys

31.3 Adding/Deleting Keys

To delete a shortcut key, simply select the key and press the D e le te button. To assign a new shortcut
to the command, click in the A d d  S ho rtc ut Ke y box, enter the new key (or key combination) and press
the Add button. Press the ESCape key to clear the A d d  S ho rtc ut Ke y box.

When adding a new key, S ho rtc ut Curre ntly  U s e d  B y will display any existing command that the key is
already assigned to. Pressing the Go to button will take you to the menu command that is currently used
by the key.

When adding or deleting a key, it will be added to (or deleted from) all available views unless Only  A d d
to /D e le te  fro m  c urre nt v ie w is enabled.

For example, Ctrl+Enter displays the File Properties in the File, Directory and GREP views. By
enabling Only  A d d  to /D e le te  fro m  c urre nt v ie w, it is possible to only redefine Ctrl+Enter in the File View
and maintain its existing functionality in the Directory and GREP views.
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31.4 Export/Import Keys

Press the E xp o rt button to export the shortcut keys to a .vkey file. Note that only the keys that have been
customized by the user are exported to the file.

Press the Im p o rt button to import the customized keys from a .vkey file. Any keys that you have
customized will remain customized, unless they have been redefined in the .vkey file.

No te

The .vkey file should not be edited

31.5 List of Keys

The Lis t o f Ke y s tab displays a list of all the keys currently used by V.

 An X is displayed in a column if that key is available in the corresponding view. The four views are:

D ir The Directory View (ie, the Directory Listing)
File The File View (viewing the file contents)
Gre p The GREP View (where V displays the GREP results)
Zip The ZIP View (viewing the contents of a ZIP file)

The Othe r column can contain one of the following:

FAV The key is assigned to a Favorite
UCMD The key is assigned to a User Command
FONT The key is assigned to a font
GRID The key is assigned to a grid
T AB The key is assigned to a Folder Tab

You can d e le te  a  ke y  by right-clicking on the key in the list and selecting D e le te  Ke y (s ). Note that
keys displayed in b o ld  cannot be deleted (and therefore, cannot be re-assigned). 
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Scro ll Ke ys
If you p re ss  a  ke y  while viewing the list of keys, the list entry corresponding to that key will be selected
(if it exists). For example, if you press Ctrl+A, the first list entry for Ctrl+A will be selected. Pressing Ctrl+A
again will select the next entry for Ctrl+A (if it exists).

This causes a problem if you use one of the scroll keys to scroll the list (like PageUp/PageDown).
Pressing PageUp will select the PageUp key in the list instead of scrolling the list. If you prefer the scroll
keys to scroll the list, enable the S c ro ll k e y s  fo r the  a b o v e  lis t option.

So rting  the  Lis t o f Ke ys
The list of keys can be "sorted" by clicking on one of the column headers. Sorting on one of the view
types (Dir, File, Grep, Zip) will display all of the keys defined in the corresponding view at the top of the
list. For example, sorting on D ir will display all of the keys defined in the Directory View at the top of the
list.
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32 FAQs (Frequently Asked Questions)

32.1 Known Bugs

The user should try to avoid the following known problems:

File tailing will not always work on network drives

Using '.' for the In Directory will usually not work when searching network drives

Greenbar does not always display properly in Print Preview - but it should print correctly

Displaying Unicode files with foreign characters requires a font to be used that supports those
characters. The same font is used for all the characters in the file. V does not use font fallback
where a different font is selected depending on the character to be displayed.

When a directory is entered into the Directory box, V will select the directory in the Explorer tree.
This does not always work if the directory is entered as a UNC (ie, in the format  \ \Co mp ute r
\D ire c to ry)

32.2 My Registration Code Doesn't Work!

My Re g is tra tio n Co d e  Do e sn' t Wo rk !

This is usually caused by an o ld  code being entered into a ne w version.

Users who registered V prior to Version 7 (ie, before November 2003) would have received an o ld
code. This code will no t wo rk  for versions after (and including) version 7.

Users who registered an earlier version of V are entitled to receive a new code fre e  o f cha rg e . To do
so, simply send an email to v@fileviewer.com requesting a new code. A new code is not required if you
are already running version 7.x.

WARNING

Although all registered users are entitled to a new code (regardless of when they registered), that code
may not allow them to use the latest version of the program.

Registration entitles you to 6 years of free upgrades. If you are trying to run a version of V that was
released more than 6 years after registering, you will get a message saying that your free upgrades
have expired (even if you are using a new code).

If you want to use the new version, you will have to re-register the program.

You may trial the new version for 30 days before deciding to register. If you do not want to register the
new version, you can go back to using the old registered version (and the expired message will go
away).

For further details, see the Upgrade Policy.

mailto:v@fileviewer.com
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32.3 My free upgrades have expired!

I g e t a  me ssa g e  sa y ing  tha t my fre e  up g ra d e s ha ve  e xp ire d !

This will happen if you are running a version that was released more than 6 years after you registered 
V.

Registered users are entitled to free upgrades for 6 years. If you want to use a version of V that was
released more than 6 years after registering, you will need to re-purchase a license.

You can continue using the older version of V without needing to upgrade.

No te

If your free upgrades have expired, you may continue evaluating the new version for up to 30 days. You
must then either upgrade to the new version or revert to using the old version.

32.4 I get a Security Warning when running V!

I g e t a n "Op e n File  - Se curity  Wa rning "  e ve ry  time  I run V!

This is caused by a new "security feature" in Windows XP SP2. It is meant to warn users that they are
about to run software that was downloaded from the Internet.

I am not sure if you can globally disable the warning, but you should be able to disable it for V.EXE as
follows:

1. In V (or Windows Explorer), locate V.EXE (usually in C:\Program Files\V)

2. Select the file V.EXE, right-click on it and select Properties

3. Press the Unblock button

32.5 I cannot install V on Windows 95!

I g e t a n e rro r me ssa g e  whe n I try  to  ins ta ll/ run V8 o n Wind o ws 95!

The standard Version 8 release will no longer run on Windows 95. If you want to run V on Windows 95,
you will have to download the Windows 95 version from:
***
http://www.fileviewer.com/Download.html

32.6 How do I get V to start in the most recently viewed directory?

Ho w d o  I g e t V to  s ta rt in the  mo st re ce ntly  v ie we d  d ire c to ry?

Enable Always restore most recent directory on startup in the Directory Options tab of Preferences, or
use the /R command line option.

http://www.fileviewer.com/Download.html
http://www.fileviewer.com/Download.html
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32.7 How do I GREP from the current directory?

Ho w d o  I GREP fro m the  curre nt d ire c to ry?

Whe n I GREP, V a lwa ys d e fa ults  to  the  p re v io us ly  se a rche d  d ire c to ry !

By default, V will always display the previously used directory in the In Directory field of the GREP
settings.

You can have V display the "current directory" by enabling Limit To and selecting Current Directory
from the drop-down list box.

32.8 How do I view multiple files from the Command Line?

Ho w d o  I v ie w multip le  fi le s  fro m the  Co mma nd  Line  (in multip le  fi le  wind o ws)?

If multiple file names are specified on the V command line, they will be opened in separate file windows
provided V is installed in the System Tray.

Click here for further details.

32.9 Can I print the Ruler?

Ca n I p rint the  Rule r?

Absolutely - you can print the ruler as either a header or a footer.

To do so, simply enable Header and/or Footer in the Print Dialog Box and enter "%r" as the header/
footer text (without the quotes).

32.10 Can I tag multiple files using the keyboard?

Ca n I ta g  multip le  fi le s  us ing  the  ke yb o a rd ?

To select multiple files using the keyboard, select the first file and then hold down the Ctrl key while
moving the Up/Down arrow buttons. Press the SPACE key to select a file (while the Ctrl key is still
pressed). Keep moving with the arrow keys and pressing SPACE to tag files.

Note that this will not work if you enable the Ctrl+Arrows keys to scroll option in the Keyboard tab of
Preferences.



V Help File310

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

32.11 Can the drive volume name be displayed with the drive letter?

Ca n the  d rive  vo lume  na me  b e  d isp la ye d  with the  d rive  le tte r?

Yes. The drive volume together with the drive icon can be displayed in the Drives list box.

You need to *disable* "Do not display Drive icons" and "Do not display Drive label" in the Directory
Options section of Preferences.

32.12 Can I have a margin when viewing a file?

Ca n I ha ve  a  ma rg in whe n v ie wing  a  fi le ?

No.

But you can enable Line Numbers. This will print line numbers to the left of each line - acting as a kind of
margin.

32.13 The V window always stays in the foreground!

T he  V wind o w a lwa ys s ta ys  in the  fo re g ro und !

You have probably enabled Always on Top (on the View menu).

Because this option can be enabled by pressing Ctrl+Shift+T, it can sometimes be accidentally turned
on.

32.14 V no longer displays TABs correctly!

V no  lo ng e r d isp la ys  T ABs co rre c tly !

You have probably enabled Sho w T a b s (on the View->Tabs menu).

Because this can be enabled by pressing Ctrl+Shift+TAB, it can sometimes be accidentally turned on.

32.15 How do I view ZIP files as hex?

Ho w d o  I v ie w ZIP fi le s  a s  he x?

Select the file and then select Vie w As->He x from the File menu (or press Ctrl+H).
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32.16 Can I create ZIP files with V?

Ca n I c re a te  ZIP fi le s  with V?

Not directly - but you can setup V to use a third party program to create ZIP files.

Click here for further details.

32.17 Shortcuts don't work when file names have spaces

I ha ve  cre a te d  a  V sho rtcut o n the  d e skto p , b ut it d o e sn' t wo rk  o n fi le s  with sp a ce s in
the ir na me ? 

I ha ve  a sso c ia te d  V with a  fi le  e xte ns io n a nd  it wo rks  mo st o f the  time .
Ho we ve r, if I use  Exp lo re r to  d o ub le -c lick  o n a  fi le na me  co nta ining  sp a ce s, it d o e sn' t
wo rk?

Use the Setup section of the Preferences Dialog box to create the shortcut or to create the file
association. This will install the shortcut/association correctly.

For those who want to create the file association manually, make sure to include quotation marks
around the file name.

Usually, the command line associated with a file extension looks something like:

c:\path\v.exe %1

This will no t work on files with spaces. To fix this, the command line should look like:

c:\path\v.exe "%1"

32.18 Can I install V in the Explorer right-click context menu?

Ca n I ins ta ll V in the  Exp lo re r rig ht-c lick  co nte xt me nu?

Yes. This is done in the Setup tab of the Preferences Dialog box.

You also have the option of installing V in the Explorer Send To menu.

No te : The following warning applies to this option.
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32.19 Where did my Toolbar Icons go?

My to o lb a r se e ms to  b e  co rrup te d  - inco rre c t ico ns a re  b e ing  d isp la ye d !

Unfortunately, when new versions of V are released, customized toolbars may become corrupt, or
more commonly, they may change back to the default toolbar.

You will need to reset the toolbar (right-click on the toolbar and select Default), and then re-customize it
(right-click and select Customize).

32.20 Can I add another button to the toolbar?

Ca n I a d d  a no the r b utto n to  the  to o lb a r?

Right-click on the toolbar and select Customize. You will see a list of Available toolbar buttons. You can
move these buttons to the main toolbar by selecting them and pressing the Add button.

If you want a button that is not in the list, please let me know and I will consider it for inclusion in a future
version.

32.21 The Microsoft Office Toolbar no longer works?

T he  Micro so ft Office  T o o lb a r no  lo ng e r wo rks?

Unfortunately, installing V in the Explorer Context menus for ALL files interferes with the operation of the
Microsoft Office Toolbar. Specifically, when you try to launch an application from the toolbar, V is
launched instead. If you want to use the Office Toolbar, you will have to disable this option. You may still
add V to the Explorer Context Menus for Unassociated files. In this case, an Op e n with V option will
appear when you right-click on a file that has no associated application.

You may still launch V from the Explorer for a ll files by installing it in the Explorer Send To menu and
"sending" the file to V.

32.22 I can't EDIT files with V?

I ca n' t EDIT  fi le s  with V?

That's right - V is a file v ie we r, not an e d ito r.

Editors are very different to viewers. They are far more complex and feature-filled programs (and
consequently, more expensive). Most good editors have macro languages, spell checking, syntax
highlighting, plugin support, and the list goes on!

In order to edit files with V, you must specify an editor for V to use.

If you want to edit a file, you can select the File->Edit command which will launch the file in your editor of
choice.
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32.23 V can't view "such and such" files!

V ca n' t v ie w "such a nd  such"  fi le s !

V is not a univ e rs a l file  v ie we r - it basically displays files in 2 formats - te xt and he x. It displays the file
data exactly as it is stored on disk.

Most file types are associated with some application. For example, DOC files are associated with
Microsoft Word, HT ML files with your browser and JPG files with a graphics program. By selecting the
File->Execute command, V will launch the program associated with the file in the same manner that
Explorer opens a file when you double click on it. V can also be configured to automatically "execute"
certain file types when you double click on them.

32.24 How do I sort the files by different criteria?

Ho w d o  I so rt the  fi le s  b y  d iffe re nt c rite ria ?

If you left-click on the column heading, V will sort the files based on that column. If you click on the same
heading again, the sort order will be reversed. A "+" or "-" will appear in the column to indicate that the
files are being sorted in ascending or descending order, respectively.

Click here for further details

32.25 How do I display line drawing characters?

Ho w d o  I d isp la y  l ine  d ra wing  cha ra cte rs?

Enable the DOS/OEM Char Set option on the View menu.

Note that this will only work if your display font supports the OEM character set.

32.26 The file icons displayed by V are incorrect!

T he  fi le  ico ns d isp la ye d  b y  V a re  inco rre c t!

This is possible if you change a file association while V is running (eg, by changing your default
browser from Netscape to IE).

V tries to speed up the directory display by keeping a "copy" of the file icon so it does not have to
continually ask the system to retrieve the icon. Unfortunately, if the icon changes, V does not know
about it, so it displays the old icon. Under certain (rare) circumstances, it is even possible for a ll the
icons to be incorrect.

Fix

Try clicking on the Re fre sh button while holding down the SHIFT key. If this does not work, you will
have to exit V and restart it.
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32.27 I can't view redirected output?

I a m re d ire c ting  the  o utp ut o f a no the r p ro g ra m into  V, b ut no thing  ha p p e ns?

For V to be able to handle the input correctly in this situation, you must use the " / f"  option.

For Example, 

dir | v /f

Alternatively,  you can enable the "Check STDIN on startup" option in the FileOptions section of
Preferences.

Doing this will cause V to automatically look for redirected output when it starts.

32.28 Printing just prints a single line?

Printing  a nd  Pre v ie wing  jus t d isp la ys  a  s ing le  l ine  o f o ve rla p p e d  te xt?

The printer font has not been set correctly. To fix this, choose Fonts from the Preferences dialog box,
make sure a valid font is selected for the printer and press OK.

32.29 How do I remove a File Mask from the drop-down list box?

Ho w d o  I re mo ve  a  File  Ma sk fro m the  d ro p -d o wn lis t b o x?

Right-click on the drop down arrow and select "Delete this entry".

Note that you cannot delete *.*

32.30 Cleansweep pops up every time I run V!

Cle a nswe e p  p o p s up  e ve ry  time  I run V!

This is actually a bug in Cleansweep which causes it to incorrectly think that V is a setup program. This
may be eventually fixed in Cleansweep - although I have now been waiting
for 2 years!

In the meantime, you can overcome the problem by renaming the file v .e xe  (say to ve e .exe).

You will also have to rename the V help files to ve e .hlp  and ve e .cnt, and you must use an editor to
modify the first line of ve e .cnt so it refers to ve e .hlp  instead of v .hlp .

Finally, you must re-apply any options you have enabled in the Setup section of Preferences.
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32.31 Can I export the V settings?

Ca n I e xp o rt the  V se tting s?

Yes.

V's program settings are stored in the Windows registry. You can use the following program to export
them to a file and import them onto another system:

http://www.fileviewer.com/VClone.html

Alternatively, if you are comfortable using the Registry Editor, you can export the following registry key:

HKEY_CURRENT_USER\Software\FileViewer\V

32.32 V just Crashed!

V jus t c ra she d !

If V c ra s he s, it will display a message saying that it encountered an une xp e c te d  p ro b le m and that it
cannot continue.

Press the S e nd button to send a detailed report to fileviewer.com for analysis.

Error reports can also be sent to fileviewer.com by selecting S e nd  E rro r R e p o rt from the Help menu

You will be presented with a list of crash files (Cra sh-xxxx.d a t) and a log file (V.lo g ). Simply select the
files that you want to send and press the Send button.

Please include a description of what you were doing just before the crash.

http://www.fileviewer.com/VClone.html
http://www.fileviewer.com/
http://www.fileviewer.com/
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32.33 Can I make V load faster?

Ca n I ma ke  V lo a d  fa s te r ?

Probably - but you will probably lose some functionality.

Every time V is started, it must read certain information from the Registry. Reducing the amount of
information it has to read may speed up the load time. However, the speed savings may be negligible -
particularly if you have a fast PC.

You can try increasing the speed by disabling the following options:

Enable MRU File List

V maintains a list of the most recently viewed files (which can be accessed from the Recent Files option
of the File Menu). If you can live without this, you can disable this option.

Maintain Directory History

V also maintains a list of the most recently visited directories, which can be selected from the Directory
drop-down list box. Disabling this option means that V will not read these directories from the registry
when it starts.

Display File Icons

By default, the Directory View displays different icons for different files - depending on the program
associated with that file (if any). Disabling this option will cause V to display the same icon for ever file,
however, it may speed up the time it takes to display the directory listing.

Do not display Drive icons/Do not display Drive label

The list of available drives usually includes an icon and label for each drive. V must access each drive
in order to obtain this information. If your system has removable drives, or perhaps slow network drives,
you may experience a slight delay when V starts. By enabling the above 2 options, V will not try to
access each drive, but will display a simple list consisting of just the drive letters.

Disable Automatic Refresh for Network Drives option

Try enabling this option if your system has mapped network drives.
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33 Tips and Hints on using V

33.1 Right-click / F1

If you are not sure how to go about doing something in V - right click. This will usually display a menu of
all the available commands.

Alternatively, pressing F1 will usually display context sensitive help.

33.2 Consider Installing V in the Tray

If you use V regularly, consider installing it in the Windows Tray.

It uses very little memory and can be quickly activated by clicking on the V tray icon. Installing V in the
tray is also necessary if you want to be able to open multiple file windows from the Command Line.

To install in the tray, you will have to enable the System Tray options in the More Options tab of
Preferences.

33.3 Use Line Numbers as a margin

V does not (yet) allow a left hand margin while viewing text. However, a good workaround is to enable
the Line Numbers display.

33.4 Determining Column Position

Use the Floating Ruler and Grid Lines to determine if your data is in the correct column.

Also, if you press the left mouse button over the start of the character (and keep it pressed), the
corresponding line and column are displayed on the status bar.  In Hex mode, the corresponding file
offset is displayed.

33.5 Viewing Redirected Output

Use V to view redirected output

33.6 File Merging

V makes it very easy to merge portions of several files into one. To do this, just use the Copy to File
command.

Simply select the first portion you want merged and save it to a file. Then do the same with the other
portions and save them to the same file - selecting the Ap p e nd  option when you are warned that the
file already exists.
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33.7 Entering File Names

When in the Directory View, you can enter the name of a fi le  directly into the D ire c to ry  Bo x. At times,
this is quicker than changing to the appropriate directory and selecting the file.

33.8 Use 2UP Mode

If you have not used 2UP Printing (and you have a printer) then p le a se  try  it. I think you will find it very
useful.

You can also print from the command line. For example,

V File.txt /2up

33.9 Use the Filename Commands

The Filename commands (on the File menu) make it very easy to quickly change the names of a group
of files.

In particular, the Modify (Regex) option is very powerful. 

33.10 Character Translation

If you do not have any need to view EBCDIC files, then you could use the EBCDIC mode to act as a file
filter or character translator.

For example, you could modify the EBCDIC mapping table so that all lower case characters were
mapped to upper case. Switching to EBCDIC mode would simply display the file in upper case.

No te

Unfortunately, only one mapping table may be defined.

33.11 Fixed Length Records

You can use the Line Length information provided by the File  Attrib ute s  command to verify that every
line in the file is the same length.

In this case, the length of the shortest line should be the same as the length of the longest line.
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34 Tips for Keyboard Users

34.1 Keyboard Tips

The following are just a few tips for users who prefer using the keyboard over the mouse.

Press the F1 key for context sensitive help.

Press the Ctrl+/Ctrl- keys in the Directory View to quickly change the sort order to ascending/
descending.

Press Ctrl-Plus (on the numeric keypad) to automatically size the column widths when displaying
the Search Results.

When viewing a file which was opened from the Search Results window, use  Ctrl-PgUp and Ctrl-
PgDown to quickly move from one match to the next.

Press Ctrl-Shift-RightArrow to scroll to the end of the longest visible line. Press Ctrl-Shift-LeftArrow
to go back to the start of the line.

Press Alt-Enter to display the File Attributes. Press Ctrl-Enter to display the File Properties.

Press Shift-F10 or the 5 key on the Numeric keypad to display right-click menus. (The 5 key will
only work if NumLock is not enabled).

Press Alt+S to toggle Dual Pane (Split) Mode

And of course, the keyboard is fully customizable.
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35 Registration

35.1 V is Shareware

V is not free software - it is distributed as sha re wa re .

This means that you are entitled to evaluate it for a trial period without charge. In this case, the trial
period is 30 d a ys. If you find the software useful and use it past this trial period, you must register it.
Further to this, V will expire after 30 days of use.

Unregistered versions of V will occasionally display a Nag Box to remind the user that the software is
unregistered. Upon registration, the user will receive a Registration Code which will permanently 
remove the Nag Box.

Unregistered use of V after the evaluation period is in violation of U.S. and international copyright laws. 

Click here for the License Agreement

Click here for details on how to register

35.2 Expiry Date

The V license allows you to evaluate V for a period of 30 days, after which time you must register it or
stop using it.

To ensure that the license is not abused, V will expire after 30 days of use. That is, it will no longer
function until you register.

Note that it will not expire 30 days from the date it was installed, but after you have used it on 30
separate days. This should be more than sufficient time to evaluate it.

Click here for details on how to register
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35.3 Features only available once registered

The following features only become fully functional once V has been registered.

Installation in System Tray

All Favorites may be selected

All User Command may be executed

Column Marking

File selection using the File List

Hex Converter

Ability to save the EBCDIC to ASCII mapping

Ability to print a ruler as a header/footer

Print Footer may be customized

Can specify a time when touching files

Column fixing

Hex line length is limited to 32

More than 500 lines can be exported to a CSV file
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35.4 Removing the Nag Box

In order to remove the Nag Box, you must register.

Upon registering, you will receive a Re g is te re d  Use r Na me  (which you select) and a
corresponding Re g is tra tio n Co d e . You must not give this code to anybody else.

To complete the registration, select Re g is te r from the He lp  menu, and enter the user name and
registration code in the appropriate sections. Pressing the Re g is te r button will then register your copy
of V.

If the registration should fail, please send an email to v@fileviewer.com, indicating the user name and
registration code used.

No te s

Please keep a copy of your registration details in a safe place. If you have to reinstall V or
perhaps install it on another machine, you will need to re-register the program.

If you lose your code, please send an email to the above address indicating your registered
user name and your code will be resent.

35.5 Upgrade Policy

All registered users are entitled to FREE upgrades for a period of 6 years.

After this time, they will need to *re-purchase* a license in order to use any newer versions.

Note that no further payment is required to continue using any version that is released within 6 years of
registering. An upgrade is only required if you want to use any versions released after 6 years of
registering.

If your free upgrades have expired, you may trial any new version for up to 30 days before registering. If
you decide that you do not want to register the new version, you can simply re-install the old version
and continue using it.

Please check the web site for further upgrade details.
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35.6 How to Register?

Details on how to register can be found at:

http://www.fileviewer.com/Order.html

http://www.fileviewer.com/Order.html
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36 Support and Feedback

36.1 Support and Feedback

The latest information on V, including the latest version of the program, FAQs and documentation, can
always be found on the V web site:

http://www.fileviewer.com/

Support for V is via email. Please send all questions, feedback and bug reports to:

v@fileviewer.com

Please note that email is a lwa ys replied to promptly. You should receive a response within 48 hours
and usually within 24 hours. If you have not received a reply to a question  within 48 hours, please do not
think that you are being ignored - the chances are that your email (or the response) has gone missing -
unfortunately these things sometimes do happen! In this case, please re-send the email.

36.2 Error Reporting

If V c ra s he s, it will display a message saying that it encountered an une xp e c te d  p ro b le m and that it
cannot continue.

Press the S e nd button to send a detailed report to fileviewer.com for analysis.

Error reports can also be sent to fileviewer.com by selecting S e nd  E rro r R e p o rt from the Help menu

You will be presented with a list of crash files (Cra sh-xxxx.d a t) and a log file (V.lo g ). Simply select the
files that you want to send and press the Send button.

Please include a description of what you were doing just before the crash.

http://www.fileviewer.com/
mailto:v@fileviewer.com
http://www.fileviewer.com/
http://www.fileviewer.com/
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36.3 Program Updates

The latest version of V can always be downloaded from:

http://www.fileviewer.com/Download.html

You can also select Che c k  fo r U p d a te s from the Help menu to see if you are running the latest version.
If a newer version is available, you will be given the option of downloading and installing it. Click here
for further details.

36.4 Suggestions

Feedback on how to make V a better product is always appreciated. If you have any suggestions a t
a ll (no matter how insignificant you may think they are), please send them to the address below.

Even feedback on why you do not like V is gratefully accepted. After all, "you can't please all of the
people, all of the time".

Please email any suggestions to:

v@fileviewer.com

http://www.fileviewer.com/Download.html
mailto:v@fileviewer.com
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37 Version History

37.1 What's New in Version 9?

Note that Version 9 will no longer run on Windows 95/98/Me/NT - it will only run on Windows XP,
2000/2003 and Vista.

The main new features in Version 9 are:

Better support for Unicode files

A Greenbar Mode when viewing files

An optional search bar at the bottom of the file window (which includes Favorite Searches)

A formatted directory listing can now be copied to the clipboard

Printer Profiles which allow you to save commonly used printer settings

U3 support

Other new features include:

You can now export/import Favorites (as well as User Commands and Grids).

The ability to view the clipboard contents as if they were a file

Alt+A (or Alt+F3) will continue searching the "next file" if no further matches are found in the file
being viewed.

Ctrl+F3 now searches for the next occurrence of any highlighted text.

Implemented double-click text selection

Gridlines can be printed (by specifying %g in the header/footer)

You can now use rules based loading to automatically load a grid based on part of the file name
being viewed

A Preview window when doing a FileName Modify

A new FileName option (Clipboard Rename) which lets you rename files based on the contents
of the clipboard

A new FileName option (Code Page) which lets you convert file names between different code
pages

A new Insert Date option in FIleName Modify

Special numeric drive volumes can be used when specifying paths in Favorites and User
Commands (useful in U3 version)

%P option specifier in User Commands prompts the user for further options

An alternative Command Processor can now be defined in the Editor/CMD tab of Preferences

V now tries to automatically recognize "EBCDIC RECFM=U" files

Support for BZip2 (.bz2) files
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New options in Version 9 include:

Display Overlay Icons on the View->Options menu

A Display Thumbnail option on the right-click menu

Try to Generate Thumbnails for Folders (in the Thumbnails Tab)

Do not sort after rename (Directory Options)

Always restore most recent directory on Startup (Directory Options)

Network/UNC timeout (Directory Options)

Do not copy CR/LF to clipboard for wrapped (to screen) lines (File Options)

A  new Unix Path option on the "Copy to Clipboard" menu.

Changed the behaviour of Windows Compatibility when dragging files (now use Ctrl key for copy,
Shift key for move)

New command line options include:

/GB to enable Greenbar mode when viewing

/PGB to enable Greenbar printing

No te s

If you have customized any of V's toolbars, you will need to re-customize them for Version 9

The existing version of VClone cannot be used to clone registry settings for V9. You will have to
download an updated version from the web site.
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37.2 What's New in Version 1.2?

The following features are new (or enhanced) in version 1.2:

Selected files can now be dragged from V

Added Column Marking

Improved text selection

Added the File List to the File View

Don't resize File View option

Delete to Recycle Bin option

Added Hex Converter

Ability to launch a Command Prompt in current directory

Slightly modified how Single Letter Commands work

Ctrl-Left and Ctrl-Right keys added for scrolling the File View

No te

Some of these features only become fully functional once V has been registered.

37.3 What's New in Version 1.3?

The following features are new (or enhanced) in version 1.3:

Supports installation in the System Tray

Files can now be dragged onto desktop shortcuts (previous version could only drag onto active
applications)

The MSDOS Name can now be displayed in the Directory View

Extra command line options implemented

User Command introduced

A ruler can now be printed as a header/footer

An End Of Line character can now be displayed/printed

Extra options introduced

The date/time of the file being printed can now be used in the header/footer as well as the current
date/time

Extra information printed in the status bar of the File View

Explorer can now use V to view any file which is not associated with an application

Microsoft IntelliMouse support

No te

Some of these features only become fully functional once V has been registered.

Ne w ke yb o a rd  a ss ig nme nts
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Alt-U, Ctrl-U User Command
TAB Move focus to the Directory Box (in Directory View)

File  Vie w

T Goto start (top) of file
B Goto end (bottom) of file
Shift-SPACE
Alt-LeftArrow Load Previous document in File List
Alt-RightArrow Load Next document in File List
Ctrl-Home Load First document in File List
Ctrl-End Load Last document in File List
Alt-DownArrow Display File List
Enter Toggle EOL mode
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37.4 What's New in Version 2.0?

The following features are new (or enhanced) in version 2.0:

The associated file icons can now be displayed (Display File Icons option)

You may now optionally Move/Copy files by dropping them onto V

The search dialog box now maintains a history of 20 search strings

Configurable wordsets which define what is highlighted when you double-click (or shift-double-
click) on a word

A column number may be specified in the Goto Dialog Box.

A list of the selected file names may now be copied to the clipboard

The MSDOS file name may now be passed to Editor/User Command

An ASCII chart can now be displayed

Enhancements to the printing functionality, including:

You may now print to a printer other than the default printer

Printer Setup may now be called directly from V

"%P" header/footer specifier

Ne w ke yb o a rd  a ss ig nme nts

Alt+A is now used to display the ASCII chart. Previously, Alt+A was used to toggle between wrapping
lines to a specified line length. This is now done by using Alt+L.
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37.5 What's New in Version 2.5?

The following features are new (or enhanced) in version 2.5:

Favorites

More User Commands

Column Fixing

Network Browsing

Advanced File Masks

Append to the clipboard

Multiple File Printing / Command Line Printing

Up to  10 headers and footers may be saved

Text Only Printing

Floating Ruler

New Hex Formats

Improved File Touching

Unicode Search

History on Copy/Move Dialogs

Customizable toolbar

More Command Line Options

Ne w ke yb o a rd  a ss ig nme nts

SPACE can now be used as Page Down
Alt-U is no longer valid for the User Command - use Ctrl-U

Ctrl-Shift-R ig ht goes to the end of longest visible line
Ctrl-Shift-Le ft goes back to column 1
Alt-N  browses the network (in Directory View)

Shift-F3 /  Shift-A perform a Find Previous
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37.6 What's New in Version 3.0?

The main new feature in version 3.0 is the file searching and text searching (GREP) functionality.

Other new (or enhanced) features in version 3.0 include:

Flat Text Mode

Configurable Start Offset

Column Search

File Position Maintenance

Improved Goto Functionality

Zoom Font

EBCDIC and ASCII Command Line Parameters

Configurable MRU Size

Separate margins for 2UP and normal printing

No te

If you have customized your toolbar in version 2.5, you will need to re-customize it for 3.0
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37.7 What's New in Version 3.1?

The main new feature in version 3.1 is the introduction of regular expression searching.

Other new (or enhanced) features in version 3.1 include:

The Zoom Out Font command  now goes down to 1 point for most fonts

A Word/Line Count command has been added to the Tools menu

Introduction of a view only command line option (/vo) which limits V to the file view and disables
many of the "advanced" features.

If a string search takes more than 5 seconds, a dialog box is displayed which allows the search
to be cancelled.

37.8 What's New in Version 2000?

The main new feature in version 2000 is ZIP file viewing.

Other new features include:

Search/GREP results may now be copied to the clipboard or to a file

Directory sort option in Directory Options

Directory History Size in Directory Options

"Hex offset in status bar" option in File Options

"Do not center found text" option in File Options

/TEXT and /Z command line options

Duplex printing command line options

"Options after file name" added in User Commands

File name remembered when "Saving to a File"

"Flip Search String" option when searching

"Restore original directory after viewing search results" option

Refresh Drives command on the View menu

Delete Temp Files command on the Tools menu

The "Shortcuts" section of Preferences was renamed to Setup
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37.9 What's New in Version 2000 (SR2)?

The main new feature in Service Release 2 is support for Unicode files.

Other new features include:

Much easier method of changing the display font

New GREP options

The search Cancel box now displays a progress indicator

Display ALL hex codes option in the File Options

If the Hex offset in status bar option is enabled, the hex code of the selected character is also
displayed in the status bar

A Create Shortcut option has been added to the File menu
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37.10 What's New in Version 2000 (SR3)?

New features in Service Release 3 include:

Send To menu

Explorer right-click menu

Double-clicking on certain files will now (optionally) execute the files

Ctrl-X/Ctrl-C/Ctrl-V can now be used as in Explorer to move/copy files

The ZIP view can now display the contents of ZIP files with directories in a standard hierarchical/
multi-level structure instead of a flat/single level listing.

Ctrl-A now selects all files in the Directory

Added columns for Created and Accessed date/time

When viewing a file, any selected text is placed in the search dialog box

When viewing a file, if you highlight a URL (or right click over it), you can send it to your browser

A second editor can now be defined for HEX mode

Selected text (and other parameters) can now be sent to User Commands

JAR files are now automatically opened (like ZIP files).

File names can now be copied to the clipboard from the ZIP View

37.11 What's New in Version 2000 (SR4)

New features in Service Release 4 include:

The font used to display the directory listing may now be modified (Change List Font on the View
menu).

When doing a search, the entire line may be highlighted in a different color to the found text.

Scrolling the file at the end/start of a chunk will automatically load the next/previous chunk.

You can now touch directories (Win NT/2000 only).

%g format specifier added to the User Commands which expands to the file name without the
extension.

Always On Top option (on the View menu)

Print from "Start of Selection" option

When copying, moving and extracting from ZIP files, the destination directory is added to the
directory history (in the Directory drop down list box).

Unicode viewing can be turned off if V incorrectly determines a file to be Unicode.

The following problems were fixed in SR4:

OEM characters were not always printed correctly
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"Print Selection" did not work for column selections

Customizing the ZIP toolbar would corrupt the GREP toolbar
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37.12 What's New in Version 2001?

New features in version 2001 include:

Improvements to hex mode viewing, including configurable line length, 64 bit mode, and the
ability to use a different font from from that used in text mode.

Ability to select commonly used print fonts from the Print dialog box

Improved line wrapping when printing.

A "Wrap Here" command while viewing text

Options for how the Home/End keys are treated

Changes to the status bar display while viewing a file

Improved File Touching

Option not to display "String not Found" message when searching

"Text Only Printing" command line options

A Keyboard tab has been added to Preferences

The following bugs were also fixed:

Cancelling a file unzip could cause a crash

Printing selected text could sometimes crash

"Sort by Size" on the View menu did not work correctly

The /ODD and /EVEN command line parameters were sometimes being ignored

When saving selected text to a file, blank lines were not always saved

Users upgrading from the release version of V 2000, should also check out the new features
introduced in SR2, SR3 and SR4.
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37.13 What's New in Version 2002?

New features in version 2002 include:

Explorer Functionality

Support for CAB, TAR and GZIP files

Multiple String Searching in GREP

Selection size displayed on the status bar

Multiple rulers

Ctrl-RightClick on the ruler (or Ctrl+Alt+R) toggles the starting column

The search string history that V maintains can now be cleared (and disabled)

Numbers in a highlighted column can be summed

Changes to Text Only printing and introduction of Raw/Binary printing

Files can be copied/moved by "right-dragging"

The Unix Path (Cygwin) of the selected files can be copied to the clipboard

Ctrl+Alt+O displays a rooted Explorer

Entry of hex numbers using the 0x prefix

Map and Disconnect Network Drive buttons

%A can be specified as the Command Path in User Commands to indicate the associated
application of the selected file

Correct line numbers are maintained when lines are wrapped and when a new chunk is loaded

New options have been introduced to:

Not display system and hidden files

Display directories at the end of the list

Ignore Binary files in GREP

Ignore form feed characters

Ignore consecutive carriage returns

Make the /F command line parameter redundant

Display the file mask on the window title

Start Search from Next Line

Wrap to Start when searching

Allow mixed hex/text data in search string

Disable the middle mouse button

Better control over directory history

Use the same path history for Copy and Move operations

Make closing the file window (by pressing X) equivalent to pressing the ESC key

Maintain sort order when changing sort column

Configure the functionality of the ENTER key
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New command line options include:

/S

/PX and /PB

/L and /O

/IFF and /IFFP

/OEMP

No te s

If you have customized the toolbar of the Directory View, the toolbar may not display correctly. You will
need to reset it to the default toolbar and then re-customize it.

The search options have been removed from the File Options tab. They can now be accessed by
pressing the Options button in the Search dialog box.
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37.14 What's New in Version 7?

New features in Version 7 include:

Greater color customization

Greater EBCDIC (including RECFM) support

Support for RAR files

Support for 4DOS descriptions

Vertical Hex Mode

Better support for paginated files

A Count button in the Search dialog box

Long lines can be wrapped onto a new page when printing

You can now goto line numbers that are outside the current chunk

You can now modify the size of the File Mask History

Changed the way that selected hex data is copied to the clipboard

The following options have been introduced:

"Do not lock file option" which allows the file to be modified while V is viewing it

Disable mouse-click rename option

Ctrl+Arrow keys to scroll option

Windows Explorer Sort option

New command line options include:

/VH for Vertical Hex Mode

/VFONT to specify the View Font

/PAGELIMIT and /WRAPPAGE printing options

/RECFM and /LRECL EBCDIC options

New keyboard shortcuts include:

Alt+J for Vertical Hex Mode

Ctrl+Shift+U to repeat the previously executed User Command

'\' to toggle the Match Case search option

No te

All registered users will need to obtain a new registration code.
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37.15 What's New in Version 7.1?

The major new feature in Version 7.1 is the ability to search the contents of ZIP files (and other
supported archives).

Other new features include:

Environment variables (like %PATH%) can now be used in GREP/Find Files

A "Disable IconHandler" option which can speed up the display of the directory listing

You can now sort the file list on the Description column

An option which causes V to treat 1K as 1000 bytes (instead of 1024)

"Executed" files are now added to the MRU

EBCDIC RECFM files may now be displayed with the ASCII character set

A "Disable Explorer Selection Delay" option

Reset Line Numbers on New Page option

You can now skip over a specified number of matches when searching

When making a column selection, "Copy Sum to Clipboard" has been added to the Auto-sum
menu

The color of the ruler grid line can now be customized (Change Colors from the View menu)

You can now count the words/lines in a selection as well as in the entire file (from the Tools
menu).

You can now pass command line options to customize the Command Prompt that V launches.
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37.16 What's New in Version 7.2?

The 2 main new features in Version 7.2 are the addition of GridLines and File Tailing.

GridLines are vertical lines (and column headings) that can be displayed while viewing a file.

File Tailing will automatically refresh a file if it is being modified while you are still viewing it.

Other new features include:

Word/Line count can now be applied to multiple files and to selected text

Favorites and User Commands can now be sorted

"Wrap To Screen" is now allowed in Flat Text Mode

"Explorer compatibility" when dragging files to another drive

Search->Count now displays the count in the current selection

Improvements to FileName->Modify

Some History lists can now be sorted

Support for Advanced Encryption Standard (AES) ZIP files

This version also introduces a new Upgrade Policy

No te

If you have customized any of V's toolbars, you will need to re-customize them for 7.2
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37.17 What's New in Version 8?

The main new features in Version 8 are:

Dual Pane (Split) Mode

Thumbnails Mode

Multiple File Windows

Support for Alternate Data Streams (ADS)

Other new features include:

GridLines can now be imported

Introduction of a Default Grid Directory

MD5/CRC32 Calculation

Auto-complete when entering a directory name

InfoTips Support

In Dual Pane Mode, you can add a pair of directories to the Favorites

User Commands support %1 and %2 prefix for split panes

Explorer-style drag and drop when using the right mouse button

"Open Selection in V" option while viewing a file

"Execute" option in Favorites

Use Bold Cursor option in the File Options tab

Tailing now works when V is not active

Option to disable left-click drag/move

A "Create File" option has been added to the Tools menu

New "FileName" options - Capitalize Initials and Translate

Decimal Offset is now displayed in the Status bar

File Mask can now specify null extensions

Added Random Sort Order to the Directory Listing

TABs and End Of Line character codes are now displayed in Vertical Hex Mode

A new Print Option which lets you "Draw a Line" (page separator) whenever a Form Feed is
encountered (instead of starting a new page).

Added Quick Launch option in Setup tab of Preferences

Option to Add the V Directory to the System PATH

Added separate display color for compressed/encrypted files

"Match Case Toggling" can now be disabled

Executed files added to the Recent Files List are now re-executed
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New command line options include:

/LEN:nn to set the wrap length when viewing a file

/SPLIT /NOSPLIT /VSPLIT /HSPLIT added for Dual Pane Mode

New Keyboard assignments  include:

Swapped meaning of the SHIFT key in Organizing Favorites

Added "Goto Root" toolbar button (Ctrl+Backspace)

Changed +/- to Ctrl +/- to change the sort order of the directory listing. Changed Auto-size to Ctrl
+Shift+Plus

Alt+N/Alt+P no longer display the next/previous file (use Alt+LeftArrow/Alt+RightArrow)

No te s

If you have customized any of V's toolbars, you will need to re-customize them for Version 8

The standard Version 8 release will no longer run on Windows 95. If you want to run V on
Windows 95, you will have to download the Windows 95 version from http://www.fileviewer.com/
Download.html

http://www.fileviewer.com/Download.html
http://www.fileviewer.com/Download.html
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38 License and Copyright

38.1 License Agreement

END USER LICENSE AGREEMENT

You are granted a non-exclusive license to use this version of V (the Software) free of charge for
evaluation and trial purposes only.

You may evaluate the Software for a period of up to 30 days from the date of installation. After this
period, you must register the software or remove it from your computer.

SINGLE USER LICENSE

Each registered copy of the Software may be installed on multiple computers as long as it is ONLY used
by the registered user. If any person other than the registered user uses the Software, then this
agreement is being violated. Alternatively, the Software may be used by multiple users as long as the
Software is installed on one and ONLY ONE computer.

MULTIPLE USER LICENSE

A Multiple User License covers the use of the Software by a group of users (or contractors) working for a
single organization. The number of licenses required depends on the number of users using the Software.
Each user needs a license which allows them to run the Software on a single computer. If the same user
is to run the Software on other computers, another license needs to be installed on each additional
computer. If the software is to be accessed via a network, then each network server that will be running
the software must be licensed in addition to each user.

See the end of this document for examples.

UNLIMITED SITE LICENSES

An Unlimted License (Single Site) allows an unlimited number of users to use the Software, provided all
users are located on a single site. A single site can consist of multiple buildings, as long as the
buildings lie within a radius of 20 miles. Users who are mobile or do not work from the main site (eg, they
may work from home) are regarded as working from the main site.

An Unlimited License (Single Site) also allows for up to 200 "off site" users. This means that a company
based in one city can still have up to 200 users around the country. If more than 200 users will be using
the Software outside the main site, they will need to be covered by a separate license.

An Unlimited License (National) allows for an unlimited number of users to use the Software, provided all
users are located in the one country. This also allows for up to 400 users outside the country. If more
than 400 users will be using the software in another country, an Unlimited License (International) needs
to be purchased.

LIMITATIONS

You may not:

use the Software after the evaluation period without paying the registration fee.

modify, translate, reverse engineer, decompile, disassemble, or create derivative works based
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on the Software

rent, lease or otherwise transfer rights to the Software

remove any proprietary notices or labels on the Software

divulge the REGISTRATION CODE obtained when licensing the Software to any outside parties.

DISCLAIMER OF WARRANTY

The Software is provided AS IS, without warranty of any kind, including without limitation the warranties
of merchantability, fitness for a particular purpose and non- infringement. The entire risk as to the quality
and performance of the Software is borne by you. Should the Software prove defective, you and not
Charles Prineas or his suppliers assume the entire cost of any service and repair.

TITLE

Title, ownership rights, and intellectual property rights in the Software shall remain with Charles Prineas.
The Software is protected by copyright and other intellectual property laws and by international treaties.

TERMINATION

The license will terminate automatically if you fail to comply with the limitations described herein.

EXAMPLES OF MULTIPLE USER LICENSES

If 10 users will be running the Software on their own computer, a 10 user license is required.

If the Software is to be installed on 10 computers where a total number of 10 users can use the software
on any computer, a 10 user license is required.

If the Software is to be installed on 20 computers where a total number of 10 users can use the software
on any computer, a 20 user license is required.

If the Software is to be installed on 10 computers where a total number of 20 users can use the software
on any computer, a 20 user license is required.

If the Software is to be installed on a network server where a maximum number of 10 users can use it, an
11 user license is required.

END
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38.2 Copyright

The V File Viewer is Copyright © 1996-2015 Charles Prineas. All Rights Reserved.

V implements regular expressions using the PCRE (Perl Compatible Regular Expressions) library
written by Philip Hazel.

At time of writing, the PCRE source code could be downloaded from

http://www.pcre.org/

PCRE is Copyright © 1997-2012 University of Cambridge.

http://www.pcre.org/
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No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including
photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the
publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no
responsibility for errors or omissions, or for damages resulting from the use of information contained in this
document or from the use of programs and source code that may accompany it. In no event shall the publisher and
the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused
directly or indirectly by this document.

Printed: November 2015

No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including
photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the
publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no
responsibility for errors or omissions, or for damages resulting from the use of information contained in this
document or from the use of programs and source code that may accompany it. In no event shall the publisher and
the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused
directly or indirectly by this document.

Printed: November 2015
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Cascade File Windows     145

CCTYPE     239

center text     158

centimetres     294

Change Colors     72

change extension     63, 70

character set     133

character translation     318

chunks     126, 135, 232, 260

chunks and goto     166

Classic Mode     48

Cleansweep     314

clear highlight     174

clear marked blocks     174

clearing selected text     176

clearing the history     272

Click here for details on Sorting User Commands    
283

clipboard     55, 59, 178, 179

clipboard (copying wrapped lines)     252

clipboard append     179

clipboard contents (viewing)     141

Clipboard rename     69

Clone V Settings     315

CMD.EXE     58, 270

code page (file name conversion)     68

Collapse all Folders     107

Collapse Folders     107

Colors     48, 72

colors (Highlight All)     76

column and line number     176

column copy     177

Column Fixing     137

column headers     91

Column headings     93

column marking     177

column names (CSV)     153

column number     165

Column Position     134

Column Search     159

column searching (using regular expressions)     221

column sum     178

column width     194

Columns     91

Command Line     25

Command Line - Viewing Multiple Files     145

Command Line Options     28

Command Line Search     31

Command Processor     270

Command Prompt     57, 58

Commander Style Interface     24

comments     101, 248

Compatibility Files     74, 104, 193, 254

COMSPEC     58

COMSPECOPTIONS     58

Conditional Subpatterns     220

Confirm File Delete     260

console     317

context menu     257, 266

Continuous scrolling     162

Control Panel     106, 257

Copy Command     50

Copy Files History     272

copy search results     195

copy to clipboard     252

copy/move     53

Copying File Names to the Clipboard     55

copying files     98, 99

copying text     178

copying text to a file     179

copying to the clipboard     178

Copyright     348

corrupt toolbar     312

corrupted ZIP files     248

count     61, 159

CR     245

crash     39, 315

CRC32     60

Create Directory     57

Create File     57

Create Shortcut Here     98

Created File Time     91

Creating Grids     224

Creating ZIP Files     249

CSV column names     153

CSV delimiter     231

CSV Export     231

CSV files     231

CSV Mode     150

CSV Options     151

CSV quotes     151

Ctrl+Arrow keys     274

Current Date     293

current file position     167

Current Line Marker     162

Current Mapping     264

current position     154

Customizing the Directory View     91
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customizing the toolbar     49

cut     178

cut and paste     99

Cygwin     55

D
date     54

Date (insert into file name)     66

Date Format     252

Debug Format     140

Debug Mode - User Commands     282

Debugging User Commands     284

decimal     59, 148

Default Grid Directory     226

default header format     293

Default Mapping     264

default printer     288

default printer profile     299

Default User Command     284

default viewer     266

default ZIP viewer     250

delete a file mask     78

Delete Command     50

descript.ion     101

Desktop     266

desktop shortcut     98

desktop shortcuts     101

destination path     53

Details Mode     87

Digital Cameras     118

Directories (show at bottom)     80

directory (on startup)     254

Directory Box     78, 318

Directory box color     73

Directory Create     57

Directory Font     81

directory history     53, 78, 272

directory listing (formatted)     103

Directory Mask     84

directory refresh     260

Directory View     47, 78, 318

Disconnect Network Drive     57

Display a Hex     264

Display File Icons     316

Display Line Number 1     264

Display Line Numbers     264

DLLs     250

DNA     160

DNA options     154

DOC Thumbnails     117

documentation     324

DOS Box     25, 57, 58, 317

DOS Character Set     137

double DWord     148

double sided printing     288

Double-Click     263

double-click text selection     174

double-sided printing     35

Drag and Drop     98

Drag and Drop Support     25

Drag and Drop using right mouse button     98

dragging files     98

drive icon     310

Drive Label     254

drive letter     78, 310

Drives Box     78, 254

dropped files     254

Dual Pane     24

Dual Pane Favorites     110

Dual Pane Mode     108

duplex     35

duplexing     288

DWord     148

E
EBCDIC     133, 264, 318

EBCDIC Files     235

EBCDIC files - searching     193

EBCDIC fixed record length     237

EBCDIC mapping     318

Edit Command     50

EDIT files with V     312

editor     87, 270, 313

Editor Options     270

Editor Path     270

elevation     64

email     324

embedded thumbnail     268

Encrypted ZIP Files     246

End of Line     123, 129

End of Line character     129

End Of Line Indicator     271

end offset     176

end point     174
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end-of-line     264

environment variables     181

environment variables (directory box)     78

EOL     123, 129, 271

error message     158

error reports     39

ES     199

ES Masks     200

ESCape key     252, 274

evaluation     320

even page printing     35

Everything Search     199

Everything Search Masks     200

exception     39

EXE icon     254

execute     242

Execute Command     50

execute file     263

EXIF     118

Expand all Folders     107

Expand Folders     107

Expand/Collapse folders     257

Expiry Date     320

Explorer     57, 105, 266, 311

Explorer background an text     74

Explorer colors     74

Explorer Context Menu     100

Explorer Context menus     312

Explorer expand     257

Explorer icons     106

Explorer menu     257

Explorer Options     257

Explorer Refresh     106

Explorer right click menu     254

Explorer right-click context menu     311

Explorer root     57

Explorer Selection Delay     257

Explorer sort     80

Export Data     228

Export Favorites     280

Export keys     305

Export to CSV     231

Export User Commands     287

Export V Settings     315

Exporting Grids     228

extension (do not select on rename)     260

Extract     243

Extract All & Run     247

Extract Options     245

F
FAQs     324

FAT     191

Favorite - Always Open in Pane 1     278

Favorite Directories     278

Favorite Files     279

Favorite Searches     170, 196

Favorites     275

Favorites (Export)     280

Favorites in Split Mode     110

Favorites Organize     277

features     22

Feedback     324

FF     294

File Attributes     139

file chunks     232, 260

File Chunks (overview)     126

file colors     76

file comments     101

File Create     57

file descriptions     101

File Encoding     179

file filter     318

file icons     254

File List     123, 241

File List Format     87

file locking (overview)     122

File Management Commands     50

File Mask     78, 82, 314

File Mask color     73

file mask history     272

File Merging     317

file name conversion (code page)     68

file names     318

file offset     165

File Position Maintenance     169

File Search     181

File Tailing     140

File Tailing (overview)     126

File View     47

File View Split     142

File Windows - Multiple     144

FileName Modify     66

filter     34, 317

find     154

Find Next     158
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Find Next from Current     158

Find Next from next line     158

Fix Columns     137

Fix Line Numbers     137

fixed length records     128, 165, 223, 226, 318

fixed line length     131

Flat Text mode     128

flip ends     148

Floating Ruler     134

fnmatch     82

folder icon     257

folder icons     106

FolderTabs     111

font     81, 149

Font scaling     14

Font Zoom     123

Fonts     137, 271

Fonts (portable)     301

footer     293

form feed     294

Form Feeds     169, 288, 294

format specifiers     293

formatted directory listing     103

found color     76

found text     76

frame     117

free upgrades     308, 322

freshen     245

From the Command Line     25

Full Path Name     293

full row click     96

G
GDIPLUS.DLL Error     119

Generic/Text Only     297

Go Up     87

Goto     165

goto and chunks     166

greedy     212

Greenbar Colors     138

Greenbar Options     138

GREP     180, 184, 195, 198

GREP Favorites     196

GREP from current directory     309

Grid Export     228

Grid Import     230

grid line color     76

Grid Lines     134

Grid rename     225

Grid Rules     227

GridLines     223

GridLines - automatically loading     226

GridLines - Default Directory     226

GridLines (printing)     293

GridLines creating     224

GridLines Fixed length records     226

GridLines Organize     225

Gridlines Wrap Options     226

Grids (export)     280

Grids and file extensions     228

GZIP     240

H
header     293

Headers and Footers     288, 293

hex     59, 140

hex characters     157, 158

Hex Converter     57

Hex Editor     270

hex font     149

hex format     148

hex line length     149

hex mode     140, 147

Hex Numbers (entering)     48

hex offset     176

hex offset in status bar     252

hex search     154, 157

hex string     157

hidden files     74, 78, 95

hidden files color     74

Hide Compatibility Files     104

hiding files     95

High DPI     14

highlight     174

Highlight all     14

Highlight All (Search Bar)     170

Highlight All colors     76

history     53, 272

hotspot     168

HP LaserJet     271, 295

HTM(L) Thumbnails     117

http     168

hyperlink     168
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I
IBM     133

IconHandler     254

icons     313

Icons (overlay)     80

Ignore Binary Files     184

Import Favorites     280

Import Keys     305

Importing Grids     230

inches     294

InfoTips     273

InfoTips for Thumbnails     118

Info-Zip     249

Install V on Desktop     27

install ZIP files     247

installing the protable version     300

IntelliMouse     164

invert the order of the sort     93

invoke     242

IUPAC Search     160

K
Keyboard Customization     302

Keyboard Shortcuts     47, 302

Keys (Export/Import)     305

keys for searching     161

L
Landscape     295

Language     274

large files     126

Large Icons     87

launch     50, 242

LF     245

License     346

License Agreement     346

line and column number     176

line count     61

Line Drawing characters     137

line feed     129, 139, 264

line length     149, 318

Line Lengths     139

line number     165

Line Number Increment     264

Line Number Reset     264

Line Numbers     135, 264

Line Numbers in Chunks     135

Line Range (print)     288

line terminator     129, 139

line wrap     291

Line Wrapping     136

LinePrinter     271

LinePrinter font     295

List Mode     87

List of Keys     305

long lines     136

longest line     139

lost code     322

lower case     63, 70

M
macro languages     313

Map Network Drive     57

mapping     133

mapping table     318

Margins     288, 294

mark blocks     174

marker color     76

marking columns     177

mask     82

Mask (directory)     84

match case toggle     161

MD5     60

menu     49

merge     317

Message Digest     60

meta-characters     204

metadata     118

Microsoft Office Toolbar     312

middle mouse button     252

Minimize on Close     262

Minimize to System Tray     262

Modify (Regex)     70

Modifying File Names     66

more     34

more command     317

More Options     260

mouse-click rename     260

Move Command     50

Moving Favorites     277

moving files     98, 99
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MPG thumbnails     117

MRU     52

MSDOS File Name     270

MSDOS Name     55

MSDOS name in lower case     254

multi-line CSV fields     152

multiple file mask     82

Multiple File Windows     144, 309

Multiple Files     144

Multiple String Searching     189

N
Nag Box     320, 322

names have spaces     311

Network browsing     78, 84

Network Drive     57

Network Drives - refresh     257

Network Neighborhood     106, 257

Network/UNC timeout     254

New File     57

new line     129

New Page     169, 294

new toolbar     14

next     96, 123

non-proportional font     271

Norton Commander     24

not found     158

NTFS     191

NTFS volumes     199

Number Entry     48

numbered bookmarks     168

O
octal     59

octal (byte)     148

octal (word)     148

odd page printing     35

OEM Character Set     137

Office Toolbar     312

offset     140, 165

older version     39

Once-only Subpatterns     218

Only if Newer     245

Open File - Security Warning     308

Open Selection in Browser     168

Open Selection in V     168

Options     28

Organize Grids     225

Organizing Favorites     277

Organizing User Commands     283

Overlay Icons     80

overwrite     245

over-writing     179

P
Pad with zero     264

page break     294

page breaks in EBCDIC files     239

Page Length     288, 294

page limit     35

page marker     169

Page Number     293

Page Range (print)     288

Page Up/Down     274

pages     169

pagination     169

pane swapping     109

Partial Name Match and ES     200

password     246

PATH environment variable     266

path history     53

pause     317

pause scrolling     162

pause search     196

PCRE     202

PDF Files (searching)     184

PDF Thumbnails     117

Perl     203

pipe     28, 34

portable file paths     281, 300

portable fonts     301

portable version installation     300

Preferences     251

preview (modify file names)     66

previous     96, 123

previous versions     40

Print     288

Print First Line in Page     264

Print From Here     292

Print from Top of Page     292

Print Last Line in Page     264

print limit     35

Print Line Numbers     288
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Print New Page     294

Print Options     288

Print Range     292

Print ruler     293

Print Setup     288

printable character     140

printer font     271, 294

Printer Fonts     295

Printer Profiles     299

printing     318

printing gridlines     293

Printing Line Numbers     264

printing problems     314

printing the directory listing     103

printing the ruler     293

Profiles (printer)     299

program error     315

Program Updates     39

Prompt before reloading     252

proportional fonts     271, 295

Q
Quick Launch Bar     266

R
RAR     240

Raw/Binray Printing     296

Recent Documents     263

Recent Files     52

RECFM     236

RECFM ASCII files     236

RECFM=F     237

RECFM=U     238

RECFM=V/VB     236

record number     165

Recycle Bin     260

redirected output     28, 34, 314, 317

Refresh     106

refresh (disable automatic)     80

Refresh Directory     87

refresh drives     78

Refresh File     123

Regex (FileName Modify)     70

Registered User Name     322

registered version     321

Registration     323

Registration Code     320, 322

registry entries     40, 266

regular expression     198

regular expression file masks     181

Regular Expression search option     154

Regular Expressions     202, 204

regular expressions (for column searches)     221

remember file position     169

Remove From List     195

remove spaces     63, 70

Removing Search Results     195

Removing the Nag Box     322

rename (do not re-sort)     260

Rename Command     50

rename files (to clipboard contents)     69

rename Grid     225

Repetition     212

Reset Line Numbers     264

Resizing the column width     91

Restore wrap settings     226

restoring previous versions     40

right click     47

right click menu     257

right dragging     98

Right To Left     127

right-click     100

Rooted Explorer     57, 87

RTL     127

Ruler     134, 252, 293

ruler (printing)     293

run     50, 242

Running V     25

S
Save as ASCII     239

saving search results     195

saving text to a file     179

Screen Font     271

scroll bars     162

Scrolling     162

scrolling (synchronized) in split mode     143

scrolling (synchronized) with multiple windows     146

scrolling speed     162

search     154, 195

Search (Favorites Searches)     170

search (GREP)     184

search abort     196



V Help File358

V Help File v15 - Copyright (C) 1996-2015 Charles Prineas, All Rights Reserved.

Search Again     154

search backwards     161

Search Bar     170

Search Bar Options     170

search cancel     196

search colors     76

search count     159

search history     154, 272

search keys     161

search line colors     76

search message     158

Search Options     158, 266

search pause     196

Search Skip     159

search string     157

search text     157

searching     48, 154, 180

Searching a List of Files     188

Searching ADS     121

Searching Columns     159

searching EBCDIC files     193

Searching on the Command Line     31

searching PDF files     184

Searching ZIP Files     187

Security Warning     308

selected background     73

selected text     73, 174

selected text color     76

selecting files     97

selecting text     174, 176

selecting text (double click)     174

Selecting words     177

selection length     176

self-extracting EXE     97

Send Error Report     39

Send To     99

Send To Menu     266, 311, 312

Sequencing Files     71

setup     247, 266

SFX     97

shared icon     257

shareware     320

Shell Notifications     260

shortcuts     98, 101

shortcuts don't work     311

shortest line     139

shortest non-empty     139

show tabs     131

Single Letter Commands     85, 260, 274

Single Pane     24

Skip Search     159

Small Icons     87

smooth scrolling     164, 260

sort (after rename)     254

Sort (Explorer option)     80

Sort (XP option)     80

Sort by Extension     93

Sort by left-click     93

Sort by right-click     93

sort directory entries     80

sort files     313

Sorting Favorites     280

Sorting File Names     95

Sorting GREP Favorites     197

Sorting the search results     195

Sorting User Commands     287

sorting ZIP files     242

speed     162

spell checking     313

Split Favorites     110

Split File View     142

Start Menu     266

start offset     131, 176

start point     174

startup directory     254

Status Bar     132, 176

stdin     28, 34, 252

string count     159

string count (search bar)     170

stripes     73

striping     73

Subpatterns     211

suggestions     325

sum     178

Summary of Features     22

Support     324

swapping panes     109

synchronized scrolling in split mode     143

synchronized scrolling with multiple windows     146

syntax highlighting     313

system colors     72

system files     78, 95

System Menus     27

System Tray     27, 262
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T
Tab Sets     114

Tab Size     252

tabbed browsing     111

Tabs     131

tagging files     97

tail     96, 252

tailing     140

tailing on Unix drives     140

TAR     240

temporary files     57, 247, 250

Testing ZIP Files     248

text file (saving to)     179

Text Mode     126

Text Only Printing     296, 297

Text Search (GREP)     184

text selection     176

The File View     122

themes     73

Thumbnail Caching     119

Thumbnail InfoTips     118

Thumbnail Preferences     268

Thumbnails in ZIP View     241

Thumbnails Mode     116

Thumbnails Mode Error     119

Tile File Windows     145

time     54

timeout (network)     254

timeout UAC     64

toolbar     49

Toolbar - Directory View     87

Toolbar - File View     123

Toolbar - ZIP View     241

toolbar corruption     312

Tools     57

Touch     54

Touch Command     50

touching directories     54

trailing spaces     236

translate characters in file name     63

translation     274

Tray     27, 262

TuFix     223

two-up     295

U
UAC     64

UAC and Everything Search     201

UCS-2     127

UNC     307

UNC Path     55

UNC/Network timeout     254

Unicode files     127

Unicode search option     154

Unicode/UTF-16     148

Uninstalling V     40

universal file viewer     313

Unix     22, 55

Unix drives (tailing)     140

Unknown Publisher     308

unsorted     242

unzip     243

UnZIP and UAC     243

Updates     39

Upgrade Policy     322

upgrades     308

upper case     63, 70

URL     168

URL Path     55

User Commands     243, 282, 283

User Commands (Export)     287

User Commands in Split Mode     110

Using File Associations     25

UTF-16     127

V
version 1.2     328

version 1.3     328

Version History     21

vertical hex mode     149

very large files     126

video frame thumbnail     117

Video Thumbnails     117

View Hex     96

View Only Mode     34

View Tail     96

viewing files     96

Viewing Multiple Files     144

Viewing Multiple Files from the Command Line     145

viewing the clipboard contents     141
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Vista UAC     64

voidtools     199

W
wc     61

What V is NOT!     313

What's New     328

whole word only     154

Window Layout     259

window title     254

Windows - Multiple     144

Windows 95     308

Windows Background Menu     100

Windows Explorer     105

word     148

word boundary     136

word count     61

Word Sets     260

wordsets     177

Wrap     123, 136

Wrap Here     136

Wrap Length     136

Wrap Lines at Column     226

Wrap Lines to Screen     252

Wrap on Word Boundary     252

wrap settings restore     226

Wrap Text     136

Wrap to Length     136

Wrap to Screen     136

Wrap to Start     158

wrapped lines (copying to clipboard)     252

Wrapping in flat text mode     136

Wrapping Lines     291

Write to File     179

X
XMIT     239

XMIT save as ASCII     239

XP Sort     80

Z
ZIP - Creating ZIP Files     249

ZIP Comments     248

ZIP files     97, 240

ZIP files (extract)     243

ZIP Folders     242

ZIP icon     250

ZIP View     240

Zoom Font     123
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